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Preface

Audience for This Guide
Welcome to Release 11i of Oracle iStore Implementation Guide.

This guide assumes you have a working knowledge of the following:

� The principles and customary practices of your business area.

� Oracle iStore 11i

If you have never used Oracle iStore 11i, Oracle suggests you attend one or 
more of the Oracle iStore 11i training classes available through Oracle 
University.

� The Oracle Applications graphical user interface. 

To learn more about the Oracle Applications graphical user interface, read the 
Oracle Applications User’s Guide.

See Other Information Sources for more information about Oracle Applications 
product information.

How To Use This Guide
This guide contains the information you need to understand and use Oracle iStore 
11i.

� Chapter 1 provides an introduction to Oracle iStore 11i and a brief description 
of its features.

� Chapter 2 describes the Oracle iStore 11i architecture and lists minimum 
software and hardware requirements.
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� Chapter 3 summarizes Oracle iStore 11i’s application dependencies and details 
required setups in the mandatory dependencies.

� Chapter 4 provides an overview of the Oracle iStore 11i implementation process 
and its tasks.

� Chapter 5 details the required implementation tasks for Oracle iStore 11i.

� Chapter 6 details the optional implementation tasks for Oracle iStore 11i.

� Chapter 7 describes tasks for verification of an Oracle iStore 11i 
implementation.

� Chapter 8 provides tips for troubleshooting Oracle iStore 11i implementation, 
use, and administration.

� Chapter 9 describes the integration of Oracle iStore 11i with Oracle Advanced 
Supply Chain Planning.

� Chapter 10 describes the integration of Oracle iStore 11i with Oracle 
Configurator.

� Chapter 11 describes the integration of Oracle iStore 11i with Oracle Contracts 
for Sales.

� Chapter 12 describes the integration of Oracle iStore 11i with Oracle iPayment.

� Chapter 13 describes the integration of Oracle iStore 11i with Oracle iSupport.

� Chapter 14 describes the integration of Oracle iStore 11i with Oracle Marketing 
Online.

� Chapter 15 describes the integration of Oracle iStore 11i with Oracle Shipping 
Execution.

� Chapter 16 describes the integration of Oracle iStore 11i with Oracle Web Cache.

� Chapter 17 describes the integration of Oracle iStore 11i with Oracle Workflow.

� Appendix A lists the profile options that are relevant to Oracle iStore 11i 
implementation and provides a procedure for setting profile options.

� Appendix B summarizes the responsibilities required to perform the Oracle 
iStore 11i implementation tasks described in this guide.

� Appendix C explains the usage of the iStore Self-Service Administrator user 
interface to implement Oracle iStore 11i.
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Typographic Conventions
This manual uses the typographic conventions listed in the following table:

Documentation Accessibility 
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
documentation includes features that make information available to users of 
assistive technology. This documentation is available in HTML format, and contains 
markup to facilitate access by the disabled community. Standards will continue to 
evolve over time, and Oracle Corporation is actively engaged with other 
market-leading technology vendors to address technical obstacles so that our 
documentation can be accessible to all of our customers. For additional information, 
visit the Oracle Accessibility Program Web site at 
http://www.oracle.com/accessibility/.

Accessibility of Code Examples in Documentation
JAWS, a Windows screen reader, may not always correctly read the code examples 
in this document. The conventions for writing code require that closing braces 
should appear on an otherwise empty line; however, JAWS may not always read a 
line of text that consists solely of a bracket or brace. 

Accessibility of Links to External Web Sites in Documentation 
This documentation may contain links to Web sites of other companies or 
organizations that Oracle Corporation does not own or control. Oracle Corporation 
neither evaluates nor makes any representations regarding the accessibility of these 
Web sites. 

Convention Meaning

italic text Book titles

Courier text User commands, file content examples, directory names

UPPERCASE Structured Query Language (SQL) commands, initialization 
parameters, profile options, responsibilities, or environment 
variables

boldface text Menu, button, keyboard, and form options, emphasis

< > Angle brackets enclose user-supplied names. 

Note: Do not type the angle brackets.
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Other Information Sources
You can choose from many sources of information, including online documentation, 
training, and support services, to increase your knowledge and understanding of 
Oracle iStore 11i.

If this guide refers you to other Oracle Applications documentation, use only the 
Release 11i versions of those guides.

Online Documentation
All Oracle Applications documentation is available online (HTML or PDF). Online 
help patches are available on MetaLink.

Related Documentation
Oracle iStore 11i shares business and setup information with other Oracle 
Applications products. Therefore, you may want to refer to other product 
documentation when you set up and use Oracle iStore 11i.

You can read the documents online by choosing Library from the expandable menu 
on your HTML help window, by reading from the Oracle Applications Document 
Library CD included in your media pack, or by using a Web browser with a URL 
that your system administrator provides.

If you require printed guides, you can purchase them from the Oracle Store at 
http://oraclestore.oracle.com.

Documents Related to All Products

Oracle Applications User’s Guide
This guide explains how to enter data, query, run reports, and navigate using the 
graphical user interface (GUI) available with this release of Oracle iStore 11i (and 
any other Oracle Applications products). This guide also includes information on 
setting user profiles, as well as running and reviewing reports and concurrent 
processes.

You can access this user’s guide online by choosing ”Getting Started with Oracle 
Applications” from any Oracle Applications help file.
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Documents Related to This Product

Oracle iStore Concepts and Procedures
This document provides users with information on general principles and 
procedures for maintaining Web stores using Oracle iStore 11i.

Oracle iStore API Reference Guide
This guide has information about Oracle iStore 11i Java APIs.

Oracle Advanced Planning and Scheduling Implementation and User’s Guide
This guide describes the implementation of Oracle Advanced Supply Chain 
Planning, which you can set up to provide global inventory availability information 
for Oracle iStore 11i.

Oracle Applications Implementation Wizard User Guide
This guide explains how to use the Oracle Applications Implementation Wizard to 
facilitate the Oracle Applications implementation process.

Oracle Configurator Developer User’s Guide
This guide explains the Oracle Configurator setup steps that allow the sale of 
configurable items through Oracle iStore 11i.

Oracle Contracts for Sales Concepts and Procedures
This guide describes the usage of Oracle Contracts for Sales, which provides 
contract negotiation and creation functionality when integrated with Oracle iStore 
11i.

Oracle CRM Application Foundation Concepts and Procedures
This guide describes the usage of Oracle CRM Application Foundation to approve 
and maintain resources for Oracle CRM applications such as Oracle iStore 11i.

Oracle CRM Technology Foundation Concepts and Procedures
This guide explains the setup and usage of Oracle CRM Technology Foundation 
features that Oracle iStore 11i uses.

Oracle CRM Technology Foundation Implementation Guide
This guide provides information on setting up Oracle CRM Technology Foundation, 
a mandatory dependency for Oracle iStore 11i.
xxv



Oracle General Ledger User Guide
This guide provides information on setting up Oracle General Ledger, a mandatory 
dependency for Oracle iStore 11i.

Oracle HTML Quoting Concepts and Procedures
This guide explains how sales representatives can use Oracle HTML Quoting to 
view carts and orders that are placed in Oracle iStore 11i.

Oracle HTML Quoting Implementation Guide
This guide describes Oracle HTML Quoting roles that use Oracle iStore 11i 
permissions.

Oracle Inventory User’s Guide
This guide provides information on setting up Oracle Inventory, a mandatory 
dependency for Oracle iStore 11i.

Oracle iPayment Concepts and Procedures
This guide describes the usage of Oracle iPayment, which provides credit card 
payment functionality for Oracle iStore 11i.

Oracle iPayment Implementation Guide
This guide describes the implementation of Oracle iPayment, which provides credit 
card payment functionality for Oracle iStore 11i.

Oracle iSupport Implementation Guide
This guide details the implementation of Oracle iSupport, which can be 
implemented with Oracle Telephony Manager to provide call-me-back functionality 
for Oracle iStore 11i.

Oracle Marketing Online Implementation Guide
This guide describes the implementation of Oracle Marketing Online, which creates 
marketing postings for display in the Oracle iStore 11i storefronts.

Oracle Master Scheduling/MRP and Oracle Supply Chain Planning User's 
Guide 
This guide describes the usage of Oracle Material Requirements Planning, which 
works with Oracle Advanced Supply Chain Planning to provide global inventory 
availability information for Oracle iStore 11i.
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Oracle Order Capture Concepts and Procedures
This guide explains how sales representatives can use Oracle Order Capture to view 
Oracle iStore 11i carts and orders.

Oracle Order Capture Implementation Guide
This guide provides information on setting up Oracle Order Capture, a mandatory 
dependency for Oracle iStore 11i.

Oracle Order Management User’s Guide
This guide provides information on setting up Oracle Order Management, a 
mandatory dependency for Oracle iStore 11i.

Oracle Pricing User’s Guide 
This guide provides information on setting up Oracle Pricing, a mandatory 
dependency for Oracle iStore 11i.

Oracle Receivables User Guide
This guide provides information on setting up Oracle Receivables, a mandatory 
dependency for Oracle iStore 11i.

Oracle Shipping Execution User’s Guide
This guide explains the setup of shipping parameters in Oracle Shipping Execution. 
Oracle iStore 11i can use these shipping parameters.

Oracle8i interMedia Text Reference
This guide explains how to set up synonym files in Oracle8i interMedia, a necessary 
step to implement synonym product search functionality in Oracle iStore 11i.

Oracle8i Server Administrator's Guide
This guide describes the administration of Oracle8i. It provides instructions on 
setting up Oracle interMedia when implementing Oracle iStore 11i’s product search.

Oracle9iAS Web Cache Administration and Deployment Guide
This guide explains the administration and deployment of Oracle Web Cache, 
which can be set up to cache and serve catalog and search pages for the Oracle 
iStore 11i storefront.
xxvii



Using Oracle HRMS - The Fundamentals
This guide provides information on using Oracle Human Resources, a mandatory 
dependency for Oracle iStore 11i.

Implementing Oracle CRM: ERP Functional Checklist, Release 11i
This document provides information on the functional flows of Oracle Enterprise 
Resource Planning (ERP) Applications when integrated with Oracle Customer 
Relationship Management products. It is available on Oracle MetaLink.

Implementing Oracle CRM: Foundation Functional Checklist, Release 11i
This document provides information on the functional flows of other Oracle 
Foundation Applications when integrated with Oracle Customer Relationship 
Management products. It is available on Oracle MetaLink.

Installation and System Administration

Oracle Applications Concepts
This guide provides an introduction to the concepts, features, technology stack, 
architecture, and terminology for Oracle Applications Release 11i. It provides a 
useful first book to read before an installation of Oracle Applications. This guide 
also introduces the concepts behind Applications-wide features such as Business 
Intelligence (BIS), languages and character sets, and Self-Service Web Applications.

Installing Oracle Applications
This guide provides instructions for managing the installation of Oracle 
Applications products. In Release 11i, much of the installation process is handled 
using Oracle Rapid Install, which minimizes the time to install Oracle Applications, 
the Oracle8 technology stack, and the Oracle8i Server technology stack by 
automating many of the required steps. This guide contains instructions for using 
Oracle Rapid Install and lists the tasks you need to perform to finish your 
installation. You should use this guide in conjunction with individual product 
user’s guides and implementation guides.

Upgrading Oracle Applications
Refer to this guide if you are upgrading your Oracle Applications Release 10.7 or 
Release 11.0 products to Release 11i. This guide describes the upgrade process and 
lists database and product-specific upgrade tasks. You must be either at Release 10.7 
(NCA, SmartClient, or character mode) or Release 11.0, to upgrade to Release 11i. 
You cannot upgrade to Release 11i directly from releases prior to 10.7.
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Maintaining Oracle Applications
Use this guide to help you run the various AD utilities, such as AutoUpgrade, 
AutoPatch, AD Administration, AD Controller, AD Relink, License Manager, and 
others. It contains how-to steps, screenshots, and other information that you need to 
run the AD utilities. This guide also provides information on maintaining the 
Oracle applications file system and database.

Oracle Applications System Administrator’s Guide
This guide provides planning and reference information for the Oracle Applications 
System Administrator. It contains information on how to define security, customize 
menus and online help, and manage concurrent processing.

Other Implementation Documentation

Oracle Workflow Guide
This guide explains how to define new workflow business processes as well as 
customize existing Oracle Applications-embedded workflow processes.You also use 
this guide to complete the setup steps necessary for any Oracle Applications 
product that includes workflow-enabled processes.

Oracle Applications Flexfields Guide
This guide provides flexfields planning, setup and reference information for the 
Oracle iStore 11i implementation team, as well as for users responsible for the 
ongoing maintenance of Oracle Applications product data. This manual also 
provides information on creating custom reports on flexfields data.

Oracle eTechnical Reference Manuals
Each eTechnical Reference Manual (eTRM) contains database diagrams and a 
detailed description of database tables, forms, reports, and programs for a specific 
Oracle Applications product. This information helps you convert data from your 
existing applications, integrate Oracle Applications data with non-Oracle 
applications, and write custom reports for Oracle Applications products. Oracle 
eTRM is available on Metalink

Oracle CRM Application Foundation Implementation Guide
Many CRM products use components from CRM Application Foundation. Use this 
guide to implement CRM Application Foundation correctly.
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Training and Support

Training
Oracle offers training courses to help you and your staff master Oracle iStore 11i 
and reach full productivity quickly. You have a choice of educational environments. 
You can attend courses offered by Oracle University at any one of our many 
Education Centers, you can arrange for our trainers to teach at your facility, or you 
can use Oracle Learning Network (OLN), Oracle University’s online education 
utility. In addition, Oracle training professionals can tailor standard courses or 
develop custom courses to meet your needs. For example, you may want to use 
your organization’s structure, terminology, and data as examples in a customized 
training session delivered at your own facility.

Support
From on-site support to central support, our team of experienced professionals 
provides the help and information you need to keep Oracle iStore 11i working for 
you. This team includes your Technical Representative, Account Manager, and 
Oracle’s large staff of consultants and support specialists with expertise in your 
business area, managing an Oracle8i server, and your hardware and software 
environment.

OracleMetaLink
OracleMetaLink is your self-service support connection with web, telephone menu, 
and e-mail alternatives. Oracle supplies these technologies for your convenience, 
available 24 hours a day, 7 days a week. With OracleMetaLink, you can obtain 
information and advice from technical libraries and forums, download patches, 
download the latest documentation, look at bug details, and create or update TARs. 
To use MetaLink, register at (http://metalink.oracle.com).

Alerts: You should check OracleMetaLink alerts before you begin to install or 
upgrade any of your Oracle Applications. Navigate to the Alerts page as follows: 
Technical Libraries/ERP Applications/Applications Installation and 
Upgrade/Alerts.

Self-Service Toolkit: You may also find information by navigating to the 
Self-Service Toolkit page as follows: Technical Libraries/ERP 
Applications/Applications Installation and Upgrade.
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Do Not Use Database Tools to Modify Oracle Applications Data
Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data 
Browser, database triggers, or any other tool to modify Oracle Applications data 
unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and 
maintain information in an Oracle database. But if you use Oracle tools such as 
SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of 
your data and you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using 
Oracle Applications can update many tables at once. But when you modify Oracle 
Applications data using anything other than Oracle Applications, you may change a 
row in one table without making corresponding changes in related tables. If your 
tables get out of synchronization with each other, you risk retrieving erroneous 
information and you risk unpredictable results throughout Oracle Applications.

When you use Oracle Applications to modify your data, Oracle Applications 
automatically checks that your changes are valid. Oracle Applications also keeps 
track of who changes information. If you enter information into database tables 
using database tools, you may store invalid information. You also lose the ability to 
track who has changed your information because SQL*Plus and other database 
tools do not keep a record of changes.

About Oracle
Oracle Corporation develops and markets an integrated line of software products 
for database management, applications development, decision support, and office 
automation, as well as Oracle Applications, an integrated suite of more than 160 
software modules for financial management, supply chain management, 
manufacturing, project systems, human resources and customer relationship 
management.

Oracle products are available for mainframes, minicomputers, personal computers, 
network computers and personal digital assistants, allowing organizations to 
integrate different computers, different operating systems, different networks, and 
even different database management systems, into a single, unified computing and 
information resource.

Oracle is the world’s leading supplier of software for information management, and 
the world’s second largest software company. Oracle offers its database, tools, and 
applications products, along with related consulting, education, and support 
services, in over 145 countries around the world.
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Introduction

This chapter provides an introduction to Oracle iStore 11i. Topics include:

� Oracle CRM E-Commerce Suite Overview

� Oracle iStore 11i Overview

� New in this Release

� Obsolete in this Release
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Oracle CRM E-Commerce Suite Overview
1.1 Oracle CRM E-Commerce Suite Overview
Oracle CRM E-Commerce Suite, Release 11i, is a comprehensive Web-based solution 
for unassisted business-to-business (B2B) and business-to-consumer (B2C) selling, 
marketing, and servicing via the Internet. It covers the entire spectrum of the 
e-commerce value cycle, from managing effective marketing campaigns to 
providing customer self-service. The Oracle CRM E-Commerce Suite encompasses 
the following:

� Merchant administration

� Affiliate linking

� Sophisticated catalog management

� Guided selling

� Merchandising

� Order management

� Payment processing

� Intelligence reporting

The following application products are included in the Oracle CRM E-Commerce 
Suite: 

� Oracle HTML Quoting

� Oracle iStore 

� Oracle iSupport

� Oracle Knowledge Management

� Oracle Marketing Encyclopedia System

� Oracle Order Capture

� Oracle Quality Online

Oracle CRM E-Commerce applications are part of the Oracle E-Business Suite, an 
integrated set of applications that is designed to transform your business into an 
e-business.
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Oracle iStore 11i Overview
1.2 Oracle iStore 11i Overview
Oracle iStore 11i provides businesses from all industries with the ability to establish 
business-to-business and business-to-consumer electronic commerce. The Oracle 
iStore 11i application provides an easy-to-use mechanism for merchants to set up 
Internet storefronts that capture and process customer orders and to integrate their 
storefronts with Oracle Enterprise Resource Planning (ERP) applications.

1.2.1 Oracle iStore 11i Features
The key features and benefits of Oracle iStore 11i include the following:

� Specialty stores to create different stores within a single instance for serving 
different customer segments. Each store can have its own product selection, 
user interface, and process flows, while all the stores can utilize a unified, 
central merchant administration and repository of products and content.

� A rich product catalog that can display in multiple languages and currencies 
and is dynamically generated to reflect customer-specific product selection and 
pricing. The product catalog also supports a variety of relationships between 
products and product groups.

� Oracle Configurator for guided selling of complex products and configurable 
items

� Sophisticated order capture for customer-specific pricing, shipping and 
handling, and tax, and access to inventory availability

� Channel integration to leverage assets and processes, and to achieve a 
consistent customer experience across the contact points

� Seeded roles and permissions to offer personalized features for different 
customer segments and channel partners

� Self-administration that enables customers to manage store users and 
processes, thereby lowering operational costs

� Personalization and recommendations that cross-sell and up-sell items and 
improve the visits to purchase ratio for your Web stores

� B2B functionality that allows management of complex relationships with 
corporate customers in a self-service environment
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New in this Release
1.3 New in this Release
The following features are new in this release:

� Storefront Reports (Data Out Bins)

� Notification Mapping

� New Notifications

� Logical Mapping of Style Sheet, Menu, and Images

� Synonym Product Search

� Business-to-Business (B2B) User Automatic Approval

� Integration with Oracle Marketing Online’s eMerchandising

� Integration with Oracle Web Cache

� Self-Service Administration

Storefront Reports (Data Out Bins)
The Storefront Reports are pre-defined reports that collect and present valuable 
business data about your customers’ interactions with your stores. Anyone with the 
required responsibility can view the reports as Data Out Bins in Oracle iStore 11i or 
in another application. Users can set their own Data Out Bin preferences. 

Notification Mapping
Oracle iStore 11i sends notifications to users and sales representatives to inform 
them that a notification event has occurred. You can select the default message for 
each notification event and map other messages to the notifications according to 
organization and user type. You can also disable a notification event, either 
completely or for specific organization-user type combinations.

New Notifications
Five new notifications are included in this release:

� Contract Negotiations Request - To Users

� Contract Negotiations Request - To Sales Representatives

� Contract Negotiations Request - Approval

� Contract Negotiations Request - Cancellation 

� Contract Negotiations Request - Disapproval
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Obsolete in this Release
Logical Mapping of Style Sheet, Menu, and Images
Oracle iStore 11i now provides a powerful way to define storefront elements using 
the Merchant UI. The style sheet, menu elements, and images now have logical 
template mappings. These mappings eliminate the need to customize code when 
you change the catalog and menu appearance with custom images and a custom 
style sheet.

Synonym Product Search
The synonym product search functionality returns search results with product 
names that you have set up as synonyms of the users’ search criteria.

Business-to-Business (B2B) User Automatic Approval 
You can choose to activate automatic approval of business-to-business (B2B) users. 

Integration with Oracle Marketing Online’s eMerchandising
The seeded catalog section, catalog item, and shopping cart pages have dynamic 
bins that can display postings from Oracle Marketing Online’s eMerchandising.

Integration with Oracle Web Cache
You can use Oracle Web Cache to cache and serve Oracle iStore 11i catalog and 
search pages. Oracle Web Cache can also cache Oracle iStore 11i style sheet files, 
static HTML pages, GIF and JPG/JPEG image files, and JavaScript (*.js) files. 

Self-Service Administration
Oracle iStore 11i’s new self-service administration simplifies and accelerates the 
implementation of one specialty store with a single currency, language, and tax. 
This store can support only B2C users who are located in the United States.

1.4 Obsolete in this Release
The following features are obsolete in this release:

� The Mona Lisa UI—Only the CABO UI is now supported.
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Technology, Requirements, and Perform
2

Technology, Requirements, and

Performance

This chapter provides an overview of the architecture and requirements of Oracle 
iStore 11i. Topics include:

� Architectural Overview

� Minimum Software Requirements

� Minimum Hardware Requirements
ance 2-1



Architectural Overview
2.1 Architectural Overview
In Oracle iStore 11i architecture, data is loaded and retrieved directly from ERP 
main tables. This functionality provides instant real time data status to Web stores 
and to other integrating systems and applications.

Figure 2–1 Oracle iStore 11i Architecture
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Minimum Hardware Requirements
2.2 Minimum Software Requirements
The minimum software requirements are listed in the following table.

See the following Web sites for documentation of the required software:

� docs.oracle.com for Oracle8i and Oracle Forms documentation

� www.apache.org for Apache documentation

2.3 Minimum Hardware Requirements
The suggested hardware configuration for Oracle iStore 11i is a series of Web 
servers in the front and a high performance database server machine in the back 
end. With global systems, the necessity for high performance database servers is 
even greater.

Oracle recommends the following server requirements: 

� ERP database server machine—high throughput at fast speed (CPU)

� Web servers running Apache for external customers

� One forms server for administration

You can determine the actual sizing of the machines after completing capacity 
planning. 

Specific hardware requirements depend on the particular installation that you 
perform. The hardware requirements listed in the following table are guidelines 
only, and assume a single-node environment.

Table 2–1 Minimum Software Requirements 

Software Requirement

Database 8.1.7 version of Oracle8i

Middle-Tier The middle-tier requirements are an Apache 3.0 version Web 
server and Oracle Forms 6.0 server (as a part of Oracle ERP 11i 
implementation). For faster page serving, you can also use a 
caching server in front of the Web server series. The caching 
server (for example, Calypso) then serves the static content 
through the cached TCP/IP packets (or cached pages). An 
invalidated cache results in service requests being directed to the 
Web servers.
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Minimum Hardware Requirements
Table 2–2 Minimum Hardware Requirements 

Hardware Requirement

CPU 2 CPUs minimum, 4 or more highly recommended

Memory 256 MB minimum, 1GB or more highly recommended

Disk Space 22GB, including 1GB in /tmp (plus an additional 9GB if 
installing from a staging area)
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Dependency Requirements and Verification

This chapter describes the setup of applications and other program functions on 
which Oracle iStore 11i depends. Topics include:

� Mandatory Dependencies

� Conditional Dependencies

� Installation and Dependency Verification
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Mandatory Dependencies
3.1 Mandatory Dependencies
Oracle iStore 11i integrates with many other Oracle application modules to provide 
and extend its functionality. You must set up the mandatory modules before Oracle 
iStore 11i can run. Setting up the optional modules is not required; however, if they 
are not set up, then the additional functionality provided by these modules will not 
be available.

The modules listed in this section must be set up for Oracle iStore 11i to function 
properly.

Oracle Application Object Library
Oracle Application Object Library (AOL) is a required dependency of all Oracle 
application modules. Oracle iStore 11i uses AOL to manage responsibilities of store 
managers as well as customers. You also define new languages and manage 
prompts for your store here.

Oracle General Ledger
Oracle General Ledger provides business unit information to Oracle iStore 11i.

Oracle CRM Technology Foundation
Oracle CRM Technology Foundation is a prerequisite for implementation of any 
Oracle CRM module. You set up properties in Oracle CRM Technology Foundation 
for debug logging trails and cookie encryption. You also specify default roles and 
responsibilities for users in this module.

Oracle Human Resources
Oracle Human Resources stores information related to your organizations, such as 
permitted bill-to and ship-to countries.

Oracle Inventory
Oracle Inventory is a required dependency for Oracle iStore 11i. The following 
information is set up in Oracle Inventory:

� Category structure to set intelligent defaults for the ways products can be 
displayed and for different multimedia components used to display products

� Item information
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� Oracle Inventory itself requires at least one inventory organization to be set up 
and at least one business unit (organization) to be set up. In addition, it requires 
at least one product catalog group to be set up, even though you may not use it.

Oracle Order Capture
Oracle Order Capture provides pricing, shipping, and tax information for Oracle 
iStore 11i, and transforms Oracle iStore 11i shopping carts into orders in Oracle 
Order Management.

Oracle Order Management 
Oracle Order Management (OM) processes orders from Oracle iStore 11i and 
provides order tracking, returns, and history. Oracle Order Management in turn 
depends upon Oracle Pricing and Oracle General Ledger. Oracle iStore 11i uses 
Oracle Order Management to keep records of orders placed by customers and 
pricing of those orders. It does so by using Oracle Order Capture APIs. Oracle 
Order Management in turn uses: 

� Oracle Receivables for keeping records of customers and invoices, and 
capturing payments upon shipments

� Oracle Order Capture for collecting order information

� Oracle Pricing for determining prices of goods sold

� Oracle Shipping Execution for shipping execution

Oracle Pricing
Oracle Pricing provides the prices of goods sold for Oracle iStore 11i. It enables 
complex, customer-specific pricing through price lists and pricing agreements.

Oracle Receivables
Oracle Receivables is a central data repository for customer information that uses 
Oracle’s Trading Community Architecture (TCA) model. It also calculates taxes and 
generates invoices.

Note: Oracle Order Management in turn requires you to set up 
the inventory and business units as well as financials-related 
parameters.
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3.1.1 Dependency Setup Process Flow
The following figure illustrates the suggested process flow for setting up Oracle 
iStore 11i dependencies. You must perform the required steps. You need to perform 
the optional steps only if you plan to use the related features or complete certain 
business functions.

Figure 3–1 Oracle iStore 11i Dependency Setup Process Flow

3.1.2 Dependency Setup Checklist
The following table lists the Oracle iStore 11i dependency setup steps.

Table 3–1 Dependency Setup Checklist 

Step Required/Optional Reference

1. Install Software Required See Installing Oracle Applications.

2. Set Up Oracle Application 
Object Library

Required Section 3.1.4, "Setting Up Languages and 
Currencies in AOL", Section 3.1.5, "Setting Up Sales 
Assistance Prompts in AOL"

3. Set Up Oracle General Ledger Required Section 3.1.6, "Setting Up Oracle General Ledger"
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Using the Oracle Application Implementation Wizard
Use the Oracle Application Implementation Wizard (AIW) to coordinate 
dependency setups and identify the steps required to implement the Oracle iStore 
11i application.

You can use the AIW to see the graphical overview of the steps involved, read 
online help on set up and open the appropriate forms. You can also document your 
actions for further reference and review.

Refer to Oracle Application Implementation Wizard User’s Guide for more details.

4. Set Up Oracle Human 
Resources

Required Section 3.1.7, "Setting Up Oracle Human Resources"

5. Set Up Oracle Inventory Required Section 3.1.8, "Setting Up Product Items in Oracle 
Inventory", Section 3.1.9, "Setting Up Oracle 
Inventory for Regular Available to Promise (ATP)"

6. Set Up Oracle Receivables Required Section 3.1.10, "Setting Up Oracle Receivables"

7. Set Up Oracle Pricing Required Section 3.1.11, "Setting Up Oracle Pricing"

8. Set Up Oracle Order 
Management

Required Section 3.1.12, "Setting Up Oracle Order 
Management"

9. Set Up Oracle Order Capture Required Section 3.1.13, "Setting Up Oracle Order Capture"

10. Set Profile Options for the 
iStore Merchant UI

Required Section 3.1.14, "Setting Profile Options for the 
Oracle iStore 11i Merchant UI"

11. Set Up Oracle CRM Technology 
Foundation

Required Section 3.1.15, "Setting Up Oracle CRM Technology 
Foundation"

12. Set Up Conditional 
Dependencies

Optional Chapter 9 through Chapter 17

13. Set Up Oracle iStore 11i Required Chapter 4, "Implementation Overview"

Table 3–1 Dependency Setup Checklist (Cont.)

Step Required/Optional Reference
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3.1.3 Accessing Oracle Forms
Some setups for Oracle iStore 11i and its dependencies require that you use Oracle 
Forms. Launch Oracle Forms by navigating to:

http://<host>:<apache port>/

and clicking Apps Logon Links > VIS Logon through the Forms cartridge. When 
Oracle Forms launches, log in with the appropriate user name and responsibility to 
perform the required tasks.

3.1.4 Setting Up Languages and Currencies in AOL
Oracle Applications 11i allows you to have a setup with multiple languages and 
currencies against one instance. The languages and currencies that you enable 
determine the set of languages and currencies that you can select for your specialty 
stores.

Oracle iStore 11i supports the implementation of a global store in a single instance. 
Each specialty store can support multiple languages and currencies. Globalization is 
also supported in an environment with multiple business units or organizations.

Every registered Web store customer has a preferred language and currency 
associated in his or her user profile. The Web store customer can change the 
preferred language or currency by modifying his or her account profile.

For a given specialty store, you select languages and currencies from those 
languages and currencies enabled at the Oracle Applications level. Your specialty 
store will be available to users only in the languages and currencies that you select. 
This functionality provides you the flexibility to create both global and 
country-specific specialty stores. See Section 5.5, "Creating Specialty Stores" for 
further details about the globalization capabilities of Oracle iStore 11i stores.

See Oracle Applications Concepts and Oracle Applications System Administrator’s Guide 
for information on setting up languages and currencies in AOL.
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3.1.5 Setting Up Sales Assistance Prompts in AOL
Web store customers can request help from a sales representative through the 
Oracle iStore 11i Sales Assistance feature. Sales Assistance events proceed through 
the following sequence:

1. The user logs in to the store.

2. The user creates a shopping cart or activates an existing saved shopping cart.

3. The user proceeds to checkout.

4. In the Review Order and Confirm page, the user clicks the Request Assistance 
button.

5. In the sales assistance request page that opens, Oracle iStore 11i prompts the 
user to choose from a list of reasons why he or she needs assistance, and to 
enter any comments.

6. The user submits the request by clicking the Submit Request button.

7. Oracle iStore 11i saves the user’s comments as notes associated with the cart. 
The application submits the shopping cart as an order with an Entered status.

8. Oracle iStore 11i sends a notification to the user’s sales representative. See 
Section 5.9.2, "Setting Up Notification Recipients" for more information.

9. The sales representative can then contact the user, provide the necessary 
assistance, and book the order.

In AOL, you can activate and set up the list of reasons for needing assistance that 
customers choose from when using the Sales Assistance feature. You accomplish 
this by setting up lookup codes with meanings for the AOL lookup type IBE_
SALES_ASSIST_REASONS_LK, using the AOL Lookups Form. 

When you are ready to activate the Sales Assistance feature, set the profile option 
IBE: Use Sales Assistance Feature to Yes, as described in Section A.6, "Oracle iStore 
11i (IBE) Profile Options for the Customer UI". Using the Sales Assistance feature is 
optional.

Use the following procedure to set up lookup codes for the lookup type IBE_
SALES_ASSIST_REASONS_LK.
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Steps
1. Log in to Oracle Forms with the Application Developer responsibility.

2. Choose Application > Lookups > Application Object Library.

The Application Object Library Lookups window opens.

3. Choose View > Find.

The Lookup Types search window opens.

4. Select IBE_SALES_ASSIST_REASONS_LK and click OK.

The Application Object Library Lookups window is populated with the lookup 
codes for IBE_SALES_ASSIST_REASONS_LK.

5. In each row of the Application Object Library Lookups window, you can add a 
lookup code for a sales assistance request reason as follows:

a. In the Code field, enter the lookup code.

b. In the Meaning field, enter a meaning for the lookup code.

c. Optional: In the From and To fields, select the effective dates for the lookup 
code.

d. Check the Enabled checkbox.

6. Save the form.

3.1.6 Setting Up Oracle General Ledger
Because Oracle Order Management and Oracle Inventory require at least one Multi 
Org and associated set of books, you must create at least one business unit in Oracle 
General Ledger. See Oracle Applications Concepts for more information on business 
units and multi-org. See Oracle General Ledger User Guide for information on setting 
up business units.

Setup of daily currency conversion rates in Oracle General Ledger is a prerequisite 
for Oracle iStore 11i’s Storefront Reports. See Section 5.10.3, "Setting Up Conversion 
Rates for Storefront Reports" for more information.

You must also perform the following tasks when setting up Oracle General Ledger:

� Define a chart of accounts in Oracle General Ledger, with a value set, an 
Accounting Flexfield Structure, and segments and segment values.

� Define a calendar.
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� Define and enable currencies.

� Define a set of books.

See Oracle General Ledger User Guide for information on how to perform these tasks.

3.1.7 Setting Up Oracle Human Resources
You must perform the following tasks when setting up Oracle Human Resources:

� Set the profile option HR: User Type at the application and Global HRMS 
Manager responsibility levels. This profile option is required for accessing the 
work structures.

� Define a Business Group.

� Define locations.

� Define a legal entity and operating unit.

� Define employees.

See Using Oracle HRMS - The Fundamentals for information on how to perform these 
tasks.

Creating global specialty stores also depends on setups for your organizations in 
Oracle Human Resources. Use Oracle Human Resources to specify the permitted 
bill-to and ship-to countries for each of your operating units. You can associate each 
of these operating units to different customer user responsibilities, as Section 5.12.4, 
"Setting Multiple Organization (MO) Profile Options" explains. 

In Oracle iStore 11i, you can then set up each of your specialty stores to support 
specific responsibilities. You can also set up each of your specialty stores to include 
or exclude B2B users by their own organization affiliations, for a higher degree of 
control over the extent of globalization available to each customer.

The Oracle Human Resources bill-to and ship-to country setups for each of the 
operating units associated with these responsibilities will determine the extent of 
globalization of each specialty store for each user.

Use the following procedure to set up bill-to and ship-to country information for an 
organization. See Using Oracle HRMS - The Fundamentals for more information.
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Steps
1. Log in to Oracle Forms with the Human Resources responsibility.

2. Choose Work Structures > Organization > Description.

The Find Organization window opens.

3. In the Find Organization window, enter the search criteria for your merchant 
organization and click Find.

The Organization form opens with the organization’s record.

4. In the Organization Classifications region, select Operating Unit in the Name 
fields.

5. Click Others.

The Additional Organization Information window opens.

6. In the Additional Organization Information window, enter %Country in the 
Find field and click Find.

7. In the search results, choose Bill to Country and click OK.

The Additional Organization Information window for Bill to Country opens.

8. Place your cursor in a Bill to Country field.

The Bill to Country window opens.

9. Add countries to the Additional Organization Information window for Bill to 
Country as follows:

a. In the Bill to Country window, click the Bill to Country LOV button.

The Bill to Country search window opens.

b. Search for a country, highlight it, and click OK.

The Bill to Country field in the Bill to Country window is populated with 
the value of this country.

c. Click OK to add the country to the Additional Organization Information 
window for Bill to Country.

d. Repeat for each country that you want to allow as a bill-to country for this 
merchant organization.

10. When you are finished adding countries, click OK in the Additional 
Organization Information window for Bill to Country.
3-10 Oracle iStore Implementation Guide



Mandatory Dependencies
You return to the Organization form with the organization’s record.

11. In the Organization Classifications region, select Operating Unit in the Name 
fields.

12. Click Others.

The Additional Organization Information window opens.

13. In the Additional Organization Information window, enter %Country in the 
Find field and click Find.

14. In the search results, choose Ship to Country and click OK.

The Additional Organization Information window for Ship to Country opens.

15. Place your cursor in a Ship to Country field.

The Ship to Country window opens.

16. Add countries to the Additional Organization Information window for Ship to 
Country as follows:

a. In the Ship to Country window, click the Ship to Country LOV button.

The Ship to Country search window opens.

b. Search for a country, highlight it, and click OK.

The Ship to Country field in the Ship to Country window is populated with 
the value of this country.

c. Click OK to add the country to the Additional Organization Information 
window for Ship to Country.

d. Repeat for each country that you want to allow as a ship-to country for this 
merchant organization.

17. When you are finished adding countries, click OK in the Additional 
Organization Information window for Ship to Country.

You return to the Organization form with the organization’s record.
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3.1.8 Setting Up Product Items in Oracle Inventory
Oracle Inventory serves as the repository of product items that can be sold through 
Oracle iStore 11i. Use Oracle Inventory to create new items, then create additional 
content for the Web through the Oracle iStore 11i Merchant UI. Before you can 
create items in Oracle Inventory, you must set up and define the structure around it. 
Refer to Oracle Inventory User’s Guide for details of inventory setup.

Guidelines
While making decisions about inventory setup, use the following guidelines:

� Products must have their Web Status set to either Published or Unpublished to 
appear in the Oracle iStore 11i Merchant UI. The Web Status can be changed 
later in Oracle Inventory or Oracle iStore 11i.

� Items that will be sold through the Web must be set with the following flags in 
the Oracle Inventory Master Item form:

� Web Status = Published

� Orderable on the Web

� Customer Orders Enabled

� Oracle iStore 11i uses the category structure to keep track of default ways of 
displaying products as well as default values for multimedia components 
associated with the product. All items belonging to a category in specified 
category sets are treated similarly from a display perspective. In Oracle iStore 
11i setup, you set the IBE: Category Set profile option to a category set value 
that enables Oracle iStore 11i to differentiate between items based on the 
categories they belong to within this category set. Items in the same category in 
this category set are treated as homogenous from display and multimedia 
default perspectives.

If you are planning to sell items of different types (e.g., books vs. computers) 
and need to display them differently (i.e., use different templates) then you 
should create two different categories within this category set. If you do not 
have the flexibility to do so, then you can specify the display properties at the 
item level. Refer to Chapter 6 for more details.

� Set up flexfields to capture additional information about items, if necessary.

� Oracle iStore 11i requires one Inventory Organization to be identified against 
which the product catalog is built. Typically this would be the Master Inventory 
Organization.
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� In a multiple operating unit environment, the Master Inventory Organization 
should consist of all the items from all the operating units. If you need to 
separate the items to be sold from each operating unit into different Inventory 
Organizations, create a separate Inventory Organization for each operating unit. 
These operating unit Inventory Organizations should exist only as subsets of 
the Master Inventory Organization. Separate items from different operating 
units in the Web stores by setting up each operating unit with its own Web store 
sub-hierarchy within the main Oracle iStore 11i hierarchy. See Section 5.6, 
"Creating the Hierarchy" for more information about setting up the Oracle 
iStore 11i hierarchy.

Steps
Product information resides in the MTL_SYSTEM_ITEMS table in Oracle Inventory. 
The following minimum Oracle Inventory setups are required:

1. For each item, set the following flags in the Master Item form:

� Web Status = Published or Unpublished (in the form’s Web Option tab)

� Orderable On the Web (in the form’s Web Option tab)

� Customer Orders Enabled (in the form’s Order Management tab)

These settings are required to display products in the Merchant UI.

2. In Inventory, map inventory items to organizational IDs (organizational IDs are 
set in General Ledger). This mapping determines the inventory items that 
specific organizational IDs can view.

3. Enter product descriptions.

You must also perform the following tasks when setting up Oracle Inventory:

� Set the profile option HR: User Type at the application and Inventory 
responsibility levels. This profile option is required for accessing the work 
structures.

� Set the profile option INV: Default Item Status at the desired levels. This profile 
option specifies a default item status. If this profile is not set, you must provide 
the item status for every item.

� Disable the seeded item catalogs, item categories, and stock locator flexfields if 
you do not plan to use them.

� Delete the seeded item types if you do not plan to use them.

� Define organization calendars.
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� Define the Unit of Measure class and units of measure.

� Define shipping methods.

See Oracle Inventory User’s Guide for information on how to perform these tasks.

3.1.9 Setting Up Oracle Inventory for Regular Available to Promise (ATP)
Oracle iStore 11i can provide regular available to promise (ATP) information on 
inventory items without customization. Oracle iStore 11i checks the ON_HAND_
QTY field in the Oracle Inventory ATP columns to determine the availability of 
items requested in the Web stores. You must set up ATP in Oracle Manufacturing, 
define ATP sourcing rules in Oracle Inventory, and enable product items for ATP by 
setting their ATP and ATP component flags. See Oracle Inventory User’s Guide for 
instructions on setting up ATP rules in Oracle Inventory for regular ATP.

If you want to enable global ATP for Oracle iStore 11i, you must install Oracle 
Advanced Supply Chain Planning and Oracle Material Requirements Planning. 
These modules will create global ATP rules that populate the ATP columns in 
Oracle Inventory. See Chapter 9, "Integrating Oracle iStore 11i with Oracle 
Advanced Supply Chain Planning" for more information on enabling global ATP.

3.1.10 Setting Up Oracle Receivables
Oracle iStore 11i uses Oracle Receivables to record customer information and tell 
customers about their invoices and payments. Customer registration information is 
maintained in the TCA/Oracle Receivables schema. At a minimum, you need to 
perform the required Oracle Receivables setups, including tax options, address 
validation, and the Sales Tax Location Flexfield Structure, as described in Oracle 
Receivables User’s Guide.

You must also turn Automatic Site Numbering on. Use the following procedure to 
activate Automatic Site Numbering in Oracle Receivables.

Note: You may be able to set up Oracle Inventory using the iStore 
Self-Service Administrator UI instead of Oracle Forms. See 
Appendix C for details.

Caution: Changing the Sales Tax Location Flexfield Structure in 
Oracle Receivables after data has been entered can corrupt data in 
the application.
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Steps
1. Log in to Oracle Forms with the Receivables Manager responsibility.

2. Choose Setup > System > System Options.

The System Options window opens.

3. In the Trans and Customers tab, check the Automatic Site Numbering checkbox.

4. Save the form.

3.1.11 Setting Up Oracle Pricing
Setting up Oracle Pricing is one of the required steps for Oracle Order Management 
but is described here separately. For each item that you plan to sell, you must 
specify the price in at least one price list and make that price list available to 
customers.

In Oracle iStore 11i, you will choose the default price lists for walk-in users, 
registered users, and B2B users in each specialty store. (See Section 5.5, "Creating 
Specialty Stores" for more details.) For walk-in users, Oracle iStore 11i always uses 
the specified price list to show item prices on product catalog pages in the store, and 
to price the shopping cart. For registered and B2B users, Oracle iStore 11i also uses 
the price lists that you chose in the Merchant UI for registered and B2B users if the 
profile option IBE: Use Price list associated with Specialty Store is set to Yes. If this 
profile option is set to No, Oracle iStore 11i passes a null price list with the party ID 
and account ID to Oracle Pricing. Oracle Pricing then determines a price list for 
which the user qualifies.

The catalog cache caches product prices for walk-in users according to price list ID. 
If you are using responsibility-based Oracle Pricing modifiers to provide product 
prices for walk-in users based on responsibility ID, you must disable the catalog 
cache so that Oracle iStore 11i will call Oracle Pricing to determine prices. You can 
set the profile option IBE: Cache On to No to disable the catalog cache. However, 
disabling the cache can diminish store performance.

Using Oracle Pricing, you can also set up advanced promotions and discounts. 
Oracle iStore 11i uses the Oracle Pricing engine to determine the best price that the 
customer can get based on the items in the shopping cart and the customer. You set 
up your pricing rules in Oracle Pricing. Oracle iStore 11i supports certain pricing 
attributes and customer-requested qualifiers (promocodes) that are set up in Oracle 
Pricing.

Pricing attributes are used to determine what is priced by Oracle Pricing. They refer 
to the product that is being sold. For example, if you use the pricing attribute "Item 
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Category," your promotions and discounts apply to an entire category of items 
rather than to a single item number.

The following table lists the pricing attributes that Oracle iStore 11i supports.

Table 3–2 Pricing Attributes Supported by Oracle iStore 11i 

Attribute Name Context Pricing Level

ALL_ITEMS Item Line

Inventory Item Id Item Line

Item Amount Line Volume Line

Item Category Item Line

Item Quantity Line Volume Line

Model Id Pricing Attributes Line

Parent List Price Pricing Attributes Line

Period1 Item Quantity Line Volume Line

Period2 Item Quantity Line Volume Line

Period3 Item Quantity Line Volume Line

Segment 1 (Key item flexfield segments) Item Line

Segment 10 Item Line

Segment 11 Item Line

Segment 12 Item Line

Segment 13 Item Line

Segment 14 Item Line

Segment 15 Item Line

Segment 16 Item Line

Segment 17 Item Line

Segment 18 Item Line

Segment 19 Item Line

Segment 2 Item Line

Segment 20 Item Line

Segment 3 Item Line
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Qualifier attributes determine who qualifies for a given adjustment. They refer to 
customer information and shopping cart or order information such as payment 
terms and shipment method. For example, by using the qualifier attribute 
"Customer Class," you can ensure that only customers in a given class qualify for a 
promotion or discount.

The following table lists the qualifier attributes that Oracle iStore 11i supports.

Segment 4 Item Line

Segment 5 Item Line

Segment 6 Item Line

Segment 7 Item Line 

Segment 8 Item Line

Segment 9 Item Line

Table 3–3 Qualifier Attributes Supported by Oracle iStore 11i 

Attribute Name Context Pricing Level

Account Type Customer Line/Header

Agreement Name Customer Line/Header

Agreement Type Customer Line/Header

Bill To Customer Line/Header

Customer Class Customer Line/Header

Customer Name Customer Line/Header

Customer PO Order Line

GSA Indicator Customer Line/Header

Invoice To Party Site Customer Line/Header

Line Category Order Line

Line Type Order Line

Line Volume Volume Line

Line Weight Volume Line

Table 3–2 Pricing Attributes Supported by Oracle iStore 11i (Cont.)

Attribute Name Context Pricing Level
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You can also create pricing agreements in Oracle Order Management or Oracle 
Pricing. Pricing agreements set up the billing specifications that allow a quote to be 
priced. The attributes of a pricing agreement are price list, purchase order number, 
bill-to address, bill-to contact, invoicing terms, payment terms, and shipment terms. 
These attributes set up and apply default pricing rules in Oracle Order 
Management. Each pricing agreement can have only one price list assigned to it, but 
one list can be linked to multiple agreements. You can create universal and 
customer-specific pricing agreements. 

Market Segment Segment Line/Header

Order Amount Volume Header

Order Amount Volume Line

Order Category Order Line

Order Qty Volume Line

Order Type Order Line/Header

Party Id Customer Line/Header

Payment Terms Terms Line/Header

Price List Modlist Line/Header

Pricing Date Order Line

Promotion Number Modlist

Request Date Order Line

Sales Channel Customer Line/Header

Ship To Customer Line/Header

Ship To Party Site Customer Line/Header

Shippable Flag Order Line

Shipping Terms Terms Line/Header

Site Use Id Customer Line/Header

Target Segment Segment Line/Header

Territory Territory Line/Header

Table 3–3 Qualifier Attributes Supported by Oracle iStore 11i (Cont.)

Attribute Name Context Pricing Level
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At a minimum, you must set up qualifiers and modifiers in Oracle Pricing to 
support Oracle iStore 11i.

Steps
1. Set qualifiers in Oracle Pricing. Qualifiers are used to calculate item prices.

2. Set modifiers in Oracle Pricing. Modifiers determine discounts or can be used to 
calculate shipping costs.

When setting up Oracle Pricing sourcing rules, the sourcing rules for Oracle Order 
Capture and Oracle Order Management must be identical. The qualifiers for these 
sourcing rules must also be identical. See Oracle Pricing User’s Guide for more 
information.

3.1.12 Setting Up Oracle Order Management
Oracle iStore 11i uses Oracle Order Management to record customer orders, set up 
payment options and shipping options, and provide order status and shipping 
information to customers. You must perform the following tasks when setting up 
Oracle Order Management:

� Define the system parameters Operating Unit, Item Validation Organization, 
and Customer Relationships.

� Define transaction types at header and line level for orders.

� Define order number sequence.

� Set up defaulting rules.

See Oracle Order Management User’s Guide for information on setting up Oracle 
Order Management.

Note: You may be able to set up Oracle Pricing using the iStore 
Self-Service Administrator UI instead of Oracle Forms. See 
Appendix C for details.
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Web-Enabled Shipping Methods
To set up Web-enabled shipping methods within the Order Management Super 
User responsibility, use the following procedure. This procedure is necessary to 
make shipping methods available to your customers in your Web stores.

Steps
1. Log in to Oracle Forms with the Order Management Super User responsibility.

2. Choose Shipping > Setup > Freight > Define Carrier Ship Methods.

3. Select Find All from the View menu.

4. Check the Web Enabled box next to the shipping methods that you want to 
make available through the Web stores.

5. Save the record.

Restricting Items Based on Operating Units
In a multiple operating unit environment, you need to set up the associations 
between the operating units and the Inventory Organizations in Oracle Order 
Management. Each of the Inventory Organizations will be a subset of the main 
Inventory Organization.

Oracle iStore 11i uses these associations to limit the items that customers can access 
in the operating units’ Web stores. You create a separate IBE customer responsibility 
for each operating unit in Oracle Forms. See Section 5.12.4, "Setting Multiple 
Organization (MO) Profile Options" for more information about associating 
responsibilities with operating units.

Each customer name is assigned one of these responsibilities when the customer 
name is approved. When a customer enters a Web store, Oracle iStore 11i notes the 
customer’s responsibility and the operating unit to which it is assigned, then uses 
the Inventory Organization associated with the operating unit to restrict customers 
to the items in the Inventory Organization. See Section 5.5, "Creating Specialty 
Stores" for instructions on choosing the responsibilities that are supported by a 
specialty store.

Specify the Item Validation Organization associated with each operating unit 
through Oracle Order Management.

Note: You may be able to set up Oracle Order Management using 
the iStore Self-Service Administrator UI instead of Oracle Forms. 
See Appendix C for details.
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3.1.13 Setting Up Oracle Order Capture
Oracle iStore 11i uses Oracle Order Capture to integrate with Oracle Order 
Management and Oracle Receivables. Oracle iStore 11i sends carts and orders from 
the Web stores to Oracle Order Capture. Oracle Order Capture saves the carts as 
quotes and passes the orders to Oracle Order Management. The Oracle Order 
Capture quote name becomes the same as the Oracle iStore 11i cart name when the 
user saves the cart. 

See Oracle Order Capture Concepts and Procedures for information on using Oracle 
Order Capture to view Oracle iStore 11i carts and orders.

The allowable quote status transitions for Oracle iStore 11i shopping carts are set up 
in Oracle Order Capture. See Oracle Order Capture Implementation Guide for 
information on how to set up quote status transitions.

Oracle iStore 11i’s Customer UI displays payment types in the Payment Book, 
Express Checkout Preferences, and checkout pages from the FND_LOOKUP_
VALUES table for the Oracle Order Capture lookup type ASO_PAYMENT_TYPE. 
The seeded values for ASO_PAYMENT_TYPE are credit card, cash, check, purchase 
order, faxed credit card, and invoice. The Customer UI displays only the payment 
types that are marked as Enabled in the lookup table. See Oracle Order Capture 
Implementation Guide for information on how to set up the Oracle Order Capture 
lookup type ASO_PAYMENT_TYPE.

When a user places an order in Oracle iStore 11i, Oracle Order Capture passes the 
order to Oracle Order Management with the status specified in the profile option 
ASO: Default Order State. Orders with the status Entered can be modified in Oracle 
Order Management. Orders with the status Booked cannot be modified in Oracle 
Order Management.

Note: Quotes and orders created in Oracle Order Capture can also 
be viewed in Oracle iStore 11i.

Note: If the credit card payment type is not enabled, the Oracle 
iStore 11i Payment Book and Express Checkout features are 
disabled. The Payment Book stores credit card information only, 
and Express Checkout is only possible with credit card payment.
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3.1.14 Setting Profile Options for the Oracle iStore 11i Merchant UI
You must set some Oracle CRM Technology Foundation (JTT) and Oracle iStore 
(IBE) profile options to enable Oracle iStore 11i’s Merchant UI. These profile options 
must be set before the Merchant UI can be launched. 

See Section A.2, "Setting Profile Options" for instructions on setting profile options.

Setting JTT Profile Options for the Merchant UI
Set the following JTT profile options at both the site level and the application level 
for iStore:

� JTF_PROFILE_DEFAULT_APPLICATION

� JTF_PROFILE_DEFAULT_BLANK_ROWS

� JTF_PROFILE_DEFAULT_CSS

� JTF_PROFILE_DEFAULT_CURRENCY

� JTF_PROFILE_DEFAULT_NUM_ROWS

� JTF_PROFILE_DEFAULT_RESPONSIBILITY (application level only)

See Section A.4.1, "JTT Profile Options for the Merchant UI" for profile option 
descriptions and values.

Setting IBE Profile Options for the Merchant UI
Set the following mandatory IBE profile options at the application level for iStore:

� IBE: Category Set

� IBE: Item Validation Organization

Optionally, you can set the profile option IBE: Item Validation Organization at 
responsibility level for IBE_ADMINISTRATOR or another store manager 
responsibility, or at user level for a store manager user.

Note: If the user chooses to pay by credit card or purchase order, 
but does not enter a credit card number or purchase order number, 
respectively, Oracle Order Capture passes the order to Oracle Order 
Management with an Entered status regardless of the setting of the 
profile option ASO: Default Order State.
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You can also set the following optional iStore (IBE) profile options at the application 
level for iStore if you do not want to use the default settings:

� IBE: Number of Days for New Item Definition

� IBE: Use Database for Media Storage (site level)

See Section A.5, "Oracle iStore 11i (IBE) Profile Options for the Merchant UI" for 
profile option descriptions and values.

3.1.15 Setting Up Oracle CRM Technology Foundation
You must implement Oracle CRM Technology Foundation as described in Oracle 
CRM Technology Foundation Implementation Guide. After this implementation, set up 
host configuration, logging trail properties, and cookie properties as described 
below. See Oracle CRM Technology Foundation Concepts and Procedures for detailed 
instructions.

Host Configuration
When you build the Oracle CRM Technology Foundation deployment 
configuration, you must set up all middle-tier hosts. For each host on which you 
will deploy Oracle iStore 11i, include iStore in the host’s deployed applications list. 

Logging Trail Properties
When setting up the Oracle CRM Technology Foundation logging trails, set the 
framework logging and service logging levels to DEBUG. 

Cookie Properties
The user session in Oracle iStore 11i is controlled and identified through cookies. 
The cookies are set on the user’s browser and are used to identify return customers 
and other related data. The Oracle iStore 11i process is transparent to cookie 
administration, setup and control. Cookies are managed by Oracle CRM 
Technology Foundation methods. If the user turns off browser cookies, Oracle CRM 
Technology Foundation ensures that the information is available through the URL.

The cookie domain is set as the Web server domain, for example, “oracle.com” for 
Oracle’s online store. Once the user registers, the user account is created in the 
database and is used in the cookies to identify the customer. If the user is 
unregistered or anonymous, a guest user account is used in the cookies.

If you want to enable cookie encryption, you must specify an encryption key when 
setting up cookie properties in Oracle CRM Technology Foundation. 
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3.2 Conditional Dependencies
The following Oracle applications modules can be set up to provide additional 
functionality for your electronic store:

� Oracle Advanced Inbound to process call-me-back requests

� Oracle Advanced Supply Chain (Global ATP Server) to provide product 
availability information

� Oracle Configurator to enable customer configured products, provide guided 
selling, and perform some of the validations of the shopping cart

� Oracle Contracts for complete contract management and service agreements

� Oracle CRM Business Intelligence to assess the performance of the store

� Oracle Incentive Compensation to manage sales compensation across all 
channels

� Oracle iPayment to process payments with online credit card authorization

� Oracle iSupport to provide return authorizations and knowledge base 
integration

� Oracle Marketing Online to define, execute, and manage marketing 
campaigns, budgets, and segments across all channels, and to define 
promotions and discounts

� Oracle Material Requirements Planning to provide product availability 
information

� Oracle Shipping to calculate shipping charges

� Oracle Web Cache to serve the non-SSL catalog content

� Oracle Workflow to send e-mail notifications and confirmations to customers
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Figure 3–2 Typical Oracle iStore 11i Integration With Other Oracle Applications
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3.3 Installation and Dependency Verification
Before you start configuring the profile options and creating the product catalog in 
Oracle iStore 11i, check that you have completed the following prerequisites.

1. Verify that the installation and middle tier setups have been done correctly.

Once the Rapid Installer Wizard finishes the installation, verify the proper 
installation and configuration of the following components:

� Apache Server: Go to http://<host>:<apache port>/apachedocs/. You 
should see the Apache Server documentation page.

� Apache JServ: Go to http://<host>:<apache port>/servlets/IsItWorking. 
You should see a message verifying that Apache JServ is working.

2. Verify that the ERP applications are installed and functioning properly. Refer to 
the Implementing Oracle CRM: ERP Functional Checklist, Release 11i document 
available on Oracle MetaLink for a description of the tasks required.

3. Verify that the dependency setup has been done correctly.

Place an order through Sales Orders Workbench. If it goes through without 
errors, then your core dependency setup has been done correctly. To find how 
to place an order, see Oracle Order Management User’s Guide.
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Implementation Overview

This chapter provides an overview of the tasks required to set up Oracle iStore 11i 
after you have verified your installation and dependency setup. Topics include:

� Process Overview

� Implementation Task Sequence

Note: When using the Oracle iStore 11i Merchant UI, ensure that 
cookies are enabled for your browser. See the relevant browser 
documentation for information on enabling cookies.
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4.1 Process Overview
Oracle iStore 11i ships with templates and defaults that allow you to develop basic 
stores. By performing the setup tasks described in Chapter 5, "Required 
Implementation Tasks" to set up the Customer UI, you can create fully operational 
online stores.

Additionally, you can customize and add functionality as required by performing 
the setup tasks described in Chapter 6, "Optional Implementation Tasks" and by 
implementing other Oracle Applications modules that are conditional dependencies 
for Oracle iStore 11i.

Planning the customization of your store involves the following tasks:

� Identify the ways in which the store will display products.

� Plan page designs and divide them into common components that you can 
make into templates.

� Invent a name for each possible template to facilitate planning and 
communication of designs.

� Customize templates now as part of the design or later in the setup cycle.

Once you have completed these planning tasks, you can perform the 
implementation tasks listed in Chapter 6, "Optional Implementation Tasks" to 
customize your store.

The following procedure suggests the sequence of steps you can use to create and 
customize your stores. 

Prerequisites
� You have set up the mandatory dependencies as described in Section 3.1, 

"Mandatory Dependencies".

� You have set up any conditional dependencies required for functionality that 
you want to include in your specialty stores. (You can also perform conditional 
dependency setup after you have implemented Oracle iStore 11i. In this case, 
you may need to return to Oracle iStore 11i to modify the implementation.)

Steps
1. Set up store manager accounts. Required.

You need a store manager user account to access the Oracle iStore 11i Merchant 
UI, where you will perform the majority of the Oracle iStore 11i implementation 
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and administration tasks. Typically, the store manager user account has the 
responsibility IBE_ADMINISTRATOR.

2. Set up the concurrent program manager. Required.

The concurrent program manager runs all Oracle iStore 11i-related concurrent 
programs with the responsibility iStore Concurrent Programs Responsibility. 
These concurrent programs are required to set up the Customer UI product 
search, process Express Checkout orders, and prepare data for Storefront 
Reports. In this step you must set profile options for iStore Concurrent 
Programs Responsibility and grant this responsibility to at least one user. You 
can also schedule concurrent programs.

3. Set up the guest user account. Required.

You must create this account before any user can view your online stores. When 
an unregistered or anonymous user comes to your online store, Oracle iStore 11i 
automatically logs the user in with the guest user name. If you do not create a 
guest user account, customers will be unable to view or register in your stores, 
and the Oracle iStore 11i system administrator will have to create a user name 
for each customer before the customer can access the stores.

4. Launch the Merchant UI. Required.

You will perform most of your Oracle iStore 11i implementation and 
administration tasks in the Merchant UI.

5. Create a specialty store. Required.

When you create a specialty store in the Merchant UI’s Setup tab, you include 
the following specifications:

� Store name, code, description, and active dates

� Supported languages and default language

� Whether the store is ATP enabled, allows walk-in (anonymous and 
unregistered) users, and checks the user’s responsibility before granting 
access

� The store’s root section in the hierarchy (which can be modified later)

� Supported customer user responsibilities, their display names in the 
specialty stores page, and the active dates for supporting the 
responsibilities

� Access restrictions by customer organization

� Supported currencies and default currency
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� Specialty store price lists for walk-in, registered B2C users, and registered 
B2B users

6. Customize multimedia. Optional.

Create proprietary media source files for use in the customized store. Some 
examples of media file types are small GIF, large GIF, descriptive text, audio, 
and video. The types of media you can use in the store depend on the 
capabilities of the browsers that will access it.

Catalog Oracle iStore 11i multimedia in the Merchant UI’s Multimedia tab to 
make them available for assignment to multimedia components. Each 
multimedia name cataloged can have a number of media source files assigned 
to it.

7. Define multimedia components. Optional.

Define and catalog multimedia components under Multimedia Components in 
the Merchant UI’s Setup tab. Enter a default multimedia name for each 
multimedia component.

8. Customize templates. Optional.

Create template source files for pages and for blocks within pages using Oracle 
JDeveloper or another Web page authoring application.

Catalog Oracle iStore 11i templates in the Merchant UI’s Template tab. Each 
template name cataloged can have a number of template source files assigned 
to it.

9. Define display styles. Optional.

Define and catalog the display styles determined during planning, under 
Display Styles in the Merchant UI’s Setup tab. Enter a default template name 
for each display style.

10. Create the hierarchy. Required.

Set up an overall hierarchy for the store sections and products in the Merchant 
UI’s Hierarchy tab. If necessary, you can later modify the hierarchy. For 
example, you can add items to a section, remove items from a section, create or 
delete sections, and change the section defaults for multimedia and templates.

11. Build the product catalog. Required.

When you build the product catalog in the Merchant UI’s Product tab, you can 
choose to publish or unpublish Oracle Inventory items in your stores. You can 
add or remove items from hierarchy sections and specialty stores. You can also 
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modify the presentation of the item by choosing templates for supported 
display styles and multimedia for supported multimedia components.

12. Create product relationships. Optional.

Create new relationship types in the Merchant UI’s Relationship tab if you do 
not want to use any of the seeded relationship types.

You can use relationships to sell additional related products to users when they 
select a product. Create relationships in the Merchant UI’s Relationship tab 
between products, categories, and sections, using the seeded relationship types 
or any relationship types that you created. If you use any relationship type 
other than RELATED, you must customize the storefront JSPs by passing in the 
relationship code to the Java API oracle.apps.ibe.catalog.Item.getRelatedItems(), 
which retrieves related items that have that relationship to the original item.

13. Customize category-level product presentation. Optional.

Customize product presentation at the Oracle Inventory category level in the 
Merchant UI’s Category tab. If there are no item-level settings for display styles 
or multimedia components in the Product tab, Oracle iStore 11i checks for the 
category-level settings and uses them to display the product if they exist.

14. Customize item-level product presentation. Optional.

Customize product presentation at the item level. You can do so by choosing 
settings for multimedia components and display styles in the Merchant UI’s 
Product tab when building the product catalog. Item-level multimedia 
component and display style settings override category-level and store-level 
settings. You can also add item descriptive flexfields.

15. Set up the product search. Required.

Set up a product search for the Customer UI. You can set up a category-based or 
section-based product search. You can also enable fuzzy search and synonym 
search functionality in the product search.

16. Customize the shopping cart. Optional.

Customize shopping cart presentation and functionality. You can customize 
shopping cart page bin content, enable unit of measure (UOM) conversions, 
allow decimal quantities for items, and specify flexfields in the checkout page.

17. Set up notifications. Required.

Oracle iStore 11i e-mail notifications are triggered by specific user and 
application events. The notifications give relevant information and instructions 
to the recipients. You can configure notifications in the Merchant UI’s Setup tab. 
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Even if you choose not to use notifications in your stores, you must still perform 
this step to disable the notifications.

18. Set up Storefront Reports. Required.

Storefront Reports present key business and transaction information to store 
managers in a concise format. You must set up the Storefront Reports before 
they can be viewed in the Merchant UI or in another Oracle CRM application.

19. Create B2B user roles. Optional.

If the seeded B2B user roles do not match your business needs, you can create 
additional B2B user roles with different combinations of the seeded Oracle 
iStore 11i permissions.

20. Set up customer user registration. Required.

You can choose whether to allow B2B or B2C registration, or both. You must set 
the default responsibilities that are assigned to B2B and B2C users upon 
registration. For B2B users, you must also set the default role that is assigned to 
them upon registration.

21. Set profile options for the Oracle iStore 11i Customer UI. Required.

You must set certain profile options to configure the Customer UI’s appearance 
and functionality.

22. Test the Oracle iStore 11i Customer UI. Required.

You should verify that the Customer UI works correctly before launching your 
specialty stores. If you modify the hierarchy or product catalog after you launch 
your stores, you can also use the Preview functionality to view your changes in 
the Customer UI before you publish the changes in your stores.

23. Manage the cache. Optional.

Oracle iStore 11i caches section and product information. If you make changes 
to sections and products, you can clear the cache without restarting the Apache 
server by using the cache management feature in the Merchant UI’s Cache tab.

24. Launch the specialty stores. Required.
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4.2 Implementation Task Sequence
The following figure illustrates the process flow for setting up stores in Oracle iStore 
11i. You must perform the required steps. You need to perform the optional steps 
only if you plan to use the related features or complete certain business functions.

Figure 4–1 Oracle iStore 11i Setup Process Flow

The following table lists the Oracle iStore 11i setup steps. You can return to any step 
number to modify your initial setup in that step. You can also perform any optional 
step after you have completed all required steps.
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Table 4–1 Oracle iStore 11i Setup Checklist 

Step Required/Optional Reference

1. Set Up Store Manager Accounts Required Section 5.1, "Setting Up Store Manager User 
Accounts"

2. Set Up the Concurrent Program 
Manager

Required Section 5.2, "Setting Up the Concurrent 
Program Manager"

3. Set Up the Guest User Account Required Section 5.3, "Setting Up the Guest User 
Account"

4. Launch the Merchant UI Required Section 5.4, "Launching the Merchant UI"

5. Create a Specialty Store* Required Section 5.5, "Creating Specialty Stores"

6. Customize Multimedia Optional Section 6.1, "Customizing Multimedia"

7. Define Multimedia Components Optional Section 6.2, "Defining Multimedia 
Components"

8. Customize Templates Optional Section 6.3, "Customizing Templates"

9. Define Display Styles Optional Section 6.4, "Defining Display Styles"

10. Create the Hierarchy* Required Section 5.6, "Creating the Hierarchy"

11. Build the Product Catalog* Required Section 5.7, "Building the Product Catalog"

12. Create Product Relationships Optional Section 6.5, "Creating Product Relationships"

13. Customize Category-Level 
Product Presentation

Optional Section 6.6, "Customizing Product Presentation 
at the Category Level"

14. Customize Item-Level Product 
Presentation

Optional Section 6.7, "Customizing Product Presentation 
at the Item Level"

15. Set Up the Product Search Required Section 5.8, "Setting Up the Product Search"

16. Customize the Shopping Cart Optional Section 6.8, "Customizing the Shopping Cart"

17. Set Up Notifications Required Section 5.9, "Setting Up Notifications"

18. Set Up Storefront Reports Required Section 5.10, "Setting Up Storefront Reports"

19. Create B2B User Roles Optional Section 6.9, "Creating B2B User Roles"

20. Set Up Customer User 
Registration

Required Section 5.11, "Setting Up Oracle iStore 11i 
Customer User Registration"

*  You can perform the required steps Create a Specialty Store, Create the Hierarchy, and Build the Product Catalog in any 
sequence relative to each other. For example, you can create the hierarchy first, then build the product catalog and create 
specialty stores.
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21. Set Profile Options for the iStore 
Customer UI

Required Section 5.12, "Setting Profile Options for the 
Customer UI"

22. Test the iStore Customer UI Required Chapter 7, "Verifying the Implementation"

23. Manage the Cache Optional Section 6.10, "Managing the Cache"

24. Launch the Specialty Store(s) Required None

Table 4–1 Oracle iStore 11i Setup Checklist (Cont.)

Step Required/Optional Reference

*  You can perform the required steps Create a Specialty Store, Create the Hierarchy, and Build the Product Catalog in any 
sequence relative to each other. For example, you can create the hierarchy first, then build the product catalog and create 
specialty stores.
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Required Implementation Tasks

This chapter describes the tasks required to set up Oracle iStore 11i after you have 
verified your installation and dependency setup. Topics include:

� Setting Up Store Manager User Accounts

� Setting Up the Concurrent Program Manager

� Setting Up the Guest User Account

� Launching the Merchant UI

� Creating Specialty Stores

� Creating the Hierarchy

� Building the Product Catalog

� Setting Up the Product Search

� Setting Up Notifications

� Setting Up Storefront Reports

� Setting Up Oracle iStore 11i Customer User Registration

� Setting Profile Options for the Customer UI

Note: When using the Oracle iStore 11i Merchant UI, ensure that 
cookies are enabled for your browser. See the relevant browser 
documentation for information on enabling cookies.
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5.1 Setting Up Store Manager User Accounts
An Oracle iStore 11i store manager performs tasks in the Merchant UI. To do this, 
the store manager must have a user name with the IBE_ADMINISTRATOR 
responsibility. When the store manager logs in to the Oracle CRM Applications 
login page at:

http://<host>:<apache port>/OA_HTML/jtflogin.jsp

with this user name, the Oracle iStore 11i Merchant UI opens.

The IBE_ADMINISTRATOR responsibility is seeded in Oracle iStore 11i. The user 
receives all the required menus and privileges to manage the store through this 
responsibility. The menu assigned to this responsibility is called iStore Admin Root 
(IBE_ADMIN_MENU). 

For a multiple operating unit environment, you can create additional store manager 
responsibilities that have the iStore Admin Root menu. You can then assign each 
responsibility to manage a different Inventory Organization by setting the profile 
option IBE: Item Validation Organization at responsibility level.

When creating a store manager user account, you must assign the IBE_
ADMINISTRATOR responsibility or another store manager responsibility as the 
default responsibility for the user.

If you need to modify the functions that the user can perform, create a new 
responsibility for the user in the Application Object Library (AOL) module. For the 
new responsibility you can assign the default menu (IBE_ADMIN_MENU) and still 
remove access to some of the tabs ("functions" in AOL terminology), or you can 
create a new menu using the Oracle iStore 11i functions. All Oracle iStore 11i 
functions can be found by searching for IBE_% in the Form Functions window.

See Oracle Applications System Administrator’s Guide for more information on creating 
users, managing responsibilities, and building menus.

Use the following procedure to set up a user account for an Oracle iStore 11i store 
manager.

Login
Log in to Oracle Forms.

Responsibility
System Administrator
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Prerequisites
None

Steps
1. Log in to Oracle Forms with the System Administrator responsibility.

2. Choose Security > User > Define.

The Users window opens.

3. In the User Name field, enter the user name that the store manager will use to 
log in to the Oracle iStore 11i Merchant UI.

4. In the Password field, enter the store manager’s password.

5. In the Responsibilities block, choose IBE_ADMINISTRATOR or another store 
manager responsibility from a Responsibility LOV. 

6. Save the user record.

7. Set the following profile options at the user level for this store manager:

� JTF_PROFILE_DEFAULT_APPLICATION

� JTF_PROFILE_DEFAULT_RESPONSIBILITY

See Section A.4.2, "JTT Profile Options for Store Manager User Accounts" for 
profile option descriptions and values.

5.2 Setting Up the Concurrent Program Manager
You must set up at least one user with the seeded responsibility iStore Concurrent 
Programs Responsibility. This user is the concurrent program manager, who is 
responsible for scheduling and running Oracle iStore 11i’s concurrent programs. All 
Oracle iStore 11i concurrent programs are run in Oracle Forms. The same user can 
be both the concurrent program manager and a store manager.

5.2.1 Oracle iStore 11i Concurrent Programs
In Oracle iStore 11i, there are six concurrent jobs seeded in the Oracle Forms 
concurrent program manager request setup: 

� iStore Search Insert

� iStore Section Search Refresh

� iStore - Express Checkout Order Submission
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� iStore Reports Fact Tables Refresh

� iStore Reports Materialized Views Refresh

� iStore Alert Reports

Run the concurrent jobs iStore Reports Fact Tables Refresh, iStore Reports 
Materialized Views Refresh, and iStore Alert Reports together, using the request sets 
iStore Reports Complete Data Refresh Set and iStore Reports Increment Data 
Refresh Set.

iStore Search Insert
This is a single request concurrent program that you execute once in the initial setup 
of Oracle iStore 11i as a post-install step. Run this batch job after you have loaded 
Oracle Inventory items and set the Inventory Organizations. This program 
populates Oracle iStore 11i’s category search table with product information from 
the Oracle Inventory tables.

Typically, you should not run the iStore Search Insert concurrent program more 
than once. You may need to rerun this program under one of the following three 
conditions:

� If you add multiple items that do not appear in the search table

� If you want to purge all items from the search table

� If you change the setting of the fuzzy search functionality, by either enabling or 
disabling it

iStore Section Search Refresh
This concurrent program populates Oracle iStore 11i’s section search table with 
product information. Run this program after running iStore Search Insert to switch 
from category-level to section-level search on the Customer UI. Rerun iStore Section 
Search Refresh to update the section search table whenever you modify the Oracle 
iStore 11i hierarchy.

If you have enabled a section-level search, rerun this concurrent program whenever 
you change the setting of the fuzzy search functionality.

iStore - Express Checkout Order Submission
Schedule this program as a batch process that runs at pre-determined intervals. This 
program converts the Express Checkout shopping carts into orders. The profile 
option IBE: Express Checkout Consolidation Time Interval specifies the time 
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interval in which Express Checkout shopping carts are converted into orders by this 
concurrent program batch job.

iStore Reports Fact Tables Refresh
This concurrent program populates Storefront Reports fact tables with data within a 
user-specified time period from Oracle Order Capture and Oracle Order 
Management data tables. The Storefront Reports are run against the data pulled by 
this concurrent program, as represented in materialized views of the fact tables.

iStore Reports Materialized Views Refresh
This concurrent program creates materialized views of the Storefront Reports fact 
tables that are populated by the concurrent program iStore Reports Fact Tables 
Refresh. The queries for the Storefront Reports are run against these materialized 
views. This architecture enhances report query performance and ensures that the 
reports are always available in the Merchant UI.

iStore Alert Reports
This concurrent program triggers the delivery of the updated Top N Orders Report 
and the Historical Summary Report as e-mail notifications.

iStore Reports Complete Data Refresh Set
This request set contains the concurrent programs iStore Reports Fact Tables Refresh 
and iStore Reports Materialized Views Refresh, which are necessary to update data 
for the Storefront Reports. The iStore Reports Complete Data Refresh Set runs these 
concurrent programs in Complete mode. The request set also contains the 
concurrent program iStore Alert Reports, which triggers the Storefront Reports 
e-mail notifications.

Run this request set when you want to change the parameters specifying the data 
that is available to the Storefront Reports, when the data within your previously 
specified parameters has changed since you last ran the program, and when you 
need to update the Storefront Reports materialized views to reflect data changes in 
the Storefront Reports fact tables.

It is recommended that you schedule this concurrent program set to run at regularly 
scheduled intervals. Otherwise, you may need to rerun it every time you want to 
refresh the Storefront Reports data.
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iStore Reports Increment Data Refresh Set
This request set contains the concurrent programs iStore Reports Fact Tables Refresh 
and iStore Reports Materialized Views Refresh, which are necessary to update 
Storefront Reports fact tables and materialized views with data for the time since 
the last data refresh. The iStore Reports Increment Data Refresh Set runs these 
concurrent programs in Increment mode instead of Complete mode. The request set 
also contains the concurrent program iStore Alert Reports, which triggers the 
Storefront Reports e-mail notifications.

Run this request set when you want to add data to the Storefront Reports fact tables 
and materialized views only for the time period between the last data refresh and 
your new desired end date.

It is recommended that you schedule this concurrent program set to run at regularly 
scheduled intervals. Otherwise, you may need to rerun it every time you want to 
refresh the Storefront Reports data.

5.2.2 Setting Concurrent Program Manager Profile Options
Set the following profile options at the responsibility level for iStore Concurrent 
Programs Responsibility:

� ASO: Default Order Type

� ASO: Default Salesrep

� ASO: Validate Salesrep

See Section A.13, "Concurrent Program Manager Profile Options" for profile option 
values.

5.2.3 Creating a Concurrent Program Manager
Use the following procedure to set up a user as a concurrent program manager.

Login
Log in to Oracle Forms.

Responsibility
System Administrator

Prerequisites
None
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Steps
1. Log in to Oracle Forms with the System Administrator responsibility.

2. Choose Security > User > Define.

The Users window opens.

3. If you are creating a new user, then perform the following steps:

a. In the User Name field, enter the user name that the concurrent program 
manager will use to log in to Oracle Forms.

b. In the Password field, enter the concurrent program manager’s password.

4. If you are making an existing user the concurrent program manager, then 
perform the following steps:

a. Choose View > Find.

b. Search for the existing user, and select that user name.

5. In the Responsibilities block, choose iStore Concurrent Programs 
Responsibility from a Responsibility LOV. 

6. Save the user record.

5.2.4 Scheduling Concurrent Programs
You should schedule the concurrent program iStore - Express Checkout Order 
Submission and the concurrent program sets iStore Reports Complete Data Refresh 
Set and iStore Reports Increment Data Refresh Set to run regularly at 
pre-determined intervals. You can schedule these concurrent programs now or later 
in your implementation. You can also run these concurrent programs only upon 
specific request.

See Section 5.10.4, "Preparing Data for Storefront Reports" for instructions on 
running and scheduling the concurrent program sets iStore Reports Complete Data 
Refresh Set and iStore Reports Increment Data Refresh Set.

Use the following procedure to run or schedule the iStore - Express Checkout Order 
Submission concurrent program.
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Login
Log in to Oracle Forms as the concurrent program manager.

Responsibility
iStore Concurrent Programs Responsibility

Prerequisites
None

Steps
1. Log in to Oracle Forms with the iStore Concurrent Programs Responsibility.

The Submit a New Request window opens.

2. Choose Single Request and click OK.

The Submit Request window opens.

3. Choose iStore - Express Checkout Order Submission from the Name LOV. 

4. Set how often and when you want to run this by clicking Schedule in the 
"Submit Request" window. 

� To run right away, select As Soon as Possible and click OK. 

� To run once at a scheduled time, click Once, enter information in the 
appropriate fields, and click OK.

� To run regularly, click Periodically or On Specific Days, enter information 
in the appropriate fields, and click OK.

5. Click Submit to submit the request. You receive a confirmation that the request 
has been submitted.
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5.2.5 Checking Concurrent Program Status 
Use the following procedure to check the status of the concurrent program iStore - 
Express Checkout Order Submission.

Login
Log in to Oracle Forms.

Responsibility
System Administrator

Prerequisites
None

Steps
1. Log in to Oracle Forms with the System Administrator responsibility. 

2. Choose Concurrent > Requests.

The Find Requests window (defaulted to "All My Requests") opens. 

3. In the Find Requests window, search for your concurrent program request.

� If the server is not busy, then clicking Find may be the fastest way to find 
your request.

� If your server is busy, it may be better to enter search criteria and look for 
"Specific Requests." 

4. The “Requests” window displays a list of submitted requests. There should be 
one (or more) entitled “iStore - Express Checkout Order Submission.” Initially, 
you may find this in the “green” state with Phase = “pending” or “running.” 

5. Click Refresh Data occasionally to check the completion status. 

6. Once in the "red" state or Phase = "Completed," the "View Output" and "View 
Log" buttons will become active if the log and output files have been setup 
correctly. Use these buttons to find out how many orders the concurrent 
program was able to submit successfully and how many failed. 
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5.3 Setting Up the Guest User Account
If you want guest users to be able to browse your Web stores, you must define a 
guest user name, assign a responsibility to it, and set up profile options. 
Anonymous users who visit your Web stores are then automatically logged in with 
the guest user name.

If a guest user makes any changes, such as modifying the preferred language or 
currency, or adding items to the shopping cart, the changes are saved in the cookie 
so that two anonymous users cannot see each other’s changes.

You must set up the guest user account before customers can view your Web stores’ 
home page. If you do not set up the guest user account, customers will be unable to 
view or register in your Web stores, and the Oracle iStore 11i system administrator 
will have to create a user name for each customer before the customer can access the 
stores.

5.3.1 Creating the Guest User
Use the following procedure to create the Oracle iStore 11i guest user account. 

Login
Log in to Oracle Forms.

Responsibility
System Administrator

Prerequisites
None

Steps
1. Log in to Oracle Forms with the System Administrator responsibility.

2. Choose Security > User > Define.

The Users window opens.

3. In the User Name field, enter a user name, such as IBEGUEST, by which a guest 
user will be automatically logged in to Oracle iStore 11i.

4. In the Password field, enter a password for this user name.
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5. In the Responsibilities block, choose an Oracle iStore 11i customer 
responsibility, such as IBE_CUSTOMER, from the Responsibility LOV.

6. Save the user record.

7. Set the following profile options at the user level for the guest user name:

� JTF_PROFILE_DEFAULT_APPLICATION

� JTF_PROFILE_DEFAULT_CURRENCY

� JTF_PROFILE_DEFAULT_RESPONSIBILITY

See Section A.4.3, "JTT Profile Options for the Guest User Account" for profile 
option descriptions and values.

8. Set up this guest user account as the Oracle CRM Technology Foundation 
self-service user. See Oracle CRM Technology Foundation Concepts and Procedures 
for instructions.

5.3.2 Verifying the Guest User Account
Use the following procedure to verify that you have set up the guest user account 
correctly.

Login
Open the Oracle iStore 11i Customer UI at the URL:

http://<host>:<apache port>/OA_HTML/ibeCZzdMinisites.jsp

Responsibility
Guest user responsibility (e.g., IBE_CUSTOMER). You are automatically logged in 
as the guest user.

Prerequisites
You have set up the guest user account as described in Section 5.3.1, "Creating the 
Guest User".

Steps
1. Log out of any Oracle applications with which you have been working.

2. Restart the Apache server.

3. Navigate to the URL:
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http://<host>:<apache port>/OA_HTML/ibeCZzdMinisites.jsp

The page that opens should have a list of the specialty stores that are accessible 
to guest users.

5.4 Launching the Merchant UI
After installing Oracle iStore 11i and setting up the Merchant UI as detailed in 
Chapter 3, you can enter the Merchant UI by logging in to:

http://<host>:<apache port>/OA_HTML/jtflogin.jsp

with a user name that the system administrator has set up as an Oracle iStore 11i 
store manager user account. See Section 5.1, "Setting Up Store Manager User 
Accounts" for more information on creating a store manager user account.

Verify that cookies are enabled for your browser before accessing the Merchant UI.

On any page of the Merchant UI, you can click the Profile icon to go to your Oracle 
CRM Technology Foundation user profile page. Here, you can switch 
responsibilities and update your profile.
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Figure 5–1 The Oracle iStore 11i Merchant UI

5.5 Creating Specialty Stores
A specialty store is any Web store. You can create multiple stores, for example a 
main store, a store for one large customer, a holiday specials store, and a store that 
requires registered users. You must create at least one store. 

Multiple currencies and languages can be selected for every specialty store. The 
customer’s preference, as defined in his or her user profile, determines which 
currency and language is to be used for a store. Once a registered customer selects a 
preferred language, the store defaults to that preferred language each time the 
customer enters. When the user preference is not set, default language and currency 
settings will take effect. 

Users can also change their display languages and currencies by choosing from a 
list of the languages and currencies supported by the store. When a customer 
changes the display language and currency, Oracle iStore 11i changes his or her 
preferred language and currency to match the newly selected display language and 
currency. This change enables consistency across customer sessions and Oracle 
applications. For example, this will ensure that the order confirmation alert in a 
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German language store will be in German, even if the customer’s previous 
preferred language was French.

Customers must also choose the responsibility with which they enter a specialty 
store. The Customer UI shows a list of available combinations of specialty stores 
and Oracle iStore 11i responsibilities. When the customer chooses one of these 
combinations, he or she enters that specialty store with that responsibility for the 
current session. The responsibility determines the operating unit against which any 
orders placed in the current session are booked. The responsibility also determines 
the values of the profile options set at the responsibility level.

You can set up specialty stores to check the customers’ responsibilities when they 
log in. For every specialty store flagged to check the user’s responsibility, the 
Customer UI excludes those specialty store-responsibility combinations containing 
responsibilities not associated with the user.

Use Oracle Forms to create responsibilities and assign them to customer user 
names. See Oracle Applications System Administrator’s Guide for more information.

Use the following procedure to create a specialty store.

Login
Log in to Oracle CRM Applications as a store manager user.

Responsibility
IBE_ADMINISTRATOR

Prerequisites
None

Note: If the customer can only access one specialty 
store-responsibility combination, he or she is automatically 
forwarded to that specialty store’s home page with that 
responsibility and does not see a list of specialty store-responsibility 
combinations. 

Note: Specialty stores are also referred to as "minisites."
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Steps
1. Launch the Merchant UI.

2. In the Setup tab, choose Specialty Stores.

3. Click Create. The Specialty Store Detail page opens.

4. Enter the basic information for the specialty store in the following fields. The 
fields marked with an asterisk in the Merchant UI are mandatory.

a. Specialty Store Name: Enter the name of the specialty store.

b. Specialty Store Code: Enter a unique programmatic access name for the 
specialty store. Oracle iStore 11i’s JSPs and Java code will use this 
programmatic access name to retrieve the specialty store information. The 
specialty store code should be an alphanumeric string without spaces.

c. Description: Enter a description for the specialty store.

d. Start Date: Enter the date when the specialty store should first be active and 
available to customers.

e. End Date: Enter the date when the specialty store should no longer be 
active and available to customers.

5. In the Languages section, check the Select checkbox next to each language that 
you want the specialty store to support.

6. In the Default Language pull-down menu, choose the default language for your 
specialty store.

7. Click Continue. The Store Flags page opens.

This page is used to select the root section for the specialty store from the Oracle 
iStore 11i hierarchy and to determine whether the specialty store will: 

� Be ATP Enabled for Oracle Inventory

� Allow walk-in customers (customers who have not logged in or registered)

� Check user responsibility

8. From the ATP Enabled pull-down menu, choose Yes if you want this store to 
provide ATP inventory information to the customer.

9. From the Walkin Customers Enabled pull-down menu, choose Yes if you want 
this store to allow walk-in customers who are not registered or logged in.

10. From the Check User Responsibility pull-down menu, choose Yes if you want 
the store to check user responsibility when customers log in.
Required Implementation Tasks 5-15



Creating Specialty Stores
11. Click Go next to the Root Section field.

A pop-up window displays the Oracle iStore 11i hierarchy.

12. Search for and highlight the root section of the store, and click Done.

The pop-up window closes, and the Root Section field is populated with the 
name of the section you have chosen.

13. Click Continue.

The Supported Responsibilities page opens.

14. Click Add Responsibility. 

The Select Responsibility pop-up window opens.

15. In the Select Responsibility pop-up window, search for responsibilities that you 
want this specialty store to support by application and responsibility name, key, 
or description, using the wildcard character % if necessary. Check the Select 
checkbox next to the responsibilities, and click Add. When you are finished 
selecting responsibilities, click Done. 

You return to the Supported Responsibilities page.

16. In the Display Name fields, enter user-friendly names by which each specialty 
store-responsibility combination will appear in the Customer UI.

17. In the Start Date and End Date fields, enter the dates when the specialty store 
will support each responsibility you have added.

18. In the Order fields, specify the order in which these responsibilities will appear 
on the customer login page.

19. Click Continue.

The Access Restrictions page opens.

20. Click Add Organization.

The Select Organization pop-up window opens.

21. In the Select Organization pop-up window, search for organizations by name or 
account number, using the wildcard character % if necessary. Check the Select 
checkbox next to the organizations you want to add to the list, and click Add. 
When you are finished selecting organizations, click Done.

Note: Each specialty store must have a root section.
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You return to the Access Restrictions page.

22. Highlight one of the three radio buttons:

� No Restriction, if you want this specialty store to allow users from any 
organization

� Include the following organizations, if you want this specialty store to allow 
only users from the organizations you specify in this page

� Exclude the following organizations, if you want this specialty store to deny 
access only to users from the organizations you specify in this page

23. In the Start Date and End Date fields, enter the dates when the inclusion or 
exclusion of the listed organizations is effective.

24. Click Continue.

The Currencies and Price Lists page displays available currencies.

25. Choose currencies by checking the Select checkbox next to the currencies that 
you want this specialty store to support.

26. For each selected currency, choose the price lists for Walk-in Customer, 
Registered Customer, and Business Partner from the pull-down menus.

27. Optional: Enter a maximum orderable limit for each selected currency.

28. Choose the default currency for the store from the Default Currency pull-down 
menu.

29. Click Continue.

The new specialty store is saved.

To modify an existing specialty store, click on its name in the Setup > Specialty 
Stores section of the Merchant UI and change the information as needed. Click on 
Update instead of Continue in the specialty store information pages to save your 
changes.

5.5.1 Creating Global Specialty Stores
If you have created specialty stores that support multiple languages and currencies, 
you can set up the stores’ home pages to allow the user to change his or her 
preferred language and currency. The store home page is the highest level featured 
section of the catalog.
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In the store home page, you can set up different UI objects where the user can 
change his or her preferred language and currency, as well as the specialty store. 
The UI objects are the following items:

� The global bin—This bin appears by default on the right side of the home 
page. The global bin displays pull-down menus in which the user can choose 
the preferred language and currency. It also displays a link to the specialty 
stores login page, where the user can choose another specialty store.

� The global bin for currency only—This bin is the same as the standard global 
bin, but displays only a currency pull-down menu.

� Store pull-down menu and language links—The home page menu bar can 
display a specialty store pull-down menu and links for the current store’s 
supported languages. The menu bar can also display a thumbnail image 
representing the current store next to the specialty store pull-down menu. The 
user can choose a new specialty store directly from the pull-down menu and 
change the preferred language by clicking a link.

Figure 5–2 UI Objects for the Global Store Home Page

Using the seeded Oracle iStore 11i page layouts, you can combine these UI objects in 
one of the scenarios described in the following table.
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The profile option IBE: Use Global Bin activates the global bin if the profile option is 
set to Yes. The profile option IBE: Use Specialty Stores Page, if set to Yes, adds the 
specialty stores login page link to the global bin. If this profile option is set to No, it 
converts the global bin into the currency-only global bin. It also adds the store 
pull-down menu and the language links if multiple specialty stores exist and 
multiple languages are supported.

You can move the global bin by setting the profile option IBE: Use Global Bin to No 
and mapping the global bin JSP to a catalog bin template, as described in Oracle 
iStore Concepts and Procedures.

Table 5–1 Global Store Home Page Layouts 

Global Bin
Global Bin 
(Currency Only)

Store Menu and 
Language Links Procedure

Yes

(Appears in all 
seeded section 
pages)

No No Set the profile option IBE: Use Global Bin to Yes and the 
profile option IBE: Use Specialty Stores Page to Yes. 
Additionally, if you want to remove the link to the 
specialty stores login page from the global bin, set the 
profile option IBE: Show Change Store Link to No.

No Yes

(Appears in all 
seeded section 
pages)

Yes Set the profile option IBE: Use Global Bin to Yes and the 
profile option IBE: Use Specialty Stores Page to No. For 
the thumbnail image representing the current specialty 
store, map image files to the multimedia programmatic 
access name STORE_LOGO_SPECIALTY for each 
specialty store. See Section 6.1.3, "Cataloging 
Multimedia" for information on mapping image files to 
multimedia programmatic access names.

No No Yes Set the profile option IBE: Use Global Bin to No and the 
profile option IBE: Use Specialty Stores Page to No. For 
the thumbnail image representing the current specialty 
store, map image files to the multimedia programmatic 
access name STORE_LOGO_SPECIALTY for each 
specialty store.

No No No Set the profile option IBE: Use Global Bin to No and the 
profile option IBE: Use Specialty Stores Page to Yes.

Note: The store pull-down menu displays every specialty store 
that you have created. Therefore, if you have set up any form of 
access control for your specialty stores, you must use the specialty 
stores login page instead of the store pull-down menu. Set the 
profile option IBE: Use Specialty Stores Page to Yes.
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The following table summarizes the recommended values for the profile options 
IBE: Use Global Bin and IBE: Use Specialty Stores Page for various store and 
globalization scenarios.

See Section A.6, "Oracle iStore 11i (IBE) Profile Options for the Customer UI" for 
more information about setting these profile options. You must also specify the 
permitted bill-to and ship-to countries for each of your operating units in Oracle 
Human Resources, as described in Section 3.1.7, "Setting Up Oracle Human 
Resources".

In addition to supporting multiple languages and currencies, your specialty stores 
can also display line level taxes if one or more of the countries in which you are a 
merchant require line level tax display. To set up line level tax display for a specialty 
store, map the template with the programmatic access name STORE_CART_LINE_
TAX to a JSP that displays line level taxes. Set this mapping for the specialty store 
and all languages. See Section 6.3.3, "Cataloging Templates" for information on 
mapping JSP files to template programmatic access names.

Table 5–2 Recommended Values for Global Store Profile Options 

Scenario IBE: Use Global Bin IBE: Use Specialty Stores Page

One specialty store with one 
language and currency

No Not applicable

One specialty store with multiple 
languages and currencies

Yes No

Multiple specialty stores with 
access control

Yes Yes

Multiple specialty stores without 
access control

Yes Yes to require the user to return to 
the specialty stores page to change 
stores, or No to activate the store 
pull-down menu and language 
links

No Yes to prevent store switching 
completely, or No to activate the 
store pull-down menu and 
language links
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5.6 Creating the Hierarchy
After saving the specialty store, you must define an overall hierarchy in the Oracle 
iStore 11i Merchant UI Hierarchy tab. This hierarchy determines the organization of 
your specialty stores and their sections and products in the Merchant UI. It also 
determines the organization and presentation of each store’s sections and products 
in the Customer UI. All the specialty stores you create will be based in the overall 
hierarchy you created when setting up your initial specialty store. 

The overall hierarchy contains products from Oracle Inventory, grouped into 
sections. Associate a specialty store to a portion of the overall hierarchy or to the 
whole hierarchy itself by setting up its root node to point to a section. When 
reorganizing store sections and products or adding new specialty stores, you need 
to modify the overall hierarchy. 

The hierarchy determines the browsing experience of the customer and what 
products are featured at different levels in the store. When users come to a specialty 
store, they see the hierarchy starting from the root node of the store. You can choose 
not to show a particular section in a specialty store even though the given specialty 
store might point to an ancestor of the section.

Set up the top level sections in the hierarchy first. For each top level section, create 
as many subsections or children as you wish. The levels of sections are driven by 
the design.

You can assign products to sections of the hierarchy from the Hierarchy or Product 
tabs. Similarly, you can create groups of featured products at any level in the 
hierarchy by creating a subsection of type Featured in that section. The products in 
a section are shown by using the display style that you specify for that section.

Your template design determines how to manifest the hierarchy for the user. You 
can create and revise new templates at any time.

Note: In the Customer UI for Oracle iStore 11i, the minisite root 
sections are treated as virtual roots. The current minisite’s root 
section will not appear in the menu tabs or the navigational 
hierarchy of the Customer UI. The minisite’s home page will 
display the first navigational subsection under the root section, not 
the root section page itself. To present featured sections on the 
minisite’s home page, make them subsections of this navigational 
subsection.
Required Implementation Tasks 5-21



Creating the Hierarchy
In the templates shipped with Oracle iStore 11i, the top level appears as tabs while 
the lower level appears as browse bins on the store pages. A section containing 
subsections shows the featured products in the middle and the subsections in the 
left browse bin. If a section contains only products, it lists the products in the 
middle. Featured sections cannot have subsections.

While working with the hierarchy, you can determine whether or not to publish 
sections. A published section is available in the Customer UI. An unpublished 
section is not available in the Customer UI, unless the user has the IBE_
ADMINISTRATOR responsibility. Thus, you can choose to keep a section 
unpublished until you have tested its appearance in the Customer UI.

You can also specify whether the descendant sections have the same 
published/unpublished status as the section on which you are currently working. If 
a section is unpublished, its descendant sections are effectively unpublished, since a 
user cannot navigate to the descendant sections in the Customer UI (unless he or 
she has the IBE_ADMINISTRATOR responsibility). However, if a user knows the 
exact URL to access a descendant section, the user can access the descendant section 
if it is published.

If any section is not published, a user lacking the IBE_ADMINISTRATOR 
responsibility cannot access the section even if he or she has the exact URL.
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Figure 5–3 The Oracle iStore 11i Merchant UI Hierarchy Tab

5.6.1 Creating a Section in the Hierarchy
Use the following procedure to create a section in the hierarchy.

Login
Log in to Oracle CRM Applications as a store manager user.

Responsibility
IBE_ADMINISTRATOR

Prerequisites
You have set the profile option IBE: Item Validation Organization. See Section 3.1.14, 
"Setting Profile Options for the Oracle iStore 11i Merchant UI" for details.
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Steps
1. Launch the Merchant UI and enter the Hierarchy tab.

2. In the left frame of the Hierarchy tab window, the overall hierarchy tree 
appears. In the tree, select the node that will host the node you want to create, 
and click Create.

3. The Basic Information page opens in the right frame of the Hierarchy tab 
window. Enter the following information:

a. Name: The name of the section.

b. Section Code: Optional. Specify a Section Code to use as a name for the 
section in customized templates. The code in your customized templates 
can refer to the section and access its information directly by using its 
Section Code.

c. Section Type: Select either Featured or Navigational. A featured section 
appears on the home page of its parent section. A navigational section 
appears as a link in the browsing map of its parent section.

d. Status: Select either Published or Unpublished. 

e. Select to apply status to all descendant sections: Check this checkbox if you 
want all descendant sections of this section to have the same status.

f. Start Date Active and End Date Active: Specify the time limit (if any) when 
this section will be active.

g. Short Description and Long Description: Fill these in to describe the section 
in the store. The descriptions will appear on the section pages.

h. Keywords: Optional. Enter keywords for the section to enable 
keyword-based searches for this section.

i. Template for displaying this section: Optional. Specify a section-level 
default template for displaying the section. Several sections can share a 
template. Leave this blank to revert to the default store-level template.

Note: Do not choose a template name that ends with the word 
"included." These templates display only the center of the section 
page, not the menu.
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j. Display Style for products in this section: Optional. Select the display style 
you want to use to display products in this section. Leave this blank to 
revert to the default store-level display style for products.

Click Continue. The Multimedia Components page opens.

4. Optional: In the Multimedia Components page, provide information about 
multimedia components specific for this section. Use this if you want to show 
or associate multimedia content with sections. For a given component, click Go 
to search the multimedia catalog. If the desired object is not found, create one 
and associate it with the section. 

Leave the fields blank to use the default multimedia for the multimedia 
components. 

Click Continue. The Specialty Stores page opens.

5. Move the specialty store(s) in which this section should appear into the 
Included Specialty Stores column. 

Decide if the section should appear only in the specialty stores that you have 
selected here or in other specialty stores if those specialty stores’ roots point to 
an ancestor of the current section. Check the box Include in all future sites if 
the site’s root section is ancestor of this section as appropriate. 

Click Continue. The Relationships page opens with a list of existing 
relationships in the section.

6. Review relationship rules for this section. See Section 6.5, "Creating Product 
Relationships" for more information. 

Click Continue. The Advanced Settings page opens.

7. Optional: Specify if the section should be populated automatically with 
products from Oracle Inventory based on certain SQL clauses, as well as specify 
the order.

Note: If the section is a leaf section, do not choose the display 
style Product Detail Style.

Note: The auto-placement rule is not currently used.
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Optional: Specify Order By clause to specify how the product for a section 
should be ordered when displayed in the Customer UI. The value for this field 
can be just one column name from MTL_SYSTEM_ITEMS or comma-separated 
columns of the same table. 

Click Finish. The Children page opens.

8. Your section has been created. Add products or subsections to this section. Note 
that a section can have either subsections or products as children, but not both. 
Featured sections cannot have subsections as children. See Section 5.6.3, 
"Adding Products to a Section" and Section 5.6.4, "Adding Subsections to a 
Section" for instructions on adding children to a section.

9. Continue to create sections and subsections for your hierarchy as needed.

10. To adjust the order of the section tabs in the specialty store, click its root section 
in the navigation tree and edit the values in the Order column. The section 
whose display name should be the first tab should have the lowest number in 
the Order column.

Guidelines
� The display style you choose for products in this section is the style used to 

display products on a section page for this section.

� Choosing Include in all future specialty stores if the store’s root section is 
ancestor of this section in the Specialty Stores page ties the section to its 
ancestors. When a specialty store is added to or deleted from the ancestor, the 
same change applies to all its descendant sections.

Example
1. In the Hierarchy tab, select the Home section in the navigation tree in the left 

frame.

2. In the right frame, click Children.

3. Click Add Section in the right frame to create a new section.

4. Enter Featured Products as the name and the code.

5. Select Featured as the section type. Everything else is optional. Click Continue.

6. On the Multimedia Components page, everything is optional. Click Continue.

7. Accept the defaults on the Specialty Store and Navigation Relationships pages. 
Click Continue.
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The Advanced Settings page opens. Click Finish.

8. In the left frame, click Refresh. Expand the Home node, which should have the 
newly-created section under it.

9. Highlight Home, and click Create. Repeat the above steps to create another 
section named Books, with type Navigational.

10. Repeat again for Music, Electronics, and Computers, making them all 
navigational sections.

5.6.2 Modifying a Section in the Hierarchy
Use the following procedure to modify a section in the hierarchy.

Login
Log in to Oracle CRM Applications as a store manager user.

Responsibility
IBE_ADMINISTRATOR

Prerequisites
You have set the profile option IBE: Item Validation Organization. See Section 3.1.14, 
"Setting Profile Options for the Oracle iStore 11i Merchant UI" for details.

Steps
1. Launch the Merchant UI and enter the Hierarchy tab.

2. In the left frame of the Hierarchy tab page, the overall hierarchy tree appears. In 
the tree, select the node for the section that you want to modify.

The Children page for the section opens in the right frame of the Hierarchy tab.

3. Optional: In the Children page, add products or subsections to this section. See 
Section 5.6.3, "Adding Products to a Section" and Section 5.6.4, "Adding 
Subsections to a Section" for instructions on adding children to a section.

4. Optional: Click Basic Information to open the Basic Information page. Enter or 
modify the basic information about the section.

Click Update to save your changes.

5. Optional: Click Multimedia Components to open the Multimedia Components 
page. Enter or modify multimedia content associations for this section.
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Click Update to save your changes.

6. Optional: Click Specialty Stores to open the Specialty Stores page. Add or 
remove this section from eligible specialty stores.

Click Update to save your changes.

7. Optional: Click Relationships to open the Relationships page. Review the 
existing relationship rules for this section. See Section 6.5, "Creating Product 
Relationships" for more information. 

Click Update to save your changes.

8. Optional: Click Advanced Settings to open the Advanced Settings page. 
Specify an Order By clause. (The auto-placement rule is not currently used.)

Click Update to save your changes.

5.6.3 Adding Products to a Section
You can add products to a section in the Hierarchy tab after building the product 
catalog. You can also add products to a section when working on the product in the 
Product tab. See Section 5.7, "Building the Product Catalog" for more information.

Use the following procedure to add products to a section in the Hierarchy tab.

Login
Log in to Oracle CRM Applications as a store manager user.

Responsibility
IBE_ADMINISTRATOR

Prerequisites
The section has no subsections.

Steps
1. Launch the Merchant UI.

2. In the Hierarchy tab, navigate to the section’s Children page in one of the 
following ways:

� Create a section as described in Section 5.6.1, "Creating a Section in the 
Hierarchy". When you finish creating your section, the Children page for 
the section opens.
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� In the hierarchy tree, select the node for the section to which you want to 
add products. The Children page for the section opens.

� While working on the section as described in Section 5.6.2, "Modifying a 
Section in the Hierarchy", click the Children link. The Children page for the 
section opens.

3. Click Add Product.

4. Perform a product search in the pop-up window.

5. Select one or more of the results and click Add.

6. Choose Done to close the pop-up window and return to the Children page in 
the Hierarchy tab.

7. Optional: Modify the start date or end date for the time period when a product 
will be available in the section. Click Update to save your changes.

8. Optional: Edit the values in the Order column to specify the order in which the 
products will be displayed in the section. The first product should have the 
lowest number in the Order column. Click Update to save your changes.

9. Optional: Check the Remove checkbox next to a product and click Update to 
remove the product from the section.

5.6.4 Adding Subsections to a Section
Use the following procedure to add subsections to a section in the Hierarchy tab.

Login
Log in to Oracle CRM Applications as a store manager user.

Note: The Add Product button appears only if the section has no 
subsections.

Note: You can also add subsections to a section by moving 
existing sections into the parent section. See Section 5.6.5, "Moving 
Sections in the Hierarchy" for instructions.
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Responsibility
IBE_ADMINISTRATOR

Prerequisites
� The section has no products.

� The section is not a Featured section.

Steps
1. Launch the Merchant UI.

2. In the Hierarchy tab, navigate to the section’s Children page in one of the 
following ways:

� Create a section as described in Section 5.6.1, "Creating a Section in the 
Hierarchy". When you finish creating your section, the Children page for 
the section opens.

� In the hierarchy tree, select the node for the section to which you want to 
add subsections. The Children page for the section opens.

� While working on the section as described in Section 5.6.2, "Modifying a 
Section in the Hierarchy", click the Children link. The Children page for the 
section opens.

3. Click Add Section. The Basic Information page for the new subsection opens.

4. Set up the subsection in the Hierarchy tab as described in Section 5.6.1, 
"Creating a Section in the Hierarchy".

5. Optional: In the section’s Children page, modify the start date or end date for 
the time period when a subsection will be available in the section. Click Update 
to save your changes.

6. Optional: Edit the values in the Order column to specify the order in which the 
subsections will be displayed in the section. The first subsection should have 
the lowest number in the Order column. Click Update to save your changes.

Note: The Add Section button appears only if the section has no 
products.
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7. Optional: Check the Remove checkbox next to a subsection and click Update to 
remove the subsection from the section.

5.6.5 Moving Sections in the Hierarchy
In the Hierarchy tab, you can move sections around the hierarchy tree by cutting, 
copying, and pasting them. Use the Cut, Copy, and Paste buttons to move an entire 
section from one place in the hierarchy to another.

Use the following procedure to cut or copy a section and paste it into another 
location in the hierarchy tree.

Login
Log in to Oracle CRM Applications as a store manager user.

Responsibility
IBE_ADMINISTRATOR

Prerequisites
None

Steps
1. Launch the Merchant UI.

2. In the Hierarchy tab’s hierarchy tree, highlight the section that you want to 
move.

3. Click Cut to cut the section, or Copy to copy the section.

4. Paste the cut or copied section into the hierarchy as follows:

a. Highlight the root section that should host the pasted section.

b. Click Paste. 

Note: To adjust the order of the section tabs in the specialty store, 
click its root section in the hierarchy tree to open the Children page, 
and edit the values in the Order column. The section whose display 
name should be the first tab should have the lowest number in the 
Order column.
Required Implementation Tasks 5-31



Building the Product Catalog
5.7 Building the Product Catalog
Setting up the product catalog involves the following considerations:

� Designing page flow and navigation.

� Determining product items to be sold, their display features, and configuration 
options.

� Determining types of data required. For example, books may require a title, 
author, and publisher. See Oracle Inventory User’s Guide for details on how to use 
the flexfield structures in Oracle Inventory to store and sort data accordingly.

If you plan to use customized multimedia or templates to display products in your 
specialty stores, then setting up the product catalog also involves the following 
considerations: 

� Designing the display appearance for different product types. This process 
determines the number and type of product templates required. For example, 
perhaps all music products list the artist first and then provide a link to an 
audio clip, but all clothing products list the clothing type (e.g., jacket) first, 
followed by a graphic of the item. Oracle iStore 11i ships with the assumption 
that all product types appear the same on the Customer UI.

� Creating template text for product types. Text embedded in a template makes 
that template specific to the given product type. For example, the word “Artist” 
in front of the flexfield where a performer’s name is to appear can only be used 
for the compact disc product category. Embedded text must be manually 
translated and saved in the required multiple languages as additional template 
types. Oracle iStore 11i does not translate template text. Alternatively, templates 
using generic terminology can be more easily applied across product types. For 
example, using the term “Lead Performer(s)” as a flexfield label could apply to 
both compact disc and videotape product categories. Providing no flexfield 
labels in a template allows templates to be most broadly applied across product 
types. 

Note: If you cut and paste a section from one location in the 
hierarchy to another, all the information about the section will 
transfer to the new location. If you copy and paste a section, all the 
information about the original section will copy into the new 
section, except for the section-level multimedia component settings.
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While working with the product catalog, you can determine whether or not to 
publish products. A published product is available in the Customer UI, assuming 
that it is also listed in at least one published section. An unpublished product is not 
available in the Customer UI, unless the user has the IBE_ADMINISTRATOR 
responsibility. Thus, you can choose to keep a product unpublished until you have 
tested its appearance in the Customer UI.

5.7.1 Searching for Products
Use the following procedure to search in the Product tab for Oracle Inventory items 
that you want to include in the product catalog. After you find an Oracle Inventory 
item, you can modify its Oracle iStore 11i product catalog information as described 
in Section 5.7.2, "Modifying the Product Catalog".

Login
Log in to Oracle CRM Applications as a store manager user.

Responsibility
IBE_ADMINISTRATOR

Prerequisites
� Products must be loaded into Oracle Inventory before they can be imported into 

Oracle iStore 11i. 

� Products in Oracle Inventory must have their Web Status flag set to either 
Published or Unpublished in the Web Option tab of the Master Item form 
before they can appear in the Oracle iStore 11i Merchant UI. The Web Status 
must not be Disabled or null. Only products with a Web Status of Published 
can be sold in your stores.

� Products in Oracle Inventory must have a checked Orderable on the Web 
checkbox in the Web Option tab of the Master Item form.

� Products in Oracle Inventory must have a checked Customer Orders Enabled 
checkbox in the Order Management tab of the Inventory Master Item form.

� JTT and IBE profile options for the Merchant UI must be set. See Section 3.1.14, 
"Setting Profile Options for the Oracle iStore 11i Merchant UI" for details.
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Steps
1. Launch the Merchant UI.

2. In the Product tab, choose the field on which you want to search from the View 
pull-down menu, and enter the search criteria in the adjacent text field. The 
searchable fields are listed below:

� Name—Retrieves products with an Oracle Inventory description matching 
the search criteria that you enter

� Part number—Retrieves products with an Oracle Inventory item ID 
matching the search criteria that you enter

� Belongs to category—Retrieves products in an Oracle Inventory category 
matching the search criteria that you enter

� Created after date—Retrieves products created in Oracle Inventory after 
the date that you enter. Use date format DD-MON-RRRR.

� Created before date—Retrieves products created in Oracle Inventory before 
the date that you enter. Use date format DD-MON-RRRR.

� Status—Retrieves products with an Oracle Inventory Web Status matching 
the status that you enter. Enter PUBLISHED or UNPUBLISHED.

� New—Retrieves products created in last x days where x is the value of the 
profile option IBE: Number of Days for New Items

3. After entering your search criteria, click Go.

A list of search results appears in the Products page. The list displays products 
in Oracle Inventory that match your search criteria, with existing product 
catalog information for those products.

See Section 5.7.2, "Modifying the Product Catalog" for instructions on 
modifying a product’s catalog information.

Note: Products are retrieved from the Inventory Organization ID 
that matches the value of the profile option IBE: Item Validation 
Organization.

Note: You can use % as a wildcard character in the search.
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If there are unpublished products in your results, the list shows them with a 
Publish button in the Wizard column. See Section 5.7.3, "Publishing Products" 
for instructions on publishing a product.

5.7.2 Modifying the Product Catalog
Use this procedure to add products to the product catalog and make them available 
for sale in your store. You can also use this procedure to remove products from the 
store.

Additionally, if you plan to use customized multimedia or templates, you can use 
this procedure to customize a product’s presentation at the item level. For example, 
defining proprietary multimedia and multimedia components enables association 
of specific images with certain products. Item-level customizations override 
category-level, section-level, and store-level settings.

Login
Log in to Oracle CRM Applications as a store manager user.

Responsibility
IBE_ADMINISTRATOR

Prerequisites
� Store layout must be determined, and the hierarchy of products, sections, and 

specialty stores must be identified. See Section 5.6, "Creating the Hierarchy" for 
details.

� If you plan to use customized multimedia or templates, you must determine 
store layout with the following additional considerations: 

� Site appearance must be decided. 

� Templates associated with each product, section, and specialty store must 
be identified. 

� Templates for full Web pages and areas within Web pages must be 
identified. 

� At the implementation level, the mappings between templates and source 
files must be decided. 
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� Source files (physical templates) must be created by the UI implementation 
team with stubs for the dynamic elements, along with the multimedia 
components to be displayed on the site.

� Templates must be populated with the dynamic JSP elements calling Oracle 
iStore 11i, using the templates shipped with Oracle iStore 11i as a model.

� Display styles must exist before you can assign them to a product. See 
Section 6.4, "Defining Display Styles" for more information.

Steps
1. Launch the Merchant UI.

2. Search for products as described in Section 5.7.1, "Searching for Products".

The search results appear in the Product tab.

3. Click on a product’s name in the search results list to edit its information.

The Basic Information page displays the Posting Status, the Oracle Inventory 
name and part number, and any descriptions you have already added to the 
product catalog.

4. To make the product available to be sold in your store, set the Posting Status to 
Published. To remove the product from your store, set the Posting Status to 
Unpublished.

5. Optional: In the Basic Information page, enter or modify the short and long 
descriptions.

6. In the Basic Information page, click Update. The product is published or 
unpublished immediately. The descriptions are saved, and are also available for 
display in your store if the product is published.

7. In this product detail page in the Products tab, choose Hierarchy Paths.

The Hierarchy Paths page displays the hierarchy of sections that have been set 
up for the store. Remove or add parent sections for the product, edit the date 

Note: Products with Posting Status Published are visible on the 
store. Be careful about changing information, since the changes go 
to the production system and are published immediately. It is 
recommended that you unpublish the product before making 
changes, and then republish the item when finished.
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range when this product will be available in each section, and number the 
product’s place in the section’s product display order. Click Update. 

8. Optional: In this product detail page in the Products tab, choose Category and 
Display Styles.

The Category and Display Styles page displays the category to which the 
product belongs and lists all display styles and any template names already 
assigned to the product. Choose a template name for each display style that you 
want to use for the product, in any of the following ways:

� To use the category-level default template for a display style, highlight the 
radio button next to the default setting on the display style line. 

� To set an item-level template, highlight the radio button next to the field on 
the display style line and click Go. Select a template from the pop-up 
window that opens.

� Leave all fields blank to keep default templates for all display styles that 
you want to use for the product. 

Click Update when finished.

9. Optional: In this product detail page in the Products tab, choose Multimedia 
Components.

The Multimedia Components page lists all multimedia components that have 
been set up for Oracle iStore 11i. Assign multimedia names to multimedia 
components. See Section 6.7.1, "Creating Images for Products" for more 
information on associating specific images with a product. Alternatively, you 
can leave fields blank to assign default multimedia names to multimedia 
components. Click Update when finished.

10. Optional: In this product detail page in the Products tab, choose Relationships.

The Relationships page displays existing relationships between the product and 
other products or sections and the rules for those relationships, such as the 
product to show for an upsell or cross sell. 

To add related items for relationships, go to the Relationship tab. See 
Section 6.5, "Creating Product Relationships" for more information.

11. In this product detail page in the Product tab, choose Specialty Stores.

The Specialty Stores page lists the specialty stores where the product will be 
displayed. By default the product appears in those specialty stores to which the 
product’s parent section belongs.
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Select the specialty stores where the product should appear and click Update.

12. Repeat this procedure for every product you want to include in the product 
catalog.

5.7.3 Publishing Products
By publishing products, you add them to the product catalog and make them 
available for sale in your stores.

When you search for an item as described in Section 5.7.1, "Searching for Products", 
the list of search results displays a Publish button in the Wizard column next to any 
unpublished products that match your search criteria. From the search results, you 
can publish an unpublished product in one of two ways:

� Click the product name and change the Posting Status to Published in the Basic 
Information page that opens. See Section 5.7.2, "Modifying the Product Catalog" 
for more information.

� Click the Publish button next to the product name. 

Use the following procedure to publish a product by clicking its Publish button.

Login
Log in to Oracle CRM Applications as a store manager user.

Responsibility
IBE_ADMINISTRATOR

Prerequisites
None

Steps
1. Launch the Merchant UI.

2. Search for products as described in Section 5.7.1, "Searching for Products".

Note: Publishing or unpublishing a product in the Oracle iStore 
11i Merchant UI also changes the product’s Web Status setting in 
Oracle Inventory.
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The search results appear in the Product tab.

3. Click the Publish button next to an unpublished product that you want to 
publish.

The Basic Information page opens.

4. Optional: Add or modify the basic and long descriptions.

5. In the Basic Information page, click Continue. The Hierarchy Paths page opens.

6. Optional: Add or remove parent sections for the item.

7. In the Hierarchy Paths page, click Continue. The Category and Display Styles 
page opens.

8. Optional: Change template assignments for one or more of the display styles.

9. In the Category and Display Styles page, click Continue. The Multimedia 
Components page opens.

10. Optional: Change multimedia assignments for one or more of the multimedia 
components.

11. In the Multimedia Components page, click Publish. 

5.8 Setting Up the Product Search
Oracle iStore 11i’s product search feature allows you to enable your customers to 
search a store for products they want to buy.

The product search feature in Oracle iStore 11i is implemented using the interMedia 
text search utility of the Oracle8i database. The product information (part number, 
description, and long description) is first loaded in an Oracle iStore 11i table (IBE_
CT_IMEDIA_SEARCH) via the concurrent program iStore Search Insert. This step is 
generally performed after the merchant has loaded his or her inventory with 
products. Once the data is loaded, any change to product information is updated in 
the Oracle iStore 11i table IBE_CT_IMEDIA_SEARCH through a database trigger 
call on the inventory table. This keeps product information current in the search 
table. Once the data is moved into the search table, the interMedia index is created 
to facilitate search capability of the keywords.
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Storing Information in the Search Table
The search table IBE_CT_IMEDIA_SEARCH is a denormalized table of MTL_
SYSTEM_ITEMS_TL and MTL_ITEM_CATEGORIES. 

The core text on which you search is stored in a Clob called INDEXED_SEARCH. 
Currently it stores a concatenation of part number, name, and description of 
products. The table also stores inventory_item_id, organizationId, category_id, 
category_set_id, and the Web status field from MTL_SYSTEM_ITEMS_B table.

Searchable Product Attributes
Searches are performed on the part number, name, and description of a product. 
The name and description are stored as description and long description columns in 
the MTL_SYSTEM_ITEMS_TL table.

Search Dependencies
The product search requires version 8.1.7 of the Oracle database with the 
interMedia option installed. It also requires the 11i version of the Oracle Inventory 
schema. 

5.8.1 Setting Up Oracle Inventory for Product Search
First, set up your inventory, under a common master organization ID. Points to 
remember while setting up your inventory include: 

� Give products unique names.

� Do not leave category names (concatenated segments) blank or non-unique. 
They can be null or non-unique in the database, but show as blanks or multiple 
times in the Categories LOV in your customer home page.

� Make sure the products have Web Status set to Published in the Master Item 
form. See Section 3.1.8, "Setting Up Product Items in Oracle Inventory" for 

Note: You must ensure that both Oracle Inventory and Oracle 
interMedia are installed and configured properly before setting up 
store search. Refer to the Oracle interMedia documentation for 
details on how to set up and configure interMedia.

Note: For enhanced query performance, enable caching of large 
object data for the interMedia DR$R table.
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instructions. You can also query this field by examining the web_status column 
of the item in the MTL_SYSTEM_ITEMS table.

Next, set the iStore profile options for search.

5.8.2 Setting Search Profile Options
Oracle iStore 11i search needs six iStore (IBE) profile options to be set. The following 
table lists these profile options with their descriptions.

Table 5–3 Search Profile Options 

Profile Option Description

Enable Fuzzy Search If set to Yes, this profile option allows users to perform fuzzy 
product searches, so that they do not have to type in the exact 
spelling of their search criteria to retrieve results that match 
these criteria. If this profile option is not set, it defaults to No.

No of Results in Search This profile option sets the maximum cap on the search results. 
For example, if the user searches for a very common keyword 
(not in the stop words list), then the search process stops after 
the maximum cap set in this profile option, even if the process 
has not searched through Oracle Inventory completely. If this 
profile option is not set, it defaults to 200.

Search Lines Per Page This profile option sets the number of lines to be displayed per 
page. If this profile option is not set, it defaults to 20.

Thesaurus File Name This profile option specifies the prefix for the thesaurus names of 
the synonym files that you load for the Oracle iStore 11i product 
synonym search. In the thesaurus names, you must use this 
prefix followed by _language_short_code. The profile option 
thus standardizes the thesaurus names. If the profile option is 
not set, it defaults to IBETHESAURUS.

Note: If you change this profile option after you have loaded 
synonym files, those synonym files are no longer accessible, and 
you must load the synonym files with their new thesaurus 
names.

Use Category Search This profile option determines whether the home page 
pull-down search menu allows category-level or section-level 
searching. Yes causes the pull-down menu to list categories with 
publishable items, while No causes it to list the minisite’s top 
level sections. A null value enables a basic search against all 
products in the current minisite.
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Decide to enable either category-level or section-level searches from the Customer 
UI home page pull-down menu, then carry out the appropriate procedure to 
populate the search table with data and create the interMedia text index.

5.8.3 Populating the Category-Level Search Table
To enable category-level search on the Customer UI, the iStore Search Insert 
program only needs to be run once to populate the search table IBE_CT_IMEDIA_
SEARCH. After this one-time product data load, the table will get updated product 
information through a database trigger call on the inventory table.

Login
Log in to Oracle Forms as the concurrent program manager.

Responsibility
iStore Concurrent Programs Responsibility

Prerequisites
Set the profile option IBE: Use Category Search to Yes.

Steps
1. Log in to Oracle Forms with the iStore Concurrent Programs Responsibility.

2. In the pop-up window, choose Single Request and click OK.

The Submit Request window opens.

3. Choose iStore Search Insert from the Name LOV.

4. Click Submit to start the concurrent request. Note the request ID.

Use Synonym Search This profile option determines whether the product search 
retrieves product names that are synonyms of the users’ search 
keywords. Yes enables the synonym search after you have 
loaded a thesaurus. No disables the synonym search. If this 
profile option is not set, it defaults to No.

Table 5–3 Search Profile Options (Cont.)

Profile Option Description
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5. Optional: You can monitor the progress of your request by looking at the 
request log and output files in $COMMON_TOP/admin/log/l<request ID>.log 
and $COMMON_TOP/admin/out/o<request ID>.out, respectively.

6. Optional: You can also view the request status by selecting View Requests and 
searching by the request ID.

This process can take a substantial amount of time, depending on the number of 
items you have. As an estimate, for about 300,000 items in inventory this program 
can take about 45 minutes to run. 

The concurrent manager calls the iStore Search Insert program, which moves the 
product data from the inventory table to the Oracle iStore 11i search table IBE_CT_
IMEDIA_SEARCH. When this job is running, the search tables are purged and the 
product search does not work correctly on the store. 

Once the request is complete, you can search for products based on part number, 
name, and description. The pull-down search menu on the store’s home page lists 
categories with publishable items. If additional product attributes are to be added in 
the search, this SQL script needs to be modified to add the extra search column.

5.8.4 Populating the Section-Level Search Table
To enable section-level search on the Customer UI for the first time, run the iStore 
Search Insert program first, then run the iStore Section Search Refresh program to 
populate the search table IBE_SECTION_SEARCH.

Whenever you update the Oracle iStore 11i hierarchy, rerun only the iStore Section 
Search Refresh program to update the search table IBE_SECTION_SEARCH.

Login
Log in to Oracle Forms as the concurrent program manager.

Note: You will only be able to search for products whose WEB_
STATUS is PUBLISHED.

Caution: Since this batch job deletes data from the search table, 
the rollback segment should be large enough for the process to 
complete. 
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Responsibility
iStore Concurrent Programs Responsibility

Prerequisites
Set the profile option IBE: Use Category Search to No.

Steps
1. Carry out the procedure outlined in Section 5.8.3, "Populating the 

Category-Level Search Table" to load data into the main search table IBE_CT_
IMEDIA_SEARCH.

2. In the iStore Concurrent Programs Responsibility, choose Single Request and 
click OK.

The Submit Request window opens.

3. Choose iStore Section Search Refresh from the Name LOV.

4. Click Submit to start the concurrent request. Note the request ID.

The concurrent manager calls the iStore Section Search Refresh program, which 
populates the search table IBE_SECTION_SEARCH with product data. The product 
search is still available to customers while the iStore Section Search Refresh program 
is running.

Once the request is complete, the pull-down search menu on the store’s home page 
lists the top level sections, not the product categories.

5.8.5 Changing Between Category-Level Search and Section-Level Search
To change the listings in the pull-down search menu from categories to sections or 
vice versa, rerun the iStore Search Insert concurrent program to ensure that product 
listings will not be duplicated.

Login
Log in to Oracle Forms as the concurrent program manager.

Responsibility
iStore Concurrent Programs Responsibility
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Prerequisites
Change the IBE: Use Category Search profile option to Yes if you are changing to 
the category-level search. Change the profile option to No if you are changing to the 
section-level search.

Steps
1. Log in to Oracle Forms with the iStore Concurrent Programs Responsibility.

2. In the pop-up window, choose Single Request, and click OK.

The Submit Request window opens.

3. Choose iStore Search Insert from the Name LOV.

4. Click Submit to start the concurrent request. Note the request ID.

5. Optional: You can monitor the progress of your request by looking at the 
request log and output files in $COMMON_TOP/admin/log/l<request ID>.log 
and $COMMON_TOP/admin/out/o<request ID>.out, respectively.

6. Optional: You can also view the request status by selecting View Requests and 
searching by the request ID.

If you are changing the search from section level to category level, the pull-down 
search menu lists categories once the request is completed.

If you are changing the search from category level to section level, perform the 
following steps after the request is completed:

7. In the iStore Concurrent Programs Responsibility, choose Single Request and 
click OK.

The Submit Request window opens.

8. Choose iStore Section Search Refresh from the Name LOV.

9. Click Submit to start the concurrent request. Note the request ID.

The pull-down search menu lists the top-level sections once the request is complete.
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5.8.6 Enabling Fuzzy Searches
The fuzzy search functionality returns search results with product names that do 
not match the spelling of the users’ search criteria exactly. For example, if a user 
enters "laptops" or "laptp," the search retrieves product names with the word 
"laptop."

You can enable the fuzzy search functionality by setting the profile option IBE: 
Enable Fuzzy Search to Yes and running the iStore Search Insert concurrent 
program, as well as the iStore Section Search Refresh concurrent program if you 
have enabled section-level searches. Every time you change the value of the IBE: 
Enable Fuzzy Search profile option, you must rerun the iStore search concurrent 
programs.

If the fuzzy search is active, part number searches are unavailable because such 
searches require completely accurate matching.

Fuzzy search is currently not supported for Japanese language implementations. 

5.8.7 Enabling Synonym Searches
The synonym search functionality returns search results with product names that 
you have set up as synonyms of the users’ search criteria. For example, if a user 
enters "database," and you have set up "database" as a synonym of the phrase 
"Oracle8i," the search retrieves product names with the phrase "Oracle8i."

You can set up synonym searches for each of your supported languages.

Synonym searches do not process wildcards. For example, if a user enters "datab%" 
as a search criterion, the synonym search would look for synonyms for "datab" only 
and would not retrieve product names that are synonyms of "database."

Set up the synonym search functionality for any language using the following 
procedure.

Login
None

Responsibility
None
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Prerequisites
Set the profile option IBE: Thesaurus File Name. See Section A.6, "Oracle iStore 11i 
(IBE) Profile Options for the Customer UI" for more details.

Steps
1. Create a synonym file ("thesaurus") for the Oracle iStore 11i product search. See 

Oracle8i interMedia Text Reference for instructions on creating a synonym file.

You can find examples of synonym files in the $ORACLE_HOME/ctx/thes 
directory, where $ORACLE_HOME points to the 8.1.7 environment.

2. Load the thesaurus using the ctxload utility in $ORACLE_HOME/ctx/bin as 
follows:

ctxload -user <username/password> -thes -name <thesaurus name> -thescase 
<y/n> -file <file name>

<username/password> is your user name and password, e.g., 
ctxsys/ctxsys.

<thesaurus name> is the thesaurus name with the syntax prefix_language_
short_code to indicate the thesaurus language. The prefix is set in the profile 
option IBE: Thesaurus File Name. For example, if the profile option is set to 
ibethes, then the thesaurus name is ibethes_us for American English, since 
the language short code is us. For French, the thesaurus name is ibethes_f, 
since the language short code is f. You can find the language codes by selecting 
LANGUAGE_CODE from the FND_LANGUAGES table.

<y/n> indicates whether the thesaurus is case sensitive. Enter y if you want the 
thesaurus to be case sensitive, or n if you want it to be case insensitive.

<file name> is the physical synonym file’s name, e.g., MyThes.txt.

The following example is the command you should run as username ctxsys 
with password ctxsys when loading an American English thesaurus with the 
physical file name MyThes.txt for a case insensitive synonym search, when the 
profile option IBE: Thesaurus File Name is set to ibethes.

ctxload -user ctxsys/ctxsys -thes -name ibethes_us -thescase n -file 
MyThes.txt

3. Set the profile option IBE: Use Synonym Search to Yes.

Synonym search is now available.
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5.8.8 Creating Search Index Tables
To be able to run external procedures to create a search index table, please ensure 
that ENVS is included in your SID_DESC part of listener.ora as follows.

Login
None

Responsibility
None

Prerequisites
None

Steps
1. Go to 8.1.7 ORACLE_HOME:

cd /u02/visappl
ksh
 . ./APPSORA.env
cd $ORACLE_HOME/../8.1.7/network/admin

This directory should contain listener.ora. 

2. Verify that listener.ora contains the following: 

(SID_DESC =
(SID_NAME = PLSExtProc)
(ORACLE_HOME = /u04/visora/8.1.7)
(ENVS = LD_LIBRARY_PATH=/u04/visora/8.1.7/ctx/lib)
(PROGRAM = extproc)

)

Note: If you have already loaded a thesaurus for a given 
language, you can use Oracle8i interMedia APIs such as ctx_
thes.create_relation and ctx_thes.delete_relation to add or remove 
synonyms in that language for existing searchable items. You can 
also add or remove phrases by using the APIs ctx_thes.create_
phrase and ctx_thes.delete_phrase. See Oracle8i interMedia Text 
Reference for more information.
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3. Before creating the search index table, make sure that the Oracle interMedia 
server is up. Use the following command to check: 

$ ps -ef | grep ctxsrv

If it is not running, start the Oracle interMedia server as follows:

4. Go to 8.1.7 ORACLE_HOME:

cd /u02/visappl
ksh
 . ./APPSORA.env
 cd $ORACLE_HOME/../8.1.7
 . ./VIS.env 

This will set up 8.1.7 ORACLE_HOME env. 

5. Run the following command:

ctxsrv -user ctxsys/ctxsys&

5.8.9 PL/SQL, Java, and JSPs Involved in Search
The following program units are used in the product search process:

� java/catalog/Search.java (main Java program that executes the query) 

� ibeCSrdSrchResults.jsp (search result JSP)

� ibeCZzdMenu.jsp (main home page) 

� ibeCSrdSrchAdvForm.jsp (search result JSP) 

� IBEVCSKS.pls (package specification)

� IBEVCSKB.pls (package body for trigger on search table)

� IBEVCSUB.pls (package body)

� IBEVIDTS.pls (package specification for the main database trigger)

� IBEVIDTB.pls (package body for the main database trigger)

� java/catalog/PrdRec.java (definition of search result object)

� IBEVCSIS.pls (package specification for section search package)

� IBEVCSIB.pls (package body for category and section search package; one time 
load of product descriptions through concurrent manager)
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� ibecsmcr.sql (creates materialized view to facilitate availability of product 
search functionality during iStore Section Search Refresh)

Figure 5–4 Oracle iStore 11i Search Tables
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5.8.10 Customizing Search
If you need to add more attributes of the item to search for, you must modify 
IBEVCSIB.pls for the initial load and the PL/SQL triggers mentioned above to make 
sure that updates to these attributes get propagated to the search table.

1. Modify the search package (IBEVCSKS.pls and IBEVCSKB.pls) for adding the 
additional product search attributes. By default, only the part number, product 
name (description column), and product description (long description column) 
are included in the search.

If additional attributes are to be added in the product search, the parameters for 
the package specification and body will have to be changed accordingly, with 
the new attributes. This package moves the subsequent changes in the product 
information, to Oracle iStore 11i’s search table IBE_CT_IMEDIA_SEARCH. Any 
insert, delete, or update on MTL_ITEM_CATEGORIES, any delete or update on 
MTL_SYSTEM_ITEMS_B and any insert, delete, or update on MTL_SYSTEM_
ITEMS_TL table will move the change to the search table IBE_CT_IMEDIA_
SEARCH through this procedure. This procedure is called from the main 
database trigger procedures, as explained in the next step.

2. If new parameters are added to the search package, the call to the search 
package must be modified in the main database trigger package IBEVIDTB.pls 
to include the new parameters added to the search move procedures. This 
package body calls all of Oracle iStore 11i’s ERP-related database trigger 
procedures, including the search package procedures. 

3. The database trigger on the product tables calls the main database trigger 
package to move the product data change to the Oracle iStore 11i search table 
IBE_CT_IMEDIA_SEARCH. 

However, modifying the search package call will not recreate the interMedia 
index to include the changed information in the search table IBE_CT_IMEDIA_
SEARCH. Administrators must refresh the interMedia search index every time 
a new product is added or an existing product is changed or deleted. You can 
refresh the interMedia index IBE_CT_IMEDIA_SEARCH_IM through the 
Oracle Enterprise Manager utility, or by executing the command "CTX_
DDL.SYNC_INDEX" in SQL*Plus as follows:

exec ctx_ddl.sync_index(’IBE_CT_IMEDIA_SEARCH_IM’);

You must have privileges to alter the interMedia index. After this step, the 
modified product information is visible in the Oracle iStore 11i product search 
process.
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5.8.11 Adding Stopwords to Searches
There are many search words such as "and," "if," and "then" which are very common 
and will return numerous search results. Search results may not be relevant to the 
user’s query if such common search keywords are used. In addition, searches on 
common keywords use processing resources and slow down performance. These 
common keywords can be excluded from the search by using the "Stop Words" 
utility in interMedia.

Log in to Oracle Enterprise Manager as CTXSYS to see the stop words in the Stop 
List. You can add more stop keywords to the Stop List.

5.9 Setting Up Notifications
Oracle iStore 11i sends notifications to users and sales representatives to inform 
them of the statuses of various activities. These notifications are for the recipients’ 
information only and do not require a reply, although some notifications alert the 
recipients to a need for action on their part. The notifications are triggered by 
specific events, such as user actions and application data refreshes.

Oracle iStore 11i comes with seeded Oracle Workflow notification events and 
messages. You can create new messages in Oracle Workflow, as described in 
Chapter 17, "Integrating Oracle iStore 11i with Oracle Workflow".

In the Merchant UI, you can select the default message for each notification event 
and map other messages to the notifications according to two parameters:

� Organization

� User type

The default message is the message where every parameter is set to ALL. For any 
notification event, if you have not set up a message for a specific organization-user 
type combination, Oracle iStore 11i uses the default message.

You can also choose to disable a notification event, either completely or for specific 
organization-user type combinations.

The following table describes all Oracle iStore 11i notifications and lists their 
triggers and recipients.

Note: The organization is determined by the setting of the profile 
option MO: Operating Unit for the user’s responsibility. 
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Table 5–4 Oracle iStore 11i Notifications 

Notification Description Recipients Trigger

User Registration A welcome message Registering user A user registers in a 
specialty store, or a B2B 
user is registered by a 
B2B primary user.

Shared Cart A message explaining how to 
access shared shopping carts 

Shared cart owner and 
sharees

A user submits a request 
to share a cart.

Order Confirmation - 
Normal

An order confirmation message User A user places an order in 
a specialty store.

Order Confirmation - 
Next steps for faxed 
orders

A message explaining the 
remaining steps for order 
submission

User A user places an order 
and chooses to fax a 
credit card or purchase 
order as payment.

Orders Not Booked 
Notification

A message announcing that an 
order has not been booked

The order 
administrator 
specified in the profile 
option IBE: Default 
Order Admin to Send 
Workflow Notification

A user’s order is not 
booked.

Sales Assistance Request - 
To Users

A message acknowledging a 
request for sales assistance

User A user requests sales 
assistance.

Sales Assistance Request - 
To Sales Representatives

A message describing a request 
for sales assistance

Sales representative 
for the user’s 
operating unit

A user requests sales 
assistance.

Contract Negotiations 
Request - To Users

A message acknowledging a 
request for a change to contract 
terms

User A user requests changes 
in contract terms.

Contract Negotiations 
Request - To Sales 
Representatives

A message describing a request 
for changes to contract terms

Contract sales 
representative for the 
user’s operating unit

A user requests changes 
in contract terms.

Contract Negotiations 
Request - Approval

A message announcing 
approval of a contract terms 
change request

User

Contract sales 
representative for the 
user’s operating unit

A contract administrator 
approves a user’s request 
for changes in contract 
terms.

Contract Negotiations 
Request - Cancellation

A message announcing 
cancellation of contract 
negotiations

User

Contract sales 
representative for the 
user’s operating unit

A contract administrator 
cancels the contract that 
was created when a user 
requested changes in 
contract terms.
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5.9.1 Message Configurations
You can configure notification events by mapping different messages to 
combinations of organization and user type. The following table shows possible 
message configurations for the notification Order Confirmation - Normal.

Users receive the order confirmation message with the configuration that matches 
the users’ data. If no customized configurations match the users’ data, the users 
receive the default message for all organizations and user types.

When Oracle iStore 11i sends a notification, it chooses the message with the 
parameters that match the user’s data most closely. For example, with the message 
configuration listed in Table 5–5, an individual user who places an order against 
Organization A receives Message 4, not Message 1 or Message 3.

If more than one message applies to the user, the user’s organization takes 
precedence over the user type. For example, with the message configuration listed 

Contract Negotiations 
Request - Disapproval

A message announcing rejection 
of a contract terms change 
request

Contract sales 
representative for the 
user’s operating unit

A contract administrator 
rejects a user’s request 
for changes in contract 
terms.

Reports - iStore Historical 
Summary

A message with the information 
from the Store Order Summary 
Data Out Bin

Users specified in the 
Merchant UI under 
Reports > Email 
Preferences

The concurrent programs 
for the Storefront Reports 
refresh the report data.

Reports - iStore Top 
Orders

A message with the information 
from the Store Orders Data Out 
Bin

Users specified in the 
Merchant UI under 
Reports > Email 
Preferences

The concurrent programs 
for the Storefront Reports 
refresh the report data.

Table 5–5 Sample Configurations for the Notification Order Confirmation - Normal 

Organization User Type Message

All All Message 1 (default)

All Business User Message 2

Organization A All Message 3

Organization A Individual User Message 4

Table 5–4 Oracle iStore 11i Notifications (Cont.)

Notification Description Recipients Trigger
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in Table 5–5, a business user who places an order against Organization A receives 
Message 3, not Message 2.

Organization and user type are not relevant to certain notifications. In such cases, 
you cannot map messages for these parameters, and the Oracle iStore 11i pull-down 
menus from which you would normally choose organization or user type display as 
read-only fields instead.

The following table shows a list of notifications and their configurable parameters.

Note: When mapping messages, you must ensure that the 
organization and user type combinations are valid. These 
combinations should correspond to the supported responsibilities 
and other access restrictions that you have set up for your specialty 
stores.

Note: Although a pull-down menu for specialty store exists for 
several notifications, configuring notifications by specialty store is 
currently not supported. You should select ALL from the specialty 
store pull-down menu when configuring notifications.

Table 5–6 Configurable Parameters for Notifications 

Notification Organization User Type

User Registration Yes Yes

Shared Cart Yes Yes

Order Confirmation - Normal Yes Yes

Order Confirmation - Next steps for faxed orders Yes Yes

Orders Not Booked Notification No No

Sales Assistance Request - To Users Yes Yes

Sales Assistance Request - To Sales Representatives Yes No

Contract Negotiations Request - To Users Yes Yes

Contract Negotiations Request - To Sales 
Representatives

Yes No

Contract Negotiations Request - Approval Yes Yes
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5.9.2 Setting Up Notification Recipients
Several Oracle iStore 11i notifications are sent to sales representatives and contract 
sales representatives. You must specify these sales representatives in Oracle Human 
Resources for each of your organizations.

Use the following procedure to set up a sales representative and a contract sales 
representative for an organization.

Login
Log in to Oracle Forms.

Responsibility
Human Resources

Prerequisites
None

Steps
1. Log in to Oracle Forms with the Human Resources responsibility.

2. Choose Work Structures > Organization > Description.

The Find Organization window opens.

Contract Negotiations Request - Cancellation Yes Yes

Contract Negotiations Request - Disapproval Yes No

Reports - iStore Historical Summary No No

Reports - iStore Top Orders No No

Note: Oracle iStore 11i no longer uses the profile option IBE: 
Default Sales Assistant to Send Workflow Notification to specify 
the recipient of sales assistance request notifications. If you 
previously used this profile option, you must now set up the sales 
representative in Oracle Human Resources.

Table 5–6 Configurable Parameters for Notifications (Cont.)

Notification Organization User Type
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3. In the Find Organization window, enter the search criteria for your merchant 
organization and click Find.

The Organization form opens with the organization’s record.

4. In the Organization Classifications region, select Operating Unit in the Name 
fields.

5. Click Others.

The Additional Organization Information window opens.

6. In the Additional Organization Information window, choose Default Notify 
User and click OK.

The Additional Organization Information - Default Notify User window opens.

7. Place your cursor in the Default Notify User field.

The Default Notify User window opens.

8. In the Contracts field of the Default Notify User window, enter the user name of 
the contract sales representative who should receive notifications of contract 
negotiation requests for the organization.

9. In the Sales Assistance field of the Default Notify User window, enter the user 
name of the sales representative who should receive notifications of sales 
assistance requests for the organization. Click OK.

10. In the Additional Organization Information - Default Notify User window, click 
OK.

11. Save the record.

12. For both sales representatives, specify e-mail addresses as follows:

a. In the Navigator, choose People > Enter and Maintain.

The Find Person window opens.

b. In the Find Person window, enter the search criteria for the sales 
representative and click Find.

The People window opens with the sales representative’s employee record.

Note: Use uppercase letters only when entering user names.
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c. In the Office Details tab, enter the sales representative’s e-mail address in 
the Email field. The sales representative will receive notifications at this 
e-mail address.

13. Save the record.

5.9.3 Adding Message Configurations
Use the following procedure to add message configurations for notification events 
according to organization or user type.

Login
Log in to Oracle CRM Applications as a store manager user.

Responsibility
IBE_ADMINISTRATOR

Prerequisites
� Create Oracle Workflow messages for Oracle iStore 11i notifications. See 

Chapter 17, "Integrating Oracle iStore 11i with Oracle Workflow" for details.

� Set the profile option IBE: Use Workflow Features in iStore to Yes. See 
Section A.6, "Oracle iStore 11i (IBE) Profile Options for the Customer UI" for 
more information.

� Set the profile option IBE: Default Order Admin to Send Workflow Notification. 
See Section A.6, "Oracle iStore 11i (IBE) Profile Options for the Customer UI" for 
more information.

� Set up sales representatives and contract sales representatives for notifications 
in Oracle Human Resources. See Section 5.9.2, "Setting Up Notification 
Recipients" for more information.

Steps
1. Launch the Merchant UI.

2. In the Setup tab, click Notifications.

The Notifications page opens.

3. Click the name of a notification event that you want to modify.

The Notification Configuration page opens, displaying the default 
configuration and existing configurations.
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4. In the Notification Configuration page, click Add Configuration.

The Add Configuration page displays pull-down menus for Status and 
Message. The page also displays pull-down menus for Specialty Store, 
Organization, and User Type if you can configure the notification by these 
parameters.

5. Choose Enabled from the Status pull-down menu. 

6. Choose the mapping specifications from the Specialty Store, Organization, and 
User Type pull-down menus.

7. Choose a message from the Message pull-down menu. The Message pull-down 
menu has a list of the messages created in Oracle Workflow for this notification.

8. Click Add.

The Notification Configuration page opens, updated with the new 
configuration.

9. Optional: Click Notifications to return to the Notifications page.

5.9.4 Modifying Message Configurations
Use the following procedure to modify existing message configurations for 
notification events. You can also use this procedure to choose another default 
message.

Login
Log in to Oracle CRM Applications as a store manager user.

Responsibility
IBE_ADMINISTRATOR

Prerequisites
� Create Oracle Workflow messages for Oracle iStore 11i notifications. See 

Chapter 17, "Integrating Oracle iStore 11i with Oracle Workflow" for details.

Note: Configuring notifications by specialty store is currently not 
supported. Select ALL from the Specialty Store pull-down menu.
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� Set the profile option IBE: Use Workflow Features in iStore to Yes. See 
Section A.6, "Oracle iStore 11i (IBE) Profile Options for the Customer UI" for 
more information.

� Set the profile option IBE: Default Order Admin to Send Workflow Notification. 
See Section A.6, "Oracle iStore 11i (IBE) Profile Options for the Customer UI" for 
more information.

� Set up sales representatives and contract sales representatives for notifications 
in Oracle Human Resources. See Section 5.9.2, "Setting Up Notification 
Recipients" for more information.

Steps
1. Launch the Merchant UI.

2. In the Setup tab, click Notifications.

The Notifications page opens.

3. Click the name of a notification event that you want to modify.

The Notification Configuration page opens, displaying the default 
configuration and existing configurations.

4. In the Notification Configuration page, highlight the Select radio button next to 
the configuration that you want to modify, and click Update.

The Update Configuration page displays pull-down menus for Status and 
Message. The page also displays pull-down menus for Specialty Store, 
Organization, and User Type if you can configure the notification by these 
parameters.

5. Choose Enabled from the Status pull-down menu. 

6. Choose the mapping specifications from the Specialty Store, Organization, and 
User Type pull-down menus.

7. Choose a message from the Message pull-down menu. The Message pull-down 
menu has a list of the messages created in Oracle Workflow for this notification.

8. Click Update.

Note: Configuring notifications by specialty store is currently not 
supported. Select ALL from the Specialty Store pull-down menu.
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The Notification Configuration page opens, updated with the modified 
configuration.

9. Optional: Click Notifications to return to the Notifications page.

5.9.5 Removing Message Configurations
Use the following procedure to remove existing message configurations from 
notification events. After you remove a message configuration, the notification uses 
its default message for that organization-user type combination if no other 
configuration applies.

Login
Log in to Oracle CRM Applications as a store manager user.

Responsibility
IBE_ADMINISTRATOR

Prerequisites
None

Steps
1. Launch the Merchant UI.

2. In the Setup tab, click Notifications.

The Notifications page opens.

3. Click the name of a notification event from which you want to remove a 
configuration.

The Notification Configuration page opens, displaying the default 
configuration and existing configurations.

4. Highlight the Select radio button next to the configuration that you want to 
delete, and click Remove.

Note: If you are modifying the default configuration, you can only 
change the status and the message. The default configuration is 
marked with an asterisk (*) in the Specialty Store column. The 
default configuration parameters are each set to ALL.
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The Notification Configuration page updates with your changes.

5.9.6 Disabling Notification Events
Use the following procedure to disable a notification event completely or for 
specific organization-user type combinations. When you disable a notification event 
completely, Oracle iStore 11i does not send any notifications for that event. When 
you disable a notification configuration, Oracle iStore 11i does not send any 
notifications for the case that you have specified.

Login
Log in to Oracle CRM Applications as a store manager user.

Responsibility
IBE_ADMINISTRATOR

Prerequisites
None

Steps
1. Launch the Merchant UI.

2. In the Setup tab, click Notifications.

The Notifications page opens.

3. If you want to disable a notification across all organizations and user types, 
follow these steps:

a. In the Notifications page, check the notification’s Disable checkbox.

b. Click Update to save your changes.

4. If you want to disable a notification for an existing configuration of 
organization and user type, follow these steps:

a. In the Notifications page, click the name of the notification event.

The Notification Configuration page opens.

Note: You cannot remove the default configuration. The default 
configuration is marked with an asterisk (*) in the Specialty Store 
column.
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b. Highlight the configuration’s Select radio button and click Update. 

The Update Configuration page opens.

c. Choose Disabled from the Status pull-down menu. 

d. Click Update to save your changes.

5. If you want to disable a notification for a new configuration of organization and 
user type, follow these steps:

a. In the Notifications page, click the name of the notification event.

The Notification Configuration page opens.

b. Click Add Configuration. 

The Add Configuration page opens.

c. Choose Disabled from the Status pull-down menu. 

d. Choose the configuration specifications from the Specialty Store, 
Organization, and User Type pull-down menus.

e. Click Add to save your changes.

Note: Configuring notifications by specialty store is currently not 
supported. Select ALL from the Specialty Store pull-down menu.
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5.10 Setting Up Storefront Reports
Oracle iStore 11i has pre-defined reports that collect and present valuable business 
data about your customers’ interactions with your stores. These reports include the 
following:

� Top Product Sales Report—This report identifies your best-selling products.

� Customer Sales Report—This report identifies your top customers.

� Top N Orders Report—This report identifies the orders with the largest sales 
totals.

� Historical Summary Report—This report summarizes orders according to 
several different time periods.

All Storefront Reports data is pulled from the time range that you specify when 
preparing the report data, as outlined in Section 5.10.4, "Preparing Data for 
Storefront Reports".

You can view these reports in the Merchant UI Reports tab by using the Data Out 
Bins. You can also set up the Top N Orders Report and Historical Summary Report 
for delivery as e-mail notifications. The following table summarizes the different 
formats available for each report.

Before viewing the reports, you must first prepare the report data in Oracle Forms. 
You also need to configure the Data Out Bins by setting your bin preferences in the 
Oracle iStore 11i Merchant UI.

Table 5–7 Storefront Reports Formats 

Report Name Data Out Bin E-mail Notification

Top Product Sales Report Yes No

Customer Sales Report Yes No

Top N Orders Report Yes Yes

Historical Summary Report Yes Yes
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5.10.1 Understanding Storefront Reports Architecture
The basic architecture for Storefront Reports is shown in the following figure.

Figure 5–5 Storefront Reports Architecture

The iStore Reports Fact Tables Refresh concurrent program pulls data that is within 
a certain user-specified time frame from Oracle Order Capture and Oracle Order 
Management data tables into Oracle iStore 11i fact tables, which act as data 
summaries. This process can be very time consuming, depending on how much 
data the tables hold and the extent of the time frame you specify. 

The reports and queries that comprise Storefront Reports are run against these fact 
tables. The following table describes the fact tables for Storefront Reports.

Table 5–8 Fact Tables for Storefront Reports 

Fact Table Name Description

IBE_ECR_MVLOG This table captures the refresh log history, as well as the 
begin date and end date of the transaction records that are 
refreshed into the base materialized views.
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The iStore Reports Materialized Views Refresh concurrent program refreshes 
materialized views of these fact tables. Refreshing a materialized view is usually a 
fast process.

If the profile option IBE: iStore Materialized Views Usage is set to Yes, then when 
the queries for Storefront Reports are run against the fact tables, the database engine 
(cost-based optimizer) automatically reroutes the queries against the corresponding 
materialized views for enhanced query performance. If the materialized views are 
not available, the queries run against the fact tables. This architecture guarantees 
that data is always available for the Storefront Reports.

The iStore Alert Reports concurrent program triggers delivery of the updated Top N 
Orders Report and Historical Summary Report as e-mail notifications.

5.10.2 Setting Profile Options for Storefront Reports
Set the following mandatory profile options to configure Storefront Reports:

� IBE: Currency Code

� IBE: GL Conversion Type

� IBE: GL Period Set Name

You can also set the following optional profile options for Storefront Reports if you 
do not want to use the default settings:

� IBE: Enable Force Refresh

� IBE: Enable Parallel Data Extraction for Reporting

� IBE: iStore Materialized Views Usage

IBE_ECR_ORDER_HEADERS_
FACT

This table provides header-level information for orders 
from Oracle Order Management tables. The orders are 
placed for sources that are specified in the lookup iStore 
Order Facts Sources (IBE_ECR_ORDER_SOURCE).

IBE_ECR_ORDERS_FACT This table provides information from Oracle Order 
Management tables about the sale and quantity of items in 
orders, including data for Product, Customer, and 
Contracts.

IBE_ECR_QUOTES_FACT This table provides information from Oracle Order 
Capture tables about items in quotes and shopping carts.

Table 5–8 Fact Tables for Storefront Reports (Cont.)

Fact Table Name Description
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� IBE: Quarter Begin Data

� IBE: Truncate Records

� IBE: Use Default Bin Preference

� IBE: YTD Data Availability in Bins

See Section A.5.2, "IBE Profile Options for Storefront Reports" for profile option 
descriptions and setup procedures.

5.10.3 Setting Up Conversion Rates for Storefront Reports
Oracle iStore 11i can have business transactions from multiple stores, each of which 
can support multiple currencies. This results in the Storefront Reports functionality 
compiling business reports from transactions in multiple currencies. These 
currencies must be resolved to a single currency for Storefront Reports. The 
Storefront Reports currency is specified at three different stages:

� The currency for the fact tables is determined by the profile options IBE: 
Currency Code and IBE: GL Conversion Type, and the daily currency 
conversion rate in Oracle General Ledger.

� The currency for the Data Out Bin fact tables is determined by the lookup iStore 
Reporting Currencies (IBE_ECR_REPORTING_CURRENCY). See Section 5.10.6, 
"Storefront Reports Lookup Types" for more information.

� The currency for the Data Out Bins is determined by the user in the Bin 
Preferences subtab of the Reports tab in the Merchant UI. See Oracle iStore 
Concepts and Procedures for more information.

Use this procedure to set the daily currency conversion rate in Oracle General 
Ledger. You can set the profile options IBE: Currency Code and IBE: GL Conversion 
Type before or after this procedure, to complete currency setup for the Storefront 
Reports fact tables.

Login
Log in to Oracle Forms.

Responsibility
General Ledger Super User

Prerequisites
None
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Steps
1. Log in to Oracle Forms with the General Ledger Super User responsibility.

2. Choose Setup > Currencies > Rates > Daily. 

The Daily Rates window opens.

3. Review or enter your desired currency conversions, using the following 
guidelines:

� There should be a line for every currency conversion that you need, for 
every date for which the Storefront Reports will request data.

� The From fields should have the currencies in which your stores provide 
transactions.

� The To fields should contain the value for the currency that you want the 
fact tables to use. This value is the same as the setting of the profile option 
IBE: Currency Code.

� The values in the Conversion Type fields should equal the value of the 
profile option IBE: GL Conversion Type.

You can enter the currency conversions one line at a time, or click Enter by Date 
Range . . . to enter the currency conversions for a date range at one time.

4. Save your changes.

5.10.4 Preparing Data for Storefront Reports
You must populate the Storefront Reports’ fact tables and materialized views with 
data for the entire time range in which you are interested before you can view the 
Storefront Reports in the Merchant UI.

When you update the data later, you can choose either to refresh the fact tables and 
materialized views for the entire new time range, or to add only the data for the 
time since the last data refresh. 

Use the iStore Reports Complete Data Refresh Set concurrent programs to refresh 
data for the entire time range. This Refresh Set provides completely updated, 
accurate data. For this reason, it is recommended that you run this Refresh Set 
instead of the iStore Reports Increment Data Refresh Set if possible.

Use the iStore Reports Increment Data Refresh Set concurrent programs to add only 
data for the time period between the last data refresh and your new desired end 
date. This Refresh Set is faster than the iStore Reports Complete Data Refresh Set, 
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but may not be accurate if the unrefreshed data has changed since it was last 
captured.

Each Refresh Set has three concurrent programs:

� iStore Reports Fact Tables Refresh

� iStore Reports Materialized Views Refresh

� iStore Alert Reports

Section 5.10.1, "Understanding Storefront Reports Architecture" describes the 
functions of these concurrent programs.

iStore Reports Complete Data Refresh Set
The iStore Reports Complete Data Refresh Set is the recommended data preparation 
procedure.

When you run the concurrent programs in the iStore Reports Complete Data 
Refresh Set, you can specify a begin date for the data. This begin date is also 
controlled by the profile options IBE: Quarter Begin Data and IBE: YTD Data 
Availability in Bins. The following table summarizes the concurrent programs’ 
begin date selection logic for different profile option settings and user date entries.

Note: It is recommended that you schedule these concurrent 
program sets to run at regularly scheduled intervals. Otherwise, 
you will need to rerun at least one of these concurrent program sets 
every time you want to refresh the Storefront Reports data.

Note: Make sure that the conversion rate from all transactional 
currencies to the reporting currency is defined for the time period 
of data that you will refresh. See Section 5.10.3, "Setting Up 
Conversion Rates for Storefront Reports" for details.
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Use this procedure to prepare Storefront Reports data with the iStore Reports 
Complete Data Refresh Set.

Login
Log in to Oracle Forms as the concurrent program manager.

Responsibility
iStore Concurrent Programs Responsibility

Prerequisites
� Set up conversion rates in Oracle General Ledger, as described in Section 5.10.3, 

"Setting Up Conversion Rates for Storefront Reports".

� Set the profile options IBE: Currency Code, IBE: GL Conversion Type, IBE: GL 
Period Set Name, IBE: Enable Force Refresh, IBE: Enable Parallel Data 
Extraction for Reporting, IBE: Quarter Begin Data, IBE: Truncate Records, and 
IBE: YTD Data Availability in Bins. See Section A.5.2, "IBE Profile Options for 
Storefront Reports" for details.

Table 5–9 iStore Reports Complete Data Refresh Set Begin Date Selection 

IBE: YTD Data 
Availability in Bins

IBE: Quarter Begin 
Data Begin Date Selection

Yes N/A The concurrent programs choose the earlier of 
the user-entered date and the first day of the 
current Oracle General Ledger year. If the user 
does not enter a begin date, the concurrent 
programs default to the first day of the current 
year.

No Yes The concurrent programs choose the earlier of 
the user-entered date and the first day of the 
current Oracle General Ledger quarter. If the 
user does not enter a begin date, the concurrent 
programs default to the first day of the current 
quarter.

No No The concurrent programs choose the earlier of 
the user-entered date and the system date. If 
the user does not enter a begin date, the 
concurrent programs default to the system 
date.
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Steps
1. Log in to Oracle Forms with the iStore Concurrent Programs Responsibility.

The Submit a New Request window opens.

2. Choose Request Set and click OK.

The Submit Request Set window opens.

3. Choose the request set iStore Reports Complete Data Refresh Set from the 
Request Set LOV.

The Submit Request Set window is populated with the concurrent programs 
that are in iStore Reports Complete Data Refresh Set.

4. Place your cursor in the Parameters field for iStore Reports Fact Tables Refresh.

The Parameters window opens.

5. Set the parameters as follows:

a. Refresh Mode: Complete

b. Begin Date: The start date for the time period for which data should be 
pulled from the Oracle Order Capture and Oracle Order Management 
tables.

c. End Date: The ending date for the time period for which data should be 
pulled from the Oracle Order Capture and Oracle Order Management 
tables. If you leave this blank, it defaults to the current system date.

Click OK.

The Parameters field for iStore Reports Fact Tables Refresh is populated with 
the parameters.

6. Place your cursor in the Parameters field for iStore Reports Materialized Views 
Refresh.

The Parameters window opens.

7. Verify that the Fact Refresh Mode parameter is set to Complete, and click OK.

The Parameters field for iStore Reports Materialized Views Refresh is populated 
with the parameter.

8. Place your cursor in the Parameters field for iStore Alert Reports.

The Parameters window opens.
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9. Set the Enabled parameter to Yes if you want to send the Top N Orders Report 
and Historical Summary Report as e-mail notifications, or No if you do not 
want to trigger the notifications. Click OK. 

The Parameters field for iStore Alert Reports is populated with the parameter.

10. Optional: Click Schedule . . . to change the time when the reports will run.

11. Click Submit to submit the concurrent program requests.

12. Choose View > Requests to see the status of your requests.

When the concurrent programs are finished, the data for the Storefront Reports is 
available for report queries from the Oracle iStore 11i Merchant UI.

iStore Reports Increment Data Refresh Set
The iStore Reports Increment Data Refresh Set chooses the begin date of the data 
refresh according to the conditions listed in the following table.

Use this procedure to prepare Storefront Reports data with the iStore Reports 
Increment Data Refresh Set. 

Note: See Oracle iStore Concepts and Procedures for information on 
specifying notification recipients and message format.

Table 5–10 iStore Reports Increment Data Refresh Set Begin Date Selection 

Condition Begin Date Selection

The previous increment data refresh was 
successful for the fact tables.

End date of the previous increment data 
refresh

The previous increment data refresh was not 
successful for the fact tables.

Begin date of the previous increment data 
refresh

You are running the iStore Reports Increment 
Data Refresh Set for the first time.

End date of the most recent successful 
complete data refresh

Note: It is recommended that you run the iStore Reports 
Complete Data Refresh Set instead, since it provides completely 
updated, accurate data that reflects all changes since the last data 
refresh.
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Login
Log in to Oracle Forms as the concurrent program manager.

Responsibility
iStore Concurrent Programs Responsibility

Prerequisites
You have run the iStore Reports Complete Data Refresh Set at least once.

Steps
1. Log in to Oracle Forms with the iStore Concurrent Programs Responsibility.

The Submit a New Request window opens.

2. Choose Request Set and click OK.

The Submit Request Set window opens.

3. Choose the request set iStore Reports Increment Data Refresh Set from the 
Request Set LOV.

The Submit Request Set window is populated with the concurrent programs 
that are in iStore Reports Increment Data Refresh Set.

4. Place your cursor in the Parameters field for iStore Reports Fact Tables Refresh.

The Parameters window opens.

5. Set the parameters as follows:

a. Refresh Mode: Increment

b. End Date: The ending date for the time period for which data should be 
pulled from the Oracle Order Capture and Oracle Order Management 
tables. If you leave this blank, it defaults to the current system date.

Click OK.

The Parameters field for iStore Reports Fact Tables Refresh is populated with 
the parameters.

6. Place your cursor in the Parameters field for iStore Reports Materialized Views 
Refresh.

The Parameters window opens.

7. Verify that the Fact Refresh Mode parameter is set to Increment, and click OK.
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The Parameters field for iStore Reports Materialized Views Refresh is populated 
with the parameter.

8. Place your cursor in the Parameters field for iStore Alert Reports.

The Parameters window opens.

9. Set the Enabled parameter to Yes if you want to send the Top N Orders Report 
and Historical Summary Report as e-mail notifications, or No if you do not 
want to trigger the notifications. Click OK. 

The Parameters field for iStore Alert Reports is populated with the parameter.

10. Optional: Click Schedule . . . to change the time when the reports will run.

11. Click Submit to submit the concurrent program requests.

12. Choose View > Requests to see the status of your requests.

When the concurrent programs are finished, the data for the Storefront Reports is 
available for report queries from the Oracle iStore 11i Merchant UI.

5.10.5 Customizing Data Out Bin Drilldown Pages
You can select a time period in the Store Order Summary Data Out Bin to view the 
Store Product Sales, Store Customer Sales, and Store Orders bins for that time 
period. You can also select a customer name in the Store Customer Sales Data Out 
Bin to view that customer’s history in Order Tracker. Additionally, you can select an 
order number in the Store Orders Data Out Bin to view more details about that 
order in Order Tracker. These drilldown options are available as links in the Data 
Out Bins.

The drilldown links are implemented as logical templates. The following table 
summarizes the logical drilldown templates for the Data Out Bins.

Note: See Oracle iStore Concepts and Procedures for information on 
specifying notification recipients and message format.

Table 5–11 Data Out Bin Drilldown Templates 

Data Out Bin Logical Drilldown Template

Store Order Summary BIN_SUMMARY_DRILLDOWN

Store Customer Sales BIN_TOP_CUSTOMER_DRILLDOWN
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You can use a customized JSP for the drilldown links by mapping the desired JSP to 
the logical drilldown template for the appropriate Data Out Bin. Then the drilldown 
link from the Data Out Bin will point to the customized JSP. See Section 6.3, 
"Customizing Templates" for information on mapping templates in the Templates 
tab of the Merchant UI.

The Template Manager gets the minisite from the cookie. If you want to provide a 
customized JSP for a specific minisite, you must set the cookie "zm" to the minisite_
id for the bin drilldown to use.

The JSP for the links takes the following parameters:

� ecr (Value = YES. Required.)

� qsd (Start book date. Required.)

� qed (End book date. Required.)

� acctnum (The customer account identifier. This parameter is supplied only for 
drilldown from the Store Customer Sales bin.)

� esid (The order source ID)

� qa (Query actions. The default value is "details". This parameter is supplied 
only for the Store Orders bin.)

� qid (The order header ID from the Store Orders bin. Optional.)

5.10.6 Storefront Reports Lookup Types
The Storefront Reports lookup types are iStore Order Facts Sources (IBE_ECR_
ORDER_SOURCE) and iStore Reporting Currencies (IBE_ECR_REPORTING_
CURRENCY).

The lookup iStore Order Facts Sources contains all reportable order sources. The 
lookup iStore Reporting Currencies contains the currency codes that are available 
for the Data Out Bins.

Use the following procedure to add lookup codes to these lookup types, using the 
AOL Lookups Form.

Store Orders BIN_TOP_ORDER_DRILLDOWN

Table 5–11 Data Out Bin Drilldown Templates (Cont.)

Data Out Bin Logical Drilldown Template
Required Implementation Tasks 5-75



Setting Up Oracle iStore 11i Customer User Registration
Steps
1. Log in to Oracle Forms with the Application Developer responsibility.

2. Choose Application > Lookups > Application Object Library.

The Application Object Library Lookups window opens.

3. Choose View > Find.

The Lookup Types search window opens.

4. Select the lookup type that you want to modify, and click OK.

The Application Object Library Lookups window is populated with the lookup 
codes for the lookup type.

5. In each row of the Application Object Library Lookups window, you can add a 
lookup code to the lookup type as follows:

a. In the Code field, enter the lookup code.

b. In the Meaning field, enter a meaning for the lookup code.

c. Optional: In the From and To fields, select the effective dates for the lookup 
code.

d. Check the Enabled checkbox.

6. Save the form.

5.11 Setting Up Oracle iStore 11i Customer User Registration
There are three basic Oracle iStore 11i customer user types:

� Guest users

� Registered B2C users

� Registered B2B users

Guest users (also called walk-in or unregistered users) can browse Web store 
catalogs and create shopping carts. However, they cannot set up a user profile, save 
a shopping cart, create a shopping list, submit an order, or access other Web store 
functionality until they register. See Section 5.3, "Setting Up the Guest User 
Account" for details about how Oracle iStore 11i treats a guest user, and instructions 
for defining the guest user account.
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Registered B2C users are individual customers. When they register in a Web store, 
they are immediately approved and can place orders in the Web store on their own 
behalf.

Registered B2B users represent customer organizations. When they register in a Web 
store, they must be approved by you or another merchant representative before 
they can act as registered users in the Web store. You can give them different levels 
of permission, including a permission to create B2B users for their organizations 
who do not need merchant approval. See Section 5.11.4, "Understanding B2B User 
Roles" and Section 6.9, "Creating B2B User Roles" for more information.

You can allow either B2B user registration or B2C user registration, or both, in your 
stores. You can also set default B2B user roles and default B2B and B2C user 
responsibilities.

5.11.1 Setting Up Customer Registration
By default, both B2B and B2C user registration are enabled in Oracle iStore 11i. If 
necessary, you can disable a registration type as follows:

� B2B user registration—Set the profile option IBE: Use B2B Features to No.

� B2C user registration—Set the profile option IBE: Use Business to Customer 
Features to No.

Oracle iStore 11i is seeded with Oracle Application Object Library messages for both 
B2B user registration and B2C user registration. These messages display in the Sign 
In page to label the links to the B2B and B2C registration pages, if the corresponding 
registration types are enabled. Oracle iStore 11i is also seeded with a message to 
display in the Sign In page for returning users. You can change the text of the 
seeded messages.

The following table summarizes the seeded Sign In page messages. The PL/SQL 
APIs in the FND_MESSAGE package are used to retrieve and set up these messages 
for display.

Table 5–12 Oracle iStore 11i Sign In Page Messages 

Message Function Message Name Seeded Text

Label for B2B 
registration link

IBE_PRMT_BIZ_REG_MSG If you are representing your 
business or organization, 
click above to register.
Required Implementation Tasks 5-77



Setting Up Oracle iStore 11i Customer User Registration
The following figure displays the Sign In page with the default seeded messages.

Figure 5–6 The Sign In Page

Use the following procedure to access the messages.

Login
Log in to Oracle Forms.

Label for B2C 
registration link

IBE_PRMT_IND_REG_MSG If you are an individual or 
consumer, click above to 
register.

Message for returning 
users

IBE_PRMT_LOGIN_CUSTOM_MSG If you had an account with 
our store before July 3, 2001, 
you will need to re-register. 
We apologize for any 
inconvenience.

Table 5–12 Oracle iStore 11i Sign In Page Messages (Cont.)

Message Function Message Name Seeded Text
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Responsibility
Application Developer

Prerequisites
None

Steps
1. Log in to Oracle Forms with the Application Developer responsibility.

2. Choose Application > Messages.

The Messages window opens.

3. Choose View > Find.

The Messages search window opens.

4. In the Find field, enter IBE_PRMT%MSG and click Find. 

Your search results display in the Messages search window.

5. Select the message that you want to view and click OK.

The Messages window is populated with the selected message.

5.11.2 Setting Default Customer Responsibilities
You must specify the Oracle iStore 11i responsibility assigned by default to a new 
customer upon registration in a Web store. You should set a default responsibility 
for both new B2B and B2C customers. The default B2B customer responsibility is the 
Oracle CRM Technology Foundation default responsibility for business users. The 
default B2C customer responsibility is the Oracle CRM Technology Foundation 
default responsibility for end users. See Oracle CRM Technology Foundation Concepts 
and Procedures for instructions on setting Oracle CRM Technology Foundation 
default responsibilities.

When you set the default responsibilities, the default application ID for both user 
types must be 671, for Oracle iStore 11i. The responsibility ID can be IBE_
CUSTOMER or another Oracle iStore 11i customer responsibility that you create. 
See Oracle Applications System Administrator’s Guide for information on creating 
additional responsibilities.
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5.11.3 Roles and Permissions for Oracle iStore 11i Users
Oracle iStore 11i is seeded with various roles that you can assign to different types 
of users. Each of these roles has a different combination of permissions, which are 
also seeded in Oracle iStore 11i. The names of the Oracle iStore 11i roles and 
permissions begin with "IBE."

You cannot use roles and permissions for B2C customers.

The following table summarizes the Oracle iStore 11i permissions.

Table 5–13 Oracle iStore 11i Permissions 

Name Description

IBE_ALLOW_PRICE_OVERRIDE Allows the user to override prices manually

IBE_ASSIGN_SALES_CREDITS Allows a user to assign sales credits

IBE_BILLTO_ANY_ACCOUNT Allows a user to search on and retrieve all 
existing customers rather than only those with 
an existing billing relationship with the sold-to 
customer

IBE_CHANGE_BILLTO_CONTACT Allows a user to change the bill-to contact from 
the default (if any) bill-to contact

IBE_CHANGE_BILLTO_CUSTOMER Allows a user to change the bill-to customer 
from the default bill-to customer

IBE_CHANGE_SHIPTO_CONTACT Allows a user to change the ship-to contact from 
the default (if any) ship-to contact

IBE_CHANGE_SHIPTO_CUSTOMER Allows a user to change the ship-to customer 
from the default ship-to customer

IBE_CREATE_ADDRESS Reserved for future use.

IBE_CREATE_BILLTO_CONTACT Allows the user to create a new contact for the 
bill-to customer who will have a bill-to 
relationship with the bill-to customer

IBE_CREATE_BILLTO_CONTACT_
ADDRESS

Allows the user to create a new address 
associated with the bill-to contact which will 
have a bill-to relationship with the bill-to contact

IBE_CREATE_BILLTO_CUSTOMER Allows a user to create a new customer with a 
billing relationship to the sold-to customer

IBE_CREATE_BILLTO_CUSTOMER_
ADDRESS

Allows the user to create a new address 
associated with the bill-to customer which will 
have a bill-to relationship with the bill-to 
customer
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IBE_CREATE_ORDER Allows a user to submit a quote or cart as an 
order

IBE_CREATE_PAYMENT_INSTRUMENT Reserved for future use.

IBE_CREATE_SHIPTO_CONTACT Allows the user to create a new contact for the 
ship-to customer who will have a ship-to 
relationship with the ship-to customer

IBE_CREATE_SHIPTO_CONTACT_
ADDRESS

Allows the user to create a new address 
associated with the ship-to contact which will 
have a ship-to relationship with the ship-to 
contact

IBE_CREATE_SHIPTO_CUSTOMER Allows a user to create a new customer with a 
shipping relationship to the sold-to customer

IBE_CREATE_SHIPTO_CUSTOMER_
ADDRESS

Allows the user to create a new address 
associated with the ship-to customer which will 
have a ship-to relationship with the ship-to 
customer

IBE_CREATE_SOLDTO_CUSTOMER Allows a user to create a new customer in the 
context of assigning a sold-to customer during 
quote creation

IBE_MODIFY_CART Reserved for future use.

IBE_MODIFY_ORDER Reserved for future use.

IBE_SHIPTO_ANY_ACCOUNT Allows a user to search on and retrieve all 
existing customers rather than only those with 
an existing shipping relationship with the 
sold-to customer

IBE_USER_ADMIN Allows a user to create additional users for his 
or her organization

IBE_USE_ATTACHMENT Allows the user to use attachments

IBE_USE_PRICING_AGREEMENT Allows the user to use pricing agreements

IBE_VIEW_ADDRESS Reserved for future use.

IBE_VIEW_CUST_WITHOUT_
ACCOUNT

Allows a user to search on and retrieve existing 
customers without an account

Table 5–13 Oracle iStore 11i Permissions (Cont.)

Name Description
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The following table lists the seeded Oracle iStore 11i user roles and shows the 
permissions that are assigned by default to each role. 

IBE_VIEW_INVOICE Allows a user to view invoices related to the 
entire organization, through My Orders. Oracle 
iStore 11i checks this permission only if the 
profile option IBE: Use Auth Permissions in 
Order Tracker is set to Yes.

IBE_VIEW_ORDER Allows a user to view orders placed on behalf of 
the entire organization, through My Orders. 
Oracle iStore 11i checks this permission only if 
the profile option IBE: Use Auth Permissions in 
Order Tracker is set to Yes.

IBE_VIEW_PAYMENT Allows a user to view payments related to the 
entire organization, through My Orders. Oracle 
iStore 11i checks this permission only if the 
profile option IBE: Use Auth Permissions in 
Order Tracker is set to Yes.

IBE_VIEW_PAYMENT_INSTRUMENT Reserved for future use.

Table 5–13 Oracle iStore 11i Permissions (Cont.)

Name Description
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Table 5–14 Oracle iStore 11i User Roles 

Name Description Default Permissions

IBE_BUSINESS_USER_ROLE Business User Role IBE_CREATE_ADDRESS

IBE_CREATE_BILLTO_CONTACT_
ADDRESS

IBE_CREATE_ORDER

IBE_CREATE_PAYMENT_
INSTRUMENT

IBE_CREATE_SHIPTO_CONTACT_
ADDRESS

IBE_MODIFY_CART

IBE_MODIFY_ORDER

IBE_VIEW_ADDRESS

IBE_VIEW_INVOICE

IBE_VIEW_ORDER

IBE_VIEW_PAYMENT

IBE_VIEW_PAYMENT_INSTRUMENT

IBE_PRIMARY_USER_ROLE Primary User Role IBE_CREATE_ADDRESS

IBE_CREATE_BILLTO_CONTACT_
ADDRESS

IBE_CREATE_ORDER

IBE_CREATE_PAYMENT_
INSTRUMENT

IBE_CREATE_SHIPTO_CONTACT_
ADDRESS

IBE_MODIFY_CART

IBE_MODIFY_ORDER

IBE_USER_ADMIN

IBE_VIEW_ADDRESS

IBE_VIEW_INVOICE

IBE_VIEW_ORDER

IBE_VIEW_PAYMENT

IBE_VIEW_PAYMENT_INSTRUMENT
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IBE_BUSINESS_USER_ROLE and IBE_PRIMARY_USER_ROLE are appropriate for 
assignment to B2B customer users. 

IBE_RESELLER_ROLE Reseller Role IBE_CHANGE_SHIPTO_CONTACT

IBE_CHANGE_SHIPTO_CUSTOMER

IBE_CREATE_ADDRESS

IBE_CREATE_BILLTO_CONTACT_
ADDRESS

IBE_CREATE_ORDER

IBE_CREATE_PAYMENT_
INSTRUMENT

IBE_CREATE_SHIPTO_CONTACT

IBE_CREATE_SHIPTO_CONTACT_
ADDRESS

IBE_CREATE_SHIPTO_CUSTOMER

IBE_CREATE_SHIPTO_CUSTOMER_
ADDRESS

IBE_MODIFY_CART

IBE_MODIFY_ORDER

IBE_SHIPTO_ANY_ACCOUNT

IBE_USE_ATTACHMENT

IBE_USE_PRICING_AGREEMENT

IBE_VIEW_ADDRESS

IBE_VIEW_INVOICE

IBE_VIEW_ORDER

IBE_VIEW_PAYMENT

IBE_VIEW_PAYMENT_INSTRUMENT

Note: The B2B role for previous releases, IBE_DEFAULT_ROLE, is 
also seeded in Oracle iStore 11i with identical permissions to IBE_
BUSINESS_USER_ROLE, for backward compatibility.

Table 5–14 Oracle iStore 11i User Roles (Cont.)

Name Description Default Permissions
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IBE_RESELLER_ROLE has quote creation permissions, but does not allow the quote 
creator to view all customer accounts in your records, bill to anyone other than the 
sold-to customer, or sell to customers who are not in your records. It is appropriate 
for assignment to resellers and others who sell your products but are not internal to 
your organization.

See Oracle HTML Quoting Implementation Guide for more information about the 
Oracle HTML Quoting role IBE_SALESREP_ROLE, which also uses Oracle iStore 
11i permissions.

5.11.4 Understanding B2B User Roles
Registered B2B users represent customer organizations. When they register in a Web 
store, they must be approved by you or another merchant representative before 
they can act as registered users in the store. You can also activate automatic 
approval of B2B users by setting the profile option IBE: Use Business User Auto 
Approval to Yes.

When you approve B2B users, you can assign them specific B2B roles that 
determine the permissions they have in the stores. You can use the seeded Oracle 
iStore 11i roles or create new B2B roles with various combinations of the Oracle 
iStore 11i permissions.

If you do not specify a role for an approved B2B user, he or she receives the default 
B2B user roles. See Section 5.11.5, "Setting Default Customer Roles for B2B Users" 
for instructions on setting the default B2B user roles.

Seeded B2B Role Values
� IBE_BUSINESS_USER_ROLE

� IBE_PRIMARY_USER_ROLE

The IBE_PRIMARY_USER_ROLE has permissions identical to those of IBE_
BUSINESS_USER_ROLE, with the addition of the IBE_USER_ADMIN permission. 
See Section 5.11.3, "Roles and Permissions for Oracle iStore 11i Users" for a list of 
these permissions.

If you give a B2B user a role with the IBE_USER_ADMIN permission, the B2B user 
can create more users for his or her organization in the Web store without the 
merchant’s approval. This B2B user can also define new B2B user roles with unique 
sets of permissions. When B2B administrative users create other B2B users for their 
organizations, they must assign roles to the new users. The B2B users created by 
B2B administrative users do not automatically receive the default B2B user role.
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When a B2B user logs in, links to the User Management and Role Management 
pages are available in the Profile page.

Figure 5–7 The B2B User’s Profile Page

The User Management page allows B2B administrative users to create B2B users for 
their organizations who do not need approval from the merchant, and to specify 
roles for these users.
5-86 Oracle iStore Implementation Guide



Setting Up Oracle iStore 11i Customer User Registration
Figure 5–8 The B2B Administrative User’s User Management Page

The Role Management page allows B2B administrative users to view available roles 
and define new roles. However, they cannot modify or delete any roles, even the 
ones that they created.

Note: A B2B administrative user can view all B2B users for his or 
her organization, even if he or she did not create them. However, 
the B2B administrative user sees role assignments only for the roles 
that he or she has. If a B2B administrative user views B2B users in 
the User Management page who have roles that he or she does not 
have, these role assignments will not appear in the B2B users’ role 
details. Instead, IBE_DEFAULT_ROLE is checked as the role 
assignment.
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Figure 5–9 The B2B Administrative User’s Role Management Page

5.11.5 Setting Default Customer Roles for B2B Users
You must specify the role assigned by default to new B2B customers. This role is the 
Oracle CRM Technology Foundation default role for business users. See Oracle CRM 
Technology Foundation Concepts and Procedures for instructions on setting this Oracle 
CRM Technology Foundation default role. You cannot set up a default role for new 
Oracle iStore 11i B2C customers.

You can select either of the seeded B2B user roles, IBE_BUSINESS_USER_ROLE or 
IBE_PRIMARY_USER_ROLE, as the default role. You can also select a B2B user role 
that you create yourself, as described in Section 6.9, "Creating B2B User Roles".

Note: In the Role Management page, the B2B administrative users 
can see the Oracle iStore 11i seeded B2B roles that are assigned to 
them. Although there are Remove checkboxes for these seeded 
roles, the B2B administrative users should not delete these roles. 
Deleting the roles in the Role Management page will also delete 
them from all other Oracle iStore 11i B2B users’ accounts.
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When B2B administrative users create other B2B users for their organizations, they 
must assign a role to them in the User Management page within their Profiles. The 
B2B users created by B2B administrative users do not automatically receive the 
Oracle CRM Technology Foundation default role for business users.

5.12 Setting Profile Options for the Customer UI
You must set Oracle iStore (IBE), Oracle Order Capture (ASO), Oracle Order 
Management (OM), and Multiple Organization (MO) profile options to define how 
the Oracle iStore 11i Customer UI will work. You must also activate debug logging 
through Oracle CRM Technology Foundation.

See Appendix A, "Profile Options" for profile option descriptions and setup 
procedures. Appendix A, "Profile Options" also lists required and recommended 
values for some profile options.

5.12.1 Setting Oracle iStore 11i (IBE) Profile Options for the Customer UI
Set the following mandatory IBE profile options to configure the Customer UI:

� IBE: Pricing Event—Before Shopping Cart

� IBE: Pricing Event for Shopping Cart

� IBE: Request Type to get a Price

You can also set the optional IBE profile options for the Customer UI if you do not 
want to use the default settings. See Section A.6, "Oracle iStore 11i (IBE) Profile 
Options for the Customer UI" for IBE profile option names and descriptions. The 
IBE profile options impact the following aspects of the Customer UI:

� Catalog—Sections

� Catalog—Items

� Catalog—Search

� Shopping Cart

� Express Checkout

� Postsales

� Notifications

� Caching

� Functionality
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5.12.2 Setting Oracle Order Capture (ASO) Profile Options
Set the following ASO profile options to configure the Customer UI:

� ASO: Credit Card Authorization

� ASO: Default Order State

� ASO: Default Order Type

� ASO: Default Salesrep

� ASO: Enable Use Contracts

� ASO: OM Defaulting

� ASO: Product Organization

� ASO: Quote Conversion Type

� ASO: Reservation Level

� ASO: Validate Salesrep

See Section A.8, "Oracle Order Capture (ASO) Profile Options" for more 
information.

5.12.3 Setting Oracle Order Management (OM) Profile Options
If you have set the IBE: Debug profile option to Yes for a user, verify or set the 
profile option OM: Debug Log Directory at site level to a directory that is writable 
by the database server. Oracle iStore 11i Customer UI user-specific logs for the 
PL/SQL layer are written in this directory. 

See Section 8.1, "Setting Up User-Level Logging" and Section A.9, "Oracle Order 
Management (OM) Profile Options" for more information.
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5.12.4 Setting Multiple Organization (MO) Profile Options
Set the MO: Operating Unit profile option to the operating unit at the IBE_
CUSTOMER responsibility level.

See Section A.10, "Multiple Organization (MO) Profile Options" for more 
information.

Setting MO Profile Options for Multiple Operating Units
For a multiple operating unit environment, you must create a separate IBE customer 
responsibility for each operating unit in Oracle Forms. You can use the seeded 
responsibility IBE_CUSTOMER as one of these responsibilities. Each customer 
name is assigned at least one such responsibility when the name is approved.

For each of the customer responsibilities, set the profile option MO: Operating Unit 
to its respective operating unit. 

When a customer enters a Web store, Oracle iStore 11i notes the customer’s 
responsibility and the operating unit to which it is assigned, then restricts the 
customer to the items in the Inventory Organization that is associated with the 
operating unit. Oracle iStore 11i accomplishes this by retrieving the Inventory 
Organization ID for the current user responsibility’s operating unit from the OE_
SYSTEM_PARAMETERS_ALL table. Use Oracle Order Management to associate 
Inventory Organization IDs with operating units.

5.12.5 Setting Site-Level Profile Options
Set the Sequential Numbering profile option at site level to configure the Customer 
UI.

See Section A.14, "Site-Level Profile Options" for more information.
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6

Optional Implementation Tasks

This chapter describes optional implementation tasks for Oracle iStore 11i. You can 
use the procedures in this chapter to customize the appearance and functionality of 
Oracle iStore 11i specialty stores. Topics include:

� Customizing Multimedia

� Defining Multimedia Components

� Customizing Templates

� Defining Display Styles

� Creating Product Relationships

� Customizing Product Presentation at the Category Level

� Customizing Product Presentation at the Item Level

� Customizing the Shopping Cart

� Creating B2B User Roles

� Managing the Cache

Note: When using the Oracle iStore 11i Merchant UI, ensure that 
cookies are enabled. See the relevant browser documentation for 
information on enabling cookies.
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6.1 Customizing Multimedia
Multimedia consist of files such as graphics, text, audio, and video, that are used to 
present content on a Web page to your customer.

The Oracle iStore 11i multimedia catalog enables you to make customized 
multimedia available for use in your stores and organize the multimedia according 
to specialty stores and languages.

To customize the appearance of your store pages, you must perform these tasks:

� Create proprietary media source files.

� Choose Oracle iStore 11i multimedia names.

� Catalog Oracle iStore 11i multimedia and assign multimedia source files to each 
multimedia object.

6.1.1 Creating Media Source Files
Creating your own media source files for use in your store pages can enhance the 
appearance of your store to serve better the store’s purposes.

Types of media source files can include small or large graphics, such as GIF files, 
descriptive text, audio, and video. You can create these files through media 
authoring programs.

You should place all media source files in the file system’s OA_MEDIA directory if 
the profile option IBE: Use Database for Media Storage is set to No, or upload the 
files to the database from the file system or your local directory if the profile option 
is set to Yes.

If you are using the database for media storage, and the Display Manager calls a 
media source file that exists in your file system but not in the database, then the 
Display Manager can still retrieve the source file from the file system.

You can use the following procedure to migrate all of the media source files in your 
file system to the database. You can run this procedure whenever necessary.

Login
Log in to Oracle CRM Applications as a store manager user.

Responsibility
IBE_ADMINISTRATOR
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Prerequisites
None

Steps
1. Launch the Merchant UI.

2. Navigate to:

http://<host>:<apache port>/OA_HTML/ibemdmgt.jsp

3. The Multimedia Migration page opens, with the View All Media in File System 
subtab listing the Oracle iStore 11i media source files that are in the file system’s 
OA_MEDIA directory.

4. Optional: View a list of the Oracle iStore 11i media source files that are in the 
database by clicking View All Media in Database.

5.  In the View All Media in File System subtab, click Migrate to begin migrating 
all of the media source files in the file system to the database.

The Migration in Process page opens. This page refreshes every two seconds 
with an update of the migration.

6. Optional: You can stop the migration at any time before it completes by clicking 
Stop in the Migration in Process page.

7. When the migration completes, or when you stop it, the Migration Summary 
Page opens.

8. Optional: To restart the migration, click Restart in the Migration Summary 
Page.

Note: You can close your browser after you start the migration.
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6.1.2 Naming Multimedia
Each multimedia object that you list in the Oracle iStore 11i multimedia catalog can 
have a number of media source files assigned to it. Each of these source files can be 
assigned to combinations of specialty stores and languages. Each multimedia object 
is in turn available for assignment to multimedia components, which are called by 
templates to determine which multimedia object appears on a given store page.

The multimedia name is the catalog name that is easy to communicate and use 
when planning your page designs. An example is CompanyLogo. This name can be 
translated for convenience in store administration.

Every multimedia name is given a programmatic access name that is short, unique, 
and not as descriptive. The programmatic access name is used to display that 
multimedia file in your Web page, if you want to refer to it directly in the template. 
An example is clogo. This name is not translated.

The multimedia name and programmatic access name represent several source files. 
You assign each source file to combinations of specialty stores and languages. The 
following table lists examples of file names for the multimedia name 
CompanyLogo.

In this example, if a French customer enters Specialty Store 1, the store displays the 
logo file clog1f.gif. An English customer entering the same specialty store sees 
clog1e.gif instead.

To see the multimedia which have been seeded into Oracle iStore 11i and are 
available for use in your store, enter the Multimedia tab. This page lists the existing 
multimedia and their programmatic access names, keywords, descriptions, and 
default source files for all specialty stores and languages. Click individual 
multimedia names for more detail. Choose View All Mappings from within an 
individual detail page to display each source file name and its relationship to 
specialty stores and languages.

Table 6–1 Sample Media File Names for the Multimedia Name CompanyLogo 

Multimedia Name
Programmatic 
Access Name File Specialty Store Language

CompanyLogo clogo clog1f.gif Specialty Store 1 French

CompanyLogo clogo clog1e.gif Specialty Store 1 English

CompanyLogo clogo clog2f.gif Specialty Store 2 French

CompanyLogo clogo clog2e.gif Specialty Store 2 English
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6.1.3 Cataloging Multimedia
Use this procedure to catalog an Oracle iStore 11i multimedia object and assign 
media source files to the multimedia object name.

Login
Log in to Oracle CRM Applications as a store manager user.

Responsibility
IBE_ADMINISTRATOR

Prerequisites
� Check whether you are storing your media source files in the file system or the 

database. See Section 6.1.1, "Creating Media Source Files" for details.

� The default language is defined.

� At least one specialty store exists.

Steps
1. Launch the Merchant UI.

2. In the Multimedia tab, search for multimedia that are already cataloged and 
available to use in your store.

The Multimedia page lists the multimedia that match your search criteria along 
with their programmatic access names, keywords, descriptions, and the default 
source files to use for all specialty stores and languages.

3. Click Create.

The Multimedia Details page opens.
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Figure 6–1 The Multimedia Details Page

4. In the Name field, define the multimedia name. Choose a name that is 
representative of the multimedia object’s characteristics and purpose.

5. In the Programmatic Access Name field, define the programmatic access name, 
which is the name by which the multimedia object will be accessed from the 
template. Do not duplicate other programmatic access names.

6. In the Displays pull-down menu, specify if this multimedia object will be 
available for product- and category-level (CATEGORY) or section-level 
(SECTION) presentation, or for page features not specifically associated with 
catalog presentation (OTHERS).

7. Optional: In the Keywords field, enter keywords for the multimedia. Entering 
keywords enables a keyword-based search for this multimedia object when 
assigning a multimedia object name to a multimedia component.

8. Optional: In the Description field, enter a description of the multimedia. 
Entering a description enables a description-based search for this multimedia 
object when assigning a multimedia object name to a multimedia component. 

9. Click Update. The Source Files used for Specialty Stores and Languages section 
appears in the Multimedia Details page.
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10. If you are storing your media source files in the file system, then provide a 
source file for the multimedia object using the following steps:

a. In the Add Source File field of the Multimedia Details page, define a media 
source file by entering the location of the file relative to the OA_MEDIA 
directory. For example, enter the GIF file product.gif from the OA_MEDIA 
directory as /OA_MEDIA/product.gif.

b. Click Add. 

The Source File Details section for the media source file appears in the 
Multimedia Details page.

11. If you are storing your media source files in the database and want to search for 
a source file in the database, follow these steps:

a. In the Multimedia Details page, click Search.

A media source file search interface appears in the Multimedia Details 
page.

b. From the Search a multimedia source file pull-down menu, select the 
parameter on which you want to search. In the text field, enter the search 
criteria, using the wildcard character % if necessary.

c. Click Go. The multimedia source file search results appear on the page.

d. Highlight the radio button next to the source file that you want to assign to 
the multimedia object, and click Continue. 

The Source File Details section for the media source file appears in the 
Multimedia Details page.

12. If you are storing your media source files in the database and want to upload a 
source file from your local directory, follow these steps:

a. In the Multimedia Details page, click Upload.

The Upload Source File section appears in the Multimedia Details page.

b. Click Browse to search for a source file in your local directory. When you 
select the file, the Source File Name field is populated with the file name.

c. Optional: In the Keywords field, enter keywords for the media source file. 
Entering keywords enables a keyword-based search for this media source 
file when assigning a source file to a multimedia object.
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d. Optional: In the Description field, enter a description of the media source 
file. Entering a description enables a description-based search for this 
media source file when assigning a source file to a multimedia object.

e. Click Upload to upload the file to the database. 

The Source File Details section for the media source file appears in the 
Multimedia Details page.

13. In the Source File Details section, add each specialty store and language where 
you want the new source file to appear.

14. Optional: Check the checkbox in the Remove column next to any specialty 
store-language mapping that you want to delete.

15. Click Update. The relationships between the multimedia name, source file, 
specialty stores, and languages are saved.

The Multimedia Details page opens, listing the newly assigned source file.

16. In the Multimedia Details page, highlight the radio button in the Show as 
Default column next to the source file name that you want the multimedia 
object to call when there is no specific source file mapping for the user’s 
specialty store and display language. Click Update to save your changes.

17. Optional: In the Multimedia Details page, check the checkbox in the Remove 
column to remove a source file from the multimedia object, and click Update.

18. Optional: Choose View All Mappings in the Multimedia Details page.

The View All Mappings page displays each source file name and its relationship 
to specialty stores and languages. This step is highly recommended.

19. Optional: In the Multimedia Details page or the View All Mappings page, click 
on a source file name to map it to more specialty store-language combinations.

6.2 Defining Multimedia Components
Multimedia components define the types of multimedia objects available for 
display on a Web page, such as an image of a certain size, short text description, or a 
ten-second audio file. They enable assignment of default and specific multimedia 
objects at the product, category, section, and store levels. Multimedia components 
are called by the store Web page templates to determine which multimedia appear 
on a given store page.

When you catalog a multimedia component, you choose a default multimedia 
object that is active at store level. In the Hierarchy tab, there are multimedia 
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component fields where you can choose a multimedia object name to correspond 
with each component for each section.

In the Product and Category tabs, there are also multimedia component fields 
where you can choose a multimedia object name to correspond with each 
component for the product or category. Pages associated with the product or 
category will use this multimedia object instead of the store-level multimedia.

If no multimedia name is associated with a multimedia component for either 
product or category, then the multimedia object chosen for the product or category’s 
parent section in the Hierarchy tab appears on pages associated with the product or 
category that use the multimedia component. If no specific multimedia name has 
been chosen for the section’s multimedia component, then the store-level default 
multimedia object appears.

Seeded Values
� STORE_PRODUCT_LARGE_IMAGE

� STORE_PRODUCT_SMALL_IMAGE

� STORE_SECTION_SMALL_IMAGE

You can view the seeded values in the Multimedia Components tab. This page lists 
existing multimedia components and their programmatic access names, 
descriptions, default multimedia, and default source files.

Use this procedure to catalog multimedia components that you want to assign to 
sections, categories, or products.

Login
Log in to Oracle CRM Applications as a store manager user.

Responsibility
IBE_ADMINISTRATOR

Prerequisites
Define the types of media objects you want to use on your store Web pages.

You can select a default multimedia object name for a multimedia component only 
after you have cataloged multimedia. If the default information is unavailable, you 
can continue the setup and select a default multimedia name at a later time. 
However, if a multimedia association is requested for any product, category, or 
section with that multimedia component, and there is no product-specific, 
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category-specific, or section-specific association for the multimedia component, 
Oracle iStore 11i uses the default multimedia object name defined at the store level.

To avoid the error, you can also use the multimedia component’s seeded values, as 
listed in the Multimedia Components tab.

Steps
1. Launch the Merchant UI.

2. In the Setup tab, choose Multimedia Components.

The Multimedia Components page displays a list of existing multimedia 
components and each component’s default multimedia name. It also lists the 
default media source file for each multimedia name.

3. Click Create.

The Multimedia Component Details page opens.

Figure 6–2 The Multimedia Component Details Page

4. In the Name field, define the multimedia component name. 

5. In the Programmatic Access Name field, define the programmatic access name. 
This name is called by the templates for the store Web pages that use this 
multimedia component.
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6. Optional: In the description field, enter a description of the multimedia 
component. Entering a description enables a description-based search for this 
multimedia component.

7. In the Default Multimedia field, click Go to select a default multimedia name 
for this component. This default multimedia object will appear in pages 
associated with this multimedia component when the pages’ products, 
categories, or sections have no specific multimedia assignments for this 
component.

8. Click Update.

The multimedia component information is saved.

6.3 Customizing Templates
Oracle iStore 11i Web page designs use common components, such as section tabs 
and browse bins. Each component is based on a template, and the templates are 
combined to create a store Web page. The templates control the appearance of the 
store through the use of JavaServer Pages (JSP), which combine Application 
Programming Interfaces (API) to call dynamic data and HTML to present static 
data. 

Oracle iStore 11i comes packaged with a complete set of JSP templates needed to 
run the store. If you want to expand the functionality of the store Web pages or 
customize the pre-packaged templates, then you need to identify the flow of the 
application and the JSP templates needed to implement the flow. See Oracle iStore 
Concepts and Procedures for more information.

To customize templates for your store, perform the following tasks after planning 
your Web page designs:

� Create template source files for pages and for blocks within pages using a Web 
authoring application.

� Choose Oracle iStore 11i template names.

� Catalog Oracle iStore 11i template names and assign template source files to 
each template name.
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6.3.1 Creating Template Source Files
You can create new JSP templates to replace or add to the Oracle iStore 11i seeded 
templates. Different physical JSP templates can be used at run-time based on the 
language and specialty store.

The major skills required to create and modify templates are HTML and JSP. JSP 
embeds Java language methods in the HTML content to generate dynamic content 
on the Web page. The structure of a JSP page is demonstrated in the following 
HTML example.

<HTML>
<% import="oracle.apps.ibe.util.*" %>
....
....
<P> Name : <% = customer.getName(12334) %>  

Where customer is a Java class on the server and getName is a public method 
in the class to retrieve the customer Name.

<P> Picture: <IMGSRC = "<%= customer.getPict(12334) %>">  
This step can retrieve the image file name from the customer Java class on the 
server.

....
</HTML>

The default UNIX directory for JSP source code is $COMMON_TOP/html. All 
ibem*.jsp templates are for the Merchant UI, and all ibeC*.jsp templates are for the 
Customer UI. New templates should also be placed in the $COMMON_TOP/html 
directory. Changes made to the JSPs may not appear immediately on the Web stores, 
since you must reboot the Apache server before changes take effect.

Deleting the server cache has the same effect as rebooting the Apache server. The 
server cache is located in the UNIX directory $COMMON_TOP/html/_pages/oa_
html. This cache directory contains .java and .class files that are generated after the 
JSP that has been called is translated. These can be safely deleted and will be 
regenerated when the JSP is invoked through an HTTP request.

Note: It is recommended that you use Oracle JDeveloper to create 
and modify JSP templates. Although you can create JSPs with any 
HTML or text editor, Oracle JDeveloper also enables you to debug 
the code.
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After creating or modifying templates, you can pre-compile them to check for 
compilation errors and to increase the speed of the initial loading.

JSP Naming Conventions
Modify JSP templates only after renaming them first. All modified JSPs should 
follow a standard naming convention, e.g., name of project-name of jsp.jsp

This will make future Oracle iStore 11i upgrades less problematic.

Cascading Style Sheets (CSS)
Oracle iStore 11i uses the logical template name STORE_STYLE_SHEET in the JSP 
template files to call the Cascading Style Sheet (CSS) that determines fonts, sizes, 
colors, and other elements of look and feel. As with JSP templates, you can map 
different CSS source files to the same logical template name for different specialty 
stores and languages.

Oracle iStore 11i comes with a single CSS called jtfucss.css, and the STORE_STYLE_
SHEET is seeded with this CSS as the default source file for all sites and languages. 
The CSS resides in the $COMMON_TOP/html directory and can be modified using 
an HTML editor. Place any other style sheets that you create in the same directory.

Modifying the Seeded Template Source Files
The Oracle iStore 11i Customer UI page is sectioned into various information 
containers, also referred to as bins or place holders. These bins hold the 
content-specific information and display it logically on the page. You can modify 
the bins’ text and layout to change the Customer UI.

Note: Sometimes it is not immediately obvious that templates 
referred to in the JSP code are in fact JSPs themselves. To find the 
JSP name of a template, search in the Template tab of the Merchant 
UI for the template name referenced in the code. The JSP name is 
included in the template listing. This JSP can then be modified to 
suit the requirements of the project.

Note: Never change an original JSP. To modify a JSP, make a copy 
of the original JSP and modify only the copy. If a bug occurs, 
compare the JSP copy to the JSP original.
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Changing the Text in Bins The text in the bins (for example, Welcome Message 
Bin, Shopping Cart Bin, Section Tree Bin) comes from the Oracle Application Object 
Library Messages that are seeded in the FND_NEW_MESSAGES table. Use the 
following procedure to change the text in the bins:

1. Log in to Oracle Forms with the Application Developer responsibility.

2. Choose Application > Messages.

The Messages window opens.

3. Choose View > Find.

The Messages search window opens.

4. In the Find field, enter IBE% and click Find.

Your search results display in the Messages search window.

5. Select the message that you want to modify and click OK.

The Messages window is populated with the selected message.

6. Modify the message to change the text in the bin where it appears. 

You can find a specific message name by viewing the JSP file that displays it. 

Changing the Layout of Bins You can change the bin placement or remove a bin 
from the Customer UI in the following ways:

� Change the profile options listed in Section A.6.1, "IBE Profile Options for the 
Catalog".

� Associate JSPs with the seeded logical bin templates listed in Table 14–1, 
"Logical Template Names for Bins".

� Modify the home page ibeCZzpHome.jsp and other corresponding JSP files. 

To verify that the home page is ibeCZzpHome.jsp, launch the Merchant UI, enter 
the Templates tab, and search the template catalog for Name = STORE_HOME. The 
default source file listed should be ibeCZzpHome.jsp.

The following diagram shows the layout of the bins on the default store page.

Note: Be careful when making these changes, which affect the 
storefronts. 
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Figure 6–3 Bin Layout on the Default Store Page

API Documentation
To make advanced changes to the Customer UI page displays, beyond bin layout 
and text messages, you must have complete knowledge of the APIs being called 
from the JSP template source file. The APIs are the key for displaying data on the 
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store pages. These are the application objects and beans. Customers and users 
cannot modify these class files.

For public class API documentation, see Oracle iStore API Reference Guide.

6.3.2 Naming Templates
Cataloging templates involves setting up Oracle iStore 11i template objects with 
names and descriptions and specifying the different physical JSP templates to be 
used at run-time based on language and specialty store. These template objects can 
be additions to, or replacements for, the Oracle iStore 11i seeded template objects. 

The template name is the catalog name that is easy to communicate and use when 
planning your page designs. An example is ProductHome. Template names may be 
translated for convenience in store administration.

Every template name also has a programmatic access name that is short, unique, 
and not as descriptive. The programmatic access name is inserted into your Web 
page or template. An example is phome. Programmatic access names are not 
translated.

The template name and programmatic access name represent several physical 
template source files. Each physical file can be assigned to combinations of specialty 
stores and languages. When Oracle iStore 11i retrieves an assigned template name, 
the template source file is determined by the mapping of the template name to the 
current specialty store and language.

The Display Manager is the class that implements Oracle iStore 11i’s Template 
Manager. The Template Manager maintains a mapping from a logical name or 
access name of a media object to a physical name on the file system. For example, 
STORE_HOME (logical) maps to ibeCZzpHome.jsp (physical). When the Web store 
is active, the Display Manager determines what physical file to call from the logical 
template or multimedia component name, based on the specialty store and 
language.

The following table shows examples of file names for ProductHome.

Table 6–2 Sample JSP File Names for the Template Name ProductHome 

Template Name
Programmatic 
Access Name File Specialty Store Language

ProductHome phome hom1f.jsp Specialty Store 1 French

ProductHome phome hom1e.jsp Specialty Store 1 English

ProductHome phome hom2f.jsp Specialty Store 2 French
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In this example, if a French customer enters Specialty Store 1, the store displays the 
home page file hom1f.jsp. An English customer in the same Specialty Store 1 sees 
hom1e.jsp instead.

Assigning Templates to Presentation Levels
Templates can also be assigned to products, categories, and sections. You can 
specify these assignments through the Display Style options available in the 
Product, Category, and Hierarchy tabs, after setting up the Display Styles catalog. 
See Section 6.4, "Defining Display Styles" for details.

You can indicate that the template associated with a given display style will be used 
when displaying a product. You can also indicate at the section level the display 
style to use for displaying products that belong to that section. Oracle iStore 11i uses 
the following process to determine which template to use when displaying a 
product according to a given display style.

1. For a given display style, Oracle iStore 11i uses the template that you associated 
with the product.

2. If no template is associated at the product level, Oracle iStore 11i retrieves the 
template associated with the product’s primary display category.

3. If no template is associated with the product or category, Oracle iStore 11i 
retrieves the default template for the display style.

6.3.3 Cataloging Templates
You can catalog templates using the Template Manager functionality, accessible 
through the Merchant UI Templates tab. Use this procedure to create template object 
names and programmatic access names, select default store-level template source 
files for them, and assign other template source files to them according to specialty 
store and language settings.

To display text in multiple languages, use Oracle Application Object Library’s 
Message Manager.

ProductHome phome hom2e.jsp Specialty Store 2 English

Table 6–2 Sample JSP File Names for the Template Name ProductHome (Cont.)

Template Name
Programmatic 
Access Name File Specialty Store Language
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Login
Log in to Oracle CRM Applications as a store manager user.

Responsibility
IBE_ADMINISTRATOR

Prerequisites
� At least one specialty store must have already been created.

� At least one language must have already been defined.

Steps
1. Launch the Merchant UI.

2. In the Templates tab, search for templates that are already cataloged and 
available for use in your store.

The Templates page lists the names of the templates that match your search 
criteria, with their programmatic access names, keywords, descriptions, display 
level, and the default source files to use for all specialty stores and languages.

3. Click Create. To modify a template listing, click the template name in the page 
instead.

The Template Details Information and Source Files page opens.

4. In the Name field, enter the name by which the template is referred to during 
the planning stage, i.e., the common name.

5. In the Programmatic Access Name field, enter the name by which the template 
is referred to in the JSP.

6. In the Default Source File For All Sites and Languages field, enter the JSP to be 
used as the default if a non-default language or specialty store mapping is not 
defined. 

7. In the Displays field, specify from the pull-down menu whether the template 
will be used to display a section (section), or a product or category (category). If 
the template will be used on Web pages that do not display the product catalog, 
choose others from the pull-down menu.

8. Optional: In the Keywords field, enter keywords for the template. Entering 
keywords enables a keyword-based search for this template when assigning a 
template to a display style.
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9. Optional: In the Description field, enter a description for the template. Entering 
a description enables a description-based search for this template when 
assigning a template to a display style.

10. Click Update. An updated Template Details Information and Source Files page 
opens with a Source File for Other Sites and Languages section.

Figure 6–4 The Template Details Information and Source Files Page

11. Optional: Click Add Source File to choose files for the same template in 
different languages and specialty stores. See the Guidelines below for details.

The Source File Details page opens.

a. Enter the name of a physical JSP source file that you want to use for the 
template name you are creating. Click Update.

An updated Source File details page opens with a Specialty Store and 
Language Mappings section.
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b. Add each store specialty store and language combination where you want 
the physical file to be used for this template, using the Specialty Store 
drop-down list and the Go buttons next to the Languages fields. Click 
Update.

The relationship between the template name, source file, specialty stores, 
and languages is saved.

c. To add another physical file, click on the template name link.

The Template Details Information and Source Files page with the Source 
File for Other Sites and Languages section opens.

d. Click Add Source File and repeat this step to add another physical file to 
this template.

12. Optional: In the Template Details Information and Source Files page, choose 
View All Mappings.

The View All Mappings page displays each physical file name and its 
relationship to specialty stores and languages. This step is highly 
recommended.

13. Optional: In the Templates tab, choose Categories if the template you created is 
meant to display product categories.

The Templates - Assigned Categories page lists the categories to which the 
template has been assigned. Click a category name to view all templates that 
have been assigned to the category.

14. Optional: If the template you created is meant to display product categories, 
you can assign it to categories now in the Category tab. In the Category tab, 
follow this procedure to add a template:

a. Click the name of the category to which the template is applicable. 

The Templates Assigned page lists all template names and default source 
template files for the chosen category.

b. In the Templates Assigned page, click Go.

A list of available template names appears.

c. Select the template(s) you wish to assign to the category.

d. Click Add. The pop-up window closes when you select Done.

You can edit template information by clicking the template name in the Templates 
tab.
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6.4 Defining Display Styles
Display styles specify how to present products on a Web page. For example, one 
display style specifies how to display Product A on a special sale page containing 
multiple products, and a different display style specifies how to display Product A 
on a page detailing product information. A display style calls an Oracle iStore 11i 
template, which then calls the appropriate template source file for the specialty 
store and language.

When you catalog display styles in the Setup tab, you choose store-level default 
template names for them. The display styles appear in the Product and Category 
tabs with fields where you can choose a template name to correspond with each 
display style for a product or a category. The display style fields also appear in the 
Hierarchy tab, where you can choose a template name to correspond with each 
display style for a section.

When a store Web page displays a product using a particular display style, Oracle 
iStore 11i selects the appropriate template as follows:

� If there is a product-specific template for the given display style, then the 
product-specific template is used.

� If no mapping is specified at the product level, and there is a category-specific 
template, then the category-specific template is used.

�  If no template name is selected for a product or a category, then the display 
style’s default store-level template is used on the Web page. 

Clicking Display Styles in the Setup tab lists seeded display styles and their 
programmatic access names, descriptions, default templates, and default source 
files.

Seeded Values
� STORE_FEATURED_PRODUCT

� STORE_PRODUCT_DESCR

� STORE_PRODUCT_DETAIL

� STORE_PRODUCT_DETAILS

� STORE_PRODUCT_SMALL_DESCR

Use the following procedure to create more display styles.
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Login
Log in to Oracle CRM Applications as a store manager user.

Responsibility
IBE_ADMINISTRATOR

Prerequisites
You can select a default template only after you have cataloged templates. If the 
information is unavailable, you may continue the setup and select a default 
template later. However, if a template association is requested for any product or 
section with that display style and is not specified, Oracle iStore 11i will use the 
default store-level template. 

To avoid the error, you can also use the seeded values for display styles, listed 
under Display Styles in the Setup tab.

Steps
1. Launch the Merchant UI.

2. In the Setup tab, choose Display Styles.

The Display Styles page displays a list of existing display styles.

3. Click Create.

The Display Style Details page opens.

4. Assign names and descriptions to the display style.

5. Optional: Click Go to select a default template for this display style.

6. Click Update.

The display style information is saved. 

You can edit display style information by clicking the display style name in the 
Display Styles page in the Setup tab.
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6.5 Creating Product Relationships
Relationships are used for merchandising, for example, to offer a substitute product 
for a product that is out of stock. Relationship types are used to create specific 
relationship rules that associate products, categories, and sections to other products, 
categories, and sections. One relationship type can contain either rules created using 
the rule builder or one SQL rule. It cannot contain both. 

The mapping rules define relationships in a From-To form. The types of From and 
To objects can be categories (defined in Oracle Inventory), sections or hierarchies 
(defined in Oracle Oracle iStore 11i), or items (defined in Oracle Inventory). The 
application evaluates each mapping rule and inserts rows in a table maintaining the 
preevaluated relationships. For example, if you have a category with two products 
assigned in your From list and a section with four products assigned in your To list, 
then Oracle Oracle iStore 11i creates a total of eight product relationships. 

Your business needs determine the creation of relationships. Oracle iStore 11i ships 
with several seeded relationship types, listed in Section 6.5.1, "Using Seeded 
Relationship Types" and also in the Merchant UI Relationship tab. 

If you use any relationship type other than the seeded relationship type RELATED, 
you must customize the Oracle iStore 11i JSPs to retrieve the related items with the 
Java API oracle.apps.ibe.catalog.Item.getRelatedItems(). This method can retrieve 
related items given an item ID and a relationship type. The method is also 
overloaded. See Oracle iStore API Reference Guide for documentation of this method.

If the relationship type is also seeded in Oracle Inventory, then 
oracle.apps.ibe.catalog.Item.getRelatedItems() retrieves related items defined in 
Oracle Inventory as well as in Oracle iStore 11i.

See Section 6.5.1, "Using Seeded Relationship Types" and Section 6.5.2, "Creating 
Relationship Types" for procedures that build relationships.

Note: Using SQL rules to define relationships by querying the 
database on particular fields is a method primarily used by Oracle 
Consulting or other highly technical personnel. Most store 
managers will use the mapping rules.
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6.5.1 Using Seeded Relationship Types
Oracle iStore 11i has several seeded relationship types that you can use to build 
relationships.

Seeded Values
� RELATED: Entity B is related to Entity A. 

� SUBSTITUTE: Entity B can be substituted for Entity A. 

� CROSS_SELL: Entity B can be offered and sold along with Entity A 

� UP_SELL: A newer version Entity B can be sold instead of Entity A.

� SERVICE: Entity B is a service item that can be added to the shopping cart for a 
serviceable Entity A.

� PREREQUISITE: Customer must have Entity B before purchasing Entity A.

� COLLATERAL: Entity B is collateral (e.g. marketing brochures) that exists for 
Entity A. 

� SUPERSEDED: Entity B supersedes Entity A, which is no longer available.

� COMPLIMENTARY: Entity B is available free of charge with Entity A.

� IMPACT: Entity A is usable together with related Entity B, but only under 
certain conditions.

� CONFLICT: Entity A is not usable together with a related Entity B.

� MANDATORY_CHARGE: Mandatory charge 

� OPTIONAL_CHARGE: Optional charge 

� PROMOTIONAL_UPGRADE: Entity A ordered by the customer is upgraded to 
Entity B of equal or higher value, with no change to the price.

Use the following procedure to create relationships using the seeded relationship 
types.

Login
Log in to Oracle CRM Applications as a store manager user.

Responsibility
IBE_ADMINISTRATOR
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Prerequisites
Products must exist in Oracle Inventory.

Steps
1. Launch the Merchant UI.

2. In the Relationship tab, review the seeded relationship types.

3. Click the name of a relationship type to create a relationship between items. For 
example, click SUBSTITUTE to make item B a substitute for item A if item A is 
out of stock.

4. Click Add Rules.

5. In the middle frame, search for the base product, and click the left arrow to add 
it to the From List.

6. Search for the related product, and click the right arrow to add it to the To List.

7. Click Done to save the relationship.

6.5.2 Creating Relationship Types
Use this procedure to define relationship types and add rules to them. 

Login
Log in to Oracle CRM Applications as a store manager user.

Responsibility
IBE_ADMINISTRATOR

Prerequisites
Products must exist in Oracle Inventory.

Steps
1. Launch the Merchant UI.

2. In the Relationship tab, choose Create.

The Create Relationship page opens.

3. In the Name field, enter the relationship type name.
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Optional: In the Description field, enter a description. This enables a 
description-based search for the relationship type.

Optional: In the Start Date and End Date fields, enter a start date and an end 
date for the relationship type to be valid.

Click Create.

The relationship type has been created. The Relationship Detail page opens, 
where you can begin adding rules to the relationship type.

4. Choose to specify the pairs of related items by SQL query or by mapping rules 
and highlight the appropriate radio button. Click Create Rule.

The Add Rules page opens if you choose Create Mapping Rules.

The Relationship Detail page opens if you choose Create a SQL Rule.

5. If you choose Create Mapping Rules, proceed as follows:

a. Conduct a search to view products, categories, or sections in the center 
table.

The search results appear in the table.

b. Select the items in your search results that you want to be in the From side 
of your rule, and click the left arrow.

The selected items appear in the From List.

c. Conduct a search to view products, categories, or sections in the center 
table.

The search results appear in the table.

d. Select the items in your search results that you want to be in the To side of 
your rule, and click the right arrow.

The selected items appear in the To List.

e. Repeat as needed to complete your From and To lists for this rule.

f. Click Done to submit the relationship rule creation, or click Preview Rules 
to validate or exclude the relationship rules to be added. 

If you click Done, the Relationship Detail page opens. The application 
generates a rule from every object in the From list to every object in the To 
list.
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If you click Preview Rules, the Preview Rules Page opens. At this point the 
rules have not been added to the system. You may exclude any rules not 
needed. When finished, click Done to see the Relationship Detail page.

g. From the Relationship Detail page, you may select a link for each rule to 
view all product to product relationships generated by that rule, or click 
View All Results to view all product to product relationships generated by 
all rules in this relationship type. 

From either option, the Relationship Result page displays the product-level 
relationship results.

If you do not want to include one or more of the generated rules, select 
Exclude and click Update.

The excluded product-level relationships can be re-included.

6. If you choose Create a SQL Rule, the following incomplete SQL displays on the 
Relationship Detail page:

SELECT msi.inventory_item_id
FROM mtl_system_items msi
WHERE

The SQL should return only the column inventory_item_id in the MTL_
SYSTEM_ITEMS table. You can add as many tables as you want in the From list 
and add any conditions in the Where clause.

6.6 Customizing Product Presentation at the Category Level
Every product is assigned or mapped to a category in Oracle Inventory. With 
customized multimedia, templates, and display styles, you can set up customized 
category-level defaults for products belonging to a category. 

Use this procedure to modify defaults for categories. You can only specify defaults 
for categories belonging to the primary display category set (the value of the IBE: 
Category Set profile option). If the product does not belong to any category in the 
primary display category set, then the store-level defaults are used.

Login
Log in to Oracle CRM Applications as a store manager user.

Responsibility
IBE_ADMINISTRATOR
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Prerequisites
� Products must be assigned to categories in Oracle Inventory in order to be 

returned upon a search of those categories.

� Multimedia, templates, and styles must exist before you can assign them to a 
category.

� The IBE: Category Set profile option must be set. See Section 3.1.14, "Setting 
Profile Options for the Oracle iStore 11i Merchant UI" for details.

Steps
1. Launch the Merchant UI.

2. In the Category tab, search for categories by Category Name or Description.

The Categories page displays a list of item categories from Oracle Inventory 
which belong to the category set specified in the IBE: Category Set profile 
option with related templates, display styles, and multimedia components.

3. Click the category name that you want to update.

The Templates Assigned page lists all template names and default source 
template files available for Web pages that display items in the chosen category.

4. In the Templates Assigned page, perform the following steps to make a 
template available for association with a display style in this category:

a. Click Add.

A list of available template names appears.

b. Select a template.

c. Click Add. The pop-up box closes when you select Done.

5. In the Category tab, choose Display Styles.

The Display Styles page lists all display styles you defined in the Setup tab. 

6. For each display style you can choose a template from the templates assigned to 
the category. Select Update.

In store Web pages related to this category that use a given display style, this 
template overrides the display style default template.

7. In the Category tab, choose Multimedia Components.

The Multimedia Components page lists all multimedia components that you 
defined in the Setup tab.
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8. Optional: Assign multimedia names to multimedia components. Click Update.

In store Web pages related to this category, when a template accesses a 
multimedia component, the multimedia name selected here overrides the 
multimedia component’s default multimedia setting. The multimedia name 
retrieves the media source file mapped to the specialty store and language used 
by the customer.

6.7 Customizing Product Presentation at the Item Level
Item-level customizations override category-level, section-level, and store-level 
settings. You can customize product presentation at the item level in the following 
ways:

� Modify the product catalog. See Section 5.7.2, "Modifying the Product Catalog" 
for more information.

� Create and associate specific images with certain products.

Defining proprietary multimedia and multimedia components enables 
association of specific images with certain products.

� Add item descriptive flexfields.

6.7.1 Creating Images for Products
To associate specific images with certain products, use the following procedure.

Login
Log in to Oracle CRM Applications as a store manager user.

Responsibility
IBE_ADMINISTRATOR

Prerequisites
None

Steps
1. Create images for products. Either create a new image for the product (usually 

done by a graphic artist) or use an existing image.
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2. Set up the multimedia in the Merchant UI as described in Section 6.1.3, 
"Cataloging Multimedia". Include the product image file in the source file 
listing for the multimedia.

3. Set up the multimedia component in the Merchant UI to associate the image 
with the product.

a. In the Product tab, search for the product that you want to associate with 
the image.

b. Click the product name.

c. Click Multimedia Components.

d. Highlight the radio button for Item Small Image and/or Item Large Image.

e. Click Go. A popup window with all the multimedia names will open.

f. Select the multimedia set up for the image.

4. Purge the product from the cache by following the instructions in Section 6.10, 
"Managing the Cache".

5. Verify that the image is associated with the product in the store’s Customer UI.

6.7.2 Adding Item Descriptive Flexfields
Oracle iStore 11i allows addition of descriptive flexfields to item detail pages. With 
this option, the item detail page will display the prompt and value of descriptive 
flexfield global segments if a value is defined for the item. Only global segments of 
the descriptive flexfield are supported. 

To set up descriptive flexfields on an item detail page, follow this procedure.

Login
Log in to Oracle Forms.

Responsibility
Application Developer

Prerequisites
None

Steps 
1. Log in to Oracle Forms with the Application Developer responsibility.
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2. Choose Flexfield > Description > Segments to open the Descriptive Flexfields 
window.

3. Choose View > Find, and query for the flexfield with Application = Oracle 
Inventory and Title = Items. 

4. Set up flexfield segments for Global Data Elements. See Oracle Applications 
Flexfields Guide for additional details. 

5. Switch to the Inventory responsibility. 

6. To set up flexfield segments and values for items and their detail pages:

a. Navigate to the Inventory Item window and find the item for which 
flexfield values will be entered. Use the inventory organization that is set in 
the profile option IBE: Item Validation Organization. 

b. Click on the rectangle enclosed within [ ] next to the Description field in the 
Inventory Item window. 

c. A window opens with the flexfield segments set up in the previous steps.

d. Enter values for the flexfield segments you want to display on the item 
detail page. 

7. Test that the descriptive flexfield segments appear in the item detail pages as 
desired, using the following procedure:

a. Reboot the Apache server to clear the cache after entering the data. 

b. In the Customer UI, navigate to the item detail page for an item with 
flexfield values entered. 

c. The flexfield segment prompts and values should appear on the item detail 
page. 

6.8 Customizing the Shopping Cart
You can customize shopping cart pages in the following ways:

� Customizing Shopping Cart Page Bin Content

� Enabling Unit of Measure (UOM) Conversions

� Allowing Decimal Quantities for Items

� Specifying Flexfields At the Checkout Page
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6.8.1 Customizing Shopping Cart Page Bin Content
All seeded shopping cart templates share the same layout. The shopping cart page 
layout has a top bin and a bottom bin. Each bin is listed as a logical template in the 
Oracle iStore 11i template manager. You can customize the content of a bin by 
mapping a JSP to the logical template. For example, you can include Oracle 
Marketing Online’s eMerchandising banners at the top and bottom of the shopping 
cart pages.

The programmatic access name of the top shopping cart bin is STORE_CART_
ITEMS_BIN_TOP. The programmatic access name of the bottom shopping cart bin 
is STORE_CART_ITEMS_BIN_BOTTOM.

Use the following procedure to customize the content of the shopping cart bins.

Login
Log in to Oracle CRM Applications as a store manager user.

Responsibility
IBE_ADMINISTRATOR

Prerequisites
None

Steps
1. Launch the Merchant UI.

2. In the Templates tab, click the name of the bin template that you want to 
modify.

The Template Details page opens.

3. Add a new source file for the bin content.

4. Add the necessary mappings for the desired minisite-language combinations. 
To use this source file for all minisites and all languages, add a mapping for all 
minisites, all languages. The changes will not be overwritten when patches are 
applied because there are no seeded default values for these bins.
6-32 Oracle iStore Implementation Guide



Customizing the Shopping Cart
6.8.2 Enabling Unit of Measure (UOM) Conversions
Oracle Pricing handles UOM conversions. The Pricing engine will only do UOM 
conversions if the Primary UOM Code checkbox is checked for the item in the Price 
List Setup window.

UOM Conversion Example
The primary UOM of Item X is Each and a conversion of 12 Each = 1 Dozen has 
been set up in Inventory. When pricing Item X, Oracle iStore 11i calls the Pricing 
engine passing in (Item X, Each) and (Item X, Dozen). The price list has a price for 
(Item X, Each).

� If the price list also contains (Item X, Dozen), the price for (Item X, Dozen) is 
returned.

� If the price list does not contain (Item X, Dozen) and the Primary UOM Code 
checkbox is checked for (Item X, Each), the price returned is 12 times the price 
of (Item X, Each).

� If the price list does not contain (Item X, Dozen) and the Primary UOM Code 
checkbox is not checked for (Item X, Dozen), an error is returned.

6.8.3 Allowing Decimal Quantities for Items
When adding an item or updating its quantity in the Oracle iStore 11i shopping cart, 
the customer can enter a decimal quantity if it is supported by the item. Oracle 
iStore 11i calls the same API used by Oracle Order Management for validating 
quantity. If an item is marked OM Indivisible, decimal quantities are not allowed for 
its primary UOM. 

To prevent the customer from selecting a decimal quantity of an item, follow this 
procedure.

Login
Log in to Oracle Forms.

Responsibility
Inventory

Prerequisites
None
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Steps 
1. Log in to Oracle Forms with the Inventory responsibility for the Master 

Inventory Organization.

2. Choose Master Items. 

3. Choose the appropriate inventory organization (the same as the Oracle iStore 
11i Item Validation Organization).

4. Query for the item.

5. In the Physical Attributes tab, check OM Indivisible.

6. Repeat for all inventory organizations that contain the item. 

To allow the customer to select a decimal quantity of an item, follow the previous 
steps, but uncheck OM Indivisible.

6.8.4 Specifying Flexfields At the Checkout Page
Oracle iStore 11i allows addition of flexfields to the checkout page and saves the 
information they contain to the quote. It passes the content of a flexfield on to 
Oracle Order Management as a comment in a non-validated field. For example, you 
can set up a flexfield for the sales representative that will go to Oracle Order 
Management as a comment that Order Administration will use to assign the correct 
sales representative ID.

Specify flexfields at the checkout page using the following procedure.

Login
Log in to Oracle Forms.

Responsibility
Application Developer

Prerequisites
None

Steps
1. Log in to Oracle Forms with the Application Developer responsibility.

2. Choose Flexfield > Description > Segments to open the Descriptive Flexfields 
window. 
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3. Choose View > Find, and query for the flexfield with Application = Oracle 
Order Capture and Title = Header: Additional Information. 

Set up flexfield segments. For example, map "Sales Rep Email" to  
"ATTRIBUTE1."

4. Query for the flexfield with Application = Oracle Order Management and 
Title = Additional Header Information.

Set up flexfield segments. For example, map "Sales Rep Email" to  
"ATTRIBUTE1."

Confirm the following:

� The same database columns are in use for both the Oracle Order Capture 
and Oracle Order Management flexfield segments (ATTRIBUTE1 in the 
previous example).

� The usage in Oracle Order Capture does not conflict with other flexfield 
definitions in Oracle Order Management.

� Only global segments of a flexfield are supported.

5. Test your checkout page using the following steps:

a. Checkout a shopping cart and proceed to the "Payment And Billing 
Information" page. 

b. You should see "Sales Rep Email" field under "Additional Information." You 
may enter information in this field, then continue.

c. After your order is created, go to Forms and check if the Sales Rep Email 
flexfield information is present in both Oracle Order Capture and Oracle 
Order Management Forms.

6. Customize the prompts for the flexfields. 

The default prompt title is, "Additional Information." To change it, log in to 
Oracle Forms and modify the message IBE_PRMT_ORD_FLEX_TITLE in the 
FND_NEW_MESSAGES table.

The default additional instruction is, "Please fill in the following fields." To 
change it, log in to Oracle Forms and modify the message IBE_PRMT_ORD_
FLEX_DESCR in the FND_NEW_MESSAGES table.
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6.9 Creating B2B User Roles
If the seeded B2B user roles IBE_BUSINESS_USER_ROLE and IBE_PRIMARY_
USER_ROLE do not meet all of your business needs, you can create new roles with 
any set of seeded Oracle iStore 11i permissions that you wish to specify. You can 
then assign the roles to B2B users who register in your Web stores. See 
Section 5.11.3, "Roles and Permissions for Oracle iStore 11i Users" for descriptions of 
seeded B2B user roles and existing Oracle iStore 11i permissions.

Use Oracle CRM Technology Foundation to create new roles. See Oracle CRM 
Technology Foundation Concepts and Procedures for instructions on creating new roles 
and mapping permissions to roles.

6.10 Managing the Cache
Oracle iStore 11i caches your Web storefront product items and sections to improve 
the performance of your Web site, if the profile option IBE: Cache On is set to Yes. 
However, if you make changes to a cached product item or section, the changes are 
not visible in the Customer UI unless the product item or section is purged from the 
cache.

Restarting the Apache server purges the entire cache, but you may not always want 
to do this, since it removes product items or sections you do not want to remove 
from the cache, and since the Web stores are unavailable while the server is 
restarting. 

Oracle iStore 11i offers a cache management feature in the Merchant UI that enables 
you to purge only the product items or sections that you want to remove from the 
cache, while keeping the server—and thus the Web stores—up and running. You 
can purge the cache of the following sets of product items and sections:

� Specific product item(s)

� Specific section(s)

� All product items

� All sections

� The entire cache

Oracle iStore 11i uses multicast messages when it purges the cache to ensure that 
the cache on each Java Virtual Machine (JVM) is purged. The Oracle iStore 11i 
initialization code starts a thread within each JVM that listens for messages on a 
specific address and port. When you choose to purge the cache from the Merchant 
UI, Oracle iStore 11i sends a multicast message to that address and port. When a 
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thread receives the message, it interprets the message and purges the appropriate 
cache. Since there is a thread on each JVM listening for messages, the cache will be 
purged in each JVM. The port number is set in the profile option IBE: Port Number 
to use for multicast messages. See Section A.6, "Oracle iStore 11i (IBE) Profile 
Options for the Customer UI" for more information about this profile option.

6.10.1 Purging the Entire Cache
Use this procedure to purge either the entire section cache or the entire product 
cache, or both.

Login
Log in to Oracle CRM Applications as a store manager user.

Responsibility
IBE_ADMINISTRATOR

Prerequisites
The profile option IBE: Cache On is set to Yes.

Steps
1. Launch the Merchant UI.

2. In the Cache tab, click on the Purge Entire Cache link.

The Purge Entire Cache page opens.

3. Highlight the radio button next to the cache purging option you want to 
exercise:

� Purge the entire Section Cache and entire Item Cache

� Purge the entire Section Cache only

� Purge the entire Item Cache only

4. Click Update.

The cache is purged.
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6.10.2 Purging the Section Cache
Use this procedure to purge individual sections from your section cache.

Login
Log in to Oracle CRM Applications as a store manager user.

Responsibility
IBE_ADMINISTRATOR

Prerequisites
The profile option IBE: Cache On is set to Yes.

Steps
1. Launch the Merchant UI.

2. In the Cache tab, click on the Purge Section Cache link.

The Purge Section Cache page opens.

3. Search for the section(s) you want to purge:

a. From the View pull-down menu, specify whether you will search by Name, 
Section Code, Section Type, or Status.

b. In the adjacent text field, enter your search criterion. Use % as a wildcard 
character if necessary.

c. Click Go.

The search results appear in the Purge Section Cache page.

4. Select the checkbox in the Select column next to the section(s) you want to 
purge.

5. Click Update.

The cache is purged.

6. Optional: You can view the contents of the section cache at any time by 
navigating to the following URL:

http://<host>:<apache port>/OA_HTML/ibemckvs.jsp
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6.10.3 Purging the Product Cache
Use this procedure to purge individual product items from your product cache.

Login
Log in to Oracle CRM Applications as a store manager user.

Responsibility
IBE_ADMINISTRATOR

Prerequisites
The profile option IBE: Cache On is set to Yes.

Steps
1. Launch the Merchant UI.

2. In the Cache tab, click on the Purge Product Cache link.

The Purge Product Cache page opens.

3. Search for the section(s) you want to purge:

a. From the View pull-down menu, specify whether you will search by Name, 
Part Number, Category, or Status.

b. In the adjacent text field, enter your search criterion. Use % as a wildcard 
character if necessary.

c. Click Go.

The search results appear in the Purge Product Cache page.

4. Select the checkbox in the Select column next to the product(s) you want to 
purge.

5. Click Update.

The cache is purged.

6. Optional: You can view the contents of the product cache at any time by 
navigating to the following URL:

http://<host>:<apache port>/OA_HTML/ibemckvp.jsp
Optional Implementation Tasks 6-39



Managing the Cache
6-40 Oracle iStore Implementation Guide



Verifying the Implemen
7

Verifying the Implementation

This chapter describes the tasks required to verify your implementation of Oracle 
iStore 11i. Topics include:

� Oracle iStore 11i Implementation Verification Tasks
tation 7-1
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7.1 Oracle iStore 11i Implementation Verification Tasks
You must also test your storefronts before launching your stores, as described in 
Section 7.1.1, "Testing the Store". 

Once you have launched your stores, you can continue to test and verify additional 
changes to the catalog before making the changes public. See Section 7.1.2, 
"Previewing Products and Sections" for more information on testing the appearance 
of products and sections in your Web stores.

7.1.1 Testing the Store
Test the storefront with the following URL:

http://<host>:<apache port>/OA_HTML/ibeCZzdMinisites.jsp

This page allows you to navigate to any of your specialty stores, and to sign in if 
necessary.

7.1.2 Previewing Products and Sections
You can use the Preview feature of Oracle iStore 11i to preview the appearance of 
products and sections in the Customer UI before publishing them for your 
customers. Assign multimedia components, display styles, and categories to your 
products and sections. Set the statuses of the products and sections to Unpublished. 
Unpublished products and sections appear in the Customer UI only if the user has 
the IBE_ADMINISTRATOR responsibility. Next, use the following procedure to 
preview unpublished products and sections in the Customer UI.

Steps
1. Launch the Merchant UI.

2. In the same browser window, navigate to the URL for the Customer UI.

3. Choose the specialty store with the unpublished products and sections that you 
want to preview, and navigate to the products and sections. 

4. After viewing the products and sections, return to the Merchant UI. Here, you 
can make additional changes or publish the products and sections.

Note: Do not log out of the Merchant UI before navigating to the 
Customer UI.
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See Section 7.1.1, "Testing the Store" for more information about the Customer UI 
and testing your stores.
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Diagnostics and Troubleshooting

This section contains instructions on error corrections and workarounds for 
problems that you may encounter in configuration or administration of Oracle 
iStore 11i. Topics include:

� Setting Up User-Level Logging

� Receiving Diagnostic Messages

� Java Applet Warning Workaround

� Error ORA-29868 While Executing amviccn.sql

� Merchant UI Menu Errors

� Hierarchy Errors

� Display Manager Errors

� Catalog Errors

� Pricing Errors

� Shopping List Errors

� Search Errors

� Notifications Errors

� Storefront Reports Errors

� Postsales Errors

� Potential Issues Installing Oracle8i interMedia Text Version 8.1.7

� Reporting Issues
oting 8-1
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8.1 Setting Up User-Level Logging
Oracle iStore 11i allows user level logging of debug messages. This feature creates 
separate user log files for the JSP/Java and PL/SQL layers. You should only use this 
feature to diagnose problems in the application.

You can activate user-level logging by setting the profile option IBE: Enable Debug 
to Yes at the user level for a specific user.

Steps to Set Up JSP/Java Level Logging
1. Note the log directory in which the Oracle CRM Technology Foundation (JTT) 

Java log resides, as specified at JServ startup.

2. Set the profile option IBE: Enable Debug to Yes at user level for a user.

When a user logs in to the Oracle iStore 11i Customer UI, the application creates 
a user-specific log file in the same directory as the system log file. As long as the 
user session is valid, all log messages are written to the same log file. 

The file name has the syntax IBE_<Username>_<Random Number>.log.

Steps to Set Up PL/SQL Level Logging
1. Set the profile option IBE: Enable Debug to Yes at user level for a user.

2. Set the profile option OM: Debug Log Directory at site level to a directory that 
is writable by the database server.

3. Set the init.ora UTL_FILE_DIR parameter to point to the same directory. 

When a user logs in to the Oracle iStore 11i Customer UI, the application writes 
all log messages for the user to a user-specific log file in the directory specified 
by OM: Debug Log Directory. 

The file name has the syntax IBE_<Username>.log.

8.2 Receiving Diagnostic Messages
When there is an Oracle iStore 11i application error in the Customer UI, such as an 
exception, Oracle iStore 11i delivers a diagnostic e-mail message to any e-mail 
address that you specify. The diagnostic message contains the exception message 
and the application context. You can specify the e-mail address in the profile option 
IBE: Email Address to send Diagnostic Messages.
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8.3 Java Applet Warning Workaround
Use the following procedure to remove the yellow bar displaying a Java Applet 
warning.

1. Uninstall JInitiator from your client machine as follows: 

a. In Windows 95/98/NT, go to Start > Settings > Control Panel > 
Add/Remove Programs. 

b. Find Oracle JInitiator 1.1.7.27 Export, and click Add/Remove. 

c. Make sure JInitiator is removed successfully.

2. Delete the identitydb.obj file from your client machine (it is usually in the 
parent directory of your JInitiator installation, i.e., C:\Program 
Files\Oracle\).

3. From your client machine, FTP to the server.

cd <COMMON_TOP>/html

where <COMMON_TOP> is the actual value (e.g., /u04/viscomn). You 
cannot use environment variables in FTP. Make sure you are using binary 
transfer mode: bin.

4. Download oajinit.exe to your client machine:

get oajinit.exe

5. Change to <APPL_TOP>/admin, where <APPL_TOP> is the actual value (e.g., 
/u02/visappl).

6. Download the certificate file appltop.cer:

get appltop.cer

7. Close the FTP session.

8. On your client machine, launch a command prompt session, and execute 
oajinit.exe from the command line. Wait until JInitiator is successfully installed.

9. Change to the directory in which JInitiator is installed (typically C:\Program 
Files\Oracle\Oracle JInitiator 1.1.7.27 Export).

10. Change to the bin subdirectory.

11. Copy the appltop.cer file into the bin directory.

12. Execute the following command exactly as shown:
Diagnostics and Troubleshooting 8-3



Error ORA-29868 While Executing amviccn.sql
./javakey.exe ic appltop appltop.cer

13. If your browser was open, close and restart it.

14. Log in to Oracle Forms. The yellow bar should not appear.

8.4 Error ORA-29868 While Executing amviccn.sql
When running the database driver and executing amviccn.sql, you may receive the 
following error message:

ORA-29868: cannot issue DDL on a domain index marked as LOADING. 

This error causes AutoPatch to halt. 

To correct this error, use the following procedure.

Steps
1. Open another window or telnet session. 

2. Set up the environment as usual.

3. Change to the $AMV_TOP/patch/1306413/amv/patch/115/sql directory. 

4. Add the FORCE clause to the DROP INDEX command by editing the file 
amviccn.sql to change the line

dbms_sql.parse(curs, ’DROP INDEX ’||dropIndex.index_name, dbms_sql.native);

to

dbms_sql.parse(curs, 'DROP INDEX '||dropIndex.index_name||’ FORCE’,                            
dbms_sql.native);

5. Save the file amviccn.sql. 

6. Use the adctrl utility to restart the failed worker by performing the following 
procedure:

a. Execute adctrl.

b. Accept defaults for all prompts until you get to the Main Menu.

Note: For instructions on how to use the AutoPatch utility, see 
Maintaining Oracle Applications.
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c. Choose 1. Show Worker Status to identify the failed worker. 

d. Press Return to continue.

e. Choose 2. Tell Worker To Restart A Failed Job and enter the ID number of 
the failed worker.

f. Choose 1. Show Worker Status again to monitor the status of the job.

7. If all else fails, stop and restart adpatch.

8.5 Merchant UI Menu Errors
Use the following fixes for the errors listed below.

Patch Has Duplicated Merchant UI Tabs
If a patch has duplicated all of the Merchant UI tabs, use the following procedure to 
remove the duplicate tabs.

Steps
1. Log in to Oracle Forms with the Application Developer responsibility.

2. Choose Application > Menu.

The Menus form opens.

3. Place the cursor in the Menu field.

4. Choose View > Find, or click the flashlight icon on the toolbar to search for 
iStore menus.

The Find Menu window opens.

5. In the Find field, enter iStore.

The iStore menu values appear in the Find Menu window.

6. Select iStore and click OK.

The Menus form for iStore (IBE_ALL_ROOT) opens.

7. In the Menus form, remove the duplicate entries from the iStore menu.

8. Save the record.

Notifications Subtab Does Not Appear
See Section 8.12, "Notifications Errors" for the fix.
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Reports Tab Does Not Appear
See Section 8.13, "Storefront Reports Errors" for the fix.

8.6 Hierarchy Errors
Use the following fixes for the errors listed below.

The Hierarchy Tree Does Not Appear
You must define the OA_JAVA alias in the Apache configuration file as follows:

1. Locate the file httpds.conf in the $APACHE_TOP/Apache/conf directory.

2. Add the following line: 

Alias /OA_JAVA/"<actual Java directory>"

For example, enter: 

Alias /OA_JAVA/"/u01/oracle/viscomn/java/"

3. Clear your cache and restart the Apache server.

The Add Section Button Does Not Appear
The Add Section button appears in the Hierarchy tab only when the Home root 
section has no subsections. To create a new subsection of Home, highlight Home 
and click Create.

Cannot Find Item to Add to Section
If you want to add an existing Oracle Inventory item to a section and cannot find 
the item, then check the following:

� In Oracle Inventory, the item’s Web Status is Published.

� In Oracle Inventory, the item is defined as Orderable on the Web.

� In Oracle Pricing, the item is defined in a price list.

Creating New Section Returns IBE_DSP_J_CRT_HIER_SCT_FAIL
This error message appears when you try to create another root section. Only one 
root section can exist. Highlight the root section and click Create to create a new 
section as a subsection of the root section.
8-6 Oracle iStore Implementation Guide



Display Manager Errors
8.7 Display Manager Errors
If a stack trace or error message indicates that a Display Manager API caused an 
error, check the top line of the exception Java stack trace for the last class and 
method that was called and caused the error. 

Display Manager uses two sets of log files:

� FWSYS, system log files that are used by JTT and are not used by Applications.

� ibe.log.run, the Application log files that contain the sequence of actions 
recorded by Oracle iStore 11i. 

8.7.1 Display Manager Error Messages
Use the following fixes and workarounds for the Display Manager error messages 
listed below.

TemplateNotFoundException or MediaNotFoundException
This error occurs when the method DisplayManager.getURL(), 
DisplayManager.getTemplate(accessName), or 
DisplayManager.getMedia(accessName) is used.

� Verify that the template or media was created in the Merchant UI by searching 
for it by access name in the Merchant UI.

� Reboot the server.

� Check the log file for diagnostic messages.

NullPointerException (Template or Multimedia Object is Null)
This error occurs when the method Item.getTemplateFileName(), 
Section.getTemplateFileName(), or Display Manager.getSectionMedia(...) is used.

This error indicates that a product or section mapping to a template or multimedia 
was not defined and that a store level default was also not defined.

� Verify that the mapping for the product or section is specified in the Merchant 
UI.

� If the category default is in use, check whether a mapping has been defined at 
the category level for the requested display style.

� Verify that the specified display styles or multimedia components are available.
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� Verify that the product or section cache was cleared after the mapping was 
created.

� Check the log file for diagnostic messages.

New Template (or Multimedia) Has Been Associated with a 
Product/Category/Section, But Won’t Show Up at Runtime.
� Verify that the association was created in the Merchant UI.

� Verify that the specified display styles or multimedia components are available.

� Verify that the product or section cache was cleared after the association was 
created.

� Check the log file for diagnostic messages.

8.8 Catalog Errors
To troubleshoot Catalog errors, use the checkpoints or the following fixes for 
specific error messages.

8.8.1 Checkpoints
� View the JSP source in the Web browser and look for a stack trace.

� Check the log file for a stack trace.

� If you know the JSP or Java method in which the error occurred, search the log 
file for debug statements from the JSP or method.

� If a Web store page does not appear, verify whether the problem is with the 
database, Apache server, connection, or JTT/AOL as follows:

1. Go to the following URL:

http://<host>:<apache port>/html/jtfmain.htm

This page has links to test the basic functionalities that Oracle iStore 11i 
depends on. 

If the page itself does not appear, the problem is with the database 
connection.

2. Follow the instructions on the page and use the links to check for 
environment problems.
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� If an eMerchandising posting from Oracle Marketing Online does not show up 
in the Oracle iStore 11i catalog, check the following points:

� Oracle Marketing Online is installed.

� The profile option IBE: Use Web Placements is set to Yes.

� The centralized posting JSP (ibecpstg.jsp or ibeCCtpPostingI.jsp) is 
modified to set the correct posting ID value.

� After modifying the centralized posting JSP, the following pages were 
removed from the _pages directory and recompiled: ibec*.java, 
ibescdch.java, ibeCCt*.java, ibeCScdViewA.java, ibec*.class, ibescdch.class, 
ibeCCt*.class, and ibeCScdViewA.class.

� If Oracle iStore 11i has successfully displayed other types of 
eMerchandising postings, the problem may be due to an Oracle Marketing 
Online setup issue or other Oracle Marketing Online problem.

8.8.2 Specific Error Messages
Use the following fixes and workarounds for the error messages listed below.

No Items in the Catalog
� Check the following profile options:

� ASO: Product Organization

� IBE: Item Validation Organization

� MO: Operating Unit

� Check the Oracle Inventory Item setup for items that should appear in the 
catalog. They must have the following setup:

� Web Status = Published

� Orderable on the Web = Y

� start_date_active is NULL or <=SYSDATE

� end_date_active is NULL or >=SYSDATE

� The item’s primary unit of measure is in MTL_UNITS_OF_MEASURE_VL.

� The item is available in the user’s organization. A user only sees items in 
his or her inventory organization. You can check the Oracle iStore 11i log 
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file for "Organization Id" to see the value of the user’s Inventory 
Organization ID.

� If there are configurable items in the catalog, confirm that their components’ 
item setups are also correct. Otherwise, their descriptions will not appear in 
Oracle iStore 11i.

Items Do Not Have Prices
� Check the following profile options:

� IBE: Pricing Event—Before Shopping Cart

� IBE: Request Type to get a Price

� IBE: Use Price list associated with Specialty Store

� Confirm that items are in the minisite price list.

� Confirm that the minisite has the correct price lists for walk-in and registered 
B2B and B2C users.

� Confirm that the price list has item prices for the correct UOMs.

� Confirm that the price is set up correctly in Oracle Pricing.

� Check the log file for the pricing API, Item.getListAndBestPrices(), that is being 
called. Confirm the values that Oracle iStore 11i passes to the Pricing engine: 
price list ID, currency code, inventory item IDs, UOM codes, price request type, 
and pricing event. Oracle iStore 11i only passes party ID and account ID for 
user-specific pricing. Check the values that Oracle Pricing returns: status code 
and status text.

� Status Code from Pricing Engine

� UPDATED

� DUPLICATE_PRICE_LIST

� INVALID_UOM

� IPL: Invalid price list ID, that is, a non-existent price list.

� If the profile option IBE: Use Price list associated with Specialty Store is set to 
No, check the following setups:

� Set the profile option ASO: OM Defaulting to Yes at the desired level: site, 
application, responsibility, or user.
8-10 Oracle iStore Implementation Guide



Catalog Errors
� Log in to Oracle Forms with the Oracle Pricing Manager responsibility. 
Choose Setup > Event Phases. Query for all event phases. Set Search Flag 
to Yes for the pricing event "LINE" in all phases.

� Log in to Oracle Forms with the Oracle Pricing Manager responsibility. 
Choose Price Lists > Price List Setup. Search for the price list in question. 
Make sure the precedence at the product level is set correctly so that Oracle 
Pricing can resolve to a single price list.

For example, if there are only two price lists defined, Price List A and Price 
List B, and all users qualify for both price lists, and if both price lists contain 
Product X with precedence 220, then Oracle Pricing returns an error 
because it cannot choose a single price list. If the Product X precedence is 
100 in Price List A and 220 in Price List B, Oracle Pricing can resolve to 
Price List A.

� To confirm that the defaulting row is set up correctly in Oracle Order 
Management, log in to Oracle Forms with the Order Management Super 
User responsibility. Choose Setup > Rules > Defaulting. Search using the 
criteria of Application = Oracle Order Management and Entity = Order 
Header. Select Order Type from the Attributes section and click Defaulting 
Rules. Add an entry in the Default Sourcing Rules with the following 
information:

– Sequence = 1

– Source Type = Constant Value

– Order Type = Standard

“Add to Cart” Buttons Do Not Appear
“Add to Cart” buttons are not displayed for items that are not orderable on the Web 
and for items that do not have defined prices.

� Check that the item setup has orderable_on_web_flag = ’Y’ in Oracle Inventory.

� Check the price setup.

� Confirm that the item’s BOM item type is not OPTION class.

� If the item’s BOM item type is MODEL, the item must have the Oracle 
Configurator UI set up.
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8.9 Pricing Errors
To troubleshoot Pricing errors, use the following checkpoints and debugging 
procedures.

8.9.1 Checkpoints
Use the following checkpoints to troubleshoot pricing in Oracle iStore 11i.

� If you want to use the Oracle Pricing engine to determine which price list to use 
in Oracle iStore 11i, then set the profile option IBE: Use Price List associated 
with Specialty Store to No at the iStore application level.

� When you change an item’s price, clear the item from the product cache by 
using the Merchant UI.

� When you create a new modifier, run the Build Sourcing Rules concurrent 
program with the Pricing Manager responsibility.

8.9.2 Generating a Pricing Debug Trace
You can generate a pricing debug trace to create detailed log files when Oracle 
iStore 11i calls the Oracle Pricing engine. Oracle iStore 11i creates two log files 
because it calls the Oracle Pricing engine twice, once in the catalog and once in the 
shopping cart. The call from the catalog goes directly to Oracle Pricing. The call 
from the shopping cart is performed through Oracle Order Capture, resulting in 
additional quote-related information in the log file.

Use the following procedure to generate the pricing debug trace.

Steps
1. Set the profile option QP: Debug to Yes at the user level for the username that 

you are testing.

2. Set the profile option OM: Debug Log Directory at the site level to the value of 
the init.ora UTL_FILE_DIR parameter. To find this value, perform the following 
SQL*Plus query:

select value
from v$parameter
where name=’utl_file_dir’;

3. Log in to the Oracle iStore 11i Customer UI as the user that you are testing.

4. Perform the pricing activity that you are trying to debug.
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5. In the operating system, navigate to the directory specified in the profile option 
OM: Debug Log Directory.

6. In this directory, locate the file named <Random Number><Username>.dbg. 
This is the debug trace for the user and session.

7. As you read the debug trace file, keep in mind the following common reasons 
for discounts not being applied:

� Discount list header is inactive.

� Discount list header is ineffective as of the pricing date.

� Source system code on discount list is not correct. (Look at this for Oracle 
iStore 11i orders.)

� Discount list line is ineffective as of the pricing date.

� Qualifiers for the discount list are not met.

� Pricing attributes for the discount list are not met.

� Discount list is getting eliminated by incompatibility.

� Price break discount conditions are not met.

8.9.3 Finding the User’s Price List
Use the following procedure to find out which price list the Oracle iStore 11i user is 
using.

Steps
1. Log in to the store as the user that you are testing.

2. Add an item to the cart.

3. Enter the following command in the browser address field:

javascript:alert(document.cookie)

The Oracle iStore 11i cookie values display in a long string with a format that 
looks like the following truncated example:

zs%3D<value of zs>zc%3D<value of zc>

4. Find the price list ID for the cart by querying the ASO_QUOTE_HEADERS_
ALL table in SQL*Plus for quote_id = the value of zc in the cookie, as follows:

select price_list_id
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from aso_quote_headers_all
where quote_header_id = <the value of zc>;

5. If PRICE_LIST_ID in the ASO_QUOTE_HEADERS_ALL table is null, then 
query the ASO_QUOTE_LINES_ALL table instead.

8.10 Shopping List Errors
To troubleshoot Shopping List, perform the following checks:

� Run ctx_output.start_log("log")

� Check the log file for errors in the program flow.

� Check whether data is stored or modified in the database table.

� Run SQL from the log files.

� Run PL/SQL scripts if a problem has occurred in the PL/SQL layer. 

8.11 Search Errors
To troubleshoot Search errors, use the following checkpoints:

� Check the Search log file by executing ctx_output.start_log(’log’).

� Check that Concurrent Manager is up and running.

� If searches are inaccurate, verify that interMedia was set up correctly. Refer to 
Section 8.15, "Potential Issues Installing Oracle8i interMedia Text Version 8.1.7".

� Look for data stored in the indexed search column.

� If you add multiple items that do not appear in the search table, re-run the 
Concurrent Manager program Store Search Insert. This program populates the 
search table in Oracle iStore 11i with product information from the Oracle 
Inventory tables.

� Verify that the listener.ora and tnsnames entries are correct so that the callout to 
the .dll can be made. For UNIX, refer to Section 8.15, "Potential Issues Installing 
Oracle8i interMedia Text Version 8.1.7". 

Note: The search function goes offline while Store Search Insert is 
running.
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For Windows NT, refer to the following example.

listener.ora
*********************
LISTENER =
  (DESCRIPTION_LIST =
    (DESCRIPTION =
      (ADDRESS_LIST =
        (ADDRESS = (PROTOCOL = IPC)(KEY = EXTPROC0))
      )
      (ADDRESS_LIST =
        (ADDRESS = (PROTOCOL = TCP)(HOST = sthattil-pc)(PORT = 1521))
      )
    )
    (DESCRIPTION =
      (PROTOCOL_STACK =
        (PRESENTATION = GIOP)
        (SESSION = RAW)
      )
      (ADDRESS = (PROTOCOL = TCP)(HOST = sthattil-pc)(PORT = 2481))
    )
  )

SID_LIST_LISTENER =
  (SID_LIST =
    (SID_DESC =
      (SID_NAME = PLSExtProc)
      (ORACLE_HOME = E:\Oracle\Ora81)
      (PROGRAM = extproc)
    )
    (SID_DESC =
      (GLOBAL_DBNAME = ORCL)
      (ORACLE_HOME = E:\oracle\ora81)
      (SID_NAME = ORCL)
    )
  )

*******************************************
tnsnames.ora
*******************************************
EXTPROC_CONNECTION_DATA.US.ORACLE.COM =
  (DESCRIPTION =
    (ADDRESS_LIST =
      (ADDRESS = (PROTOCOL = IPC)(KEY = EXTPROC0))
    )
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    (CONNECT_DATA =
      (SID = PLSExtProc)
      (PRESENTATION = RO)
    )
  )

If the code is correct, refresh the dr$libx so it can find the .dll to create the index 
(my oractxx8.dll is in my $ORACLE_HOME\bin directory). The command to 
recreate the library is: 

create or replace library dr$libx as ’e:\oracle\ora81\bin\oractxx8.dll’;

Start the ctxsrv and re-index.

� If you have implemented category-level search and the search is not working, 
run the following search query in SQL*Plus:

select  i.inventory_item_id, i.description, i.category_id,
score(100) nearness

from ibe_ct_imedia_search i, mtl_system_items_b b
where contains (i.indexed_search, ’laptop’ , 100) > 0
and i.language = userenv(’LANG’)
and i.category_id = i.category_id
and i.organization_id = 204
and exists (

select 1
from jtf_dsp_section_items s, jtf_dsp_msite_sct_items b
where s.section_item_id = b.section_item_id
and b.mini_site_id = 10120
and s.inventory_item_id = i.inventory_item_id
and (s.end_date_active > sysdate or s.end_date_active is null)
and s.start_date_active < sysdate
)

and rownum < 200
and i.inventory_item_id = b.inventory_item_id
and i.organization_id   = b.organization_id
order by SCORE(100)
/

The query will probably return ORA errors that indicate that the problem is 
with the environment, and not with the Oracle iStore 11i product search.

If the query returns search results instead, then file a bug on Oracle iStore 11i 
(product code 384, component SEARCH).
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� If you get the error "IBE_DSP_J_GET_ITM_LST_FAIL: Unable to get list of 
product items in Merchant UI" when you try to perform a product search in the 
Merchant UI, then you are not including the wildcard character % in your 
search keyword. You must enter the wildcard character if you do not know the 
exact name of the product that you want. Alternatively, you can apply patch 
1460870 to modify the code so that a wildcard character is automatically 
included if the search keyword field is left blank (null).

8.12 Notifications Errors
Use the following fixes for the errors listed below.

Notifications Subtab Does Not Appear in Merchant UI
If the Notifications subtab does not appear in the Merchant UI’s Setup tab, use the 
following procedure to include it.

Steps
1. Create the notification function as follows:

a. Log into Oracle Forms with the Application Developer responsibility.

b. Choose Application > Function.

The Form Functions window opens.

c. In the Description tab, enter IBE_WF_NOTIFICATIONS in the Function 
field.

d. In the Description tab, enter iStore Notifications in the User 
Function Name field.

e. In the Web HTML field, enter ibemndsetup.jsp in the HTML Call field. 

f. Save this record.

2. Add the notification function to the Setup tab submenu as follows:

a. Log into Oracle Forms with the System Administrator responsibility.

b. Choose Application > Menu.

The Menus form opens.

c. Choose View > Find, or click the flashlight icon on the toolbar to search for 
the Setup tab submenu.
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The Find Menu window opens.

d. In the Find field, search for and select @Setup.

The Menus form for @Setup (IBE_SETUP) opens.

e. Add a new record to the menu entries, with the following values:

– In the Seq field, enter 04.

– In the Prompt field, enter Notifications.

– In the Function field, choose iStore Notifications from the LOV.

– In the Description field, enter Setting up the workflow 
notifications.

f. Save your changes and quit Oracle Forms.

3. Launch the Oracle iStore 11i Merchant UI. 

The Notifications subtab should now appear.

Notifications Are Not Delivered or Have Errors
This error occurs if you did not remove the access locks from the messages and 
items of the Oracle iStore 11i-related Oracle Workflow definition before upgrading 
Oracle iStore 11i. The patch or upgrade cannot overwrite the Oracle Workflow 
definition if you do not first remove the access locks. 

Use the following procedure to back up the necessary customized messages, 
remove the access locks, and apply the patch or upgrade again to fix this error.

Steps
1. Open the Oracle Workflow data store file (IBENOTIF.wft) that contains this item 

type.

2. In Oracle Workflow Builder, back up the item type iStore Alerts Workflow 
(IBEALERT) as follows:

a. Choose File > Save As.

The Save As window opens.

b. In the Save As window, highlight the File radio button, enter the file name, 
and click OK.
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3. Unlock all seeded objects, such as messages, in the database copy of the item 
type iStore Alerts Workflow (IBEALERT). To do so, perform the following steps 
for each seeded Oracle Workflow object in the item type:

a. Select the object.

b. Choose Edit > Properties.

The Navigator Control Properties window opens.

c. In the access tab, uncheck the options Preserve Customizations and Lock at 
this Access Level.

d. Click OK.

4. Save the Oracle Workflow data store file back to the database. 

5. Apply the patch or upgrade to overwrite the existing Oracle iStore 11i-related 
Oracle Workflow definitions.

8.13 Storefront Reports Errors
If the Reports tab does not appear in the Merchant UI, use the following procedure 
to make the tab appear in the application menu. You can also use this procedure to 
add the Reports tab to other applications’ menus.

Steps
1. Log in to Oracle Forms with the System Administrator responsibility.

2. Choose Application > Menu.

The Menus form opens.

3. Place the cursor in the Menu field.

4. Choose View > Find, or click the flashlight icon on the toolbar to search for 
iStore menus.

The Find Menu window opens.

5. In the Find field, enter iStore.

The iStore menu values appear in the Find Menu window.

6. Select iStore and click OK.

The Menus form for iStore (IBE_ALL_ROOT) opens.
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7. Add a new record to the menu entries, with the following values:

a. In the Seq field, enter 09.

b. In the Prompt field, enter Reports.

c. In the Submenu field, choose iStore Report Menu from the LOV.

8. Save your changes and quit Oracle Forms.

9. Restart the Apache server.

10. Launch the Oracle iStore 11i Merchant UI. 

The Reports tab should now appear.

8.14 Postsales Errors
To fix issues with Postsales, first verify that the following prerequisites were done.

� All the views in Postsales are “VALID” in the database.

� Regions exist in Apps. Use the developer responsibility AK Developer or Apps 
for the Web Manager.

� Shipments, invoices and payments were created by the merchant through ERP 
applications before trying to view them in Oracle iStore 11i.

Order Summary Page Records Out of Sequence
If the order summary page records are out of sequence, use search to locate an 
order.

Order Feedback Queue Errors
If you are experiencing order feedback queue errors, see Oracle Order Capture 
Implementation Guide for troubleshooting instructions.

Note: If you want to add the Reports tab to another application’s 
menu, choose that menu instead. Users must have the IBE_
ADMINISTRATOR responsibility before they can view Oracle 
iStore 11i Data Out Bins in another application.
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8.15 Potential Issues Installing Oracle8i interMedia Text Version 8.1.7
Use the following procedures to troubleshoot problems installing Oracle8i 
interMedia Text Version 8.1.7.

8.15.1 Manually Installing ctxsys Data Dictionary
Data Dictionary Installation interMedia Text is integrated with the Oracle Database 
Creation Assistant (DBCA) so the ctxsys data dictionary should be installed when 
using this tool. If the ctxsys data dictionary does not install, use the following 
procedure to install it manually.

Prerequisites
� The interMedia Text files are installed.

� The database does not have a ctxsys user.

� The current directory is ?/ctx/admin.

� You can sqlplus internal.

Steps
1. Create the ctxsys user and pass it the ctxsys password, default tablespace, and 

temporary tablespace as arguments.

sqlplus internal @dr0csys <password> <def_tblspc> <tmp_tblspc> 

2. Install the data dictionary: 

sqlplus ctxsys/<password> @dr0inst <ctxx_library> 

The argument is the full path to the ctxx library, for instance: 

sqlplus ctxsys/<password> @dr0inst $ORACLE_HOME/ctx/lib/libctxx8.so 

3. Install appropriate language-specific default preferences. There are more than 
forty scripts in ?/ctx/admin/defaults that create language-specific default 
preferences. They are named in the form drdefXX.sql, where XX is the language 
code (from the Server Reference Manual).

For instance, to install the US defaults:

sqlplus ctxsys/<password> @defaults/drdefus.sql

interMedia Text should now be installed and working.
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8.15.2 Post-Installation Setup
If this database was an existing ConText site, make sure to remove text_enable from 
the init.ora. It is no longer used in Oracle8i, and will actually prevent Oracle8i from 
operating properly. You will get errors such as “Cannot find package DR_
REWRITE.”

Ensure that the Net8 listener is running and is configured to invoke external 
procedures. A brief description of the process is below, and complete details are in 
Oracle8i Server Administrator’s Guide.

Steps
1. Add an entry to the tnsnames.ora:

extproc_connection_data =
  (DESCRIPTION =
     (ADDRESS = (PROTOCOL = ipc)
                (KEY = DBSID))
     (CONNECT_DATA = (SID = ep_agt1)))

DBSID is the database SID. ep_agt1 can be named anything.

extproc_connection_data should not be changed.

2. Add the following to the listener SID_LIST: 

SID_DESC = (SID_NAME = ep_agt1)
           (ORACLE_HOME = /oracle) 
           (ENVS = LD_LIBRARY_PATH=/oracle/ctx/lib)
           (PROGRAM = extproc))

ep_agt1 matches the CONNECT_DATA SID for extproc_connection_data in the 
tnsnames.ora. The PROGRAM section tells the Net8 listener to start the external 
procedure process. The ENVS section, which is shown here for UNIX, will 
ensure that the environment includes ?/ctx/lib in LD_LIBRARY_PATH. This is 
needed so that indexing can use the INSO filters.

3. Since the extproc_connection_data ADDRESS section specifies ipc, make sure 
that the ADDRESS_LIST of listener.ora accepts ipc connections.

A quick way to test the Net8 configuration is to do: 

exec ctx_output.start_log(’log’) 

from SQL*Plus. If the setup was not performed correctly, you get the error, 

DRG-50704: Net8 listener is not running or cannot start external procedures.
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To troubleshoot this error, check the following possible causes: 

� listener is not running.

� listener.ora is not configured for extproc.

� tnsnames.ora is not configured for extproc.

� listener does not accept ipc connections.

8.16 Reporting Issues
Use the following guidelines to report problems and file bugs.

Check store functionality in the following order:

1. Check whether all server processes (Oracle, TNS listener, WebDB listener, 
Forms server, Reports server, Apache, etc.) are up and running.

2. Check Oracle CRM Technology Foundation (JTT) login by going to:

http://<host>:<apache port>/html/jtflogin.jsp

and trying to log in as SYSADMIN. If login fails, the problem is with JTT. File a 
bug on JTT (product code 1199).

3. Check the Oracle iStore 11i Merchant UI by logging in to:

http://<host>:<apache port>/OA_HTML/jtflogin.jsp

with a store manager user name. (See Section 5.1, "Setting Up Store Manager 
User Accounts" for more information on creating the user name.) If login fails, 
the problem is with the Merchant UI. File a bug on Oracle iStore 11i (product 
code 384, component SPCLTYSTR).

4. Check the Customer UI by going to:

http://<host>:<apache port>/OA_HTML/ibeCZzdMinisites.jsp

and seeing if the store comes up. If not, file a bug on Oracle iStore 11i (product 
code 384). Use the error message as guidance for which component to specify in 
the bug.
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5. If the store comes up but there are problems adding items to the shopping cart 
and/or placing orders, check if Oracle Order Capture is working. Log in to 
Oracle Forms with the Order Capture Sales Manager responsibility, choose 
Order Capture, and enter a quote. (Refer to Oracle Order Capture Concepts and 
Procedures for instructions.) If Oracle Order Capture is not working, file a bug 
on Oracle Order Capture (product code 769). If Oracle Order Capture is 
working, file a bug on Oracle iStore 11i (product code 384, component 
SHPCRT).

Note: Make sure you have set up the guest user account before 
checking the Customer UI. See Section 5.3, "Setting Up the Guest 
User Account" for more information.
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Integrating Oracle iStore 11i with Oracle

Advanced Supply Chain Planning

This chapter describes the integration of Oracle iStore 11i with Oracle Advanced 
Supply Chain Planning. Topics include:

� Overview of Oracle Advanced Supply Chain Planning

� Setting Up Oracle Advanced Supply Chain Planning
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9.1 Overview of Oracle Advanced Supply Chain Planning
Oracle Advanced Supply Chain Planning is a comprehensive, Internet-based 
planning solution that decides when and where supplies such as inventory, 
purchase orders, and work orders should be deployed within an extended supply 
chain. It performs the supply planning function. Oracle Advanced Supply Chain 
Planning addresses the following key supply planning issues:

� Planning your supply chain in the least amount of time possible

� Minimizing the number of plans and iterations

� Planning your entire supply chain

� Involving your trading partners

� Accessing your plan from anywhere

� Improving your plans

� Planning all manufacturing methods

9.2 Setting Up Oracle Advanced Supply Chain Planning
Set up Oracle Advanced Supply Chain Planning for Global ATP if you want to 
provide global inventory availability information to your customers. As part of the 
rules for determining availability, you can provide sourcing rules that encompass 
orders already placed, open purchase orders, and other availability factors. 

To set up the dependencies for ATP, perform the following tasks:

� Set up ATP in Oracle Manufacturing.

� Define ATP sourcing rules in Oracle Inventory.

� Enable product items for ATP by setting their ATP and ATP component flags in 
Oracle Inventory.

� Define an application instance.

For more details, refer to Oracle Advanced Planning and Scheduling Implementation and 
User's Guide, Oracle Inventory User’s Guide, and Oracle Order Management User’s 
Guide.

You must also set up Oracle Material Requirements Planning. See Oracle Master 
Scheduling/MRP and Oracle Supply Chain Planning User's Guide for more information.
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 Integrating Oracle iStore 11i with Oracle

Configurator

This chapter describes the integration of Oracle iStore 11i with Oracle Configurator. 
Topics include:

� Overview of Oracle Configurator

� Creating Configurable Product Models

� Oracle iStore 11i Functionality with Oracle Configurator

� Setting Up Oracle Configurator

� Testing the Oracle Configurator Setup

� Troubleshooting Oracle Configurator Integration
gurator 10-1



Overview of Oracle Configurator
10.1 Overview of Oracle Configurator
Oracle Configurator allows user configuration of complex items. It also provides 
guided selling, where the user is offered a list of choices or sequential questions to 
create a hierarchical list of items to view and purchase. Oracle Configurator is used 
to create product models and to help the buyer assemble related and dependent 
products in the shopping cart.

10.2 Creating Configurable Product Models
You can use the Configurator Developer UI to create the product models for 
dependent and related products, and to build rules around the products.

To be configurable in Oracle iStore 11i, a product model must have the following 
characteristics:

� The model and its associated option classes and standard items are defined in 
the Master Inventory Organization and assigned to the shipping organization.

� The model has a BOM item type of "Model" in Oracle Inventory, and its 
associated options have a BOM item type of "Option Class."

� The model and its associated options are published and orderable on the Web.

� The model and its associated option classes have a BOM structure defined in 
Oracle Bills of Material.

� The model and its components have been added to a price list. You can set the 
price of the option classes to zero if necessary, but they must be assigned to a 
price list.

� You have transferred the model and its components to the Oracle Configurator 
schema by running the Populate Configuration Models concurrent program 
from Oracle Manufacturing. (Choose Flow Manufacturing > Setup > Other > 
Configurator > Populate Configuration Models.)

� If you changed the model and its components in Oracle Order Management 
after you populated it into the Oracle Configurator schema, then you must run 
the Refresh Configuration Models concurrent program from Oracle 
Manufacturing. (Choose Flow Manufacturing > Setup > Other > Configurator 
> Refresh Configuration Models.)

The product models are imported initially from BOM models. You can use the 
Configurator Developer UI to create a tree structure for the product model. For 
example, if customers want to build their own laptops from a store of electronic 
items, then you can use the Configurator Developer UI to define the structure and 
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the dependent (mandatory and optional) products (e.g., a 15” or 17” screen with 
16MB or 32MB RAM and 6GB or 8GB drive).

10.3 Oracle iStore 11i Functionality with Oracle Configurator
When the customer is browsing items in an Oracle iStore 11i store, a Configure 
button appears next to each configurable item. Configurable items have a BOM item 
type of "Model" in Oracle Inventory and are associated with a Configurator UI.

When the user clicks Configure, the store sends a message to populate the 
Configurator UI with the item ID. The Configurator UI appears in the frame 
provided in an Oracle iStore 11i page. Here, the related or dependent products can 
be assembled for placing the order. Once the customer has finished building the list 
of selected items for the order, clicking Done in the Configurator UI’s top menu bar 
places all the items in the shopping cart. The configuration must be complete and 
valid before the customer can add it to the shopping cart.

Launching Oracle Configurator from Oracle iStore 11i is not supported if users are 
connected to your stores through Secure Socket Layer (SSL) network connections.

See Oracle Configurator Developer User’s Guide for detailed setup documentation.

10.3.1 Retrieving the Configurator UI 
Oracle iStore 11i gets the Configurator UI via the Oracle Configurator Servlet URL, 
which handles all interaction between the client and the server. The URL is the 
location where the Oracle Configurator servlet resides. The installer of the servlet 
sets up this URL. For example, the URL could be

http://apps-server-host:8800/oa_servlets/oracle.apps.cz.servlet.UiServlet

The server and directory structure are installation-specific information that the 
calling application must read, but the oracle.apps.cz.servlet.UiServlet 
portion is always the same. Oracle iStore 11i reads this URL from the profile option 
BOM: Configurator URL of UI Manager. Set this profile option to the correct URL. 
You must also set the profile option ASO: Configurator URL to the same URL.
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10.3.2 Changing the Oracle Configurator UI
The Configurator UI is created with DHTML or a Java applet. The look and feel are 
similar to the Oracle iStore 11i UI. If you want to change the Configurator UI, you 
can modify the HTML templates for Oracle Configurator. These templates are 
loaded in Oracle iStore 11i’s html directory on the same server by default. The 
Oracle Configurator data is stored in the CZ tables in the APPS schema.

If you change the UI for a model in Oracle Configurator Developer, you must restart 
the Apache server and clear the cache before the new UI is available in Oracle iStore 
11i.

10.4 Setting Up Oracle Configurator
Use the following procedure to integrate Oracle iStore 11i with Oracle Configurator.

Prerequisites
� Rapid Install is complete.

� The file env.txt, located in the $COMMON_TOP/html directory, defines the 
directory that the variable $FND_TOP represents. The content of the file should 
be similar to the following example:

FND_TOP=/<root path>/<database or environment name>/fnd/11.5.0

� You have set up and tested the Oracle Configurator servlet.

� You have built Configurator UIs for the configurable items that you plan to sell.

Steps 
1. In Oracle Inventory, make sure that every item that can be shown for a 

configured item, from the root model item to every option class and every leaf 
node, is set with the following flags in the Master Item form:

� Web Status = Published

� Orderable on the Web

� Customer Orders Enabled

2. In Oracle Pricing, make sure that every item that can be shown for a configured 
item is added to the price list that will be used by the store and customer, even 
if it has a zero price.
10-4 Oracle iStore Implementation Guide



Setting Up Oracle Configurator
3. Log in to Oracle Forms with the System Administrator responsibility and set 
the profile option BOM: Configurator URL of UI Manager at site, iStore 
application, and IBE_CUSTOMER responsibility level to the Oracle 
Configurator Servlet URL:

http://<host>:<apache port>/<servlet zone>/oracle.apps.cz.servlet.UiServlet

The values for the host, Apache port, and servlet zone are determined by your 
Apache server configuration. See Section A.11, "Oracle Bills of Material (BOM) 
Profile Options" for more information about this profile option. 

4. Set the profile option ASO: Configurator URL to the same value as BOM: 
Configurator URL of UI Manager. See Section A.8, "Oracle Order Capture 
(ASO) Profile Options" for more information about this profile option.

5. Edit the database instance’s Database Configuration (".dbc") file. The .dbc file 
enables connection to the database and is installed in the $FND_TOP/secure/ 
directory. The following edits are required in addition to any configuration 
settings that are required by other Oracle applications:

� Only Oracle thin drivers are supported, so uncomment: APPS_JDBC_
DRIVER_TYPE=THIN 

� Add the following line and replace the item between brackets with the 
appropriate value: BATCH_VALIDATE_USER=[Applications Username 
of the Guest] 

� Add the following line and replace the item between brackets with the 
appropriate value: BATCH_VALIDATE_PWD=[Applications Password 
of the Guest] 

� Uncomment the following line and replace "host_name" with the 
appropriate value: DB_HOST=host_name 

� Uncomment the following line and replace "port_number" with the 
appropriate value: DB_PORT=port_number 

� Uncomment the following line and replace "database_name" with the 
appropriate value: DB_NAME=database_name 

6. The jserv.properties file must have the template URL defined as follows (these 
URLs must be able to be resolved when entered into a browser): 

wrapper.bin.parameters=-Dcz.uiservlet.templateurl=http://<host>:<apache 
port>/OA_HTML/US/czFraNS.htm 
wrapper.bin.parameters=-Dcz.uiservlet.templateurl.ie=http://<host>:<apache 
port>/OA_HTML/US/czFraIE.htm 
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7. In the Oracle iStore 11i Merchant UI, add the model item to some part of the 
catalog to be displayed.

10.5 Testing the Oracle Configurator Setup
Use the following procedure to test the Oracle Configurator setup.

Prerequisites
You have enabled cookies for both the browser and the middle tier. Oracle 
Configurator requires cookies.

Steps
1. Test that the Oracle Configurator middle tier servlet is running and getting the 

Oracle Configurator version, by entering the following URL in the browser:

http://<host>:<apache port>/<servlet zone>/oracle.apps.cz.servlet.UiServlet? 
test=version

The browser should return a message similar to the following statement:

Using configuration software build: 11.5.1.14.27 Expecting schema: 14c

2. Create the Configurator Standalone Test Page by writing the following lines 
into an HTML file with an .htm file name extension.

<!--========================================================================
 |      Copyright (c)2000 Oracle Corporation, Redwood Shores, CA
 |                         All rights reserved. 
 +==========================================================================
 |
 | FILE
 |   Configurator Standalone Test Page
 |
 | DESCRIPTION
 |   This page posts an initialize message to the Configurator Servlet
 |   in order to provide an test of the middle tier, isolated from the
 |   rest of iStore.
 |
 |   To use this page, read the comments below and replace the values in [] 
 |   with values specific to your implementation. Remove the []’s too.  
 |   Remember to edit the form action near the bottom of the page.
 |   Then open the page in a browser and click the Launch DHTML button.
 |
 +=======================================================================-->
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<HTML>
<HEAD>
<TITLE>Configurator Standalone Test Page</TITLE>
<SCRIPT LANGUAGE=javascript>
<!--
  //globals
        var ns4 = (document.layers)? true : false;
        var ie4 = (document.all)? true : false;

        function submitXML1 () {
          var xmlValue = ’’;
          xmlValue += ’<initialize>’;
//Replace the file name with the implemented dbc filename:
          xmlValue += ’<param name="database_id">[dbcfilename.dbc]</param>’;
//Replace the value with the inventory info of the configurable model item:
          xmlValue += ’<param name="model_id">[1234]</param> ’;
          xmlValue += ’<param name="model_uom">[Ea]</param> ’;
          xmlValue += ’<param name="model_quantity">1</param> ’;
//Try to use an icx session ticket retrieved from a logged init message
          xmlValue += ’<param name="icx_session_ticket">CB3E55CF36C0AECD
            </param> ’;
//This responsibility ID is currently irrelevant
          xmlValue += ’<param name="responsibility_id">22372</param> ’;
//Enter the appropriate application ID (usually, it will be 671 for iStore)
          xmlValue += ’<param name="calling_application_id">[671]</param> ’;
//Enter the organization ID for the configurable item:
          xmlValue += ’<param name="context_org_id">[123]</param> ’;
//Use any date earlier than the current sysdate
          xmlValue += ’<param name="config_creation_date">[06-1-2000] 
            </param> ’;
//Do not change the UI type for this test:
          xmlValue += ’<param name="ui_type">DHTML</param>’;
//If the jserv properties are not correctly defined, the template URL can be 
//defined here:
//        xmlValue += ’<param name="template_url"> 
//          http://[machine]:[port]/OA_HTML/US/czIFrame.htm</param>’;

//Alternate way of connecting to the database if the dbc file is not working 
//(replaces database_id)
//        xmlValue += ’<param name="alt_database_name"> 
//          jdbc:oracle:thin:@[machine]:[port]:[sid]</param>’;
//        xmlValue += ’<param name="user">[login]</param>’;
//        xmlValue += ’<param name="pwd">[password]</param>’;
//        xmlValue += ’<param name="gwyuid">[login]/[password]</param>’;
//Alternate way of specifying which DHTML UI to launch (replaces model_id 
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//and context_ord_id)
//        xmlValue += ’<param name="ui_def_id">[1234]</param>’;

          xmlValue += ’</initialize>’;
          submitXML (xmlValue);
        }

        function submitXML (xml) {
          if (ns4) {
            document.form1.XMLmsg.value = xml;
            document.form1.submit ();
          } else if (ie4) {
            form1.XMLmsg.value = xml;
            form1.submit();
          }
        }
//-->
</SCRIPT>
</HEAD>
<BODY>
<FORM 
action="http://[machine]:[port]/servlets/oracle.apps.cz.servlet.UiServlet" 
method=POST
id=form1 name=form1>
<input type="hidden" name="XMLmsg" value=’’>
</FORM>

<FORM action="" method=POST id=form2 name=form2>
<INPUT type="button" value="Launch DHTML" id=button1 name=button1 
onclick="javascript:submitXML1();">
</FORM>
</BODY>
</HTML>

3. Edit the fields in the Configurator Standalone Test Page as explained in the 
comment lines.

4. Open the Configurator Standalone Test Page in a browser.

5. In the Configurator Standalone Test Page, click Launch DHTML. 

The UI should appear.
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10.6 Troubleshooting Oracle Configurator Integration
This section lists checkpoints and fixes that you can use to resolve common Oracle 
Configurator integration errors. You can also use the Oracle Configurator initialize 
and terminate messages in the Oracle iStore 11i Java log file as diagnostic tools.

10.6.1 The Initialize and Terminate Messages
The Oracle iStore 11i Java log file displays the XML messages that launch and close 
Oracle Configurator. Search for the words "initialize_string" and "terminate 
message" to find the XML strings that are used to launch and return from Oracle 
Configurator, respectively. See Section 10.6.2, "Common Oracle Configurator 
Integration Errors" for instructions on reviewing these messages for possible errors. 

The Initialize Message
The initialize message should be similar to the following example:

<initialize xmlns:cfg="http://appsserverhost/apps/cz/cz-javaClient.dtd">
<param name="database_id">ap123sun_dbc</param>
<param name="icx_session_ticket">26A50EB218A8C8D6</param>
<param name="ui_type">DHTML</param>
<param name="context_org_id">204</param>
<param name="model_id">137</param>
<param name="model_quantity">1</param>
<param name="model_uom">Ea</param>
<param name="config_creation_date">07-30-2001-11-14-39</param>
<param name="calling_application_id">671</param>
<param name="responsibility_id">22372</param>
<param name="ibe_back_fail">ibeCScdViewA.jsp</param>
<param name="ibe_back_success">ibeCScdViewA.jsp</param>
<param name="return_url">http://ap123sun:12345/html/ibeCFgpRedirect.jsp 
  </param>
<param name="template_url">http://ap123sun:12345/OA_HTML/US/czIFrame.htm 
  </param>
<param name="pricing_package_name">aso_cfg_pub</param>
<param name="price_mult_items_proc">Pricing_Callback</param>
<param name="configurator_session_key">6832-1</param>
<param name="ibe_cart_line_id">6832</param> 
<param name="ibe_cart_id">2634</param> 
</initialize>
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The Terminate Message
The terminate message should be similar to the following example:

<?xml version="1.0"?>
<terminate>
<config_header_id>3240</config_header_id>
<config_rev_nbr>1</config_rev_nbr>
<valid_configuration>true</valid_configuration> 
<complete_configuration>true</complete_configuration> 
<exit>save</exit>
<total_price>782.00</total_price>
<prices_calculated_flag>true</prices_calculated_flag>
<config_outputs> 
---- a series of options like the one following ----
<option>
<ps_node_id>2085</ps_node_id>
<selection_line_id>9664</selection_line_id>
<parent_line_id>9665</parent_line_id>
<quantity>1</quantity>
<list_price>0.00</list_price>
<discounted_price>0.00</discounted_price>
</option> 
---- and then the end ---- 
</config_outputs> 
<config_messages></config_messages> 
</terminate>

A Terminate Message With an Error
A terminate message for an error looks like the following example:

<?xml version="1.0"?> 
<terminate> 
<exit>error</exit> 
<config_messages> 
<message> 
<message_type>error</message_type> 
<message_text>java.lang.NoClassDefFoundError: oracle/apps/cz/logic/Engine 
  </message_text> 
</message> 
</config_messages> 
</terminate>
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10.6.2 Common Oracle Configurator Integration Errors
This section lists checkpoints and fixes for common Oracle Configurator integration 
errors.

Configurable Item Does Not Appear in the Catalog
This error happens when the item is not published to the storefront correctly.

� Check that you have added the item to a published store section.

� In Oracle Inventory, confirm that the item’s Web Status is Published. 

Configure Button Does Not Appear After Generating the Model
This error can happen for a variety of reasons. Use the following checkpoints and 
fixes to resolve the error:

� Make sure the model was populated for the Master Inventory Organization. 
Using the Bills of Material responsibility, run the Populate Configuration 
Models concurrent program for the model and choose the value of the profile 
option IBE: Item Validation Organization for the Organization parameter.

� Check that all of the model’s option classes and components are on the price list 
that is defined for the user, and that they have prices. 

� In Oracle Inventory, check that the item has the properties Orderable on the 
Web and Web Status = Published. 

� Check that a Configurator UI exists for the model, using the following SQL 
query:

select cz_cf_api.ui_for_item
(<item_id>,<org_id>,sysdate,’DHTML’,-1,1234,<appid - iStore is 671>) 
from dual;

For example, see the following SQL statement:

select cz_cf_api.ui_for_item
(137,204,sysdate,’DHTML’,-1,1234,671) 
from dual; 

If the SQL query returns a non-null value, the Configurator UI exists. 

If the query returns a null value, the cause is one of the following cases:

� No Configurator UI exists for the model. You must use Oracle Configurator 
Developer to build a Configurator UI.
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� A Configurator UI exists for the model, but it is not published for the user’s 
application (usually Oracle iStore 11i). In Oracle Configurator Developer, 
check that the model is in Complete status and includes Oracle iStore 11i 
(IBE) as an application, then publish the Configurator UI. If the user’s 
application ID is something other than 671 for Oracle iStore 11i, the model’s 
Configurator UI must be published for that application too. You can check 
the user’s application ID in the cookie and in the initialize message from the 
Oracle iStore 11i Java log file. Once the Configurator UI is published, you 
must restart the Apache server and clear the cache to make the 
Configurator UI available.

� When the Configure button appears for a configurable item after completing 
these fixes or any other fixes, you should first try to add a standard item to the 
shopping cart. If you cannot add the standard item, then the issue is with the 
shopping cart and you will not be able to add a configurable item. 

Clicking the Configure Button Does Not Launch the Configurator UI
This error can happen for a variety of reasons. Use the following checkpoints and 
fixes to resolve the error:

� Make sure the value of the profile option BOM: Configurator URL of UI 
Manager is valid. Remember to check the machine name, domain name, port 
number, and servlet zone. 

� Test that Oracle Configurator itself has been installed correctly and that the 
servlet is running, as described in Section 10.5, "Testing the Oracle Configurator 
Setup".

� Check that the Oracle Configurator HTML pages exist by navigating to:

http://<host>:<apache port>/OA_HTML/US/czIFrame.htm

Your browser should display a row of four buttons, labeled Summary, 
Availability, Done, and Cancel.

� Verify that the database instance’s .dbc file is in the $FND_TOP/secure 
directory.

� Check that the correct $FND_TOP directory is specified in the $COMMON_
TOP/html/env.txt file.

� Check that cookies are turned on for both the browser and the middle tier.
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� Check the Oracle iStore 11i Java log file’s initialize and terminate messages for 
Oracle Configurator. Review the log messages to find possible errors, such as 
references to other environments and missing or incorrect values. 

� Check that Oracle Configurator can run independently of Oracle iStore 11i by 
using the Configurator Standalone Test Page described in Section 10.5, "Testing 
the Oracle Configurator Setup". If you have the initialize message from the 
Oracle iStore 11i Java log file, edit the Configurator Standalone Test Page to 
include the message’s values. When you click Launch DHTML in the page, the 
UI should launch and run, and you should be able to click Done and see 
summary information. If the UI does not launch or you cannot see summary 
information, there is a middle tier setup issue.

Clicking the Configure Button Returns IBE_ORD_CAUGHT_ERR
This error occurs when profile options have not been set up correctly. 

� Verify that all required profile options have been set up.

Blank Screen
This error can occur for a variety of reasons. Check the Oracle Configurator UI log 
files for the errors listed below, and use the fix described for the error. The Oracle 
Configurator UI log files are named cz_exc__.log. They are located in the $OAH_
TOP/util/apache/1.3.9/Apache/logs/ directory or the $APACHE_
TOP/Jserv/logs directory.

� Database Connection Error—The .dbc file has not been set up correctly. Set up 
the .dbc file using the guidelines in Section 10.4, "Setting Up Oracle 
Configurator".

� Socket Connection Error—The Apache server is not running. Restart the 
Apache server.

� Data/End of Communication Error—The Apache server is not running. Restart 
the Apache server.

� Unsatisfied Link Error—The LD_LIBRARY_PATH and shared library linking 
are not correct. Correct the LD_LIBRARY_PATH and shared library linking.

� OCI8/Thick Driver Error—The thin driver is not specified in the .dbc file. Edit 
the .dbc file to specify the thin driver.

� Other Errors—The profile option that identifies the Configurator URL has an 
invalid value. Enter the correct URL as the value of the profile options BOM: 
Configurator URL of UI Manager and ASO: Configurator URL.
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Clicking Done in the Configurator UI Does Not Return User to Cart Page
This error can happen for a variety of reasons. Use the following checkpoints and 
fixes to resolve the error:

� Check that the item configuration is complete and valid.

� Check the terminate message in the Oracle iStore 11i Java log file to see if Oracle 
Configurator returned an error. If so, there is an issue with the Oracle 
Configurator setup.

Items in a Configuration Have Null Descriptions in the Cart
This error happens when the items are not set up correctly in Oracle Inventory.

� In Oracle Inventory, check that the items have the properties Orderable on the 
Web and Web Status = Published. 

Cannot Create an Order with a Configured Item
This error can happen for a variety of reasons. Use the following checkpoints and 
fixes to resolve the error:

� Verify that carts holding only standard items can be placed as orders. If not, 
then the issue is not necessarily related to Oracle Configurator.

� In Oracle Order Management, check that for the Standard transaction type, a 
line flow has been defined for the item’s User Item Type. For example, if the 
User Item Type is ATO Model, then verify that a line flow for the Item Type 
ATO Model has been defined for the Standard transaction type.
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This chapter describes the integration of Oracle iStore 11i with Oracle Contracts for 
Sales. Topics include:

� Overview of Oracle Contracts for Sales

� Oracle iStore 11i Functionality with Oracle Contracts for Sales

� Setting Up Oracle Contracts for Sales
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11.1 Overview of Oracle Contracts for Sales
Oracle Contracts for Sales automates the full life cycle of a contract for online 
selling. You can author, execute and control non-industry specific contracts with 
Oracle Contracts for Sales. Oracle Contracts for Sales also acts as a central repository 
for the collection and dissemination of contract information. It contains all data on 
terms and conditions, deliverables, and parties to the contracts.

11.2 Oracle iStore 11i Functionality with Oracle Contracts for Sales
You can integrate Oracle iStore 11i with Oracle Contracts for Sales to enable contract 
creation and negotiation in Web stores. This contract functionality has two major 
features:

� Customers can review standard terms and conditions in the storefront when 
they proceed to checkout. Oracle iStore 11i retrieves the standard terms and 
conditions from a contract template.

� Customers can accept or reject the contract terms in the storefront. If customers 
reject the terms, Oracle iStore 11i initiates an online contract negotiation process.

You must set up a standard contract template in Oracle Contracts for Sales for use 
with all initial quotes. You can set up different standard contract templates for each 
Oracle iStore 11i customer responsibility.

The following diagram shows the process flow for contract creation and negotiation 
in Oracle iStore 11i.
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Figure 11–1 Process Flow for Oracle iStore 11i Contracts

When customers proceed to checkout with a shopping cart, Oracle iStore 11i 
displays the terms and conditions of the standard contract in the order review page 
and asks the customers to agree or disagree.

If the customers agree with the terms and conditions, they can place the order. At 
this point, a standard contract in the signed state is created if the profile option IBE: 
Create Standard Contract is set to Yes. The standard contract is associated with the 
quote number.

If the customers disagree with the terms and conditions, the following sequence of 
events takes place:

1. Oracle iStore 11i forces the customers to save the shopping cart.
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2. The customers must enter a reason for their disagreement in a text field. These 
comments are associated with the contract created by the application.

3. The standard contract is created and associated with the shopping cart.

4. Oracle iStore 11i sends an e-mail to the sales representative, contract 
administrator, and customer with the quote number and contract ID. The sales 
representative’s e-mail is specified in Oracle Human Resources for each of your 
organizations. The contract administrator is set up in Oracle Contracts for Sales, 
and also in Oracle CRM Application Foundation as a CRM Resource.

5. The contract administrator looks at the quote and the customer’s reason for 
disagreeing with the standard terms and conditions.

6. If the contract administrator approves the requested change in terms and 
conditions, the customer and the sales representative are notified automatically 
through Oracle Workflow. At this point, the customer can either place the order, 
which creates the revised contract in the signed state, or disagree with the terms 
and conditions again, which repeats the process of notifying the contract 
administrator and sales representative. The customer cannot otherwise modify 
the cart.

7. If the contract administrator rejects the requested change in terms and 
conditions, the sales representative is notified and decides whether the contract 
administrator should pursue negotiation or cancel the contract.

8. If the contract administrator pursues negotiation, the negotiation continues 
until the contract is either approved or cancelled.

9. If the contract administrator cancels the contract, the customer cannot modify 
or checkout the shopping cart.

11.3 Setting Up Oracle Contracts for Sales
Use the following procedure to set up contract functionality in Oracle iStore 11i.

Prerequisites
� You have created at least one contract template in Oracle Contracts for Sales. 

See Oracle Contracts for Sales Concepts and Procedures for details.

� The sales representatives and contract administrators have Oracle Applications 
user names. See Oracle Applications System Administrator’s Guide for details.

� Oracle Workflow’s Notification Mailer is set up. See Oracle Workflow Guide for 
details.
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� The contract administrators are set up as employees in Oracle Human 
Resources.

Steps
1. Set the profile options associated with Oracle Contracts integration:

� Set the profile option ASO: Enable Use Contracts to Yes at the iStore 
application level.

� Set the profile options IBE: Create Standard Contract and IBE: Notification 
User Role at the iStore application level according to your business needs.

� Set the profile option IBE: Use Workflow Features in iStore at the iStore 
application level to Yes.

� Set the profile options OKC: Change Request Approver, OKC: Contract 
Approver, OKC: Contract template for standard terms and conditions, 
OKC: Default contract administrator for notifications, OKC: Notify 
administrator about new contract from iStore, and OKC: User Directory.

� Optional: Set the profile option OKC: Default group for contracts created 
from quote.

See Section A.6, "Oracle iStore 11i (IBE) Profile Options for the Customer UI", 
Section A.8, "Oracle Order Capture (ASO) Profile Options", and Section A.12, 
"Oracle Contracts Core (OKC) Profile Options" for profile option descriptions 
and setup procedures.

2. For each of your organizations, set up the default sales representative user who 
will receive the contract-related notifications, as described in Section 5.9.2, 
"Setting Up Notification Recipients".

3. Set up contract administrators as CRM Resources, as follows:

a. Log in to Oracle Forms with the CRM Resource Manager responsibility.

b. Choose Maintain Resources > Import Resources.

The Selection Criterion window opens.

c. Choose Employee from the Resource Category pull-down menu, and enter 
your other search criteria in the Selection Criterion window.

d. Click Search.

The search results appear in the Search Results region of the Selection 
Criterion window.
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e. Check the Select checkbox next to the person that you are setting up as a 
contract administrator. 

f. Click Create Resource.

The Default Values window opens.

g. Optional: You can enter active dates, manager’s name, and role information 
in this window.

h. Click OK.

The Selected Resources window opens, showing the contract administrator 
as a resource.

i. Check the Select checkbox next to the contract administrator’s resource 
record and click Save Resource.

The contract administrator is now saved as a CRM Resource.

j. Click Details.

The Resource form for the contract administrator opens.

k. In the Roles tab, choose Contracts from the Role Type LOV and Contracts 
Administrator from the Role LOV.

l. Save the record.

m. Switch to the System Administrator responsibility, and make sure the 
contract administrator has a user name.

4. Set up the workflow for notifications that are sent to contract administrators, as 
follows:

a. Log in to Oracle Forms with the System Administrator responsibility.

b. Choose Requests > Run.

The Submit a New Request window opens.

c. Choose Single Request and click OK.

The Submit Request window opens.

d. Choose Workflow Background Process from the Name LOV.

The Parameters window opens.

e. Set the following parameters for the item type Contract Approval and click 
OK:
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– Item Type: Contract Approval

– Process Deferred: Yes

– Process Timeout: Yes

The Submit Request window is populated with these parameters.

f. Place the cursor in the Parameters field.

The Parameters window opens.

g. Set the following parameters for the item type Contract Alert and click OK:

– Item Type: Contract Alert

– Process Deferred: Yes

– Process Timeout: Yes

The Submit Request window is populated with these parameters.

h. Click Submit to submit the request.

5. Set up contracts-related notifications for customers and sales representatives in 
Oracle Workflow and Oracle iStore 11i. See Section 5.9, "Setting Up 
Notifications" and Chapter 17, "Integrating Oracle iStore 11i with Oracle 
Workflow" for details.
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12.1 Overview of Oracle iPayment
Oracle iPayment provides an integrated electronic payment solution for both 
electronic commerce applications and client-server applications. It offers 
user-friendly access and control of payment processing to these applications. Oracle 
iPayment supports two electronic payment methods: credit card payments and 
bank account transfers. It also supports payment partners.

Oracle iPayment has easy installation, administration, and extension capabilities. Its 
risk management functionality can quantify and identify fraudulent online 
transactions for both B2B and B2C models.

Because there are few standards in electronic commerce and payment processing, 
Oracle iPayment supports several routing options, payment methods, processing 
models, and security features.

12.2 Setting Up Oracle iPayment
If you are planning to provide credit card payment options, then you must set up 
Oracle iPayment to perform credit card authorization and fund capture. In your 
setup, you can determine whether authorization occurs when the order is being 
placed or at a later time. See Oracle iPayment Implementation Guide, Oracle Order 
Management User’s Guide, and Oracle Receivables User’s Guide for additional setups 
required for Oracle iPayment, including how to set up the Oracle iPayment system 
to communicate with the provider networks.

Use the following procedure to set up credit card payment functionality in Oracle 
iStore 11i. 

Steps
1. Log in to Oracle Forms with the System Administrator responsibility.

2. Choose Profile > System. 

3. Query Application = iStore, User = ibe_customer, and set the following 
profile option values at the iStore application level:

a. iStore Setup Profile Options

Set the IBE: Authorize Payment Offline During Normal Checkout profile 
option to No to allow only online authorization.

Set the IBE: Finalize Order On Error in Authorize Payment profile option to 
Yes to submit orders even if the authorize payment error is a system error.
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b. Oracle Order Capture Setup Profile Options

Set the ASO: Credit Card Authorization profile option to No at the iStore 
application level only. (Do not set this profile option at responsibility or 
user level).

4. In Oracle Receivables, make sure the Merchant ID is assigned to the receipt 
method, as follows:

a. Log in to Oracle Forms with the Receivables Manager responsibility.

b. Choose Setup > Receipt > Receipt classes.

c. Query the receipt method with Name = Credit Card.

d. Make sure the Merchant ID field has the same value as the Payee ID of 
Oracle iPayment. (The Merchant ID is the ID that identifies your business 
through the Oracle iPayment server by Payment System, Credit Card 
Vendors and Banks. The Merchant ID that you provide in your receipt class 
is the same as the Payee ID that you have defined in the iPayment 
Administration).

5. Perform the manual post-installation configuration steps for Oracle iPayment as 
described in Oracle iPayment Implementation Guide. You should also be familiar 
with typical Oracle iPayment Administration operations, which are 
documented in Oracle iPayment Concepts and Procedures.

6. To integrate Oracle iPayment with Oracle iStore 11i, create a payee as follows:

a. Go to the Oracle iPayment UI Administration page.

b. In the Payee Tab, click Create.

c. Fill in the form.

Payee Identifier should have the same value as the Merchant ID in 
Accounts Receivable, or else integration will fail.

d. Check the Credit Card check box.

7. Click Create to save the record.

Oracle iStore 11i uses customers’ account ID numbers to store and track their credit 
card numbers in the AP_BANK_ACCOUNT_USES_ALL table, as per the TCA 
model and inline with the Oracle Receivables Forms UI.
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13.1 Overview of Oracle iSupport
Oracle iSupport is a comprehensive Web-based customer service portal that 
empowers the users to receive self service and assisted service over the Internet. It 
provides a personalized self service experience to users for many functions.

A large majority of customer support questions are repetitive. By empowering the 
users to request service for their common support questions over the Internet and 
offering automated response mechanisms, Oracle iSupport enables service 
organizations to reduce the total cost of customer support. 

Service organizations can increase customer satisfaction and remain competitive by 
empowering customers through self-service and self-administration. Not only does 
iSupport allows the users to take control of their support experience, but it also 
enables a support organization to provide closed loop customer support by 
seamlessly integrating with Oracle Telephony Manager, the call center-enabled 
agent-facing application. 

Oracle iSupport accomplishes the following goals for a service organization:

� Reduces customer support costs by empowering customers to perform 
self-service tasks such as creating and tracking their service requests

� Enhances customer satisfaction by providing easy access to the same product 
information and knowledge base that the support organization uses to resolve 
customer issues

� Provides real time online transactional inquiries to customers on orders, 
returns, invoices, contracts, and payments

� Provides a platform for users to collaborate among themselves through forums

13.2 Setting Up Oracle iSupport
Oracle iStore 11i provides call-me-back functionality whereby customers can click a 
link in the Customer UI’s welcome bin to request a call from a merchant 
representative. The call request is processed in the Oracle Telephony Manager call 
center.

The callback feature requires integration of Oracle iStore 11i with Oracle iSupport 
and Oracle Telephony Manager. See Oracle iSupport Implementation Guide for details. 
After setting up Oracle iSupport and Oracle Telephony Manager, set the profile 
option IBE: Use Call Me Back to Yes to activate the callback feature. See Section A.6, 
"Oracle iStore 11i (IBE) Profile Options for the Customer UI" for information on 
setting this profile option. 
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� Setting Up Oracle Marketing Online
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14.1 Overview of Oracle Marketing Online
Oracle Marketing Online is a complete marketing automation software application. 
It helps companies to win and retain profitable customers by enabling marketers to 
plan, execute, analyze, and optimize overlapping customer-focused programs.

Oracle Marketing Online provides a complete solution for building targeted 
marketing campaigns, executing campaigns through multiple channels, modifying 
promotions at any time, and measuring the results to determine the most effective 
and profitable marketing activities. This automated, closed loop process enables 
marketers to follow campaigns all the way through from demand creation to 
revenue recognition.

Oracle Marketing Online allows marketers to track, coordinate, and analyze 
marketing results from all communication channels in real time. This capability 
allows marketers to use real-time data for decision making. They can quickly 
allocate additional resources to successful campaigns or redefine targets of 
non-performing campaigns without waiting until a campaign is completed. At any 
point in the campaign execution, marketers can modify any element of the 
campaign and track results accordingly. 

14.2 Setting Up Oracle Marketing Online
You can use the eMerchandising module of Oracle Marketing Online to personalize 
Oracle iStore 11i stores and make recommendations for customers. See Oracle 
Marketing Online Implementation Guide for information about setting up Oracle 
Marketing Online.

Store personalization and customer-specific recommendations are accomplished 
through storefront postings from eMerchandising and store event capture.

14.2.1 Storefront Postings
You can create postings in Oracle Marketing Online’s eMerchandising, create rules 
that determine the content for a given posting, and associate each posting with a 
placement on an Oracle iStore 11i storefront page. You must also set the profile 
option IBE: Use Web Placements to Yes to enable eMerchandising postings in the 
storefront placements.

The placements are bins on the common storefront page layouts. The seeded catalog 
section and item pages each have seven left bins, seven right bins, one top bin, and 
one bottom bin. The seeded shopping cart pages each have one top bin and one 
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bottom bin. Each bin is listed as a separate logical template in the Oracle iStore 11i 
template manager.

After creating eMerchandising postings in Oracle Marketing Online, you modify 
Oracle iStore 11i physical templates to make reference to posting tags, and associate 
each physical template with the logical template for the bin where you want the 
posting to appear.

When a user views your specialty store online, the Oracle iStore 11i template that 
references the posting tag passes the user’s party ID, specialty store, page type 
(section, item, or shopping cart), and top-level section ID or item ID if applicable, to 
Oracle Marketing Online. The Oracle iStore 11i template also passes its bin location. 
Oracle Marketing Online’s eMerchandising module creates a storefront posting for 
the corresponding placement.

The following table lists the logical template names for the bins on the catalog 
section, catalog item, and shopping cart pages. See Oracle iStore Concepts and 
Procedures for more information about customizing the bins.

Table 14–1 Logical Template Names for Bins 

Catalog Section Pages Catalog Item Pages Shopping Cart Pages

STORE_CTLG_BIN_LEFT_1

STORE_CTLG_BIN_LEFT_2

STORE_CTLG_BIN_LEFT_3

STORE_CTLG_BIN_LEFT_4

STORE_CTLG_BIN_LEFT_5

STORE_CTLG_BIN_LEFT_6

STORE_CTLG_BIN_LEFT_7

STORE_CTLG_BIN_RIGHT_1

STORE_CTLG_BIN_RIGHT_2

STORE_CTLG_BIN_RIGHT_3

STORE_CTLG_BIN_RIGHT_4

STORE_CTLG_BIN_RIGHT_5

STORE_CTLG_BIN_RIGHT_6

STORE_CTLG_BIN_RIGHT_7

STORE_CTLG_SECTION_BIN_TOP

STORE_CTLG_SECTION_BIN_
BOTTOM

STORE_CTLG_ITEM_BIN_LEFT_1

STORE_CTLG_ITEM_BIN_LEFT_2

STORE_CTLG_ITEM_BIN_LEFT_3

STORE_CTLG_ITEM_BIN_LEFT_4

STORE_CTLG_ITEM_BIN_LEFT_5

STORE_CTLG_ITEM_BIN_LEFT_6

STORE_CTLG_ITEM_BIN_LEFT_7

STORE_CTLG_ITEM_BIN_RIGHT_1

STORE_CTLG_ITEM_BIN_RIGHT_2

STORE_CTLG_ITEM_BIN_RIGHT_3

STORE_CTLG_ITEM_BIN_RIGHT_4

STORE_CTLG_ITEM_BIN_RIGHT_5

STORE_CTLG_ITEM_BIN_RIGHT_6

STORE_CTLG_ITEM_BIN_RIGHT_7

STORE_CTLG_ITEM_BIN_TOP

STORE_CTLG_ITEM_BIN_BOTTOM

STORE_CART_ITEMS_BIN_
TOP

STORE_CART_ITEMS_BIN_
BOTTOM
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14.2.2 Event Capture
Oracle iStore 11i can capture the following important events during users’ visits to 
Web stores:

� Anonymous user registration

� Registered user login

� Click on an item to view its detail

� Add an item to the shopping cart

� Remove an item from the shopping cart

� Place an order

When an event occurs, Oracle iStore 11i calls an eMerchandising event handler that 
captures the following information:

� Whether the user is anonymous or registered

� Party ID for a registered user

� Unique Cookie ID for an anonymous user

� Item ID

Oracle Marketing Online’s eMerchandising module uses this information to 
enhance personalization of the customer experience.
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15.1 Overview of Oracle Shipping Execution
Oracle Shipping Execution allows you to set up shipping parameters, transportation 
calendars, pick slip rules, container-item relationships, suppliers (freight carriers), 
and document printing.

15.2 Setting Up Oracle Shipping Execution
The Oracle Shipping Execution module must be in place to enable post-order 
tracking and shipping detail views in Oracle iStore 11i. At a minimum, you must 
perform the following tasks when setting up Oracle Shipping Execution:

� Define pick slip grouping rules.

� Define release sequence rules.

� Define shipping parameters.

� Define freight carriers.

� Define carrier-shipping method relationships.

See Oracle Shipping Execution User’s Guide for more information.

Note: Set up shipping methods in Oracle Inventory, not Oracle 
Shipping.
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This chapter describes the integration of Oracle iStore 11i with Oracle Web Cache. 
Topics include:

� Overview of Oracle Web Cache

� Oracle iStore 11i Functionality with Oracle Web Cache

� Setting Up Oracle Web Cache
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Overview of Oracle Web Cache
16.1 Overview of Oracle Web Cache
Oracle Web Cache accelerates Oracle iStore 11i’s non-transactional content, 
including static pages and images, catalog pages, and search results. By 
compressing and caching dynamically generated content, Oracle Web Cache 
reduces the load on the other tiers in the architecture and shortens the amount of 
time required to serve cached content. Once a page is loaded into the cache, other 
requests for the same page are served from the cache memory instead of the 
application server. Through the inclusion of a set of Oracle Web Cache-specific tags 
in the HTML, Oracle Web Cache is also capable of caching content with some 
personalization. Additionally, the cache server can load balance requests across 
multiple HTTP servers.

Oracle Web Cache is compatible with Oracle HTTP Server or any other 
HTTP-compliant application Web server. Possible scenarios for deployment of 
Oracle Web Cache include the following:

� Deploy Oracle Web Cache on the same computer as the application Web server 
or on a separate computer.

� Use Oracle Web Cache as a load balancer or in a Failover pair.

� Install Oracle Web Cache inside or outside the firewall.

16.2 Oracle iStore 11i Functionality with Oracle Web Cache
You can integrate Oracle Web Cache 2.0.0 with the Oracle iStore 11i Customer UI. 
You must deploy Oracle Web Cache in the same domain as the application Web 
servers, because Oracle iStore 11i session cookies are created by application servers 
and are only visible to other servers within the same domain. However, the 
subdomain can be different. 

You can set up Oracle Web Cache to cache and serve catalog JSPs(ibeCCt*.jsp), 
search JSPs (ibeCSr*.jsp, ibeSQtdItemSrch.jsp, ibeSQtpSrch.jsp, and 
ibeSQtpSrpSrchRslts.jsp), and other pages such as style sheet files, static HTML 
pages, GIF and JPG/JPEG image files, JavaScript (*.js) files, and jtfdload.jsp.

See Oracle9iAS Web Cache Administration and Deployment Guide, Release 2.0.0 for more 
information about Oracle Web Cache deployment.
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16.3 Setting Up Oracle Web Cache
Set up Oracle Web Cache to cache and serve Oracle iStore 11i Customer UI pages, 
using the following procedures.

Prerequisites
Your Oracle iStore 11i implementation must meet the following requirements for 
integration with Oracle Web Cache:

� Your stores must not allow Express Checkout. Set the profile option IBE: Use 
Express Checkout to No.

� Your stores must use the specialty store price lists. Set the profile option IBE: 
Use Price List associated with Specialty Store to Yes.

� Set the profile option IBE: Use Web Cache Feature to Yes. This enables Oracle 
iStore 11i to create the cookies that you will set up Oracle Web Cache to use for 
session tracking.

Steps
1. Perform Initial Setup for Oracle Web Cache.

2. Create a Rule for Multiple Documents with Same Selector by Cookies.

3. Create Session/Personalized Attribute Definitions.

4. Create Session/Personalized Attribute Related Caching Rules.

5. Create Cacheability Rules.

6. Create Expiration Rules.

7. Create a Selector Association for the Multiple Documents Rule.

8. Create Selector Associations for Sessions and Personalized Attributes.

9. Set Up Simple Personalization.

Note: The following procedures assume that you want to cache 
search JSPs. However, since search keywords can vary greatly and 
search results can be numerous, you may not want to cache search 
results. In this case, do not complete these procedures for the 
following JSPs: ibeCSr*.jsp, ibeSQtdItemSrch.jsp, ibeSQtpSrch.jsp, 
and ibeSQtpSrpSrchRslts.jsp.
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10. Set Up HTTP Error Caching.

11. Set Up Test Environment.

16.3.1 Perform Initial Setup for Oracle Web Cache
Check your deployment requirements. Make sure the following Oracle Web Cache 
setups are correct:

� Administration Port and Protocol

� Invalidation/Statistics Port and Protocol

� Security

� Resource Limits

� Process Identity

� Apology Pages

� Application Web Servers

� Oracle Web Cache Listen Ports

� Access Logs

See Oracle9iAS Web Cache Administration and Deployment Guide, Release 2.0.0 for more 
information.

16.3.2 Create a Rule for Multiple Documents with Same Selector by Cookies
You can set up Oracle Web Cache to use the Oracle iStore 11i cookie 
"CombinedCookie" to identify multiple versions of the same catalog page based on 
the cookie value and cache the versions separately. The cookie "CombinedCookie" 
combines minisite ID (minisite_id), responsibility ID (resp_id), language (language_
code), and currency (currency_code).

Create a rule for multiple documents with the same selector by the cookie 
"CombinedCookie." You will later create a selector association between this rule and 
the catalog JSPs, as described in Section 16.3.7, "Create a Selector Association for the 
Multiple Documents Rule".

Steps
1. In Oracle Web Cache Manager, choose Multiple Documents with Same 

Selector by Cookies, under Administering Web Sites > Cacheability Rules.
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2. Click Create or Add. 

The Edit/Create Multiple Documents with the Same Selector by Cookies Rule 
window opens.

3. Create the cookie selector for Oracle iStore 11i catalog pages with the following 
parameters, and click Apply Changes when finished:

� Cookie Name = CombinedCookie

� Cache without Cookie = NO

16.3.3 Create Session/Personalized Attribute Definitions
Session tracking does not alter the actual content of a page. Therefore, session 
definitions enable Oracle Web Cache to share the same caches with multiple 
sessions by substituting one user’s session information with another’s based on the 
session information in the session cookies or, if cookies are disabled, the 
corresponding embedded URL parameters. Oracle Web Cache redirects any HTTP 
request that does not include session cookies to the application servers.

Oracle iStore 11i uses the following session cookies:

� JTT Session Cookie

� JServ Session Cookie

� Database Session Cookie

It also uses the URL parameter "jfn."

The session cookies JTT Session Cookie, JServ Session Cookie, and Database Session 
Cookie contain information about the JTT session, JServ session, and database 
session, respectively. The parameter "jfn" contains information about the current 
responsibility ID, application ID, and security ID, to facilitate opening multiple 
applications (responsibilities) simultaneously.

You must create the session definitions JTTSession, JServSession, DbSession, and 
JFNSession so that Oracle Web Cache can track the respective session cookies and 
URL parameter.

You must also create personalized attribute definitions for the Oracle iStore 11i 
cookies "zd," "PersonName," "CartTotal," "SignInOutUrl," and "SignInOutImage." 

The cookie "zd" indicates that you have signed into your store with a store manager 
(IBE_ADMINISTRATOR) responsibility. Logging in as a store manager enables you 
to preview the storefront display of items and sections before they are published to 
your customers, as described in Section 7.1.2, "Previewing Products and Sections". 
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Using the procedure in Section 16.3.4, "Create Session/Personalized Attribute 
Related Caching Rules", you will later set up Oracle Web Cache to cache nothing 
when this cookie exists, to ensure that you are previewing the latest version of the 
pages.

Oracle Web Cache can use the Oracle iStore 11i cookies listed in the following table 
to share the same cache with multiple users by substitution of personalized 
information into the catalog pages’ welcome bin.

Oracle Web Cache’s substitution of personalized information into cached pages is 
called Simple Personalization. ibeCAcdWelcome.jsp, the seeded JSP for the 
welcome bin, includes the Oracle Web Cache tags for Simple Personalization within 
HTML comments, which are transparent to application servers. You will later 
enable Simple Personalization as described in Section 16.3.9, "Set Up Simple 
Personalization".

Steps
1. In Oracle Web Cache Manager, choose Session/Personalized Attribute 

Definition, under Administering Web Sites > Session Management.

2. Click Create or Add. 

The Create/Edit Session/Personalized Attribute Definition window opens.

3. Create the sessions and personalized attributes listed in the following table, and 
click Apply Changes when finished.

Table 16–1 Oracle iStore 11i Cookies for Welcome Bin Personalization 

Cookie Function

PersonName Stores the user’s first and last names

CartTotal Stores the user’s shopping cart amount

SignInOutUrl Stores the sign in and sign out label

SignInOutImage Stores the sign in and sign out icon

Table 16–2 Oracle Web Cache Session and Personalized Attribute Definitions 

Session/Attribute Cookie Name URL Parameter

UserNameCookie PersonName

CartTotalCookie CartTotal
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16.3.4 Create Session/Personalized Attribute Related Caching Rules
You must create caching rules for the sessions and personalized attributes that you 
have defined.

Steps
1. In Oracle Web Cache Manager, choose Session/Personalized Attribute Related 

Caching Rules, under Administering Web Sites > Session Management.

2. Click Create or Add. 

The Add Session/Personalized Attribute Related Caching Rule window opens.

3. Create the caching rules listed in the following table. Click Apply Changes 
when finished.

SignInOutUrlCookie SignInOutUrl

SignInOutImageCookie SignInOutImage

AdminRespCookie zd

DbSession The Database Session Cookie name is <DB_
HOST>_<DB_NAME>, where the values for 
DB_HOST and DB_NAME come from the .dbc 
file in the directory $FND_TOP/secure/.

JFNSession jfn

JServSession The JServ Session Cookie name is set through 
JServ configuration. 

JTTSession The JTT Session Cookie name is <Database 
ID>_<JTT Cookie property value>. You can set 
the property in Oracle Business Center. 

Table 16–3 Oracle Web Cache Session/Personalized Attribute Caching Rules 

Session/Attribute
Cache without 
Session/Attribute

Cache with 
Session/Attribute

Can be derived without 
Session/Attribute

UserNameCookie No Yes No

CartTotalCookie No Yes No

SignInOutUrlCookie No Yes No

Table 16–2 Oracle Web Cache Session and Personalized Attribute Definitions (Cont.)

Session/Attribute Cookie Name URL Parameter
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16.3.5 Create Cacheability Rules
Set up Oracle Web Cache to cache all Oracle iStore 11i catalog pages, except 
ibeCCtpBuyRoute.jsp, for the HTTP methods GET, GET with query string, and 
POST with any parameters. The Oracle iStore 11i catalog pages are named 
ibeCCt*.jsp.

ibeCCtpBuyRoute.jsp is not cacheable because it invokes the real-time shopping 
cart process and is a route page to the shopping cart display page. Oracle Web 
Cache can cache all other catalog route pages if you set it up to accept HTTP 302 as 
a cacheable HTTP response code, as described in Section 16.3.10, "Set Up HTTP 
Error Caching". 

You can also set up Oracle Web Cache to cache the Oracle iStore 11i search pages 
ibeCSr*.jsp, ibeSQtdItemSrch.jsp, ibeSQtpSrch.jsp, and ibeSQtpSrpSrchRslts.jsp for 
the HTTP methods GET, GET with query string, and POST with any parameters. 

Additionally, you can set up Oracle Web Cache to cache style sheet files, static 
HTML pages, GIF and JPG/JPEG image files, JavaScript (*.js) files, and jtfdload.jsp.

You should enable compression of all JSPs and HTML pages, and disable 
compression of images. You can enable or disable compression of JavaScript files 
and style sheets. Style sheets should not be compressed for Netscape browsers.

Steps
1. In Oracle Web Cache Manager, choose Administering Web Sites > 

Cacheability Rules.

2. Select the last default rule and click Insert Below.

The Create Cacheability Rule window opens.

SignInOutImageCookie No Yes No

AdminRespCookie Yes No No

DbSession Yes Yes No

JFNSession Yes Yes Yes

JServSession Yes Yes No

JTTSession No Yes No

Table 16–3 Oracle Web Cache Session/Personalized Attribute Caching Rules (Cont.)

Session/Attribute
Cache without 
Session/Attribute

Cache with 
Session/Attribute

Can be derived without 
Session/Attribute
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3. Create the cacheability rules listed in the following table, and click Apply 
Changes when finished. 

Table 16–4 Oracle Web Cache Cacheability Rules 

Priority URL Expression HTTP Methods
POST Body 
Expression

Cache/ 
No Cache Compress

1 \.pdf$ GET, GET with 
query string

Don’t 
Cache

Off

2 \.html?$ GET, GET with 
query string

Cache On for all 
browsers 

3 \.jpe?g$ GET, GET with 
query string

Cache Off

4 \.gif$ GET, GET with 
query string

Cache Off

5 \.js$ GET, GET with 
query string

Cache On for all 
browsers, or off

6 \.css$ GET, GET with 
query string

Cache On for 
non-Netscape 
browsers, or off

7 /OA_HTML/ibeCCtpBuyRoute\.jsp.* N/A Don’t 
Cache

On for all 
browsers 

8 /OA_HTML/ibeCCt.*\.jsp.* GET, GET with 
query string, 
POST

.* Cache On for all 
browsers 

9 /OA_HTML/jtfdload.jsp GET, GET with 
query string

Cache Off

10 /OA_HTML/ibeCSr.*\.jsp.* GET, GET with 
query string, 
POST

.* Cache On for all 
browsers 

11 /OA_HTML/ibeSQtdItemSrch\.jsp.* GET, GET with 
query string, 
POST

.* Cache On for all 
browsers 

12 /OA_HTML/ibeSQtpSrch\.jsp.* GET, GET with 
query string, 
POST

.* Cache On for all 
browsers 

13 /OA_HTML/ibeSQtpSrpSrchRslts\.jsp.* GET, GET with 
query string, 
POST

.* Cache On for all 
browsers 
Integrating Oracle iStore 11i with Oracle Web Cache 16-9



Setting Up Oracle Web Cache
16.3.6 Create Expiration Rules
When you change catalog content, Oracle Web Cache does not automatically 
invalidate cached pages. You must define expiration rules based on a time interval 
or invalidate cached pages manually in Oracle Web Cache Manager. Expiration 
rules specify when documents expire in the cache, and how long documents can 
reside in the cache after they expire.

You should set up your expiration rules according to your content management 
needs. Since Oracle iStore 11i JSPs and HTML pages do not include expiration 
headers, you cannot set up expiration rules for these pages using "As per HTTP 
Expires header." 

Here is an example of some expiration rules that you can define:

� Invalidate all scripts, style sheet files, cached JSPs, and cached HTML pages 
every two hours after cache entry, then refresh them within two minutes based 
on the application servers’ capacity.

� Invalidate all image files every two days after cache entry, then refresh them 
within five minutes based on the application servers’ capacity.

To set up these sample expiration rules, use the following procedure.

Steps
1. In Oracle Web Cache Manager, choose Expiration Rules, under Administering 

Web Sites > Cacheability Rules.

2. Click Create or Add. 

The Create Expiration Rule window opens.

3. Create the expiration rules and selector associations listed in the following 
table, and click Apply Changes when finished.
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16.3.7 Create a Selector Association for the Multiple Documents Rule
Create a selector association to associate catalog JSPs with the rule for multiple 
documents with the same selector by the Oracle iStore 11i cookie 
"CombinedCookie."

Steps
1. In Oracle Web Cache Manager, choose Multiple Documents with Same 

Selector by Cookies, under Administering Web Sites > Cacheability Rules.

2. Select the rule for the cookie name "CombinedCookie."

3. Click Change Selector Association. 

The Change Policy-Selector Association window opens.

4. Create an association between the selector /OA_HTML/ibeCCt.*\.jsp.* and 
the rule. Click Apply Changes when finished.

Table 16–5 Oracle Web Cache Expiration Rules 

Expire After Expiration Selector Association

7200 seconds after 
cache entry

Refresh on demand as 
application web server 
capacity permits AND no later 
than: 120 seconds after 
expiration. 

\.html?$ 

\.css$ 

\.js$

/OA_HTML/ibeCCt.*\.jsp.*

/OA_HTML/ibeSQtdItemSrch\.jsp.*

/OA_HTML/ibeCSr.*\.jsp.* 

/OA_HTML/ibeSQtpSrch\.jsp.* 

/OA_HTML/ibeSQtpSrpSrchRslts.jsp.*

172800 seconds 
after cache entry

Refresh on demand as 
application web server 
capacity permits AND no later 
than: 300 seconds after 
expiration. 

\.jpe?g$

\.gif$

/OA_HTML/jtfdload\.jsp.*
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16.3.8 Create Selector Associations for Sessions and Personalized Attributes
You must associate the selectors that are listed in your cacheability rules with the 
sessions and personalized attributes that you have defined. Apply the session 
definitions JTTSession, JServSession, DbSession, and JFNSession to all cached JSPs. 
Do not bind them to other cached files, such as image files and scripts.

Steps
1. In Oracle Web Cache Manager, choose Session/Personalized Attribute Related 

Caching Rules, under Administering Web Sites > Session Management.

2. Select a session or attribute.

3. Click Change Selector Association. 

The Change Policy-Selector Association window opens.

4. Create the selector associations listed in the following table for each session and 
attribute. Click Apply Changes when finished.

Table 16–6 Oracle Web Cache Session/Personalized Attribute Selector Associations 

Session/Attribute Selector Associations

UserNameCookie /OA_HTML/ibeCCt.*\.jsp.*

CartTotalCookie /OA_HTML/ibeCCt.*\.jsp.*

SignInOutUrlCookie /OA_HTML/ibeCCt.*\.jsp.*

SignInOutImageCookie /OA_HTML/ibeCCt.*\.jsp.*

AdminRespCookie \.html?$

\.jpe?g$

\.gif$

\.js$

\.css$

/OA_HTML/ibeCCt.*\.jsp.*

/OA_HTML/jtfdload.jsp

/OA_HTML/ibeCSr.*\.jsp.*

/OA_HTML/ibeSQtdItemSrch\.jsp.*

/OA_HTML/ibeSQtpSrch\.jsp.*

/OA_HTML/ibeSQtpSrpSrchRslts\.jsp.*
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DbSession /OA_HTML/ibeCCt.*\.jsp.*

/OA_HTML/jtfdload.jsp

/OA_HTML/ibeCSr.*\.jsp.*

/OA_HTML/ibeSQtdItemSrch\.jsp.*

/OA_HTML/ibeSQtpSrch\.jsp.*

/OA_HTML/ibeSQtpSrpSrchRslts\.jsp.*

JFNSession /OA_HTML/ibeCCt.*\.jsp.*

/OA_HTML/jtfdload.jsp

/OA_HTML/ibeCSr.*\.jsp.*

/OA_HTML/ibeSQtdItemSrch\.jsp.*

/OA_HTML/ibeSQtpSrch\.jsp.*

/OA_HTML/ibeSQtpSrpSrchRslts\.jsp.*

JServSession /OA_HTML/ibeCCt.*\.jsp.*

/OA_HTML/jtfdload.jsp

/OA_HTML/ibeCSr.*\.jsp.*

/OA_HTML/ibeSQtdItemSrch\.jsp.*

/OA_HTML/ibeSQtpSrch\.jsp.*

/OA_HTML/ibeSQtpSrpSrchRslts\.jsp.*

JTTSession /OA_HTML/ibeCCt.*\.jsp.*

/OA_HTML/jtfdload.jsp

/OA_HTML/ibeCSr.*\.jsp.*

/OA_HTML/ibeSQtdItemSrch\.jsp.*

/OA_HTML/ibeSQtpSrch\.jsp.*

/OA_HTML/ibeSQtpSrpSrchRslts\.jsp.*

Table 16–6 Oracle Web Cache Session/Personalized Attribute Selector Associations 

Session/Attribute Selector Associations
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16.3.9 Set Up Simple Personalization
Use the following procedure to set up Simple Personalization.

Steps
1. In Oracle Web Cache Manager, choose Simple Personalization, under 

Administering Web Sites > Cacheability Rules.

2. Select Parse HREFs = YES.

3. Click Change Selector Association.

The Change Policy-Selector Association window opens.

4. Make the selector associations listed in the following table for simple 
personalization. Click Apply Changes when finished.

16.3.10 Set Up HTTP Error Caching
Use the following procedure to set up HTTP error caching.

Steps
1. In Oracle Web Cache Manager, choose Administering Web Sites > 

Cacheability Rules.

2. For each URL Expression listed below, select the corresponding cacheability 
rule and click Edit Selected.

� /OA_HTML/ibeCCt.*\.jsp.*

� /OA_HTML/ibeCSr.*\.jsp.*

� /OA_HTML/ibeSQtpSrch\.jsp.*

The Edit Cacheability Rule window opens. 

Table 16–7 Oracle Web Cache Simple Personalization Selector Associations 

Selector Parse HREFs

/OA_HTML/ibeCCt.*\.jsp.* YES

/OA_HTML/ibeSQtdItemSrch\.jsp.* YES

/OA_HTML/ibeCSr.*\.jsp.* YES

/OA_HTML/ibeSQtpSrch\.jsp.* YES

/OA_HTML/ibeSQtpSrpSrchRslts.jsp.* YES
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3. In the HTTP Error Caching row, enter 302 in the Error Codes to Cache field.

4. In the Edit Cacheability Rules window, click Submit.

5. Click Apply Changes when finished.

16.3.11 Set Up Test Environment
You can validate cacheability rules by monitoring three log files:

� The Oracle Web Cache access log

� The Oracle Web Cache event log

� The application server’s access log

Set up the Oracle Web Cache event log in verbose mode using the following 
procedure.

Steps
1. In Oracle Web Cache Manager, choose Administering Oracle Web Cache > 

Event Logging.

2. Click Edit and check YES for Verbose mode.

3. Apply the change to Oracle Web Cache.
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This chapter describes the integration of Oracle iStore 11i with Oracle Workflow. 
Topics include:

� Overview of Oracle Workflow

� Oracle iStore 11i Functionality with Oracle Workflow

� Setting Up Oracle Workflow
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Overview of Oracle Workflow
17.1 Overview of Oracle Workflow
Business processes today involve getting many types of information to multiple 
people according to rules that are constantly changing. Oracle Workflow lets you 
automate and continuously improve business processes, routing information of any 
type to people both inside and outside your enterprise according to business rules 
that you can easily change.

17.2 Oracle iStore 11i Functionality with Oracle Workflow
Oracle iStore 11i Web stores communicate with their users by e-mail notifications. 
These notifications include information about registration, order confirmation, cart 
sharing, sales assistance, contract negotiation, and more. Notifications are triggered 
by events such as a user’s registration, a user’s request for sales assistance, and 
placing an order.

Oracle iStore 11i uses Oracle Workflow to send notifications. Oracle iStore 11i is 
seeded with notification events and messages for the e-mails that are sent when 
notification events are triggered. A notification event can be triggered by a Web 
store user (e.g., registration) or by the application itself (e.g., when an update 
message is scheduled for daily delivery). The messages include attributes that are 
dynamically replaced with user-specific values, such as the user’s name, when an 
e-mail is sent. Notification events and messages are stored in Oracle Workflow. 

You can choose to use only the seeded messages for notifications. You can also 
create messages using Oracle Workflow Builder if you do not want to use the 
seeded messages. When you have the messages that you need, you then select 
messages for notification events based on organization-user type combinations, 
using the Oracle iStore 11i Merchant UI.

When one of these notification events is triggered, Oracle iStore 11i selects the 
message for the notification based on the recipient’s organization and user type. 
Oracle Workflow then parses the message, enters dynamic content, and sends the 
resulting e-mail to the user.
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17.3 Setting Up Oracle Workflow
To activate Oracle Workflow integration with Oracle iStore 11i, you must set the 
profile option IBE: Use Workflow Features in iStore to Yes. You must also set the 
profile option IBE: Default Order Admin to Send Workflow Notification. See 
Section A.6, "Oracle iStore 11i (IBE) Profile Options for the Customer UI" for profile 
option descriptions.

In Oracle Human Resources, you must specify the sales representatives and contract 
sales representatives who receive notifications, as described in Section 5.9.2, "Setting 
Up Notification Recipients".

17.3.1 Planning Messages
You can choose to use only the seeded messages for Oracle iStore 11i notifications. If 
you want to create additional messages, you must first perform the following tasks 
to plan the messages:

� Decide the number of organizations that you will have.

� Decide what the content of the default messages, if any, should be.

� Decide exactly what combinations of organizations and user types need 
messages that are different from the defaults.

� Decide what the content of the non-default messages should be.

17.3.2 Creating Messages
Use Oracle Workflow Builder to create and edit messages for Oracle iStore 11i 
notifications. The Oracle Workflow item type iStore Alerts Workflow (IBEALERT), 
in the data store file IBENOTIF.wft, contains all Oracle iStore 11i notifications and 
their messages and attributes, except for the notifications Summary Report and Top 
N Orders Report. The item type iStore Alert Reports (IBEECRRP), in the data store 
file IBEVWFR.wft, contains the notifications Summary Report and Top N Orders 
Report.

Note: Before upgrading Oracle iStore 11i, you must back up any 
necessary customized messages and remove the access locks from 
the messages and items of the Oracle iStore 11i-related Oracle 
Workflow definition, so that the upgrade can overwrite the Oracle 
Workflow definition. See Section 8.12, "Notifications Errors" for 
details.
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Each message’s internal name must begin with a prefix that associates it with an 
Oracle iStore 11i notification event. The following table lists the message prefix for 
each notification event. See Section 5.9, "Setting Up Notifications" for descriptions of 
the notification events.

Oracle Workflow replaces attributes in messages dynamically with user-specific 
values when it sends a notification. The following table lists the iStore Alerts 
Workflow attributes.

Note: Do not modify the seeded messages. Changes to the seeded 
messages will be overwritten when you apply patches. Instead, 
copy the seeded messages into new messages, then modify the new 
messages.

Table 17–1 Message Internal Name Prefixes for Oracle iStore 11i Notifications 

Notification Event Message Internal Name Prefix

User Registration ACCTREG (for B2C users)

ACCTREGB2B (for B2B users)

Shared Cart SHAREDCART

Order Confirmation - Normal ORDCONF

Order Confirmation - Next steps for faxed orders ORDFAX

Orders Not Booked Notification ORDNOTBOOKED

Sales Assistance Request - To Users CUSTASSIST

Sales Assistance Request - To Sales Representatives SALESASSIST

Contract Negotiations Request - To Users CUSTQUOTE

Contract Negotiations Request - To Sales Representatives SALESQUOTE

Contract Negotiations Request - Approval TERMAPPROVED

Contract Negotiations Request - Cancellation TERMCANCELLED

Contract Negotiations Request - Disapproval TERMREJECTED

Reports - iStore Historical Summary SUMM_MSG

Reports - iStore Top Orders TOPORD_MSG
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The item type iStore Alert Reports has a different set of attributes, listed in the 
following table.

Table 17–2 Attributes for the Item Type iStore Alerts Workflow 

Display Name Internal Name Description Type

First Name FIRSTNAME User’s first name Text

Last Name LASTNAME User’s last name Text

Login Name LOGINNAME User’s login name Text

Password PASSWORD User’s password Text

Email Address EMAILADDRESS User’s e-mail address Text

Event Type EVENTTYPE Notification event type Text

Send To SENDTO Recipient’s e-mail address Text

Quote Id QUOTEID Quote ID Number

Quote Name QUOTENAME Quote name Text

Contract Number CONTRACTNO Contract number Number

Order Detail ORDERDETAIL Order detail Document

Order Header ORDERHEADER Order header Document

Order Footer ORDERFOOTER Order footer Document

Error Message ERRMSG Error message Text

Comments COMMENTS User’s comments Text

Order Header ID ORDERID Order header ID Number

Item Key ITEMKEY Item key Text

Quote Number QUOTENUM Quote number Number

Message Name MESSAGE Message name Text

URL URL URL (e.g., a shared cart link) Text

Sharee Number SHNUM Cart sharee number Text
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Use the following procedure to create customized Oracle Workflow messages for 
the Oracle iStore 11i notifications.

Steps
1. Create a new message using Oracle Workflow Builder, and name it with the 

appropriate prefix for the notification event, as listed in Table 17–1, "Message 
Internal Name Prefixes for Oracle iStore 11i Notifications".

2. Copy the message attributes from the seeded message for the notification event 
to the new message.

3. Modify the message text as necessary.

4. Restart the Java Virtual Machine (JVM) to refresh the cache objects.

5. You can now map this message to its notification by organization and user type. 
See Section 5.9, "Setting Up Notifications" for more information.

See Oracle Workflow Guide for more information on working with messages.

Table 17–3 Attributes for the Item Type iStore Alert Reports 

Display Name Internal Name Description Type

Report Frequency FREQUENCY Report frequency, e.g., DAY, 
MONTH

Text

Report Scale SCALE Report amount scale Number

Currency Code CURRENCY Currency code Text

Number of Rows NUMROW Number of rows Number

Report Subject REPORT_SUBJECT Report subject Text

Document Identifier DOCUMENTID Document identifier Text

Report Body REPORT_BODY Report body Text

Bin Refresh Date BIN_DATE Bin refresh end date Text
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Profile Options

This chapter describes profile option settings that are required for successful 
implementation. Topics include: 

� Before You Begin

� Setting Profile Options

� Finding Responsibility ID Values

� Oracle CRM Technology Foundation (JTT) Profile Options

� Oracle iStore 11i (IBE) Profile Options for the Merchant UI

� Oracle iStore 11i (IBE) Profile Options for the Customer UI

� Other Oracle iStore 11i (IBE) Profile Options

� Oracle Order Capture (ASO) Profile Options

� Oracle Order Management (OM) Profile Options

� Multiple Organization (MO) Profile Options

� Oracle Bills of Material (BOM) Profile Options

� Oracle Contracts Core (OKC) Profile Options

� Concurrent Program Manager Profile Options

� Site-Level Profile Options
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Before You Begin
A.1 Before You Begin
Before making Oracle Forms settings, ensure that all Oracle Applications server 
processes are up and running. In particular, if you stopped concurrent managers 
before applying Oracle Applications patchsets, restart them now by changing to 
$COMMON_TOP/admin/scripts, and executing adcmctl.sh <APPS 
username/APPS password> start.

A.2 Setting Profile Options
Use the following procedure to set any profile option.

Steps
1. Log in to Oracle Forms with the System Administrator responsibility.

2. Go to Profile > System.

The Find System Profile Values window opens.

3. Check the level(s) at which you want to set the profile option. The available 
levels are listed below:

� Site

� Application—If you select this level, choose the application from the 
Application LOV for which you want to set the profile option.

� Responsibility—If you select this level, choose the responsibility from the 
Responsibility LOV for which you want to set the profile option.

� User—If you select this level, choose the user from the User LOV for whom 
you want to set the profile option.

4. In the Profile field, enter the profile name, such as IBE: Item Validation 
Organization, or a wildcard search criterion such as IBE%.

5. Click Find.

The System Profile Values form opens with the results of your search.

6. Verify or set the profile option(s) at the levels that you selected.
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A.3 Finding Responsibility ID Values
You must know the APPLICATION_ID values and RESPONSIBILITY_ID values for 
store manager and customer responsibilities before you can set the required Oracle 
CRM Technology Foundation (JTT) profile options for users with these 
responsibilities.

Use the following procedure to find the APPLICATION_ID value and 
RESPONSIBILITY_ID value of a responsibility.

Steps
1. Log in to Oracle Forms with the System Administrator responsibility.

2. Choose Security > Responsibility > Define.

The Responsibilities form opens.

3. Choose View > Find. Search for the responsibility, highlight it, and click OK in 
the search window.

The Responsibilities form is populated with the record for the responsibility 
that you chose.

4. With your cursor in any field of the record, choose Help > Diagnostics > 
Examine.

The Examine Field and Variable Values window opens.

5. In the Examine Field and Variable Values window, choose APPLICATION_ID 
from the Field LOV. 

The Value field in the Examine Field and Variable Values window is populated 
with the value of APPLICATION_ID.

6. In the Examine Field and Variable Values window, choose RESPONSIBILITY_
ID from the Field LOV. 

The Value field in the Examine Field and Variable Values window is populated 
with the value of RESPONSIBILITY_ID.

Note: The APPLICATION_ID value for the seeded IBE_
ADMINISTRATOR and IBE_CUSTOMER responsibilities is 671 (for 
iStore). The RESPONSIBILITY_ID value for IBE_
ADMINISTRATOR is 21819. The RESPONSIBILITY_ID value for 
IBE_CUSTOMER is 22372.
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A.4 Oracle CRM Technology Foundation (JTT) Profile Options
This section summarizes the Oracle CRM Technology Foundation (JTT) profile 
options that you need to set when implementing Oracle iStore 11i.

A.4.1 JTT Profile Options for the Merchant UI
Set the profile options in this section at the following levels:

� Site

� Application—iStore

Table A–1 JTT Profile Options for the Merchant UI 

Profile Option Name Value Description

JTF_PROFILE_DEFAULT_APPLICATION 671 Default application ID 
(671=iStore)

JTF_PROFILE_DEFAULT_BLANK_ROWS 3 Number of blank rows on 
Merchant UI forms (can be set to 
any integer > 0)

JTF_PROFILE_DEFAULT_CSS jtfucss.css Default Oracle CRM Technology 
Foundation Cascading Style 
Sheet

JTF_PROFILE_DEFAULT_CURRENCY USD Default currency. Enter the 
currency code in all uppercase 
letters.

JTF_PROFILE_DEFAULT_NUM_ROWS 10

JTF_PROFILE_DEFAULT_RESPONSIBILITY 
(application level only)

21819 Default responsibility ID 
(21819=IBE_ADMINISTRATOR)
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A.4.2 JTT Profile Options for Store Manager User Accounts
Set the profile options in this section at the following levels:

� User—Store manager user name

A.4.3 JTT Profile Options for the Guest User Account
Set the profile options in this section at the following levels:

� User—The guest user name

Table A–2 JTT Profile Options for Store Manager Users 

Profile Option Name Value1 

1 See Section A.3, "Finding Responsibility ID Values" if you need to find the APPLICATION_ID and 
RESPONSIBILITY_ID values for a responsibility. 

Description

JTF_PROFILE_DEFAULT_
APPLICATION

671 Default application ID 
(671=iStore)

JTF_PROFILE_DEFAULT_
RESPONSIBILITY

RESPONSIBILITY_ID 
value of the store 
manager’s responsibility

Default responsibility ID 
(21819=IBE_ADMINISTRATOR)

Table A–3 JTT Profile Options for the Guest User 

Profile Option Name  Value1

1 See Section A.3, "Finding Responsibility ID Values" if you need to find the APPLICATION_ID and 
RESPONSIBILITY_ID values for a responsibility. 

Description

JTF_PROFILE_DEFAULT_
APPLICATION

APPLICATION_ID 
value of the guest 
user’s responsibility

Default application ID 
(671=iStore)

JTF_PROFILE_DEFAULT_CURRENCY Currency code for the 
guest user’s default 
currency, e.g., USD 
for U.S. dollars

Default currency

JTF_PROFILE_DEFAULT_
RESPONSIBILITY

RESPONSIBILITY_ID 
value of the guest 
user’s responsibility

Default responsibility ID 
(22372=IBE_CUSTOMER)
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A.5 Oracle iStore 11i (IBE) Profile Options for the Merchant UI
There are IBE profile options for Merchant UI setup and for Storefront Reports, 
which are viewed in the Merchant UI.

A.5.1 IBE Profile Options for Merchant UI Setup
Set the profile options in this section at the following levels:

� Application—iStore

You can also set these profile options at the following levels if the descriptions state 
that you can:

� Site

� Responsibility—IBE_ADMINISTRATOR or another store manager 
responsibility

� User—Store manager user name

The following table describes the IBE profile options for Merchant UI setup.

Table A–4 IBE Profile Options for Merchant UI Setup 

Profile Option Name Mandatory Description

IBE: Category Set Yes This profile option is used when searching 
for products in the Merchant UI based on 
category. (The value “Inv. Items” is for the 
Vision database.)

See Table A–9 for profile option 
description relevant to Customer UI.

IBE: Item Validation Organization Yes This profile option specifies the inventory 
organization when adding products to the 
catalog. It allows only the items belonging 
to this inventory organization to be added 
to the catalog hierarchy.

For vision demo, master organization is 
Vision Operations (204).

Recommended Value: Master Inventory 
Organization
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IBE: Item Validation Organization

(Responsibility or user level)

No This is the same profile option as the IBE: 
Item Validation Organization profile 
option that is set at application level. 
However, you may wish to set it at 
responsibility level if you have a multiple 
operating unit environment and want 
different store managers to be able to 
manage items from only certain Inventory 
Organizations.

To set this profile option at responsibility 
level, first set up store manager 
responsibilities in addition to the IBE_
ADMINISTRATOR responsibility. Next, 
set up Inventory Organizations that are 
subsets of the master Inventory 
Organization. Then for each store manager 
responsibility, set the profile option at 
responsibility level to the Inventory 
Organization that you want the 
responsibility to manage. Finally, create 
store manager user accounts with these 
responsibilities.

You can also set the profile option at user 
level for individual users.

IBE: Number of Days for New 
Item Definition

No An item created within the number of 
days specified in this profile option is 
considered a new item in the Merchant UI. 
If this profile option is not set, only items 
created on the current day are considered 
new items.

Table A–4 IBE Profile Options for Merchant UI Setup (Cont.)

Profile Option Name Mandatory Description
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A.5.2 IBE Profile Options for Storefront Reports
Set the profile options in this section at the following levels:

� Application—iStore

The following table describes the IBE profile options for Storefront Reports.

IBE: Use Database for Media 
Storage

(Site level)

No This profile option specifies whether you 
store media source files in the database or 
the file system. Yes enables media storage 
in the database, allowing you to search the 
database for media source files when 
setting up multimedia objects. No disables 
media storage in the database, so that you 
store media source files in the file system 
and enter the directory paths for the files 
when setting up multimedia objects. The 
profile option defaults to value No if not 
set.

If this profile option is set to Yes, use a 
media cache system to enhance 
performance, so that only the first access 
to any medium goes to the database.

Table A–5 IBE Profile Options for Storefront Reports 

Profile Option Name Mandatory Description

IBE: Currency Code Yes This profile option specifies the currency 
code used in Storefront Reports.

IBE: Enable Force Refresh No This profile option specifies whether to 
populate the Storefront Reports fact tables 
with data even if they already hold data 
for exactly the same time period that you 
have specified in the parameters of the 
iStore Reports Complete Data Refresh Set 
concurrent programs. Yes forces this data 
refresh. No prevents this data refresh; this 
option refreshes only the unpopulated 
data. The profile option defaults to value 
Yes if not set.

Table A–4 IBE Profile Options for Merchant UI Setup (Cont.)

Profile Option Name Mandatory Description
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IBE: Enable Parallel Data 
Extraction for Reporting

No This profile option specifies whether 
parallelism is enabled when running the 
data refresh concurrent programs for 
Storefront Reports. Yes enables 
parallelism. No disables parallelism. The 
profile option defaults to value No if not 
set.

IBE: GL Conversion Type Yes This profile option specifies the Oracle 
General Ledger currency conversion type 
for Storefront Reports. The Oracle General 
Ledger currency conversion type provides 
the information necessary to convert 
transaction amount data from the original 
currencies to the currency required by 
Storefront Reports, which is specified in 
the profile option IBE: Currency Code.

The setting for IBE: GL Conversion Type 
must match the conversion type chosen 
when you set up the daily currency 
conversion rate in Oracle General Ledger 
for the required Storefront Reports period.

IBE: GL Period Set Name Yes This profile option specifies the Oracle 
General Ledger period set used by the 
Storefront Reports. Set the profile option 
to the calendar that you want the 
Storefront Reports to use. This calendar 
must use the Oracle General Ledger 
standard period types Month, Quarter, 
and Year.

The Oracle General Ledger time periods in 
the calendar must be non-adjusting 
periods.

IBE: iStore Materialized Views 
Usage

No This profile option controls whether the 
database engine reroutes Storefront Report 
queries against materialized views when 
the queries are run against the fact tables. 
The database engine reroutes the queries if 
the profile option is set to Yes. The profile 
option defaults to value Yes if not set.

Table A–5 IBE Profile Options for Storefront Reports (Cont.)

Profile Option Name Mandatory Description
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IBE: Quarter Begin Data No This profile option specifies whether the 
iStore Reports Complete Data Refresh Set 
can default the Begin Date parameter to 
the start date of the current quarter if the 
user does not define a value, or if the 
user-defined value is later than the quarter 
start date. Yes enables defaulting to the 
quarter start date. No disables defaulting. 
The profile option defaults to value Yes if 
not set.

The value of the profile option is irrelevant 
if the profile option IBE: YTD Data 
Availability in Bins is set to Yes.

IBE: Truncate Records No This profile option specifies whether 
records are deleted or truncated in the 
Storefront Reports fact tables. Yes 
truncates the records, resulting in faster 
performance. The profile option defaults 
to value Yes if not set.

IBE: Use Default Bin Preference No This profile option specifies whether 
default Data Out Bin preferences apply for 
users who have not set up their bin 
preferences in the Reports tab. The default 
preferences place only the Store Order 
Summary bin on the left side of the first 
Data Out Bins page. Yes configures Data 
Out Bins according to default bin 
preferences until the users configure their 
preferences. No makes default bin 
preferences unavailable. The profile option 
defaults to value No if not set. 

Table A–5 IBE Profile Options for Storefront Reports (Cont.)

Profile Option Name Mandatory Description
A-10 Oracle iStore Implementation Guide



Oracle iStore 11i (IBE) Profile Options for the Customer UI
A.6 Oracle iStore 11i (IBE) Profile Options for the Customer UI
There are IBE profile options for the following aspects of the Customer UI:

� Catalog

� Template Manager

� Shopping Cart

� Express Checkout

� Postsales

� Notifications

� Caching

� Functionality

A.6.1 IBE Profile Options for the Catalog
Set the profile options in this section at the following levels:

� Application—iStore

The following tables describe the IBE profile options for these aspects of the catalog: 

� Sections

� Items

IBE: YTD Data Availability in Bins No This profile option specifies whether the 
iStore Reports Complete Data Refresh Set 
can default the Begin Date parameter to 
the start date of the current year if the user 
does not define a value, or if the 
user-defined value is later than the year 
start date. Yes enables defaulting to the 
year start date. No disables defaulting. 
The profile option defaults to value Yes if 
not set.

If the profile option is set to Yes, the value 
of the profile option IBE: Quarter Begin 
Data is irrelevant.

Table A–5 IBE Profile Options for Storefront Reports (Cont.)

Profile Option Name Mandatory Description
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� Search

Table A–6 IBE Profile Options for Catalog—Sections 

Profile Option Name Mandatory Description

IBE: Items Per Section for Display No This profile option specifies the maximum 
number of items to display per section. If 
the profile option is not set, all items in a 
section will be displayed.

IBE: Lines Per Section for 
Multiple Section Display

No This profile option specifies the number of 
items displayed per section when the 
application displays multiple sections on a 
catalog page. If no value is specified, the 
value in the profile option IBE: Items Per 
Page for Display is used.

IBE: Number of Menu Subtabs No This profile option specifies the number of 
menu subtabs. It defaults to value 5 if not 
set.

IBE: Number of Menu Tabs No This profile option specifies the number of 
menu tabs. It defaults to value 5 if not set.

IBE: Sections Per Page for display No This profile option specifies the total 
number of sections to be displayed per 
catalog page. If the number of subsections 
that belong to the catalog page’s current 
section exceeds the number set in this 
profile option, they are paginated so that 
the user can navigate to subsequent 
catalog pages for this section that display 
the additional subsections. If no value is 
specified, the number of sections per page 
is not limited.

IBE: Show Change Store Link No This profile option specifies whether the 
link to the specialty stores login page 
appear in the global bin. The value of this 
profile option is relevant only if the profile 
options IBE: Use Global Bin and IBE: Use 
Specialty Stores Page are set to Yes. Set 
this profile option to Yes if you want the 
global bin to allow the user to change 
store, language, or currency. Set the profile 
option to No if you want the global bin to 
allow the user to change only language 
and currency. The profile option defaults 
to value Yes if not set.
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IBE: Use Catalog exclusions No This profile option specifies whether to 
use catalog exclusions in the specialty 
store. If exclusions are never specified in 
any specialty store, then set to No to 
improve performance. 

IBE: Use Global Bin No This profile option specifies whether the 
global bin is displayed on section pages in 
its default location. The global bin has a 
link to the specialty stores page, where 
users can change to another specialty 
store. It also allows users to select their 
preferred language and currency from 
pull-down menus. The profile defaults to 
Yes if not set.

If the profile option IBE: Use Specialty 
Stores Page is set to No, the global bin 
contains only the currency pull-down 
menu.

If the profile option IBE: Use Specialty 
Stores Page is set to Yes and the profile 
option IBE: Show Change Stores Link is 
set to No, the global bin contains only the 
language and currency pull-down menus.

IBE: Use Logical Media for Menu 
images

No This profile option specifies whether to 
use logical media for the menu images. Set 
the profile option to Yes to use logical 
media for the menu images if you 
customize the images, so that the 
application uses DisplayManager to 
retrieve the images. Set this profile option 
to No to disable logical media for the 
menu images and use the default menu 
images. The profile option defaults to 
value No if not set.

Note: STORE_LOGO is always retrieved 
by DisplayManager.

IBE: Use Section Bin No This profile option specifies whether the 
section browse bin is displayed on section 
pages in its default location. The profile 
option defaults to value Yes and displays 
the section bin if not set.

Table A–6 IBE Profile Options for Catalog—Sections (Cont.)

Profile Option Name Mandatory Description
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IBE: Use Section Path No This profile option specifies whether the 
section path is displayed on section and 
item pages in its default location. The 
profile option defaults to value Yes and 
displays the section path if not set.

IBE: Use Specialty Stores Page No This profile option specifies whether the 
user must return to the specialty stores 
page to switch stores. If the profile option 
is set to Yes, the user must return to the 
specialty stores page. A link to the page 
appears in the global bin. (The profile 
options IBE: Use Global Bin and IBE: Show 
Change Stores Link must be set to Yes.) If 
the profile option is set to No, a store 
pull-down menu and supported language 
links appear in the stores’ home page 
menu bars if there are multiple specialty 
stores or supported languages. The 
pull-down menu displays all stores. The 
global bin, if activated, displays only a 
currency pull-down menu. The profile 
option defaults to value Yes if not set.

Note: If you have set up access control for 
your specialty stores, then set the profile 
option to Yes. 

IBE: Use Welcome Bin No This profile option enables/disables the 
welcome bin on section pages in its default 
location. If no value is specified, the 
welcome bin is enabled.

Table A–7 IBE Profile Options for Catalog—Items 

Profile Option Name Mandatory Description

IBE: Items Per Page for Display No This profile option specifies the number of 
items to display on a leaf section page. If 
the number of items in the section exceeds 
this value, the page displays a Next link. 
This profile option defaults to value 20 if 
not set.

Table A–6 IBE Profile Options for Catalog—Sections (Cont.)

Profile Option Name Mandatory Description
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IBE: Pricing Event — Before 
Shopping Cart 

Yes This profile option specifies the 
user-defined pricing event (defined in 
Pricing) for the catalog stage.

Recommended value: Enter Order Line

IBE: Retrieve All Units of 
Measure for an Item

No If this profile option is set to Yes, the 
application retrieves all units of measure 
with prices for an item and displays them 
in a UOM pull-down menu in the Web 
store catalog. If this profile option is set to 
No, the application retrieves only the 
primary unit of measure and its prices. 
The application retrieves all units of 
measure if this profile option is not set.

IBE: Retrieve Price When 
Displaying Items

No If the profile option is set to Yes, the 
application retrieves prices for an item’s 
primary UOM based on the specialty 
store’s price list when loading the item. 
Otherwise, prices will be retrieved when 
the price APIs are called.

Recommended values: Yes if retrieving 
prices only for the primary UOM. 
Otherwise, No.

IBE: Use Add Item Bin No This profile option specifies whether the 
Add Item bin is displayed on item pages 
in its default location. If no value is 
specified, the Add Item bin is enabled.

Table A–8 IBE Profile Options for Catalog—Search 

Profile Option Name Mandatory Description

IBE: Enable Fuzzy Search No If the profile option is set to Yes, the 
application allows users to perform fuzzy 
product searches, so that they do not have 
to type in the exact spelling of their search 
criteria to retrieve results that match these 
criteria. The profile option defaults to 
value No if not set.

Table A–7 IBE Profile Options for Catalog—Items (Cont.)

Profile Option Name Mandatory Description
Profile Options A-15



Oracle iStore 11i (IBE) Profile Options for the Customer UI
IBE: Search Lines Per Page No This profile option specifies the number of 
search results displayed on a single search 
result page. It defaults to value 20 if not 
set.

IBE: Thesaurus File Name No This profile option specifies the prefix for 
the thesaurus names of the synonym files 
that you load for the Oracle iStore 11i 
product synonym search. In the thesaurus 
names, you must use this prefix followed 
by _language_short_code. The profile 
option thus standardizes the thesaurus 
names. If the profile option is not set, it 
defaults to IBETHESAURUS.

Note: If you change this profile option 
after you have loaded synonym files, those 
synonym files are no longer accessible, 
and you must load the synonym files with 
their new thesaurus names.

IBE: Use Category Search No If this profile option is set to Yes, it 
activates Category search so that the home 
page pull-down menu shows categories 
with publishable items. If this profile 
option is set to No, it activates Section 
search so that the home page pull-down 
menu shows top level sections for the 
minisite where the customer is browsing. 
Null value removes the home page 
pull-down menu so that search is only 
enabled in all products.

IBE: Use Synonym Search No This profile option specifies whether the 
product search retrieves product names 
that are synonyms of the users’ search 
keywords. Yes enables the synonym 
search after you have loaded a thesaurus. 
No disables the synonym search. The 
profile option defaults to value No if not 
set.

Table A–8 IBE Profile Options for Catalog—Search (Cont.)

Profile Option Name Mandatory Description
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A.6.2 IBE Profile Options for the Template Manager
Set the profile options in this section at the following levels:

� Application—iStore

The following table describes the IBE profile options for the Template Manager.

A.6.3 IBE Profile Options for the Shopping Cart
Set the profile options in this section at the following levels:

� Application—iStore

You can also set these profile options at the following levels if the descriptions state 
that you can:

� Responsibility—IBE_CUSTOMER or another Oracle iStore 11i customer user 
responsibility

� User—Customer user name

The following table describes the IBE profile options for the Shopping Cart.

Table A–9 IBE Profile Options for Template Manager 

Profile Option Name Mandatory Description

IBE: Category Set Yes This profile option specifies the category 
set for determining the display category 
for an item. If an item belongs to a 
category in this category set, the Customer 
UI will use the display style mapping for 
the category if an association is not found 
at the item level. (The value “Inv. Items” is 
for the Vision database.)

Table A–10 IBE Profile Options for Shopping Cart 

Profile Option Name Mandatory Description

IBE: Authorize Payment Offline 
during normal Checkout 

No This profile option specifies if payment 
authorization offline before checkout is 
allowed. Yes enables offline authorization. 
No allows only online authorization. The 
profile option defaults to value Yes if not 
set.
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IBE: Create Order in Entered 
State, if it has errors while 
booking

No This profile option specifies if the order 
should be created in the Entered state even 
if there are errors while booking it. The 
profile option defaults to value No if not 
set.

IBE: Create Standard Contract No This profile option specifies whether a 
contract is created when a customer agrees 
to standard terms and conditions. If the 
profile option is set to Yes, a contract is 
created in the signed state when the 
customer places the order. If the profile 
option is set to No, no contract is created. 
The profile option defaults to value Yes if 
not set.

You need to set this profile option only if 
the profile option ASO: Enable Use 
Contracts is set to Yes.

IBE: Finalize Order On Error in 
Authorize Payment

No If there is an error in the conversion of a 
quote to an order of Booked status, this 
profile option specifies whether the order 
is finalized. If the profile option is set to 
Yes, the order is submitted in Entered 
status. The profile option defaults to value 
No if not set.

IBE: Merge Shopping Cart Lines No This profile option specifies whether to 
merge item lines in the shopping cart if the 
same item is added to the cart more than 
once. The profile option defaults to value 
No if not set.

IBE: Preferred Shipping Method

(Responsibility or user level)

No This profile option specifies preferred 
shipping method.

IBE: Pricing Event for Shopping 
Cart

Yes Set this profile option to Batch Processing. 
This profile option specifies the pricing 
event for processing the shopping cart 
price in Oracle Pricing. You must set the 
profile option to Batch Processing to 
ensure that the price lists, modifiers, 
discounts, promotion codes, and 
surcharges are applied correctly at both 
header and line level.

Table A–10 IBE Profile Options for Shopping Cart (Cont.)

Profile Option Name Mandatory Description
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IBE: Recalculate Price in Order 
Management

No If the profile option is set to No, the 
quote-related prices are passed on to 
Oracle Order Management unchanged. If 
the profile option is set to Yes, the 
quote-related prices can be changed in the 
order because Oracle Order Management 
is allowed to recalculate the prices for the 
quote. The profile option defaults to value 
No if not set.

IBE: Request Type to get a Price Yes Select the transaction application (e.g., 
Oracle Order Management) that calls the 
Pricing engine.

IBE: Shopping Cart Expiration 
Duration

No This profile option specifies the number of 
days that shopping carts are maintained 
and available to the merchant and 
customer. The profile option defaults to 
value 0 if not set.

IBE: Shopping Cart Price based 
on Owner

No If the profile option is set to Yes, the 
shopping cart price will be based on the 
shopping cart owner if retrieved by 
someone sharing the cart. Otherwise, the 
cart price will be recalculated based on 
modifications to the cart made by the 
person sharing the cart. The profile option 
defaults to value No if not set.

IBE: Use fax credit card as a 
Payment Option

No This profile option specifies whether users 
can choose to fax their credit card as a 
payment method in the billing 
information page during checkout. The 
profile option defaults to value Yes if not 
set.

IBE: Use invoice as a Payment 
Option

No This profile option specifies whether users 
can choose invoice as a payment method 
in the billing information page during 
checkout. The profile option defaults to 
value Yes if not set.

IBE: Use Line Level Shipping No This profile option specifies whether users 
can enter line level shipping information 
in the shipping information page during 
checkout. The profile option defaults to 
value Yes if not set.

Table A–10 IBE Profile Options for Shopping Cart (Cont.)

Profile Option Name Mandatory Description
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A.6.4 IBE Profile Options for Express Checkout
Set the profile options in this section at the following levels:

� Application—iStore

The following table describes the IBE profile options for Express Checkout.

IBE: Use Price list associated with 
Specialty Store

No If the profile option is set to Yes, Oracle 
iStore 11i uses the price lists that are 
specified in the Merchant UI for walk-in, 
registered, and B2B users in the specialty 
stores. If the profile option is set to No, 
then for registered and B2B users, Oracle 
iStore 11i passes a null price list with the 
party ID and account ID to Oracle Pricing. 
Oracle Pricing then determines a price list 
for which the user qualifies. When the 
profile option is set to No, Oracle iStore 11i 
still uses the price lists that are specified in 
the Merchant UI for walk-in users in the 
specialty stores. If the profile option is not 
set, it defaults to value Yes.

IBE: Use Shipping Instructions No This profile option specifies whether a 
user can enter shipping instructions on the 
shipping information page or the order 
review page during checkout. The profile 
option defaults to value Yes if not set.

Table A–11 IBE Profile Options for Express Checkout 

Profile Option Name Mandatory Description

IBE: Express Checkout 
Consolidation Time Interval 

No This profile option specifies the time 
interval, in minutes, in which the Express 
Checkout shopping cart will be converted 
in an order by the concurrent batch job. 
The profile option defaults to value 60 if 
not set.

Table A–10 IBE Profile Options for Shopping Cart (Cont.)

Profile Option Name Mandatory Description
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A.6.5 IBE Profile Options for Postsales
Set the profile options in this section at the following levels:

� Application—iStore

The following table describes the IBE profile options for Postsales.

Table A–12 IBE Profile Options for Postsales 

Profile Option Name Mandatory Description

IBE: Enable Invoices in Order 
Tracker

No This profile option specifies whether the 
Invoices link is displayed in the third level 
menu of Order Tracker/My Orders. The 
profile defaults to value Yes if not set and 
displays the link.

IBE: Enable Payments in Order 
Tracker

No This profile option specifies whether the 
Payments link is displayed in the third 
level menu of Order Tracker/My Orders. 
The profile defaults to value Yes if not set 
and displays the link.

IBE: Number of Invoice/Order 
Lines displayed

No This profile option specifies the number of 
invoice and order lines displayed in Order 
Tracker/My Orders. The profile option 
defaults to value 10 if not set.

IBE: Use Auth Permissions in 
Order Tracker

No This profile option specifies if permission 
checking is enforced for users to view only 
the orders placed by themselves or all of 
their organization’s orders. If the profile 
option is set to Yes, Order Tracker checks 
that the user has the permissions IBE_
VIEW_INVOICE, IBE_VIEW_ORDER, and 
IBE_VIEW_PAYMENT before allowing the 
user to view invoices, orders, and 
payments, respectively, in My Orders. The 
profile option defaults to value No if not 
set.
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A.6.6 IBE Profile Options for Notifications
Set the profile options in this section at the following levels:

� Application—iStore

The following table describes the IBE profile options for notifications.

A.6.7 IBE Profile Options for Caching
Set the profile options in this section at the following levels:

� Application—iStore

You can also set these profile options at the following levels if the descriptions state 
that you can:

� Site

The following table describes the IBE profile options for caching.

Table A–13 IBE Profile Options for Notifications 

Profile Option Name Mandatory Description

IBE: Default Order Admin to 
Send Workflow Notification

No This profile option specifies the default 
order administrator’s Oracle Workflow 
user name. An e-mail is sent to this order 
administrator upon errors in submitting 
orders.

If the profile option is set, the profile 
option IBE: Use Workflow Features in 
iStore must also be set to Yes.

IBE: Email Address to send 
Diagnostic Messages

No This profile option specifies the e-mail 
address that receives diagnostic messages 
when there is an Oracle iStore 11i 
application error in the Customer UI, such 
as an exception. Oracle iStore 11i sends the 
exception message and application context 
to this e-mail address. The recipient can 
use the information to troubleshoot Oracle 
iStore 11i.

IBE: Notification User Role No This profile option specifies the user 
responsibility for setting notifications.

Recommended value: System 
Administrator
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Table A–14 IBE Profile Options for Caching 

Profile Option Name Mandatory Description

IBE: Cache On

(Site level only)

No This profile option specifies whether to 
enable the store cache for sections and 
items. If the profile option is set to Yes, the 
store cache is enabled. If the profile option 
is set to No, sections and items are not 
cached. The profile defaults to value No if 
not set.

If you are using responsibility-based 
Oracle Pricing modifiers to provide 
product pricing for walk-in users based on 
responsibility ID, you cannot use the store 
cache because it caches prices for walk-in 
users according to price list ID. In this 
case, set the profile option to No. 

Recommended value: Yes

IBE: Enable Preloading of Cache 
for Catalog

No If this profile option is set to Yes, the 
application preloads the catalog when the 
first user logs in, depending on the size 
specified in the cache size profile options. 
At the expense of the first hit, the 
subsequent catalog search and navigation 
become faster. If the profile option is not 
set, the application does not preload the 
section and item cache.

IBE: Item Cache Size No This profile option specifies the maximum 
number of items to cache on the middle 
tier. The profile option defaults to value 
200 if not set, and if the cache is on.

IBE: No of Results in Search No This profile option specifies the number of 
hits that a store product search returns. 
The product search retrieves and sorts the 
first n items in Oracle Inventory, where n 
is the profile option value. It does not sort 
all items in Oracle Inventory before 
retrieving the search results. Therefore, the 
number of hits that you specify in the 
profile option should be high enough to 
provide search results that reflect the 
actual content of your inventory. The 
number should also be low enough for 
efficient performance. The profile option 
defaults to value 200 if not set.
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A.6.8 IBE Profile Options for Functionality
Set the profile options in this section at the following levels:

� Application—iStore

You can also set these profile options at the following levels if the descriptions state 
that you can:

� User—Customer user name

The following table describes the IBE profile options for functionality.

IBE: Order Tracker Object Cache No This profile option specifies whether 
Order Tracker Java objects are cached in 
the middle tier.

Recommended value: Yes

IBE: Port Number to use for 
multicast messages

No This profile option specifies the port 
number to use for multicast messages. The 
profile option defaults to port 50000 if not 
set.

IBE: Preload Specialty Store 
Cache

No This profile option specifies whether the 
specialty store cache is preloaded to the 
middle tier. Yes preloads the cache. The 
profile option defaults to value No if not 
set.

IBE: Section Cache Size No This profile option specifies the maximum 
number of sections to cache on the middle 
tier. The profile option defaults to value 
100 if not set, and if the cache is on.

Table A–15 IBE Profile Options for Functionality 

Profile Option Name Mandatory Description

IBE: Enable Debug

(User level only)

No This profile option specifies whether 
user-specific logging is available for the 
JSP/Java and PL/SQL layers. Yes activates 
user-specific logging. The profile option 
defaults to value No if not set.

IBE: Use AOL Menu No This profile option specifies whether to 
use AOL’s menu framework.

Table A–14 IBE Profile Options for Caching (Cont.)

Profile Option Name Mandatory Description
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IBE: Use B2B Features No This profile option specifies whether B2B 
features such as business user registration, 
Profile user administration, and Profile 
role management are available to the 
customer. The profile option defaults to 
value Yes if not set.

See Oracle iStore Concepts and Procedures for 
a detailed review of Oracle iStore 11i B2B 
features.

IBE: Use Business to Customer 
Features

No This profile option specifies whether B2C 
registration is available in your stores. The 
profile option defaults to value Yes if not 
set.

IBE: Use Business User Auto 
Approval

No This profile option specifies whether 
approval of B2B users is automatic. Yes 
enables automatic approval of B2B users. 
See Oracle iStore Concepts and Procedures for 
details. No disables automatic approval of 
B2B users, so that each B2B user 
registration request is queued for the 
system administrator’s approval. The 
profile option defaults to value No if not 
set.

IBE: Use CABO UI No Set this profile option to Yes. The profile 
option defaults to value Yes if not set.

IBE: Use Call me Back No This profile option specifies whether the 
callback feature is enabled. With the 
callback feature, users can click a link in 
the welcome bin to request that a 
merchant representative call them back. 
The callback feature requires integration of 
Oracle iStore 11i with Oracle iSupport and 
Oracle Telephony Manager. The profile 
option defaults to value No if not set.

IBE: Use Direct Item Entry No This profile option specifies whether 
customer-to-merchant part number 
mapping is available. The profile option 
defaults to value Yes if not set.

IBE: Use Express Checkout No This profile option specifies whether 
Express Checkout is enabled. The profile 
option defaults to value Yes if not set.

Table A–15 IBE Profile Options for Functionality (Cont.)

Profile Option Name Mandatory Description
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IBE: Use Sales Assistance Feature No This profile option specifies whether Sales 
Assistance is enabled. The profile option 
defaults to value Yes if not set.

See Section 3.1.5, "Setting Up Sales 
Assistance Prompts in AOL" for more 
information about the Sales Assistance 
feature.

IBE: Use Sensitive Pages No A sensitive page is a page that displays 
personal user-specific information. In 
Oracle iStore 11i, the checkout and account 
pages are sensitive.

The checkout pages are the pages that 
appear from the point when users click 
Checkout, until they place an order. Some 
of the pages in the checkout flow include 
billing information, shipping information, 
and order review.

The account pages are the pages where 
users view and update their passwords, 
names, phones, emails, addresses, credit 
cards, and Express Checkout settings. For 
B2B users, the User Management and Role 
Management pages are also sensitive.

Catalog (sections and products), shopping 
cart, and My Orders pages are not 
sensitive.

If the profile option is set to Yes, the 
application reauthenticates a logged-in 
user before displaying a sensitive page. If 
the profile option is set to No, 
reauthentication does not take place. The 
profile option defaults to value Yes if not 
set.

IBE: Use Share Cart No This profile option specifies whether 
customers can share shopping carts in 
Oracle iStore 11i. The profile option 
defaults to value No if not set.

IBE: Use Shop List No This profile option specifies whether 
shopping list functionality is available to 
customers. The profile option defaults to 
value Yes if not set.

Table A–15 IBE Profile Options for Functionality (Cont.)

Profile Option Name Mandatory Description
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A.7 Other Oracle iStore 11i (IBE) Profile Options
The following IBE profile options are related only to Oracle HTML Quoting. See 
Oracle HTML Quoting Implementation Guide for more information.

� IBE: Attachment Document Category

� IBE: Search Operator

� IBE: Use Line Types

� IBE: Use Notes

� IBE: Use Quote Publishing

� IBE: Use Tasks

IBE: Use Support No This profile option is currently not in use. 
Set the profile option to No.

IBE: Use Support Cart Level No This profile option is currently not in use. 
Set the profile option to No.

IBE: Use Web Cache Feature No This profile option enables Oracle Web 
Cache integration. If the profile option is 
set to Yes, Oracle iStore 11i creates the 
cookies that Oracle Web Cache uses for 
session tracking. If the profile option is set 
to No, you cannot integrate Oracle iStore 
11i with Oracle Web Cache. The profile 
option defaults to No if not set.

IBE: Use Web Placements No This profile option specifies whether 
eMerchandising postings from Oracle 
Marketing Online can display on Oracle 
iStore 11i Web store pages. Yes enables 
eMerchandising postings. No disables 
eMerchandising postings. The profile 
option defaults to value Yes if not set.

IBE: Use Workflow Features in 
iStore

No This profile option specifies whether 
Oracle Workflow features, such as e-mail 
notifications to customers regarding 
registration, orders, and order status 
requests, are available in your instance. 
The profile option defaults to value Yes if 
not set.

Table A–15 IBE Profile Options for Functionality (Cont.)

Profile Option Name Mandatory Description
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� IBE: View Custom Quote Line Details

The following IBE profile options are not supported:

� IBE: Add number of rows to direct entry cart

� IBE: Capture Payment for Downloadable Products

� IBE: Cart Level Support Duration

� IBE: Days For Email

� IBE: Default Contract Template Name

� IBE: Default Display Context

� IBE: Default Item Media

� IBE: Default Item Template

� IBE: Default Payment Term

� IBE: Default Pricing Agreement for the User

� IBE: Default Request Terms Change User to Send Workflow Notification

� IBE: Default Sales Assistant to Send Workflow Notification

� IBE: Default Section Media

� IBE: Default Section Template

� IBE: Default Specialty Store

� IBE: Email Promotions

� IBE: Express Checkout Error Behavior

� IBE: iStore Non Secure URL

� IBE: iStore Secure URL

� IBE: Line Level Pricing Event for Shopping Cart

� IBE: Maximum Number of Saved Shopping Carts

� IBE: Maximum Number of Shopping Lists

� IBE: Preferred Support Level for Shopping Cart

� IBE: Reserve Items On Every Express Checkout

� IBE: Search Minimum Prefix Value

� IBE: Section Name for CD Packs Section
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� IBE: Shopping Cart Price Frozen Duration

� IBE: Top Number of Items

� IBE: URL Prefix for DataBase Media

� IBE: Use CD Packs

� IBE: Use Contracts

� IBE: Use CSI Number in Order Tracker

� IBE: Use Shopping Lists 

A.8 Oracle Order Capture (ASO) Profile Options
Set the profile options in this section at the following levels:

� Site

� Application—iStore

You can also set these profile options at the following levels if the descriptions state 
that you can:

� Responsibility—IBE_CUSTOMER and any other Oracle iStore 11i customer 
user responsibility

The following table describes the ASO profile options.

Table A–16 ASO Profile Options 

Profile Option Name Value Description

ASO: Configurator URL Oracle 
Configurator 
Servlet URL

This profile specifies the URL for the 
Oracle Configurator Servlet. The URL 
should be the same as the value of BOM: 
Configurator URL of UI Manager. If you 
are using Oracle Configurator for product 
configurations in Oracle iStore 11i, you 
must set this profile option.

ASO: Credit Card Authorization

(Application level only)

No If this profile option is set to Yes, payment 
is authorized at the time the shopping cart 
is created.

Recommended value: No
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ASO: Default Order State Entered or 
Booked

Oracle Order Capture passes Oracle iStore 
11i orders to Oracle Order Management 
with this status. However, if the user 
chooses to pay by credit card or purchase 
order and does not enter the credit card 
number or purchase order number, the 
order is passed to Oracle Order 
Management with the status Entered, 
regardless of the profile option setting.

ASO: Default Order Type

(Site, application, and 
responsibility levels)

Mixed This profile option determines how the 
order is to be processed in Oracle Order 
Management. The order types are set up in 
Oracle Order Management. The profile 
option determines what price list and 
currency code appear by default in the 
main Oracle Order Capture form.

ASO: Default Salesrep No Sales 
Credit

The default sales representative who is 
allocated the sales credits for booked 
orders when the user is not entered as a 
sales representative.

ASO: Enable Use Contracts

(Application level only)

Yes/No Yes activates integration with Oracle 
Contracts, to enable features such as 
storefront display of standard terms and 
conditions from a contract template, 
requirement of agreement with terms and 
conditions before checkout, and 
negotiation of terms and conditions. Before 
setting this profile option to Yes, you must 
install Oracle Contracts and set the OKC 
profile options listed in Table A–20, "OKC 
Profile Options". 

ASO: Enable Use Contracts defaults to 
value No if not set.

ASO: OM Defaulting Yes/No This profile option specifies whether 
Oracle Order Management defaults values 
according to its rules for the following 
attributes of an order when the order is 
placed: salesrep_id, order_type_id, 
payment_term_id, fob_code, freight_
terms_code, and shipment_priority_code.

Table A–16 ASO Profile Options (Cont.)

Profile Option Name Value Description
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A.9 Oracle Order Management (OM) Profile Options
Set the profile options in this section at the following levels:

� Site

The following table describes the OM profile options.

ASO: Product Organization Master 
Inventory 
Organization

The organization that Oracle Order 
Capture uses to validate inventory items.

ASO: Quote Conversion Type Set this profile option to the same value as 
the Oracle Order Capture application level 
setting.

ASO: Reservation Level

(Site level only)

Null This profile option specifies the level at 
which item reservations are performed. 
Items can be reserved manually, or 
automatically when the order is placed.

ASO: Validate Salesrep No This profile option specifies whether a 
sales representative must be specified on a 
quote prior to submitting it as an order.

Table A–17 OM Profile Options 

Profile Option Name Value Description

OM: Debug Log Directory <Directory 
path>

If you have set the IBE: Debug profile 
option to Yes for a user, verify or set the 
profile option OM: Debug Log Directory to 
a directory that is writable by the database 
server. Oracle iStore 11i Customer UI 
user-specific logs for the PL/SQL layer are 
written in this directory.

Table A–16 ASO Profile Options (Cont.)

Profile Option Name Value Description
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A.10 Multiple Organization (MO) Profile Options
Set the profile options in this section at the following levels:

� Responsibility—IBE_CUSTOMER and any other Oracle iStore 11i customer 
user responsibility

The following table describes the MO profile options.

Setting Up MO Profile Options for Multiple Operating Units
For a multiple operating unit environment, you must create a separate IBE customer 
responsibility for each operating unit in Oracle Forms. You can use the seeded 
responsibility IBE_CUSTOMER as one of these responsibilities. Each customer 
name is assigned at least one such responsibility when the name is approved.

For each of the customer responsibilities, set the profile option MO: Operating Unit 
to its respective operating unit. 

When a customer enters a Web store, Oracle iStore 11i notes the customer’s 
responsibility and the operating unit to which it is assigned, then restricts the 
customer to the items in the Inventory Organization that is associated with the 
operating unit. Oracle iStore 11i accomplishes this by retrieving the Inventory 
Organization ID for the current user responsibility’s operating unit from the OE_
SYSTEM_PARAMETERS_ALL table. Use Oracle Order Management to associate 
Inventory Organization IDs with operating units.

Table A–18 MO Profile Options 

Profile Option Name Value Description

MO: Operating Unit Operating 
unit

This profile specifies the operating unit 
against which the user can place orders. 
The user can only view and purchase items 
that are in the Inventory Organization 
associated with this operating unit.
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A.11 Oracle Bills of Material (BOM) Profile Options
Set the profile options in this section at the following levels:

� Site

� Application—iStore

� Responsibility—IBE_CUSTOMER and any other Oracle iStore 11i customer 
user responsibility

The following table describes the BOM profile options.

A.12 Oracle Contracts Core (OKC) Profile Options
Set the profile options in this section at any of the following levels:

� Site

� Application—iStore

� Responsibility—IBE_CUSTOMER and any other Oracle iStore 11i customer 
user responsibility

The following table describes the OKC profile options.

Table A–19 BOM Profile Options 

Profile Option Name Value Description

BOM: Configurator URL of UI 
Manager

Oracle 
Configurator 
Servlet URL

This profile specifies the URL for the 
Oracle Configurator Servlet. If you are 
using Oracle Configurator for product 
configurations in Oracle iStore 11i, you 
must set this profile option.

Table A–20 OKC Profile Options 

Profile Option Name Value  Description

OKC: Change Request 
Approver

User name This profile option specifies the Oracle 
Contracts user who can approve, reject, or 
forward contract terms and conditions 
change requests.
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OKC: Contract Approver User name This profile option specifies the Oracle 
Contracts user who can approve contract 
terms and conditions change requests, or 
forward them to the user named in the 
OKC: Change Request Approver profile 
option.

OKC: Contract template for 
standard terms and conditions

Oracle 
Contracts 
template 
name

This profile option specifies the default 
Oracle Contracts template name. You can 
set up different Oracle Contracts templates 
for each Oracle iStore 11i customer user 
responsibility. Oracle iStore 11i displays the 
terms and conditions of this contract 
template when the user clicks Review 
Terms and Conditions in the Order 
Review page.

OKC: Default contract 
administrator for notifications

User name This profile option specifies the contract 
administrator who receives a notification 
when an Oracle iStore 11i user rejects 
standard terms and conditions. The 
notification appears in the contract 
administrator’s Oracle Contracts inbox.

Note: This contract administrator must also 
be a CRM Resource.

OKC: Default group for 
contracts created from quote

Oracle 
Contracts 
group

This profile option specifies the default 
group for contracts created from Oracle 
iStore 11i shopping carts. It is optional.

OKC: Notify administrator 
about new contract from iStore

Yes This profile option specifies whether the 
contract administrator named in the OKC: 
Default contract administrator for 
notifications profile option receives a 
notification when a new contract is created 
in Oracle iStore 11i.

OKC: User Directory

(Site level only)

Absolute 
directory 
path

This profile option specifies the absolute 
directory path to the XSL style sheet for 
contracts.

Table A–20 OKC Profile Options (Cont.)

Profile Option Name Value  Description
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A.13 Concurrent Program Manager Profile Options
Set the profile options in this section at the following levels:

� Responsibility—iStore Concurrent Programs Responsibility

The following table describes the profile option values for the concurrent program 
manager.

A.14 Site-Level Profile Options
Set the profile options in this section at the following levels:

� Site

The following table describes the site-level profile option values.

Table A–21 Profile Options for the Concurrent Program Manager 

Profile Option Name Value1

1 Generally, set the same profile option values for the iStore Concurrent Programs Responsibility as for 
the IBE_CUSTOMER responsibility.

ASO: Default Order Type Standard 

ASO: Default Salesrep No Sales Credit 

ASO: Validate Salesrep No 

Table A–22 Site-Level Profile Options 

Profile Option Name Value

Sequential Numbering Partially Used
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B

Seeded Responsibilities

This appendix lists the Oracle Forms, Oracle CRM Applications, and Oracle iStore 
11i Customer UI users and responsibilities necessary to implement Oracle iStore 11i.

You can create new users and responsibilities, and assign responsibilities as needed. 
See Oracle Applications System Administrator’s Guide, Oracle CRM Technology 
Foundation Implementation Guide, and Oracle CRM Technology Foundation Concepts and 
Procedures for more information.

Topics include:

� Oracle Forms Responsibilities

� Oracle CRM Applications Responsibilities

� Oracle iStore 11i Customer UI Responsibilities
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B.1 Oracle Forms Responsibilities
Access Oracle Forms by navigating to:

http://<host>:<apache port>/

and clicking Apps Logon Links > VIS Logon through the Forms cartridge. Log in 
with the appropriate user name and responsibility to perform the specified tasks.

The following table summarizes the responsibilities necessary to perform setup and 
administrative tasks for Oracle iStore 11i in Oracle Forms.

Table B–1 Oracle Forms Responsibilities 

Responsibility Tasks

AK Developer Define regions in Apps to troubleshoot Postsales errors. See 
Section 8.14, "Postsales Errors" for details.

Application Developer Enable or disable B2B or B2C user registration. See Section 5.11.1, 
"Setting Up Customer Registration" for details.

Modify messages to change the text in the Customer UI bins. See 
Section 6.3.1, "Creating Template Source Files" for details.

Set up descriptive flexfields to appear on item detail pages. See 
Section 6.7.2, "Adding Item Descriptive Flexfields" for details.

Set up comment flexfields to appear on the checkout page. See 
Section 6.8.4, "Specifying Flexfields At the Checkout Page" for 
details.

Apps for the Web 
Manager

Define regions in Apps to troubleshoot Postsales errors. See 
Section 8.14, "Postsales Errors" for details.

General Ledger Super 
User

Set the daily currency conversion rate in Oracle General Ledger 
for Storefront Reports. See Section 5.10.3, "Setting Up Conversion 
Rates for Storefront Reports" for details.

Inventory responsibility 
for the Master Inventory 
Organization

Publish items in Oracle Inventory to make them available for sale 
in the specialty stores. See Section 3.1.8, "Setting Up Product 
Items in Oracle Inventory" and Section 5.7, "Building the Product 
Catalog" for details.

Specify in Oracle Inventory if customers can order decimal 
quantities of an item in the specialty stores. See Section 6.8.3, 
"Allowing Decimal Quantities for Items" for details.
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iStore Concurrent 
Programs Responsibility

Schedule the concurrent program iStore - Express Checkout 
Order Submission to submit Express Checkout orders. See 
Section 5.2.4, "Scheduling Concurrent Programs" for details.

Run the concurrent programs iStore Search Insert and iStore 
Section Search Refresh when setting up product searches. See 
Section 5.8, "Setting Up the Product Search" for details.

Schedule or run the request set iStore Reports Complete Data 
Refresh Set, which has the concurrent programs iStore Reports 
Fact Tables Refresh and iStore Reports Materialized Views 
Refresh, to prepare data for Storefront Reports. See Section 5.10.4, 
"Preparing Data for Storefront Reports" for details.

Schedule or run the request set iStore Reports Increment Data 
Refresh Set, which has the concurrent programs iStore Reports 
Fact Tables Refresh and iStore Reports Materialized Views 
Refresh, to increment data for Storefront Reports. See 
Section 5.10.4, "Preparing Data for Storefront Reports" for details.

Oracle Pricing Manager Set up Oracle Pricing. See Section 3.1.11, "Setting Up Oracle 
Pricing" for details.

Order Capture Sales 
Manager

Set up Oracle Order Capture. See Section 3.1.13, "Setting Up 
Oracle Order Capture" for details.

Check to make sure Oracle Order Capture is working when 
troubleshooting problems with adding items to shopping carts or 
placing orders. See Section 8.16, "Reporting Issues" for details.

Order Management 
Super User

Set up Oracle Order Management. See Section 3.1.12, "Setting Up 
Oracle Order Management" for details.

Set up Web-enabled shipping methods. See Section 3.1.12, 
"Setting Up Oracle Order Management" for details.

Receivables Manager Set up Oracle Receivables. See Section 3.1.10, "Setting Up Oracle 
Receivables" for details.

Set up Oracle Receivables for credit card payments in Oracle 
iStore 11i. See Section 12.2, "Setting Up Oracle iPayment" for 
details.

Table B–1 Oracle Forms Responsibilities (Cont.)

Responsibility Tasks
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System Administrator Set Oracle CRM Technology Foundation (JTT) profile options. See 
Section 3.1.14, "Setting Profile Options for the Oracle iStore 11i 
Merchant UI" for details.

Set Oracle iStore (IBE) profile options. See Section 3.1.14, "Setting 
Profile Options for the Oracle iStore 11i Merchant UI" and 
Section 5.12.1, "Setting Oracle iStore 11i (IBE) Profile Options for 
the Customer UI" for details.

Set up Oracle iStore 11i store manager user accounts. See 
Section 5.1, "Setting Up Store Manager User Accounts" for details.

Set profile options for the responsibility iStore Concurrent 
Programs Responsibility. See Section 5.2.2, "Setting Concurrent 
Program Manager Profile Options" for details.

Set up a user as the concurrent program manager. See 
Section 5.2.3, "Creating a Concurrent Program Manager" for 
details.

Check the status of concurrent program requests. See 
Section 5.2.5, "Checking Concurrent Program Status" for details.

Set up the Oracle iStore 11i guest user account. See Section 5.3, 
"Setting Up the Guest User Account" for details.

Set Oracle Order Capture (ASO) profile options. See 
Section 5.12.2, "Setting Oracle Order Capture (ASO) Profile 
Options" for details.

Set Oracle Order Management (OM) profile options. See 
Section 5.12.3, "Setting Oracle Order Management (OM) Profile 
Options" for details.

Set Multiple Organization (MO) profile options. See 
Section 5.12.4, "Setting Multiple Organization (MO) Profile 
Options" for details.

Set site-level profile options. See Section 5.12.5, "Setting Site-Level 
Profile Options" for details.

Enter values for the descriptive flexfields that appear on item 
detail pages when they are set up with the Application Developer 
responsibility. See Section 6.7.2, "Adding Item Descriptive 
Flexfields" for details.

Set the profile option BOM: Configurator URL of UI Manager. See 
Section 10.4, "Setting Up Oracle Configurator" for details.

Set up credit card payments in Oracle iStore 11i. See Section 12.2, 
"Setting Up Oracle iPayment" for details.

Table B–1 Oracle Forms Responsibilities (Cont.)

Responsibility Tasks
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B.2 Oracle CRM Applications Responsibilities
Access the Oracle CRM Applications login page at:

http://<host>:<apache port>/OA_HTML/jtflogin.jsp

Log in with the appropriate user name and responsibility to perform the specified 
tasks.

The following table summarizes the user names and responsibilities necessary to 
perform setup and administrative tasks for Oracle iStore 11i in Oracle CRM 
Applications.

Table B–2 Oracle CRM Applications Users and Responsibilities 

User Responsibility Tasks

<Store Manager 
User Account>

IBE_ADMINISTRATOR

Logging in with this 
responsibility launches 
the Oracle iStore 11i 
Merchant UI.

Set up and modify specialty stores. See 
Section 5.5, "Creating Specialty Stores" for 
details.

Set up and modify the hierarchy. See 
Section 5.6, "Creating the Hierarchy" for details.

Set up and modify the product catalog. See 
Section 5.7, "Building the Product Catalog" for 
details.

Set up notification configurations. See 
Section 5.9, "Setting Up Notifications" for 
details.

Set up store appearance by managing 
multimedia, multimedia components, 
templates, and display styles at item, category, 
section, and store level. See Chapter 6 for more 
information.

Set up product relationships. See Section 6.5, 
"Creating Product Relationships" for details.

Manage the product and section caches. See 
Section 6.10, "Managing the Cache" for details.
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B.3 Oracle iStore 11i Customer UI Responsibilities
Customers are also assigned user names and responsibilities, which customize their 
Web store experience. At least one customer responsibility is assigned to each 
customer name when the name is approved during user registration. You can use 
the seeded IBE_CUSTOMER responsibility and create other customer 
responsibilities too.

In a multiple operating unit environment, you need to create a customer 
responsibility for each operating unit if you want a customer to access only items 
from the Inventory Organization specific to each operating unit.

In the Merchant UI, you can specify a list of the customer responsibilities that are 
supported by a given specialty store. You can select these from all existing 
responsibilities. You can also specify for a given specialty store whether Oracle 
iStore 11i checks the customer’s responsibilities and grants access only if the 
customer has an assigned responsibility that is supported by the specialty store.

If multiple responsibilities are supported by a specialty store, a customer who logs 
in to the store must choose one responsibility for that session. The responsibility 
uniquely identifies the operating unit against which any orders placed during the 
session will be booked. The responsibility is assigned only for the current session.

If you set up a specialty store to check the customer’s responsibility, the customer 
can choose only from the responsibilities that have been assigned to him or her 
during registration. If the specialty store is not set up to check the customer’s 

SYSADMIN CRM HTML 
Administration

Logging in with this 
responsibility launches 
the Oracle CRM System 
Administrator Console.

Set up Oracle CRM Technology Foundation. 
See Section 3.1.15, "Setting Up Oracle CRM 
Technology Foundation" for details.

Set up the Oracle iStore 11i guest user account 
as the Oracle CRM Technology Foundation 
self-service user. See Section 5.3.1, "Creating the 
Guest User" for details.

Set up default roles and responsibilities for 
customer users. See Section 5.11, "Setting Up 
Oracle iStore 11i Customer User Registration" 
for details.

Create B2B user roles. See Section 6.9, "Creating 
B2B User Roles" for details.

Table B–2 Oracle CRM Applications Users and Responsibilities (Cont.)

User Responsibility Tasks
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responsibility, then the customer can choose any supported responsibility in any 
specialty store that does not check the customer’s assigned responsibilities.

The following table summarizes the responsibilities seeded by Oracle iStore 11i for 
Web store customers to use in the Customer UI, located at:

http://<host>:<apache port>/OA_HTML/ibeCZzdMinisites.jsp

Table B–3 Oracle iStore 11i Customer UI Users and Responsibilities 

User Responsibility Tasks

<Guest User 
Account>

IBE_CUSTOMER The guest user name is assigned to every 
customer who browses the store without 
registering. You must assign the IBE_
CUSTOMER responsibility or another customer 
responsibility as a default for guest users. See 
Section 5.3, "Setting Up the Guest User Account" 
for details.

<Customer User 
Account>

IBE_CUSTOMER Select IBE_CUSTOMER or another customer 
responsibility to be assigned by default to every 
registered customer. See Section 5.11.2, "Setting 
Default Customer Responsibilities" for details.
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C

Self-Service Administration

This appendix describes the tasks required to manage a store using the iStore 
Self-Service Administrator UI instead of the Merchant UI. Topics include:

� The iStore Self-Service Administrator UI

� Home Page

� Store

� Catalog

� Pricing

� Orders

� Currency and Language
ration C-1
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C.1 The iStore Self-Service Administrator UI
The iStore Self-Service Administrator UI enables easy deployment of Oracle iStore 
11i. Product descriptions, availability, and pricing can be revised or added to a Web 
site quickly and easily. With this ability to act quickly, merchants can set themselves 
apart from the competition and reach the market faster.

C.1.1 Benefits of Self-Service Administration
B2C retailers can rapidly deploy Web stores. Self-service setups provide the 
following:

� One-stop easy setup

� Point-click-customize storefront

� Easy catalog management through self-service upload and download 
functionality, eliminating the need for the daily assistance of technical staff

� Seamless integration with Oracle’s existing CRM and ERP applications: Oracle 
Inventory, Oracle Pricing, Oracle Order Management, Oracle Contracts, Trading 
Community Architecture (TCA)

� Integration with backend fulfillment systems

� Global and scalable application with high availability

C.1.2 Components of Self-Service Administration
Self-service setups for Oracle iStore 11i leverage existing CRM and ERP applications 
and are fully integrated with the Oracle e-Business Suite. The following 
functionality is included in the self-service setups:

� Store Setup: Store Setup allows merchants to set up the supported currencies, 
languages, locations (bill-to and ship-to countries), payment types, notifications, 
and shipping methods. Merchants can set up sales tax for all U.S. states and 
item exceptions for sales tax, using the store setup screens.

� Storefront Setup: Merchants can create storefronts with custom content, logo, 
layout, and colors using a point-and-click interface that does not require 
knowledge of HTML.

� Enhanced Catalog Management: Merchants can create sections, products with 
basic prices, and multimedia. They can perform bulk upload and download of 
products. Both XML and CSV formats are supported.
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� Pricing and Promotion Management: Merchants can create price lists and 
manage percent and price override discounts for customers and products. 
Percent and flat rate freight charges can be created for all shipping methods. 
Batch upload and download of price lists is also supported.

� Order Management: Self-service order management provides order history for 
customers. Orders can be downloaded from the system and interfaced with a 
backend fulfillment system. Both CSV and XML formats are supported for 
order management.

C.1.3 Restrictions of Self-Service Administration
Your organization must meet the following criteria before you can use the iStore 
Self-Service Administrator UI to implement Oracle iStore 11i:

� You are implementing Oracle iStore 11i for the first time.

� You support only B2C accounts.

� You have never used the Oracle iStore 11i Merchant UI to modify your store in 
any way. This restriction holds true even if you originally set up your store in 
the iStore Self-Service Administrator UI.

� You are using the seeded Oracle iStore 11i templates.

� You are only doing business in the U.S.

� You support only price override and percentage discounts.

� You support only flat and percentage freight charges based on order amounts.

Organizations that fit the above criteria can use self-service setups. Otherwise, you 
should use the Oracle iStore 11i Merchant UI.

C.1.4 Setting Up a Self-Service Administrator Account
You must have the iStore Self-Service Administrator responsibility to access the 
iStore Self-Service Administrator UI. Use the following procedure to create a user 
account with the iStore Self-Service Administrator responsibility.

Steps
1. Log in to Oracle Forms with the System Administrator responsibility.

2. Choose Security > User > Define.

The Users window opens.
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3. In the User Name field, enter the user name that the store manager will use to 
log in to the Oracle iStore 11i Merchant UI.

4. In the Password field, enter the store manager’s password.

5. In the Responsibilities block, choose iStore Self Service Administrator from a 
Responsibility LOV. 

6. Save the user record.

7. In the Navigator, choose Profile > System.

The Find System Profile Values window opens.

8. Check User, and choose the store manager’s user name from the User LOV.

9. In the Profile field, enter JTF_PROFILE%.

10. Click Find.

The System Profile Values form opens with the results of your search.

11. Verify or set the profile options listed in the following table at the user level for 
this store manager:

C.1.5 Self-Service Administrator Profile Options
If you choose to implement a Web store using the Self-Service Administrator UI, 
you must set the related profile options. Use the following procedure to set these 
profile options.

Steps
1. Log in to Oracle Forms with the System Administrator responsibility.

2. Go to Profile > System.

The Find System Profile Values window opens.

Table C–1 User-Level Profile Options for Self-Service Administrators 

Profile Option Name Value Description

JTF_PROFILE_DEFAULT_
APPLICATION

671 Default application ID 
(671=iStore)

JTF_PROFILE_DEFAULT_
RESPONSIBILITY

23033 Default responsibility ID 
(23033=iStore Self Service 
Administrator)
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3. Check Site, Application, and Responsibility. Select iStore as the application 
and iStore Self Service Administrator as the responsibility.

4. In the Profile field, enter IBE%EOS%. Click Find.

5. Verify or set the Self-Service Administrator profile options listed in the 
following table at site, application, responsibility, or user level as required.

Table C–2 Self-Service Administrator Profile Options 

Profile Option Name Description

IBE: EOS Admin Specialty Store This profile specifies the specialty store that is currently 
active.

IBE: EOS Allow Close Order This profile is not in use.

IBE: EOS Allow Contract Approval This profile is not in use.

IBE: EOS Default Price List This profile specifies the default price list.

IBE: EOS Display Home Bins This profile specifies whether the home page bins are 
displayed.

IBE: EOS File Location This profile specifies the directory location of the files 
for your specialty store.

IBE: EOS Media Location This profile specifies the directory location of the media 
source files for your specialty store.

IBE: EOS Ship Carrier This profile specifies the available shipping carrier for 
your specialty store.
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C.2 Home Page
The Home page is the landing page for the self-service application. From this page, 
merchants can see a summary of store activity, top customers, top orders, and top 
selling products. The background job status box is also on the Home page, enabling 
users to review completed jobs, and those in process.

C.2.1 Background Job Status Box
This bin shows the status of store jobs. Jobs are typically upload or download 
requests.

Job status can be:

� In Process—A job is in the queue, or is currently running with normal 
conditions.

� Completed Successfully—A job has completed with no errors.

� Completed with Errors—A job has completed with errors.

� Inactive—A job is disabled, on hold, or has no manager.

To see the jobs with a particular status, click the number hyperlink next to the job 
status.  This opens the Background Job Search window, which lists all jobs of the 
specific status. To see a background job’s details, select its radio button from the 
search result list and click View Details. 

C.2.1.1 Searching for a Background Job
To search for a job type, enter its job number and click Go. If you do not know the 
job number, go to the advanced search page by clicking Advanced.

The advanced search for background jobs enables you to search for jobs by the date 
the job was submitted or completed, job number, job status, and description. Enter 
your query and click Go.

To see a background job’s details, select its radio button from the search result list 
and click View Details. 

Note: The list of statuses on the advanced search page is more 
detailed than the list in the background job bin.
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C.2.1.2 Background Job Details
The Background Job Details page shows the job details and all errors and warnings 
that occurred during processing.

Errors indicate that the record in the line number was not processed at all.  
Warnings indicate that although the record was processed, there was a possible 
discrepancy that you should investigate.

C.3 Store
From the Store tab, store managers can set up basic business fundamentals as well 
as customize the look and feel of their store front.

C.3.1 Defining the Store Site
Before a store can open for business, basic site information must be set up. After the 
store is open, some of these settings can be changed, but the merchant must be 
careful to minimize the impact on customers.

The process flow below illustrates the steps in the site definition. The grey boxes 
indicate required steps, while the steps in white boxes are optional.
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C.3.2 Site
Use this procedure to define your site, or to change existing settings.

1. Select the Store tab.

The Site window opens under the Set Up subtab.

2. Complete the Site Information section. Fields with an asterisk (*) are required:

a. *Site Name field: Enter the name of your site.

b. Site description field: Enter your store description. This description will be 
used by some external search engines. Make sure the description clearly 
communicates what your store sells so you can attract buyers.

c. *Default Language: Select the language that your company uses regularly. If 
you operate internationally, select the language in which most of your 
content will originate. 

d. *Default Currency: Select the base currency in which you do business. 

e. Disable Walk in Users: Select this checkbox if you want to require all site 
visitors to register with your store before they can browse your inventory. 

f. Site Status: A read only field indicating store status. New stores default to 
closed until they are explicitly activated. See "Status" for more details.

3. Click Apply to save your site settings.

C.3.3 Language
Merchants can manage their store in multiple languages. This feature is extremely 
beneficial when selling to a global market, but it does require the merchant to 
supply necessary translations for each supported language.

If a single default language is defined in the site setup, then this will be the only 
language supported. See "Defining the Store Site".

Use this procedure to define the languages your store will support.

1. Select the Store tab.

The Site window opens under the Set Up subtab.

2. Select Language from the side navigation list menu.

The Store Languages window opens.

3. Find the languages that your store will support. 
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Note: Click Next at the bottom of the table to view the complete language list.

4. Enable the languages you want by selecting their checkboxes.

5. Save selections by clicking Apply.

You will need to click Apply for every set of languages before you click Next. 

C.3.4 Currency
Merchants can do business in many currencies. This is an advantage for 
international businesses that must support multiple currency price lists. 

If your store will only support the default currency, then skip this procedure.

Use this procedure to define the currencies you want to support.

1. Confirm that a price list exists for the currency that you want to enable.

See "Creating New Price Lists" for more details. 

2. Select the Store tab.

The Site window opens under the Set Up subtab.

3. Select Currency from the side navigation list menu.

The Currency and Price Lists window opens.

4. Enable currencies by selecting their checkboxes.

5. Select the price list that should be effective for the currency.

6. Save selections by clicking Apply.

C.3.5 Country
Merchants may choose not to do business with certain countries for various reasons. 
Merchants can block a customer from buying from their store in two different ways:

� Stop a transaction if the Ship To location is in a country that the merchant does 
not do business with 

� Stop a transaction if the Billing Address of the customer is in a country that the 
merchant does not do business with.

Use this procedure to define the countries your store will do business with.

1. Select the Store tab.

The Site window opens under the Set Up subtab.
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2. Select Countries from the side navigation list menu.

The Bill To/Ship To Locations window opens.

3. Find the countries that you will do business with by searching for the countries 
or clicking Next at the bottom of the table to view the complete list of countries.

4. Enable the countries as Bill To or Ship To locations.

5. Save selections by clicking Apply.

C.3.6 Payment
Merchants must select the customer payment options that they want to support. 
Merchants will receive orders with payment information specific to the option that 
was selected by the customer. Merchants are responsible for authorizing and taking 
payment themselves.

Use this procedure to define the payment options that you want to support.

1. Select the Store tab.

The Site window opens under the Set Up subtab.

2. Select Payment from the side navigation list menu.

The Payment Types window opens.

3. Enable all payment options that you want to support by clicking their check 
boxes.

4. Save selections by clicking Apply. 

You may need to click Next at the bottom of the table to find additional 
payment options.

C.3.7 Tax
Merchants can set up tax rules for sales within the United States. Merchants are 
responsible for maintaining the tax rate that they will charge for each state.

Taxes are based on the buyer’s Ship To location. Merchants must specify the states 
for which they want to charge tax.

Use this procedure to define the U.S. tax rates for your store.

1. Select the Store tab.

The Site window opens under the Set Up subtype.
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2. Select Tax from the side navigation list menu.

The US Sales Tax Rates window opens.

3. Fill in the tax rate for each state where tax will be charged. 

Note: 8.5% should be entered as 8.5. For states that you are not charging tax, 
leave 0.

4. Click Apply when you finish entering rates on a page.

5. Click Next to retrieve the next set of states.

6. Repeat steps 3-5 until you finish entering all of your tax rates.

C.3.7.1 State Tax Item Exceptions
Some items in your inventory may have a different state tax rate. For example, tax 
in the state of California is 8.25%, but cigarettes have a much higher tax of 20.5%.

Use the following procedure to configure item state tax exceptions.

1. From the US Sales Tax Rate page, click Item Exceptions.

The Item Exception Detail window opens.

2. Click Add Item Exception.

The Add Item Exception window opens.

3. Enter the item number.

If you do not know the exact item number, click the flashlight and search for the 
item. Select the item from the result list and click Apply. 

4. Pick the state. Enter the exception rate and the start and end dates for this 
exception.

You can leave dates blank.

5. Click Add Another Row to add a new row for state tax exceptions.

6. Repeat steps 4 and 5 for every state exception for this item.

Note: Searches are case sensitive.
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C.3.8 Shipping
Use this procedure to define the shipping charges.

1. Select the Store tab.

The Site window opens under the Set Up subtab.

2. Select Shipping from the side navigation list menu.

The Shipping Method window opens.

3. To create a new shipping method:

a. Click Create Shipping Method.

A new row in the shipping method table is inserted.

b. Fill in the name of the shipping method.

The customer will see the name when selecting his or her shipping 
preference, so you should make the name descriptive.

c. Save the new method by clicking Apply.

4. Create freight calculation methods for the shipping method.

If you do not want to bill the customer for this method, then you can skip this 
step.

a. Click the Freight update icon next to the method name.

The Shipping Method Details window opens.

b. Click Create Freight Calculation Method.

The Create Freight Calculation Method window opens.

c. Select the calculation method.

d. Select currency.

e. Save changes by clicking Apply.

5. Define calculation rules.

You can define different shipping calculation rules based on the calculation 
method that you have chosen. For example, if you chose Percentage Based on 
Order Amount as your calculation method, then you may want to charge 20% 
of the order for all orders under $30, 10% for all orders between 30 and 100, and 
7% for all orders over $100. You cannot create overlapping amount ranges.

The following table shows an example of these freight calculation rules.
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6. Save the calculation rules by clicking Apply.

7. Test the calculation rules.

Test shipping rules with the Rules Test Calculator, located below the rules table.

8. Enable the shipping method.

a. Click Return to Shipping Details in the Freight Calculation page.

b. Enable the calculation method by selecting the Enable checkbox and 
clicking Apply.

c. Return to the Shipping Methods window and confirm that the shipping 
method is also enabled.

C.3.9 Notification
To set up customer notifications, use the following procedure.

1. Select the Store tab.

The Site window opens under the Set Up subtab.

2. Select Notifications from the side navigation list menu.

The Notifications window opens.

3. Customize the text for each notification.

a.  Click Update for each notification.

The Notification Details window will open.

b. Customize the text of the notification. 

c. Click Apply to save your changes.

4. Repeat for each enabled notification.

The following table lists all of the available notifications with the set of tags 
available to each. 

Order Amt From Order Amount To Percentage

0 30 20

30.01 100 10

100.01 999,999,999 7
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Notification Tag Description

Account Registration 
Notification

E-mail notification sent to new users 
after they have registered at your store

&FIRSTNAME User’s registered first name

&LOGINNAME User’s login name

&PASSWORD User’s password

Close Order Notification E-mail notification sent when the 
order has been closed and fulfilled by 
the merchant

&STOREADDRESS The customer’s ship to address

&ORDERHEADER Contains the order number, tracking 
number, ship date, ship method, and 
the ship to address

&ORDERDETAIL Contains the products purchased with 
quantity, licensing unit, shipping 
status, and amount

&ORDERSUM Contains the total sum of the order 
including tax and shipping

Contract Term Approved Notification sent to the customer 
when a new contract is approved for 
him or her

&FIRSTNAME User’s registered first name

&CONTRACTREF

&CARTNAME

Customer Notification 
on Request for Sales 
Assistance

&ORDERHEADER Contains the order number, tracking 
number, ship date, ship method, and 
the ship to address

&ORDERDETAIL Contains the products purchased with 
quantity, licensing unit, shipping 
status, and amount

&ORDERFOOTER Contains the shipping cost, tax 
estimate, and total order amount
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 Notification for 
Customer Quote

&ORDERHEADER Contains the order number, tracking 
number, ship date, ship method, and 
the ship to address

&ORDERDETAIL Contains the products purchased with 
quantity, licensing unit, shipping 
status, and amount

&ORDERFOOTER Contains the shipping cost, tax 
estimate, and total order amount

Notification to Salesrep 
for Customer Quote

&ORDERHEADER Contains the order number, tracking 
number, ship date, ship method, and 
the ship to address

&ORDERDETAIL Contains the products purchased with 
quantity, licensing unit, shipping 
status, and amount

&ORDERFOOTER Contains the shipping cost, tax 
estimate, and total order amount

 Order Confirmation 
Notification

E-mail notification sent to customers 
after they submit their orders

&ORDERHEADER Contains the order number, tracking 
number, ship date, ship method, and 
the ship to address

&ORDERDETAIL Contains the products purchased with 
quantity, licensing unit, shipping 
status, and amount

&ORDERFOOTER Contains the shipping cost, tax 
estimate, and total order amount

 Order Confirmation for 
Faxed Orders

E-mail notification sent to customers 
after they fax their purchase orders

&ORDERHEADER Contains the order number, tracking 
number, ship date, ship method, and 
the ship to address

&ORDERDETAIL Contains the products purchased with 
quantity, licensing unit, shipping 
status, and amount

Notification Tag Description
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C.3.10 Profile Preferences
Use the following procedure to set up basic profile options.

1. Select Store Profiles from the side navigation menu.

2. Complete the form. Descriptions of each preference are below.

C.3.10.1 Catalog
� Display number of items per page: The number of items that are displayed on 

a leaf section page. If the number of items in the section exceeds this value, the 
page displays a Next link. This profile defaults to value 20.

� Display number of sections per page: The number of sections that appear on a 
page. Customers will be able to see all sections by clicking Next.

� Display number of items per section: The maximum number of items that are 
displayed per section. If the profile is not set, all items in a section are 
displayed.

&ORDERFOOTER Contains the shipping cost, tax 
estimate, and total order amount

Salesrep Notification on 
Request for Sales 
Assistance

E-mail sent to the merchant when the 
customer does not accept the standard 
terms of a contract

&ORDERHEADER Contains the order number, tracking 
number, ship date, ship method, and 
the ship to address

&ORDERDETAIL Contains the products purchased with 
quantity, licensing unit, shipping 
status, and amount

&ORDERFOOTER Contains the shipping cost, tax 
estimate, and total order amount

Order has been shared When a customer shares his cart, an 
e-mail is sent to the sharee to notify 
him or her

$QUOTENAME The name of the shopping cart

&COMMENTS The sharer’s comments

&PASSWORD The password to the cart

Notification Tag Description
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C.3.10.2 Shopping Cart
� Expiration Duration: The number of days that an inactive shopping cart is 

available to the customer.

� Price Frozen Duration: The number of days to maintain original prices on 
shopping cart items.

� Use Shopping List: Allow customers to create shopping lists.

� Use Sales Assistance: Allow customers to request sales assistance.

� Sales Assistance Username: The username of the sales representative 
responsible for assisting online customers. This user will receive the sales 
assistance notifications at the e-mail address that is set up in his or her profile.

C.3.10.3 Orders
� Use Express Check out: Allow users to check out quickly by using their profile 

information.

� Order Admin Username to send notification: The username of the merchant 
that should get the order information. This user will receive the order 
notifications at the e-mail address that is set up in his or her profile.

C.3.10.4 Contracts
� Use Contracts: Enable the contracts feature. 

C.3.11 Status
Use the following procedure to check the status of your store and to open or close it 
to the public.

1. Select the Store tab.

The Site window opens under the Setup subtab.

2. Select Status from the side navigation menu. 

The Store Status window opens. Check that all of the information is correct.

3. Click Open Store. If your store is already open, the Close Store button appears 
instead.
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C.3.12 Store Front
A Store Front is the look and feel of your online store. You can set up several store 
fronts, but only one can be active at a time. 

The process flow below illustrates all of the steps required to set up a new store 
front.

C.3.13 Creating New Store Fronts
If your store is already active and you want to change the look and feel without 
affecting your customers, then you must create a new store front. 

There are two ways to create a new store front. 

Use this procedure to create a new store front with no defaults set.

1. Select the Store tab.

The Site window opens under the Set Up subtab.

2. Select the Store Front subtab.

The store front window opens.
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3. Click Create Store Front.

The store front details window opens.

4. Enter the site name and description.

These values are for the merchant only. Customers will not see them.

5. Save your changes by clicking Apply.

Use this procedure to create a new store front by duplicating an existing one.

1. Select the Store tab.

The Site window opens under the Set Up subtab.

2. Select the Store Front subtab.

The Store Front window opens.

3. Select the radio button of the store front that you want to duplicate.

4. Click Duplicate.

The Store Front details window opens.

5. Modify the store front name and description.

Two store fronts cannot have the same name.

6. Save your changes by clicking Apply.

C.3.14 Editing Existing Store Fronts
Use this procedure to edit a store front.

1. Select the Store tab.

The Site window opens under the Set Up subtab.

2. Select the Store Front subtab.

The Store Front window opens.

3. Select the radio button of the store front that you want to edit.

4. Click Update.

The Store Front Details window opens.

5. Modify the store front details.

6. Click Apply to save changes.
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You can also delete an existing store front by selecting it from the table and clicking 
Delete. 

C.3.15 Store Front Content
You can customize the content your customers will see on your store front with 
Bins, special pages, and a store logo.

C.3.16 Bin Content Selection
Bins are sections of content that are grouped together on the section pages. A 
merchant can have up to six Bins on a page.

Use this procedure to select the Bins you want to display.

1. Go to the Update window for your store front.

Follow the instructions in "Editing Existing Store Fronts".

2. Select Content from the side navigation list menu.

The Content Container (Bins) window opens.

3. Select the Bins that you want to display.

4. Save your changes by clicking Apply.

Custom Bins
Use the following procedure to modify the content of the Custom Bins.

1. From the Content Container (Bins) window, click the Update button of the 
Custom Bin that you want to edit.

The Customize Bin Content window opens.

2. Enter the Bin Title and Body with plain text.

3. Save the Custom Bin definition by clicking Apply.

4. Click Preview to preview the Bin’s appearance. 

Note: You cannot delete active store fronts.
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C.3.17 Special Pages
Special pages are used by merchants to communicate important information about 
their store. Use the following procedure to set up the special pages of your site.

1. Go to the Update window for your store front.

Use the instructions in "Editing Existing Store Fronts".

2. Select Content from the side navigation list menu.

The menu expands with submenu items.

3. Select Special Pages from the side navigation list menu.

The Special Pages Window opens.

4. Select the special pages that you want to include on your site.

5. Save your selections by clicking Apply.

Customizing Special Pages
Use the following procedure to customize the content of a special page.

1. From the Special Page window, click the Update button of the special page that 
you want to edit.

The Customize Special Page Content window opens.

2. Enter the special page title and body with plain text. 

3. Save the special page content by clicking Apply.

4. Click Preview to preview the special page’s appearance. 

Note: Each store front can have a unique set of special pages. If 
you are creating a new store front, then you must redefine these 
pages. However, if you are creating a new store by duplicating a 
existing one, you will get a copy of the other store front’s special 
pages.
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C.3.18 Store Logo
Your store logo should have the actual name of your store, as well as the image that 
represents it. 

To select your store logo, use the following procedure.

1. Go to the Update window for your store front.

Use the instructions in "Editing Existing Store Fronts".

2. Select Content from the side navigation list menu.

The menu expands with submenu items.

3. Select Store Logo from the side navigation list menu.

The Store Logo Window opens.

4. Click the flashlight icon to search for your store logo in the multimedia library.

If you cannot find your logo in the multimedia library, then upload it. For more 
information, see "Multimedia".

5. Click Apply to save changes.

C.3.19 Configuring Layout
In this section you will determine how the content is displayed in your store. There 
are three major parts to this section: 

� Page Layout

� Bin Locations

� Display Styles

C.3.19.1 Page Layout
Page Layout represents the general layout for all Web pages in your store. 

Use this procedure to select your preferred layout.

1. Go to the Update window for your store front.

Use the instructions in "Editing Existing Store Fronts".

2. Select Layout from the side navigation list menu.

The menu expands with submenu items, and the Page Layout window opens.

3. Select your preferred page layout.
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4. Save your choice by clicking Apply.

C.3.19.2 Bin Locations
Bin locations enable you to manipulate the order and arrangement of the Bins that 
were selected earlier. See "Bin Content Selection".

Use this procedure to arrange the location of your Bins.

1. Go to the Update window for your store front.

Use the instructions in "Editing Existing Store Fronts".

2. Select Layout from the side navigation list menu.

The menu expands with submenu items, and the Page Layout window opens.

3. Select BIN Locations from the side navigation list menu.

The Bin Locations and Order window opens.

4. Use the arrows to arrange the location and order of the Bins.

5. Save your changes by clicking Apply.

6. Preview the Bin arrangement by clicking Preview.

A separate window launches with your store front content shown in preview 
mode. When you finish previewing, close the window and return to the store 
manager.

C.3.19.3 Display Styles
In this section, you will select the default layout of each type of page in your store. 
There are four major page types:

� Items: An Item page is what the user will see when looking at a single product 
in your store. This page has all the information about that product. 

� Leaf Sections: Sections that contain items are called Leaf Sections. These pages 
show the list of products in the section.

� Non Leaf Sections with Featured Subsections: Sections with subsections are 
called Non Leaf Sections. The page layout of Non Leaf Sections with Featured 
Subsections displays both the subsections and the items of the featured 
subsections.

� Non Leaf Sections without Featured Subsections: The page layout of Non Leaf 
Sections without Featured Subsections displays subsections only.
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Use the following procedure to configure the display styles.

1. Go to the Update window for your store front.

Use the instructions in "Editing Existing Store Fronts".

2. Select Layout from the side navigation list menu.

The menu expands with submenu items, and the Page Layout window opens.

3. Select Display Styles from the side navigation list menu.

The Display Styles window opens.

4. Select a default style for each page type.

5. Save your changes by clicking Apply.

C.3.20 Selecting Colors
Use the following procedure to select the color scheme that best suits your store.

1. Go to the Update window for your store front.

Use the instructions in "Editing Existing Store Fronts".

2. Select Colors from the side navigation list menu.

The Colors window opens.

3. Select a color scheme.

4. Save your changes by clicking Apply.

5. Preview the Bin arrangement by clicking Preview.

C.3.21 Store Front Preview
The Store Front Preview shows all of your configuration choices, but not specific 
store data.

Use the following procedure to preview your store front.

1. Select the Store tab.

The Site window opens under the Set Up subtab.

2. Select the Store Front subtab.

The Store Front window opens.

3. Select the radio button of the store front that you want to preview.
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4. Click Preview.

A modal window opens with a preview of the store front configurations.

C.3.22 Setting the Default Store Front
If you have defined more than one store front, you must set one as the default.

Use the following procedure to set a store front as the default:

1. Select the Store tab.

The Site window opens under the Set Up subtab.

2. Select the Store Front subtab.

The Store Front window opens.

3. Select the radio button of the store front that you want to set as the default.

4. Click Activate.

C.4 Catalog
From the Catalog tab, merchants can access and maintain store sections, items, and 
multimedia content.

C.4.1 Sections
In this section you will learn how to add items to your store, and how to organize 
them into store sections. Before you configure the system, please review the 
material below about store sections and the best way to use them.

� The goal of most merchants is to enable customers to find what they want 
quickly, using the smallest number of browser clicks.

� If you do not have many products in your store, you may choose to list them all 
on your home page. Users will see them and be able to purchase with a few 
clicks.

� If you have a significant number of products in your store, listing them on the 
home page would be confusing to the customer. To address this problem, 
merchants can organize their items into sections.

� Stores with hundreds or thousands of products may need to create subsections 
to help their customers locate the desired products.
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� Merchants may want to feature certain products. This is useful for items that are 
on sale or new to your store.

Merchants can meet the above objectives with store sections. Store sections define 
the hierarchy, and the way that the customer experiences and browses your store. 

Sections: Sections are created to help organize the items in your store. A section 
may contain subsections or items, but not both.

Subsection: A subsection is a section within a section. In the figure, Computers and 
Cameras are subsections of Electronics, and Romance and Science Fiction are 
subsections of Books.

Featured Sections: Featured sections are used to highlight products. In the figure, 
Sale Items is a featured section. All items in that section will be shown on the home 
page. Book Sale is another featured section. All items in this section will be shown 
on the Books page.

Leaf Sections: Leaf sections contain items only and no subsections. In the figure, 
Computers, Cameras, Romance, and Science Fiction are all leaf sections.

Non Leaf Sections: Non leaf sections are the opposite of leaf sections—they contain 
subsections only. In the figure, Electronics and Books are non leaf sections.
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Non Leaf Sections with Featured Sections: Non leaf sections with featured sections 
have at least one subsection that is featured. In the figure, Books is a non leaf section 
with a featured subsection called Book Sale.

Non Leaf Sections without Featured Sections: Non leaf sections without featured 
sections have no featured subsections. In the figure, Electronics is a non leaf section 
without any featured subsections.

Parent Section: The parent section is the section to which the subsection belongs. In 
the figure, Electronics is the parent section of Computers and Cameras.

C.4.2 Creating New Sections
Use the following procedure to create a new store section.

1. Select the Catalog tab.

The Sections window opens under the Sections subtab.

2. Click the Sections subtab.

The Sections window opens.

3. Click Create.

The Section Details window opens.

4. Fill in the form using the field descriptions below:

*Code: A unique 20 alphanumeric field that identifies this section. This code is 
used in the item upload and download formats.

*Name: A name for the store section that will be meaningful to your customers. 
For example, Electronics, Books, or Software. 

Description: Use this to describe the section. This text will be automatically 
displayed on the section page, depending on the display style chosen.

Keywords: Used by the customer to search your store. 

Parent: Select a navigational section or Home for the parent. Click the flashlight 
to search for the section you want. 

Publish: Sections that are published can be viewed by customers. Unpublished 
sections are hidden from them. When you create a new section, you should 
keep it unpublished until it is complete, so that customers will not see work in 
progress.
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Featured: Sections are the way to highlight products. Only leaf sections can be 
featured.

C.4.3 Editing Sections
Use the following procedure to edit a store section.

1. Select the Catalog tab.

The Catalog window opens under the Sections subtab.

2. Find the section you want to edit. You can find a section in two ways:

� Search for Section Name or Code

� Navigate the Section Hierarchy

3. Search for Section Name or Code: If you know the section’s name or code, 
enter it into the search field and click Go.

4. Navigate the Section Hierarchy: If you don’t know the section’s name or code, 
navigate through the section hierarchy.

a. To navigate down a level, click the name of the section to which you want 
to navigate. 

The Catalog Hierarchy window opens with the section you clicked as the 
root. Note the section hierarchy path that is displayed at the top.

b. If the section is a navigation section, then you can continue to navigate 
down or create a new section under it.

c. If the section is a leaf section, then the list of items in the section is 
displayed.  You can also add items to the section.

d. To navigate up a level, click the name of the parent section.

5. When you are finished editing a section, click Apply to save changes.

C.4.4 Adding Items to Sections
Use the following procedure to add items to a leaf section.

1. Find the leaf section to which you want to add items.

Refer to "Editing Sections" for more details.

2. Click Add Items to Section.

The Add Item to Section window opens.
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3. Search for the items that you want to add.

You can search for an item by name, code, or description. Searches are case 
sensitive.

4. Select the items that you want to add.

5. Click Apply to save the changes.

C.4.5 Publishing Sections
Use the following procedure to publish a section.

1. Select the Catalog tab.

The Sections window opens under the Sections subtab.

2. Select the Section you want to publish and click Update.

The Section Details window opens.

3. Select the Publish checkbox.

Save your change by clicking Apply.

C.4.6 Previewing Sections 
Follow the steps below to preview your store sections with minimal impact to your 
customers.

1.  Confirm that the section is unpublished.

To avoid showing incorrect information to your customers, unpublish your 
section until you are finished previewing it.

2. Preview your section.

Select the section you want to preview and click Preview. A modal window 
launches, enabling you to see what the unpublished section will look like. 
When you finish previewing, close the window.

Note: You can only add items to leaf sections.
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C.4.7 Creating Items
Items are the products that you sell in your store. 

Use the following procedure to create a new item.

1. Select the Catalog tab.

The Sections window opens under the Sections subtab.

2. Click the Item subtab.

The Item Summary window opens.

3. Click Create Item.

The Item Details window opens.

4. Fill in the form using the field descriptions below:

*Part Number: This is a required field. It is a unique alphanumeric code that the 
merchant will use when uploading item information. 

*Name: This is also a required field. While it does not have to be unique, it 
should state clearly what the product is.

Description: Use this text field to describe the product to your customers. It will 
be displayed on product pages. 

Unit of Measure: You can use Each and Lbs (pounds) as units of measure.

Walk-in User Price: Price must be entered in the same currency as the 
merchant’s default currency.

Unit Weight: You can use EA (Each) and Lbs (pounds) as units of weight.

Publish: A published item can be seen by the customers. Unpublished items are 
not visible to customers. 

Shippable: An item that is shippable will invoke the shipping calculations at 
time of purchase. Non shippable items will not.

Section Level Image: The image of the item displayed at the section page. 
Select a Section Multimedia image from your multimedia library. If the image 
you want does not exist, upload it to the library. 

Detail Level Image: Displayed at the product page level. Select an Item 
Multimedia image from your multimedia library. If the image you want does 
not exist, upload it to the library. 
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Sections Published: Click Add Item to Leaf Sections to select all store sections 
where you want this item to appear. When the Add Item to Leaf Sections page 
opens, select the checkboxes for the desired sections and click Apply. You can 
only place items in leaf sections.

5. Click Apply to save your changes.

C.4.7.1 Deleting Items
Items cannot be deleted from your store. To prevent items from appearing, 
unpublish them.

C.4.8 Searching for Items
To search for items, you can use the view filter, simple search, or advanced search. 
For all searches, if the result set is greater than 10, click Next to see the entire list.

C.4.8.1 View Filter
The view filter enables you to list all items, published items, or unpublished items. 
Select the type of filter you want, then click Go. The list will automatically refresh.

C.4.8.2 Simple Search
Simple search enables you to search for items by their part number, name, or type. 
This search is case sensitive. 

C.4.8.3 Advanced Search
Advanced search enables you to search for items by an item creation date range, 
part number, and item name. After filling in the search parameters, click Go. The 
search is case sensitive.

C.4.9 Editing Items
Use the following procedure to edit an item.

1. Select the Catalog tab.

The Sections window opens under the Sections subtab.

2. Click the Item subtab.

The Item Summary window opens.

3. Find the item you want to edit.
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Refer to "Searching for Items" for information on how to find an item.

4. Select the item that you want to edit and click Update.

The Item Details Page for the item opens. In this window, you can make the 
necessary changes.

5. Click Apply to save the changes.

The Item Detail page refreshes.  Confirm that there are no errors.

C.4.10 Adding Sections to Items
Use the following procedure to add sections to an item.

1. Open the Detail Item window for the item.

Refer to "Editing Items" for more details.

2. Click Add Item to Leaf Section.

The Add Item to Leaf Section window opens.

3. Search for the leaf sections to which you want to add the item.

You can search for a section by section name or code.

4. Select the sections that you want.

5. Click Apply to save the changes.

The Item Detail page will be returned with the new sections.  Confirm that there 
are no errors.

C.4.11 Downloading Items
Downloading items allows merchants to synchronize their online inventory with a 
separate system.

Use the following procedure to download items.

1. Use the view filter, simple search, or advanced search to list the items you want 
to download.

2. In the Items window, click Download.

Download will automatically download all items in your inventory.

Note: You can only add items to leaf sections.
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3. Select a file type.

The choices are a Comma Separated Values (CSV) file or an Extended Markup 
Language (.XML) file. See "Item File Format" for more information. 

4. Select Generate Compressed File if you want to download a file that is 
compressed with WinZip. This is helpful if you expect a large file.

5. Click Download.

The Download Confirmation window opens, showing the job number. 

6. Click Check Download Status.

The Background Job window opens.

7. Click Refresh to update the job status.

You must wait for the job status to be Completed and the status to be Normal 
before viewing.

8. Select your completed job and click View Details.

The Background Status Details window opens.

9. Click Download to download the file.

To get the format of the item download file, go to "Item File Format".

C.4.12 Uploading Items
For merchants with many products, uploading inventory changes is an effective 
way of maintaining inventory. The upload method may be used to add new items 
or to update existing items. 

You can only upload items that are on the price list specified in the profile option 
IBE: EOS Default Price List.

If you are uploading items in CSV format, and an item is associated with more than 
one section, you must enter multiple rows for the same item in the CSV file. The 
number of item rows in the CSV file must equal the number of sections with which 
the item is associated. All item information is obtained from the first row, except for 
the part number and section information, which are read from the subsequent rows.

Follow the steps below to upload inventory information. 

1. Prepare item files.

This file preparation process will vary based on the format chosen (CSV or 
XML). Go to "Item File Format" for more information.
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2. Click the Catalog tab and the Upload subtab. 

3. Click Start Upload in the lower right of the screen. 

4. Fill in the upload parameters and click Upload. Details of the parameters are 
explained below.

Filename: Click Browse to select the file from your local drive.

Error handling options: There are two options for handling errors during the 
upload. You can choose to stop the upload when a specified number of errors 
occurs, or upload as much as possible irrespective of the number of errors.

5. Check upload results.

The Background Status Jobs box, found in the upper right side of your Upload 
page, shows how many items your store has in the queue to be processed, how 
many jobs completed successfully, and how many completed with errors.

The processing time depends on the size of the file and the traffic at the site. If 
your upload job stays on the queue for longer than an hour you may want to 
contact support.

If your job completes successfully, check the Background Job Details page for 
job details and for any errors and warnings that occurred during processing. 
Click the number in the status box, then select the job that you want to 
investigate and click View Details.

If your job completes with errors, the record in the line number was not 
processed at all. Warnings mean the record was processed but there was an 
error that you should review. Depending on the specific errors, you may need 
to repair the file and reprocess it.

C.4.13 Item File Format
A Comma Separated Value file (CSV), must have the list of attribute names first, 
followed by the rows of data.

For both CSV and XML files you must include the headers of all the fields, even if 
you are not supplying data for each of them.

The following table lists each field in an item file for upload or download.
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Attribute Required Type Description

Part Number Yes Char (40) The item number. If the item number is new, 
then a new item will be created. If the item 
number already exists, then the item will be 
updated.

Name Yes Char (240) Name of item

Description No Char (240) Description of item

Language Yes Char (3) Code for the language in which the item is 
being uploaded. See "Language Mappings" 
to get codes.

Item Weight No Number Item weight in pounds

Item UOM No Char (3) Unit of measure—currently only LBs 
(pounds) and EA (each) are supported.

Publish No Char (1) The default is Y (yes). If you want to 
unpublish an item, set this field to N.

Shippable No Char (1) The default is Y (yes). If you want to make 
this a non shippable item (no freight charges 
applicable), set this field to N.

Price list 
name

Yes, if 
including a 
price

Char(240) The name of the price list that you want to 
update. The price list must already exist.

Currency Yes, if 
including a 
price

Char(30) The currency in which the prices are 
displayed. See "Currency Codes" for a list of 
codes. Store must already be configured to 
support currency.

Price No Number The price of the item

Section Level 
image

No Char (40) The name of the section level image as it 
appears in the multimedia library

Detail level 
image

No Char (40) The name of the item image as it appears in 
the multimedia library

Section Code No Char (240) The section code where you want the item 
published. To place an item in multiple 
sections, create a new row for that item for 
each section. The section name must already 
exist. New sections cannot be created during 
item upload.
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C.4.13.1 Example of an Item CSV File
Part Number,Name,Description,Language,Item Type,Item Weight,Weight 
UOM,Publish,Shippable,UOM,Walk-in User Price,Currency,Price List Name,Section 
Level Image,Detail Level Image,Section Code

PMF2000,Phoebe 2000 Doll,Favorite Doll ideal for ages 
2-4,US,Toy-Tax,,Lbs,Y,Y,EA,19.95,USD,Northern American Prices,PMF2000 
section,PMF2000 detailed,Toy

PMF2001,Phoebe 2001 Doll,New improved over the Phoebe 2000 
Doll,US,Toy-Tax,,Lbs,Y,Y,EA,29.95,USD,Northern American Prices,PMF2000 
section,PMF2000 detailed,Toy

C.4.13.2 Example of an Item XML File
<?xml version="1.0" ?> 
  <CATALOG items_count="2" date="03-AUG-01"> 
    <ITEM item_id="30"> 
    <PART_NUMBER>PMF2000</PART_NUMBER> 
    <NAME>Phoebe 2000 Doll</NAME> 
    <DESCRIPTION>Favorite Doll ideal for ages 2-4</DESCRIPTION> 
    <LANGUAGE>US</LANGUAGE> 
    <ITEM_TYPE>Toy-Tax</ITEM_TYPE> 
    <ITEM_WEIGHT /> 
    <WEIGHT_UOM>Lbs</WEIGHT_UOM> 
    <PUBLISH>PUBLISHED</PUBLISH> 
    <SHIPPABLE>Y</SHIPPABLE> 
    <UOM>EA</UOM> 
    <PRICE /> 
    <CURRENCY /> 
    <PRICE_LIST_NAME /> 
    <SECTION_LEVEL_IMAGE /> 
    <DETAIL_LEVEL_IMAGE /> 
    <SECTIONS> 
      <SECTION_CODE>Dolls</SECTION_CODE> 
    </SECTIONS> 
   </ITEM> 
   <ITEM item_id="31"> 
     <PART_NUMBER>PMF2001</PART_NUMBER> 
     <NAME>Phoebe 2001 Doll</NAME> 
     <DESCRIPTION>New improved over the Phoebe 2000 Doll</DESCRIPTION> 
     <LANGUAGE>US</LANGUAGE> 
     <ITEM_TYPE>Toy-Tax</ITEM_TYPE> 
     <ITEM_WEIGHT /> 
     <WEIGHT_UOM>Lbs</WEIGHT_UOM> 
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     <PUBLISH>PUBLISHED</PUBLISH> 
     <SHIPPABLE>Y</SHIPPABLE> 
     <UOM>EA</UOM> 
     <PRICE /> 
     <CURRENCY /> 
     <PRICE_LIST_NAME /> 
     <SECTION_LEVEL_IMAGE /> 
     <DETAIL_LEVEL_IMAGE /> 
     <SECTIONS> 
       <SECTION_CODE>Dolls</SECTION_CODE> 
     </SECTIONS> 
    </ITEM> 
</CATALOG>

C.4.14 Multimedia
Oracle Store provides a central repository for all merchant multimedia content.

Use the following procedure to upload a new image.

1. Select the Catalog tab.

The Items window opens under the Items subtab.

2. Select the Multimedia subtab.

The Multimedia window opens.

3. Click Add.

The Add Multimedia File window opens.

4. Fill in the form using the field descriptions below:

Display Name: The alternate name of the image.

*Display Class: Pick the type of multimedia file you are uploading.

� Item: Product images found on the product page. Recommended size is 125 
x125 pixels.

� Section: Product images found on the section page. Recommended size is 80 
x 80 pixels.

� Logo: Store logo found in the upper left corner of every store page. 
Recommended size is 350 x 110 pixels.

� Other: Any type of image can be uploaded. However, the store templates 
only support a maximum of 350 x 350 pixels.
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*Language: Select the file language. If it is global, select All.

Filename: Click Browse to locate the file from your local file system.

5. Click Apply to save changes.

Use the following procedure to upload several images at one time.

1. Prepare a compressed zipped file.

Use WinZip to compress the images that you want to upload to the Multimedia 
Library. All images should be of the same type.

2. Add the WinZip file the same way you would add a single multimedia file. See 
the procedure above.

After uploading the compressed file, the images will be decompressed and 
added to the multimedia library. The Display Name for each file will default to 
the image file name. The Display Class and the Language will default to the 
values selected when uploading the compressed file.

C.5 Pricing
Merchants can have multiple price lists for the items, in different currencies.   
Customers will see the prices from the price list enabled for their currency. 

C.5.1 Enabling Price Lists
Use the following procedure to enable a price list.

1. Select the Pricing tab.

The Price List window opens under the Price List subtab.

2. Select the price list to be enabled.

3. Click Enable.

C.5.2 Creating New Price Lists
By default your store will sell items at the price you have set at the item level (see 
"Creating Items"). You must create a new price list for each currency that you 
support.

Use the following procedure to create a new price list.

1. Select the Pricing tab.
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The Price List window opens under the Price List subtab.

2. Click Create Price List.

The Create Price List window opens.

3. Fill in the form using the field descriptions below:

*List Name: This is a name for merchants only. 

Description: A brief description to explain the purpose of the list.

*Currency: Select the currency this list is for. 

*Status: Indicates if the price list is enabled or disabled. You should keep a new 
list disabled until it is finished so that customers do not see inaccurate prices.

C.5.3 Editing Price Lists
Use the following procedure to edit a price list.

1. In the Pricing tab, choose the Price List subtab.

2. Select the price list that you want to edit and click Update.

The Price List Details window opens.

3. You can now edit the price list as necessary. See "Creating New Price Lists" and 
"Adding New Products to Price Lists" for instructions.

4. Click Apply to save your changes.

C.5.4 Adding New Products to Price Lists
Use the following procedure to add new items to a price list.

1. Go to the Price List Details window for the price list you want to update.

This window will automatically open when creating a new price list. For 
existing lists, select the price list you want to change and click Update.

2. Click Add Item.

The Add Items window opens.

3. Search for the item that you want to add by the part number or item name.

A list of matches will appear.

4. Select the items that you want to add, and supply prices for them.
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5. Save changes by clicking Apply.

C.5.4.1 Removing Products from Price Lists
Use the following procedure to remove items from price lists.

1. In the Price List Details window, search for the item that you want to remove by 
the part number or item name.

2. Select the item’s checkbox.

3. Click Remove.

C.5.4.2 Changing Product Prices
Use the following procedure to change product prices in price lists.

1. In the Price List Details window, search for the item that you want to update by 
the part number or item name.

2. Enter the new price to replace the old price.

3. Click Apply to save the changes.

C.5.5 Downloading Prices
Use the following procedure to download a price list.

1. From the Price List Summary window, select the price list you want to 
download.

2. Click Download.

The Download Parameters window opens.

3. Select the format type that you want.

See "Price List File Formats" for more information.

4. Click Start Download.

The Download Results page opens. It will list a job number for your download 
request. 

5. Click Check Download Status.

A list of all jobs will be presented with their status. Click Reload to refresh the 
page.

6. After your download job completes, select it and click View Details.
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The Background Job window opens.

7. Click Download to download the file to your local storage drive.

C.5.6 Uploading Prices
Use the following procedure to upload a price list.

1. Prepare price files.

This file preparation process will vary based on the format chosen (CSV vs. 
XML). For more information, go to "Price List File Formats".

2. Select the Pricing tab.

The Pricing List window opens.

3. Select the Upload subtab.

The Upload Introduction window opens.

4. Click Start Upload in the lower right side of the screen. 

5. Fill in the upload parameters and click Upload. Details of the parameters are 
explained below.

Filename: Click Browse to select the file from your local drive.

Error handling options: There are two options for handling errors that might 
occur during the upload. You can choose to stop the upload if a certain number 
of errors occur, or you can choose to upload as much as possible regardless of 
how many errors may occur.

6. Check upload results.

The Background Status Jobs box, found in the upper right side of your Upload 
page, shows how many items your store has on the queue to be processed, how 
many jobs completed successfully, and how many completed with errors.

The time it takes to get your job processed depends on the size of the file and 
the traffic at the site. If your upload job stays on the queue for longer than an 
hour, you may want to contact support.

If your job completes successfully, there were no errors or warnings.

If you job completes with errors, then you should drill into the details by 
clicking on the number in the status box. Select the job that you want to 
investigate and click View Details.
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The Background Job Details page shows the job details and all errors and 
warnings that occurred during processing.

Errors mean the record in the line number was not processed at all. Warnings 
mean the record was processed but there was some error that you should look 
into. Depending on the errors, you may need to repair the file and reprocess it.

Reprocessed files will not create duplicate records.

C.5.7 Price List File Formats
For both CSV and XML files you must include the headers of all the fields, even if 
you are not supplying data for each of them.

The following table lists all of the fields that can be uploaded in a price list upload.

Field Name Required Values Field Description

EFFECTIVE_DATE No Data Type = Date 
MM-DD-YYYY

Header information. The start 
date of the effective period for 
the price list.

EXPIRATION_DATE No Data Type = Date 
MM-DD-YYYY

Header information. The end 
date of the effective period for 
the price list.

PRICE_LIST_NAME Yes No default value

Data-type: 
Varchar2(240)

Header information. The price 
list’s code.

CURRENCY Yes No default value

Data-type: 
Varchar2(30)

Header information. Currency 
code associated to item prices in 
this price list.

DESCRIPTION No No default value

Data-type: 
Varchar2(2000)

Header information. Price list 
description.

LANGUAGE Yes Defaults to US

Data-type: 
Varchar2(4)

Header information. See 
"Language Mappings".

PRICE_LIST_TYPE Yes Data-type: 
Varchar2(30) 
Default Value = 
PRL

Header information. Must be 
set to PRL for price list.
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C.5.7.1 Example of a Price List CSV File
EFFECTIVE_DATE,EXPIRATION_DATE,PRICE_LIST_
NAME,CURRENCY,DESCRIPTION,LANGUAGE,PRICE_LIST_TYPE,STATUS

12-JUL-01,,Default Price List,USD,Default Price List,US,PRL,Y

LINE_TYPE,UOM_CODE,PRICE_TYPE,PRICE,PART_NUMBER,PRODUCT_PRECEDENCE

ACTIVE No Default = Y

Data Type = 
Varchar2(1)

Available Values 
Y/N

Header information. Indicates if 
the list is active or not.

PART NUMBER Yes No default value

Data-type: 
Varchar2 (40)

Line information. Part number 
of the item. 

UOM_CODE No Default = 
Primary UOM 
Code 

Data-type: 
Varchar2(3)

Line information. 

PRICE Yes No default value

Data-type: 
Number

Line information. Item’s price. 
Negative and null values are 
not allowed, but the price can 
be zero. If the merchant does 
not insert a correct value in the 
price, the line is rejected.

LINE_TYPE Yes Data-type: 
Varchar2(30) 
Default = PLL

Line information. The only 
valid value is PLL. 

PRICE_TYPE Yes Data Type: 
Char(30)

Default = UNIT_
PRICE

Line information. The only 
valid value is UNIT_PRICE.

PRODUCT_PRECEDENCE No Default Value = 
Null 

Data type = 
Number

Line information. Reserved for 
future use.

Field Name Required Values Field Description
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PLL,,UNIT_PRICE,12.25,ITLFD-001,
PLL,,UNIT_PRICE,190,eostest-001,
PLL,,UNIT_PRICE,1000000,ITLCAR-001,

C.5.7.2 Example of a Price List XML File
<?xml version = "1.0" ?>
<SYNC_PRICELIST_001>
  <PRICELIST>
    <CSV_REFERENCE_LINE>1</CSV_REFERENCE_LINE>
    <EFFECTIVE_DATE></EFFECTIVE_DATE>
    <EXPIRATION_DATE></EXPIRATION_DATE>
    <PRICE_LIST_NAME>Default Price List</PRICE_LIST_NAME>
    <CURRENCY>USD</CURRENCY>
    <DESCRIPTION>Default Price List</DESCRIPTION>
    <LANGUAGE>US</LANGUAGE>
    <PRICE_LIST_TYPE>PRL</PRICE_LIST_TYPE>
    <STATUS>Y</STATUS>
    <PRCLSTLINE>
      <CSV_REFERENCE_LINE>2</CSV_REFERENCE_LINE>
      <LINE_TYPE>PLL</LINE_TYPE>
      <UOM_CODE></UOM_CODE>
      <PRICE_TYPE>UNIT_PRICE</PRICE_TYPE>
      <PRICE>12.25</PRICE>
      <PRODUCT_PRECEDENCE></PRODUCT_PRECEDENCE>
      <PART_NUMBER>ITLFD-001</PART_NUMBER>
    </PRCLSTLINE>
    <PRCLSTLINE>
      <CSV_REFERENCE_LINE>3</CSV_REFERENCE_LINE>
      <LINE_TYPE>PLL</LINE_TYPE>
      <UOM_CODE></UOM_CODE>
      <PRICE_TYPE>UNIT_PRICE</PRICE_TYPE>
      <PRICE>190</PRICE>
      <PRODUCT_PRECEDENCE></PRODUCT_PRECEDENCE>
      <PART_NUMBER>eostest-001</PART_NUMBER>
    </PRCLSTLINE>
    <PRCLSTLINE>
      <CSV_REFERENCE_LINE>4</CSV_REFERENCE_LINE>
      <LINE_TYPE>PLL</LINE_TYPE>
      <UOM_CODE></UOM_CODE>
      <PRICE_TYPE>UNIT_PRICE</PRICE_TYPE>
      <PRICE>1000000</PRICE>
      <PRODUCT_PRECEDENCE></PRODUCT_PRECEDENCE>
      <PART_NUMBER>ITLCAR-001</PART_NUMBER>
    </PRCLSTLINE>
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  </PRICELIST>
</SYNC_PRICELIST_001>

C.5.8 Discount
Discounts enable merchants to sell items at a special price or a reduced price, to 
some or all of their customers, for a particular time period. When multiple 
discounts apply, the customer is offered the best price.

Use the following procedure to create a discount.

1. Select the Pricing tab.

The Price List window opens under the Price list subtab.

2. Select the Discount subtab.

The Discount window opens.

3. Click Create Discount.

The Create Discount window opens.

4. Fill in the form using the field descriptions below:

*Code: Every discount needs to have a code to identify it uniquely. This code 
can be alphanumeric with 240 characters.

*Discount Name: The name of the discount will be seen by merchants only.

*Currency: Discounts are applied to only one currency. If you are supporting 
multiple currencies and want to have global discounts, then you must define a 
discount for each.

*Discount Method: Discounts can be applied in two ways: percentage or price 
override. A percentage discount enables the merchant to enter a percentage off 
of a product price, while a price override enables the merchant to enter a new 
price for the item regardless of original price.

Effective From Date: The date you want the discount to start. Effective dates 
are inclusive.

Effective To Date: The date you want the discount to end. Effective dates are 
inclusive.

Status: Enabled means the discount is active or will be active when the effective 
dates begin. Disabled means the discount is not active. It is recommended that 
status remains disabled until you finish defining the discount.
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Ask For Promotion Code: Check this box if you want to secure the discount 
with a promotion code. In order for customers to take advantage of the 
discount, they must supply the discount code.

Discount Method: The type of discount. See "Percentage Discount" and "Price 
Override" for more information.

5. Save changes by clicking Apply.

Depending on the type of discount method, a different window will open.

C.5.8.1 Percentage Discount
Percentage discount enables you to enter a discount percentage based on the 
customer’s total order amount. Below are some examples of this type of discount.

� Give users 10% discount on all products.

� Give users 10% off certain products.

� Give users 10% off all purchases over $100.

� Give users 10% off certain products if they buy over a certain amount.

� Give user 10% off all purchases under $100 and 15% off purchases over $100.

Use the following procedure to define the percentage discount.

1. Fill in the Discount Rules table.

Each line of the table requires a “Amount From” and an “Amount To” in the 
currency that the discount is for, and the percentage of the discount.

2. Save the rules table by clicking Apply.

The following table is an example of discount rules.

From Amt To Amt Percentage Note

0 100 10 This line will give 10% discount for 
purchases less than or equal to 100.

100.01 200 15 This line will give 15% discount for 
purchases greater than $100 and less 
than or equal to $200

200.01 999999999 20 This line will give 20 discount for 
purchases greater than $200
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C.5.8.2 Price Override
For price override discounts, you must enter the new prices for the items via the 
discount qualifiers for items. See "Adding Eligible Items to Discounts" for details.

C.5.9 Searching for Discounts
To search for discounts, you can use the view filter, simple search, or advanced 
search. For all searches, if the result set is greater than the display limit, click Next to 
see the entire list.

C.5.9.1 View Filter
The view filter enables you to list all discounts, active discounts, or inactive 
discounts. Select the type of filter you want, then click Go. The list will 
automatically refresh.

C.5.9.2 Simple Search
Simple search enables you to search for discounts by their name or code. This search 
is case sensitive. 

C.5.9.3 Advanced Search
Advanced search enables you to search for discounts by name, code, currency, 
effective dates, status, qualified customers, qualified items, and whether the 
discounts are ask-for promotions. After filling in the search parameters, click Go. 
The search is case sensitive.

C.5.10 Editing Discounts
Use the following procedure to edit discounts.

1. In the Pricing tab, choose the Discount subtab.

2. Select the discount that you want to edit.

3. Click Update.

The Discount Details window opens.

4. Edit the discount as necessary. See "Discount" for details.

5. Click Apply to save your changes.
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C.5.11 Adding Eligible Customers to Discounts
If the discount is applicable for all customers, then skip this procedure.

Use the following procedure to choose the eligible customers for a discount.

1. From the Discount Details window, select Qualifiers from the side navigation 
list menu.

The menu expands with submenu items.

2. Select Customers.

The Customer window opens.

3. Click Add Customer.

4. Search for the customer by entering the name and clicking Go.

A list of customers that match your search query appears.

5. Select the customers that you want to add.

6. Save your selection by clicking Apply.

C.5.12 Adding Eligible Items to Discounts
If the discount is for all items in your inventory, then skip this procedure.

Use the following procedure to choose the eligible items for a discount.

1. From the Discount Details window, select Qualifiers from the side navigation 
list menu.

The menu expands with submenu items.

2. Select Items.

The Items window opens.

3. Click Add Item.

4. Search for the item by entering the name or part number and clicking Go.

A list of items that match your search query appears.

5. Select the items that you want to add.

6. Save your selection by clicking Apply.
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Adding Items to a Price Override Discount
Make sure that you supply a discount price for the items you are selecting. The 
discount price must be in the same currency as the discount.

C.5.13 Enabling Discounts
Use the following procedure to enable a discount.

1. Select the Pricing tab.

The Price List window opens under the Price list subtab.

2. Select the Discount subtab.

The Discount window opens.

3. Find and select the discount to be enabled.

4. Click Enable.

C.5.13.1 Disabling Discounts
Use the following procedure to disable a discount.

1. Select the Pricing tab.

The Price List window opens under the Price List subtab.

2. Select the Discount subtab.

The Discount window opens.

3. Find and select the discount to be disabled.

4. Click Disable.

Note: In order for a discount to be effective in the store, it must be 
enabled and within the effective date range of the discount.
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C.6 Orders
 The process flow diagram below illustrates how orders should be processed.

 

C.6.1 Searching for Orders
To search for orders, use a simple or advanced search. If result sets are larger than 
your preferred limit, click Next to view them.

C.6.1.1 Simple Search
Simple search enables you to search for orders by the date the order was placed. 
Enter the date range and click Go.

C.6.1.2 Advanced Search
Advanced search enables you to search for orders by the date the order was placed, 
the order number, a part number within the order, user name, first name, or last 
name of the customer, or the city, state, and country of the customer billing address.

The search parameters are case sensitive. After entering the search parameters, click 
Go.
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C.6.2 Downloading Orders
Use the following procedure to download orders.

1. Use the simple or advanced search to list the orders you want to download.

2. In the Orders Summary window, click Download.

All orders in the result set will be downloaded. You do not need to select all 
orders from the result set.

3. Select a file type.

The choices are a Comma Deliminated (CSV) file or an Extended Markup 
Language (XML) file. For more information, go to "Order File Formats".

4. Select Generate Compressed File if you want to download a file that is 
compressed with WinZip. This is helpful for large files.

5. Click Download.

The Download Confirmation window opens, showing the job number. 

6. Click Check Download Status.

The Background Job window opens.

7. Click Refresh to update the job status.

You must wait for the job status to be Completed and the status to be Normal 
before viewing.

8. Select your completed job and click View Details.

The Background Status Details window opens.

9.  Click Download to download the file to your local storage system.

C.6.3 Retrieving Orders
After a customer places an order, the order is stored in the system with a Booked 
status. 

Use the following procedure to retrieve orders:

1. Select the Orders tab.

The Order Search window opens under the Summary subtab.

2. Enter the date range and click Go.
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You may also choose to use the advanced search by clicking Advanced. This 
allows you to search for orders using more complex parameters.

The result set contains a list of orders that match your criteria. If there are more 
than ten, click Next to view them.

Click the order number to view details.

3. Select the orders of interest to you.

To select all of the orders, click Select All.

4. If you want the selected orders e-mailed to you, click E-mail Orders.

Orders are automatically e-mailed to the merchant e-mail address as defined in 
your profile.

C.6.4 Order File Formats
Orders can be downloaded in Comma Separated Value files (CSV) or Extended 
Markup Language (XML) formats.

The table below shows all the fields in an order download.

Field Data Type Description

Language Varchar (3) Oracle language codes. See "Language Mappings".

Store Name Char(30) Name of store

Order Header Id Number iStore primary key that uniquely identifies an order

Order Number Number Order number. This number is not guaranteed to be 
unique for all orders.

Order Status Code Char(30) CLOSED, CANCELLED, or BOOKED

Ship Date DD-MON-YYYY Date the order was shipped, e.g., 04-Oct-2001. 
Required to close an order. 

Ship Method Char (240) The shipping method chosen by the customer. 
Required for closing orders. If shipping method is 
different than the customer’s initial selection, 
confirm that the shipping method exists, and that it 
is spelled correctly with proper capitalization.

Tracking Number Char (30) Number the customer should use to track order

Invoice Number Number Invoice number

Comments Char (30) Comments
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Order Status Char (30) The status of the order when downloaded. Possible 
values are BOOKED, CLOSED, or CANCELLED.

PO Number Char (30) PO number used when customer selected PO as a 
payment method

Date Created Date 
mm/dd/yyyy

Order entry date

Last Update Date 
mm/dd/yyyy

Date of last order update

User Name Varchar (10) Customer user name

Currency Varchar (3) Oracle currency codes. See "Currency Codes" for 
more information.

Bill to First Name Varchar (30) Billing information

Bill To Last Name Varchar (30) Billing information

Bill To Email Varchar (30) Billing information

Bill To Address 
Line 1

Varchar (30) Billing information

Bill To Address 
Line 2

Varchar (30) Billing information

Bill To Address 
Line 3

Varchar (30) Billing information

Bill To Address 
Line 4

Varchar (30) Billing information

Bill To City Varchar (30) Billing information

Bill To County Varchar (30) Billing information

Bill To State Varchar (2) Billing information

Bill To Postal Code Varchar (10) Billing information

Bill To Country Varchar (2) Billing information

Ship to First Name Varchar (30) Shipping information

Ship To Last Name Varchar (30) Shipping information

Ship To Email Varchar (30) Shipping information

Ship To Address 
Line 1

Varchar (30) Shipping information

Field Data Type Description
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C.6.4.1 Example of an Order CSV File
HEADER,Language,Store Name,Order Header ID,Order Number,Order 
Status Code,Ship Date,Ship Method,Tracking Number,Invoice Number,
Comments,Order Status,PO Number,Date Created,
Last Update,User Name,Currency,
Bill to First Name,Bill To Last Name,Bill To Email,
Bill To Address Line 1,Bill To Address Line 2,
Bill To Address Line 3,Bill To Address Line 4,
Bill To City,Bill To County,Bill To State,
Bill To Postal Code,Bill To Country,
Ship to First Name,Ship To Last Name,Ship To Email,

Ship To Address 
Line 2

Varchar (30) Shipping information

Ship To Address 
Line 3

Varchar (30) Shipping information

Ship To Address 
Line 4

Varchar (30) Shipping information

Ship To City Varchar (30) Shipping information

Ship To County Varchar (30) Shipping information

Ship To State Varchar (2) Shipping information

Ship To Postal 
Code

Varchar (10) Shipping information

Ship To Country Varchar (2) Shipping information

Shipping Charge Number Shipping charge as calculated by the store

Tax Total Number Tax charge as calculated by the store

Sub Total Number Order value without shipping or tax charges

Order Total Number Order value with shipping and tax charges

Payment Type Varchar(30) Payment method selected by the customer

Card Type Varchar(30) The credit card type, e.g., Visa, American Express

Card Number Varchar(50) The credit card number. Only the last 4 digits are 
used. The rest are screened out for security reasons.

Card Expiration Date 
mm/dd/yyyy

Credit card expiration date

Field Data Type Description
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Ship To Address Line 1,Ship To Address Line 2,
Ship To Address Line 3,Ship To Address Line 4,
Ship To City,Ship To County,Ship To State,Ship To Postal Code,
Ship To Country,
Shipping Charge,Tax Total,Sub Total,Order Total,
Payment Type,Card Type,Card Number,Card Expiration
,
US,E-Commerce Online Services - Development’s ,1050,25,CANCELLED,,
UPS - GROUND,,,,Entered,,27-Jul-01,27-Jul-01,,,,,979 Ponderosa Ave. 
#C,,,,Sunnyvale,US,CA,94086,,,,,,,,,,,,,,3,0.51,6.125,,,,,,

LINE,Line Number,Part Number,Product Name,Unit of 
Measure,Quantity,Price,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,
,1,ITLFD-001,TEST,EA,1,6.125,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,

C.6.4.2 Example of an Order XML File
<?xml version = "1.0"?>
<SALESORDERS orders_count="9" date="15-AUG-01">
   <LANGUAGE>US</LANGUAGE>
   <STORENAME>E-Commerce Online Services - Development</STORENAME>
   <ORDER>
      <SOHEADER>
         <ORDERHEADERID>1051</ORDERHEADERID>
         <ORDERNUMBER>26</ORDERNUMBER>
         <ORDERSTATUSCODE>CLOSED</ORDERSTATUSCODE>
         <SHIPDATE>31-AUG-2001 </SHIPDATE>
         <SHIPMETHOD>UPS-GROUND</SHIPMETHOD>
         <TRACKINGNUMBER/>
         <INVOICENUMBER/>
         <COMMENTS/>
         <ORDERSTATUS>Entered</ORDERSTATUS>
         <PONUMBER/>
         <DATECREATED>27-JUL-01</DATECREATED>
         <LASTUPDATE>27-JUL-01</LASTUPDATE>
         <USER_NAME>SPECIALCHAR</USER_NAME>
         <CURRENCY>USD</CURRENCY>
         <BILLTOCONTACT>
            <BILLTOFIRSTNAME/>
            <BILLTOLASTNAME/>
            <BILLTOEMAIL/>
         </BILLTOCONTACT>
         <BILLTOADDRESS>
            <BILLTOADDRLINE1>458 Fernando Ave.</BILLTOADDRLINE1>
            <BILLTOADDRLINE2/>
Self-Service Administration C-55



Orders
            <BILLTOADDRLINE3/>
            <BILLTOADDRLINE4/>
            <BILLTOCITY>Palo Also</BILLTOCITY>
            <BILLTOCOUNTY>US</BILLTOCOUNTY>
            <BILLTOSTATE>CA</BILLTOSTATE>
            <BILLTOPOSTALCODE>94306</BILLTOPOSTALCODE>
            <BILLTOCOUNTRY>US</BILLTOCOUNTRY>
         </BILLTOADDRESS>
         <SHIPTOCONTACT>
            <FIRSTNAME/>
            <LASTNAME/>
            <EMAIL/>
         </SHIPTOCONTACT>
         <SHIPTOADDRESS>
            <BILLTOADDRLINE1>458 Fernando Ave.</BILLTOADDRLINE1>
            <BILLTOADDRLINE2/>
            <BILLTOADDRLINE3/>
            <BILLTOADDRLINE4/>
            <BILLTOCITY>Palo Also</BILLTOCITY>
            <BILLTOCOUNTY>US</BILLTOCOUNTY>
            <BILLTOSTATE>CA</BILLTOSTATE>
            <BILLTOPOSTALCODE>94306</BILLTOPOSTALCODE>
            <BILLTOCOUNTRY>US</BILLTOCOUNTRY>
         </SHIPTOADDRESS>
         <CHARGES>
            <SHIPPINGCHARGE>3</SHIPPINGCHARGE>
            <TAXTOTAL>.51</TAXTOTAL>
            <SUBTOTAL>6.125</SUBTOTAL>
            <ORDER_TOTAL>9.635</ORDER_TOTAL>
         </CHARGES>
         <PAYMENT>
            <PAYMENTTYPE/>
            <CARDTYPE/>
            <CARDNUMBER/>
            <CARDEXPIRATION/>
         </PAYMENT>
      </SOHEADER>
         <SOLINES>
            <LINE>
               <LINE_NUMBER>1</LINE_NUMBER>
               <PRODUCT_NUMBER>ITLFD-001</PRODUCT_NUMBER>
               <PRODUCT_NAME>Pizza Margherita</PRODUCT_NAME>
               <ORDER_QUANTITY>1</ORDER_QUANTITY>
               <ORDER_QUANTITY_UOM>EA</ORDER_QUANTITY_UOM>
               <PRICE>6.125</PRICE>
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            </LINE>
         </SOLINES>
   </ORDER>
</SALESORDERS>

C.7 Currency and Language
This section lists the codes used for currency and languages.

C.7.1 Currency Codes
The following table lists currency codes and their corresponding currency names.

Currency Code Currency Name

ADP Andorran Peseta 

AED UAE Dirham

AFA Afghani   

ALL Lek

AMD Armenian Dram

ANG Netherlands Antillian Guilder 

AOK Kwanza    

AON New Kwanza

ARA Austral   

ARS Argentine Peso

ATS Schilling 

AUD Australian Dollar 

AWG Aruban Guilder

AZM Azerbaijanian Manat

BBD Barbados Dollar    

BDT Taka      

BEF Belgian Franc

BGL Lev
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BHD Bahraini Dinar

BIF Burundi Franc

BMD Bermudian Dollar (Bermuda Dollar) 

BND Brunei Dollar

BOB Boliviano 

BOV Mvdol 

BRC Cruzado

BRL Brazilian Real

BSD Bahamian Dollar

BTN Ngultrum  

BUK Kyat (Obsolete)

BWP Pula

BYB Belarussian Ruble

BZD Belize Dollar

CAD Canadian Dollar

CHF Swiss Franc

CLF Unidades de formento

CLP Chilean Peso 

CNY Yuan Renminbi

COP Colombian Peso

CRC Costa Rican Colon  

CSK Koruna 

CUP Cuban Peso

CVE Cape Verde Escudo  

CYP Cyprus Pound 

CZK Czech Koruna 

DEM Deutsche Mark

DJF Djibouti Franc

Currency Code Currency Name
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Currency and Language
DKK Danish Krone 

DOP Dominican Peso

DZD Algerian Dinar

ECS Sucre

ECV Unidad de Valor Constante (UVC)

EEK Kroon 

EGP Egyptian Pound

ESB Convertible Peseta Accounts    

ESP Spanish Peseta

ETB Ethiopian Birr

EUR Euro 

FIM Markka    

FJD Fiji Dollar  

FKP Falkland Islands Pound         

FRF French Franc 

GBP Pound Sterling

GEK Georgian Coupon    

GHC Cedi      

GIP Gibraltar Pound    

GMD Dalasi    

GNF Guinea Franc 

GRD Drachma   

GTQ Quetzal   

GWP Guinea-Bissau Peso 

GYD Guyana Dollar

HKD Hong Kong Dollar   

HNL Lempira   

HRD Croatian Dinar

Currency Code Currency Name
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Currency and Language
HRK Croatian kuna

HTG Gourde    

HUF Forint    

IDR Rupiah    

IEP Irish Pound  

ILS Shekel    

INR Indian Rupee 

IQD Iraqi Dinar  

IRR Iranian Rial 

ISK Iceland Krona

ITL Italian Lira 

JMD Jamaican Dollar    

JOD Jordanian Dinar    

JPY Yen

KES Kenyan Shilling    

KGS Som

KHR Riel      

KMF Comoro Franc 

KPW North Korean Won   

KRW Won

KWD Kuwaiti Dinar

KYD Cayman Islands Dollar          

KZT Tenge     

LAK Kip

LBP Lebanese Pound

LKR Sri Lanka Rupee    

LRD Liberian Dollar    

LSL Loti      

Currency Code Currency Name
C-60 Oracle iStore Implementation Guide



Currency and Language
LTL Lithuanian Litas   

LUC Convertible Franc  

LUF Luxembourg Franc   

LUL Financial Franc    

LVL Latvian Lats 

LVR Latvian Ruble

LYD Libyan Dinar 

MAD Moroccan Dirham    

MDL Moldovan Leu 

MGF Malagasy Franc

MKD Denar     

MMK Kyat      

MNT Tugrik    

MOP Pataca    

MRO Ouguiya   

MTL Maltese Lira 

MUR Mauritius Rupee    

MVR Rufiyaa   

MWK Kawacha   

MXN Mexican Nuevo Peso 

MXP Mexican Peso 

MYR Malaysian Ringgit  

MZM Metical   

NAD Namibia Dollar

NGN Naira     

NIC Cordoba   

NIO Cordoba Oro  

NLG Netherlands Guilder

Currency Code Currency Name
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Currency and Language
NOK Norwegian Krone    

NPR Nepalese Rupee

NZD New Zealand Dollar 

OMR Rial Omani

PAB Balboa    

PEI Inti      

PEN Nuevo Sol 

PGK Kina      

PHP Philippine Peso    

PKR Pakistan Rupee

PLN Polish Zloty 

PLZ Zloty     

PTE Portuguese Escudo  

PYG Guarani   

QAR Qatari Rial  

ROL Leu

RUR Russian Ruble

RWF Rwanda Franc 

SAR Saudi Riyal  

SBD Solomon Islands Dollar         

SCR Seychelles Rupee   

SDD Sudanese Dinar

SDP Sudanese Pound

SEK Swedish Krona

SGD Singapore Dollar   

SHP Saint Helena Pound 

SIT Tolar     

SKK Slovak Koruna

Currency Code Currency Name
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SLL Leone     

SOS Somali Shilling    

SRG Suriname Guilder   

STAT      Statistical  

STD Dobra     

SUR Rouble    

SVC El Salvador Colon  

SYP Syrian Pound 

SZL Lilangeni 

THB Baht      

TJR Tajik Ruble  

TMM Manat     

TND Tunisian Dinar

TOP Pa’anga   

TPE Timor Escudo 

TRL Turkish Lira 

TTD Trinidad and Tobago Dollar

TWD New Taiwan Dollar  

TZS Tanzanian Shilling 

UAK Karbovanet

UGS Uganda Shilling (Obsolete)

UGX Uganda Shilling    

USD US dollar 

USN US Dollar (next day) 

USS US Dollar (same day)

UYP Uruguayan Peso

UYU Peso Uruguayo

UZS Uzbekistan Sum

Currency Code Currency Name
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Currency and Language
VEB Bolivar   

VND Dong      

VUV Vatu      

WST Tala      

XAF CFA Franc BEAC

XAG Silver    

XAU Gold      

XCD East Carribbean Dollar 

XEU European Currency Unit (E.C.U.)

XOF CFA Franc BCEAO    

XPD Palladium 

XPF CFP Franc 

XPT Platinum  

XTS Testing   

YDD Yemeni Dinar 

YER Yemeni Rial  

YUD New Yugoslavian Dinar

YUN Yugoslvian Dinar   

ZAL Financial Rand

ZAR Rand      

ZMK Kwacha    

ZRN New Zaire 

ZRZ Zaire     

ZWD Zimbabwe Dollar    

Currency Code Currency Name
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Currency and Language
C.7.2 Language Mappings
The following table lists values for language, Oracle language code, ISO language, 
territory, and ISO territory.

Languages

Oracle 
Language 
Code

ISO 
Language Territory ISO Territory

American US EN America US

Arabic AR AR United Arab Emirates AE

Brazilian 
Portuguese

PTB PT Brazil BR

Bulgarian BG BG Bulgaria BG

Canadian French FRC FR Canada CA

Catalan CA CA Catalonia CT

Croatian HR HR Croatia YU

Czech CS CZ Czechoslovakia CZ

Danish DK DA Denmark DK

Dutch NL NL The Netherlands NL

Egyptian EG EG Egypt EG

English GB EN United Kingdom GB

Finnish SF FI Finland FI

French F FR France FR

German D DE Germany DE

Greek EL EL Greece GR

Hebrew IW IW Israel IL

Hungarian HU HU Hungary HU

Icelandic IS IS Iceland IS

Italian I IT Italy IT

Japanese JA JA Japan JP

Korean KO KO Korea KR
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Latin American 
Spanish

ESA ES Mexico MX

Lithuanian LT LT Lithuania LT

Norwegian N NO Norway NO

Polish PL PL Poland PL

Portuguese PT PT Portugal PT

Romanian RO RO Romania RO

Russian RU RU CIS SU

Simplified Chinese ZHS ZH China CN

Slovak SK SK Slovenia SI

Slovenian SL SL Slovenia SI

Spanish E ES Spain ES

Swedish S SV Sweden SE

Thai TH TH Thailand TH

Traditional Chinese ZHT ZH Taiwan TW

Turkish TR TR Turkey TR

Languages

Oracle 
Language 
Code

ISO 
Language Territory ISO Territory
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A
APIs, 6-15
Available to Promise (ATP), 3-14

global, 9-2

B
B2B user permissions, 5-80, 6-36

IBE_USER_ADMIN, 5-85
B2B user roles, 5-85

creating, 6-36
seeded values, 5-85

B2B users
default customer responsibility, 5-79
Role Management, 5-87
user administration, 5-85
User Management, 5-86

B2C users
default customer responsibility, 5-79

C
cache management, 6-36

product cache, 6-37, 6-39
purging entire cache, 6-37
section cache, 6-37, 6-38

Cascading Style Sheets, 6-13
categories, 6-27

assigning display styles, 6-27, 6-28
assigning multimedia, 6-27, 6-28
assigning templates, 6-27, 6-28

concurrent programs
checking program status, 5-9, 5-43

iStore - Express Checkout Order 
Submission, 5-4, 5-7

iStore Alert Reports, 5-5, 5-66
iStore Reports Complete Data Refresh Set, 5-5, 

5-7, 5-69
iStore Reports Fact Tables Refresh, 5-5, 5-65
iStore Reports Increment Data Refresh Set, 5-6, 

5-7, 5-72
iStore Reports Materialized Views Refresh, 5-5, 

5-66
iStore Search Insert, 5-4, 5-42, 5-45
iStore Section Search Refresh, 5-4, 5-44, 5-45

contracts, 11-1 to 11-7
cookies, 3-23
credit card payments, 12-2
currencies, 3-6
currency

user choice, 5-17, A-13
customers

responsibilities, 5-79
user names and responsibilities, B-6

D
Data Out Bins, 5-64

customizing drilldown pages, 5-74
debugging, 3-23, 8-2
dependency

verification, 3-26
dependency requirements, 3-2
display styles

assigning to categories, 6-27
calling templates, 6-21
cataloging, 6-21
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seeded values, 6-21

E
error messages

IBE_DSP_J_CRT_HIER_SCT_FAIL, 8-6
IBE_DSP_J_GET_ITM_LST_FAIL, 8-17
IBE_ORD_CAUGHT_ERR, 10-13
MediaNotFoundException, 8-7
NullPointerException, 8-7
ORA-29868, 8-4
TemplateNotFoundException, 8-7

errors
catalog, 8-8
Display Manager, 8-7
Oracle8i interMedia ctxsys data dictionary, 8-21
Oracle8i interMedia post-installation, 8-22
Postsales, 8-20
pricing, 8-8, 8-12
product search, 8-14
shopping list, 8-14

Express Checkout
processing orders, 5-4, 5-7

G
globalization, 5-17, A-13

H
hardware requirements, 2-3
hierarchy

adding products to sections, 5-28
adding subsections to sections, 5-29
assigning products to, 5-21
creating, 5-21
creating sections, 5-23
modifying, 5-21
modifying sections, 5-27
moving sections, 5-31

host configuration, 3-23

I
installation

verification, 3-26

J
Java applet warning workaround, 8-3
JavaServer Pages, 6-11
JSPs, 6-11

caching, 6-12
Cascading Style Sheets, 6-13
naming conventions, 6-13
product search, 5-49
source code directory, 6-12

K
keywords, 6-6, 6-7

L
language

user choice, 5-17, A-13
languages, 3-6
lookup codes

sales assistance, 3-7
Storefront Reports, 5-75

M
Merchant UI, 5-12
multimedia

assigning to categories, 6-27
cataloging, 6-5
creating media source files, 6-2
customizing, 6-2
naming, 6-4

multimedia components
cataloging, 6-8
seeded values, 6-9

N
notifications, 5-52

adding configurations, 5-58
configurable parameters, 5-55
disabling, 5-62
mapping messages, 5-54
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modifying configurations, 5-59
parameter precedence, 5-54
removing configurations, 5-61

O
operating units

responsibilities, B-6
setting up multiple, 3-13, 3-20, 5-2, 5-91, A-7, 

A-32, B-6
Oracle 8i interMedia, 8-21
Oracle Advanced Supply Chain 

Planning, 9-1 to 9-2
Oracle Application Object Library (AOL), 3-2

currencies, 3-6
languages, 3-6
sales assistance prompts, 3-7
Storefront Reports, 5-75

Oracle Configurator, 10-1 to 10-14
Oracle Contracts for Sales, 11-1 to 11-7
Oracle CRM Technology Foundation, 3-2, 3-23
Oracle Forms

logging in, 3-6, B-2
responsibilities, B-2
setting up Oracle iStore user accounts, 5-2

Oracle General Ledger, 3-2, 3-8
Oracle Human Resources, 3-2, 3-9
Oracle Inventory, 3-2, 5-21, 5-25, 5-32

setting up, 3-12
setting up for product search, 5-40
setting up for the product catalog, 5-33

Oracle iPayment, 12-1 to 12-3
setting up for credit card payments, 12-3

Oracle iSupport, 13-1 to 13-2
Oracle Marketing Online, 14-1 to 14-4
Oracle Order Capture

setting up, 3-21
Oracle Order Management, 3-3, 6-33

setting up, 3-19
setting up checkout page flexfields, 6-34

Oracle Pricing, 6-33
setting up, 3-15

Oracle Receivables
setting up, 3-14
setting up for credit card payments, 12-3

Oracle Shipping Execution, 15-1 to 15-2
Oracle Web Cache, 16-1 to 16-15
Oracle Workflow, 17-1 to 17-6

P
product catalog

modifying, 5-35
Oracle Inventory prerequisites, 5-33
setting up, 5-32

product search
category-level, 5-42
changing type, 5-44
Oracle Inventory prerequisites, 5-40
profile options, 5-41
program units, 5-49
search index tables, 5-48
search tables, 5-40, 5-50
searchable attributes, 5-40, 5-51
section-level, 5-43
setting up, 5-39
stopwords, 5-52

products
adding item descriptive flexfields, 6-30
assigning templates, 5-37
category-level presentation, 6-27
creating images for, 6-29
publishing, 5-35

profile options
concurrent program manager, A-35
Customer UI, 5-89
Merchant UI, 3-22
Multiple Organization (MO), 5-91, A-32
Oracle Contracts Core (OKC), A-33
Oracle CRM Technology Foundation 

(JTT), 3-22, A-4
Oracle iStore (IBE), 3-22, 5-89, A-6 to A-29
Oracle Order Capture (ASO), 5-90, A-29
Oracle Order Management (OM), 5-90, A-31
setting, A-2
site level, 5-91, A-35

R
relationship rules, 5-25, 5-28, 6-23
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creating mapping rules, 6-26
creating SQL rules, 6-27

relationship types, 6-23
adding relationship rules, 6-25
creating, 6-25
seeded values, 6-24

relationships
creating, 6-23

reporting problems, 8-23
requirements

hardware, 2-3
Oracle applications, 3-2
software, 2-3

responsibilities, B-1
creating, A-5
customers, 5-79, B-6
Oracle Forms, B-2

roles, 5-80

S
sales assistance, 3-7, A-26
search index tables, 5-48
searches

category-level, 5-42
section-level, 5-43

seeded values
B2B user roles, 5-85
display styles, 6-21
multimedia components, 6-9
relationship types, 6-24
responsibilities, B-1
user roles, 5-82

Self-Service Administrator UI, C-1 to C-66
shipping

define methods, 3-14
enabling methods for Web, 3-20
parameters, 15-2
rules, 15-2

shopping cart
checkout page flexfields, 6-34
credit card payments, 12-2
decimal quantities, 6-33
UOM conversions, 6-33

software requirements, 2-3

specialty store
creating, 4-2, 5-13
customization, 4-2
globalization, 5-13
root section, 5-15, 5-25, 5-26
testing the storefront, 7-2

Storefront Reports, 5-64
architecture, 5-65
concurrent programs, 5-65, 5-66, 5-68
formats, 5-64
lookup codes, 5-75
preparing data, 5-68

T
templates

assigning presentation levels, 6-17
assigning to categories, 6-27
Cascading Style Sheets, 6-13
cataloging, 6-17
creating template source files, 6-12
creating text for, 5-32
customizing, 6-11
JSP caching, 6-12
JSP naming conventions, 6-13
JSP source code directory, 6-12
modifying seeded source files, 6-13
naming, 6-16

testing the store, 7-2

U
user names

customers, B-6
user roles

seeded values, 5-82
users, B-1

concurrent program manager, 5-3
creating, A-5
guest account, 5-10, A-5
roles, 5-80
store manager account, 5-2
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